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Chapter 1. C Language

This chapter describes the target specific features of the C language, including language extensions that
are not standard in ISO-C. For example, pragmas are a way to control the compiler from within the C
source.

The TASKING VX-toolset for ARM® C compiler fully supports the ISO-C standard and adds extra
possibilities to program the special functions of the target.

In addition to the standard C language, the compiler supports the following:

« attribute to specify alignment and absolute addresses

« intrinsic (built-in) functions that result in target specific assembly instructions
» pragmas to control the compiler from within the C source

» predefined macros

* the possibility to use assembly instructions in the C source

» keywords for inlining functions and programming interrupt routines

* libraries

All non-standard keywords have two leading underscores (__).

In this chapter the target specific characteristics of the C language are described, including the above
mentioned extensions.

1.1. DataTypes

The TASKING C compiler for the ARM supports the following data types.

C type Size Align Limits
_Bool 1 8 Oor1l
signed char 8 8 [-27, 27-1]
unsigned char 8 8 [0, 28-1]
short 16 16 [-2°, 27°-1)
unsigned short 16 16 [0, 216-1]
int 32 32 [-2%%, 2%
unsigned int 32 32 [0, 232-1]
enum 32 32 [-2° 2%
long 32 32 [-2%, 2%
unsigned long 32 32 [0, 232-1]
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C type Size Align Limits

long long 64 64 [-263, 263-1]

unsigned long long 64 64 [0, 264-1]

float (23-bit mantissa) 32 32 [-3.402E+38, —1.175E-38]
[+1.175E-38, +3.402E+38]

double 64 64 [-1.797E+308, -2.225E-308]

long double (52-bit mantissa) [+2.225E-308, +1.797E+308]

_Imaginary float 32 32 [-3.402E+38i, —1.175E-38i]
[+1.175E-38i, +3.402E+38i]

_Imaginary double 64 64 [-1.797E+308i, -2.225E-308i]

_Imaginary long double [+2.225E-308i, +1.797E+308i]

_Complex float 64 32 real part + imaginary part

_Complex double 128 64 real part + imaginary part

_Complex long double

pointer to data or function 32 32 [0, 232-1]

1.2. Changing the Alignment: __unaligned, _packed _and
__align()

Normally data, pointers and structure members are aligned according to the table in the previous section.

Suppress alignment

With the type qualifier __unal i gned you can specify to suppress the alignment of objects or structure
members. This can be useful to create compact data structures. In this case the alignment will be one bit
for bit-fields or one byte for other objects or structure members.

At the left side of a pointer declaration you can use the type qualifier __unal i gned to mark the pointer
value as potentially unaligned. This can be useful to access externally defined data. However the compiler
can generate less efficient instructions to dereference such a pointer, to avoid unaligned memory access.

You can always convert a normal pointer to an unaligned pointer. Conversions from an unaligned pointer
to an aligned pointer are also possible. However, the compiler will generate a warning in this situation,
with the exception of the following case: when the logical type of the destination pointer is char orvoi d,
no warning will be generated.

Example:

struct

{
char c;
__unaligned int i; /* aligned at offset 1 ! */

}os;

__unaligned int * up = & s.1i;
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Packed structures

To prevent alignment gaps in structures, you can use the attribute __packed__ . When you use the
attribute __packed___directly after the keyword st r uct , all structure members are marked __unal i gned.
For example the following two declarations are the same:

struct __packed__

{

char c;

int * i;
} sl
struct
{

char __unaligned c;

int * _unaligned i; /* __unaligned at right side of

to pack pointer menber */

} s2;

The attribute __packed__ has the same effect as adding the type qualifier __unal i gned to the
declaration to suppress the standard alignment.

You can also use __packed___in a pointer declaration. In that case it affects the alignment of the pointer
itself, not the value of the pointer. The following two declarations are the same:

int * _ unaligned p;
int * p __ packed__;

Change alignment

With the attribute __al i gn( n) you can overrule the default alignment of objects or structure members
to n bytes.

1.3. Placing an Object at an Absolute Address: _ at()

With the attribute __at () you can specify an absolute address.

The compiler checks the address range, the alignment and if an object crosses a page boundary.
Examples

unsi gned char Display[80*24] _ at( 0x2000 );

The array Di spl ay is placed at address 0x2000. In the generated assembly, an absolute section is
created. On this position space is reserved for the variable Di spl ay.

int i __at(0x1000) = 1;

The variable i is placed at address 0x1000 and is initialized.
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void f(void) __at( Oxfoff + 1) { }

The function f is placed at address 0xf100.

Restrictions

Take note of the following restrictions if you place a variable at an absolute address:
» The argument of the __at () attribute must be a constant address expression.

* You can place only global variables at absolute addresses. Parameters of functions, or automatic
variables within functions cannot be placed at absolute addresses.

» Avariable that is declared ext er n, is not allocated by the compiler in the current module. Hence it is
not possible to use the keyword __at () on an external variable. Use __at () at the definition of the
variable.

* You cannot place structure members at an absolute address.

» Absolute variables cannot overlap each other. If you declare two absolute variables at the same address,
the assembler and/or linker issues an error. The compiler does not check this.

1.4. Accessing Hardware from C

It is easy to access Special Function Registers (SFRs) that relate to peripherals from C. The SFRs are
defined in a special include file (*. h) as symbol nhames for use with the compiler.

The TASKING VX-toolset for ARM supports the Cortex Micro-controller Software Interface Standard
(CMSIS). You can find details about this standard on www.onarm.com.

The product includes a full set of CMSIS files in the cnsi s directory under the product installation directory.
This includes SFR files for the supported devices and for the various Cortex cores. The organization of
the CMSIS files in the product installation is as follows:

cnsi s/ CMD/ Cor eSupport directory with Cortex-MO0 header files and C files

cnsi s/ CMD/ Devi ceSupport/ vendor/ devi ce directory with Cortex-MO device specific header files
and C files

cnsi s/ CMB/ Cor eSuppor t directory with Cortex-M3 header files and C files

cnsi s/ CM3/ Devi ceSupport/ vendor/ devi ce directory with Cortex-M3 device specific header files
and C files

When you include CMSIS SFR file in your source you must set an include search path to the appropriate
CMSIS directory.

Example of including an SFR file:

#i ncl ude "stnB2f 10x. h"

voi d mai n(voi d)

{

4
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SCB->VTOR | = (1 << SCB_VTOR TBLBASE_Pos);
}

Compiler invocation:

ccarm-c -CARW7M -1"install ation_dir\cnsi s\ CMB\ Devi ceSupport\ ST\ STM32F10x"
-1"installation_dir\cnsi s\ CMB\ CoreSupport” file.c

When you use Eclipse you can easily add the include search paths by using the option Project »
Properties for » C/C++ Build » Settings » C/C++ Compiler » Add CMSIS include paths.

1.5. Using Assembly in the C Source: __asm()

With the keyword __asmyou can use assembly instructions in the C source and pass C variables as
operands to the assembly code. Be aware that C modules that contain assembly are not portable and
harder to compile in other environments.

The compiler does not interpret assembly blocks but passes the assembly code to the assembly source
file; they are regarded as a black box. So, it is your responsibility to make sure that the assembly block
is syntactically correct. Possible errors can only be detected by the assembler.

You need to tell the compiler exactly what happens in the inline assembly code because it uses that for
code generation and optimization. The compiler needs to know exactly which registers are written and
which registers are only read. For example, if the inline assembly writes to a register from which the
compiler assumes that it is only read, the generated code after the inline assembly is based on the fact
that the register still contains the same value as before the inline assembly. If that is not the case the
results may be unexpected. Also, an inline assembly statement using multiple input parameters may be
assigned the same register if the compiler finds that the input parameters contain the same value. As
long as this register is only read this is not a problem.

General syntax of the __asm keyword

__asn( "instruction_tenplate"”
[ : output_paramli st
[ : input_paramli st
[ : register_reserve_list]]] );

instruction_template Assembly instructions that may contain parameters from the input
list or output list in the form: %parm_nr
%parm_nr Parameter number in the range 0 .. 9.
output_param_list [[ "=[&]constraint_char" (C_expression)],...]
input_param_list [ "constraint_char" (C_expression)],...]
& Says that an output operand is written to before the inputs are read,
so this output must not be the same register as any input.
constraint _char Constraint character: the type of register to be used for the

C_expression. See the table below.
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C_expression Any C expression. For output parameters it must be an Ivalue, that
is, something that is legal to have on the left side of an assignment.
register_reserve_list ["register_name"],...]
register_name Name of the register you want to reserve. For example because this

register gets clobbered by the assembly code. The compiler will not
use this register for inputs or outputs. Note that reserving too many
registers can make register allocation impossible.

Specifying registers for C variables
With a constraint character you specify the register type for a parameter.

You can reserve the registers that are used in the assembly instructions, either in the parameter lists or
in the reserved register list (register_reserve_list). The compiler takes account of these lists, so no
unnecessary register saves and restores are placed around the inline assembly instructions.

Constraint Type Operand Remark
character
r general purpose register |rO .. r11, Ir Thumb mode r0 .. r7
number type of operand it is same as %number |Input constraint only. The number must
associated with refer to an output parameter. Indicates
that %enumber and number are the same
register.

If an input parameter is modified by the inline assembly then this input parameter must also be
added to the list of output parameters (see Example 6). If this is not the case, the resulting code
may behave differently than expected since the compiler assumes that an input parameter is not
being changed by the inline assembly.

Loops and conditional jumps

The compiler does not detect loops with multiple __asn{) statements or (conditional) jumps across
__asn() statements and will generate incorrect code for the registers involved.

If you want to create a loop with __asn{( ) , the whole loop must be contained in a single __asmn()
statement. The same counts for (conditional) jumps. As a rule of thumb, all references to a label in an
__asn() statement must be in that same statement. You can use numeric labels for these purposes.

Example 1: no input or output

A simple example without input or output parameters. You can use any instruction or label. When it is
required that a sequence of __asn{) statements generates a contiguous sequence of instructions, then
they can be best combined to a single __asmn() statement. Compiler optimizations can insert instruction(s)
in between __asm() statements. Note that you can use standard C escape sequences. Use newline
characters \n’to continue on anew lineina__asn{) statement. For multi-line output, use tab characters
\t' to indent instructions.
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__asn( "nop\n"
"\'tnop" );

Example 2: using output parameters

Assign the result of inline assembly to a variable. With the constraint r a general purpose register is
chosen for the parameter; the compiler decides which register it uses. The %9 in the instruction template
is replaced with the name of this register. The compiler generates code to assign the result to the output
variable.

int out;

void main( void )

{

__asm( "mov %O, #Oxff"
"=r* (out) );

}

Generated assembly code:

mov r 0, #0xf f
| dr rl,.L2
str r0,[r1, #0]
bx Ir
.Size main,$-main
.align 4
.L2:
. dw out

Example 3: using input parameters

Assign a variable to a register. A register is chosen for the parameter because of the constraint r ; the
compiler decides which register is best to use. The %0 in the instruction template is replaced with the
name of this register. The compiler generates code to move the input variable to the input register. Because
there are no output parameters, the output parameter list is empty. Only the colon has to be present.

int in;
void initreg( void)
{
__asn( "MV RO, %"
rin) )
}
Generated assembly code:
| dr ro,.L2
| dr r0,[rO0, #0]
MOV RO, rO
bx Ir
.Size initreg,$-initreg
.align 4
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.L2:
. dw in

Example 4: using input and output parameters

Add two C variables and assign the result to a third C variable. Registers are used for the input and output
parameters (constraint r , 9% for out , %4 for i n1, %2 for i n2 in the instruction template). The compiler
generates code to move the input expressions into the input registers and to assign the result to the output
variable.

int inl, in2, out;

voi d add32( void )

{
_asm "add %, %, w"
"=r" (out)
“r" (inl), "r" (in2) );

}

Generated assembly code:
| dr ro,.L2
| dr rl,[rO0, #0]
| dr ro, [ro0, #4]
add r0, rl1, rO0
| dr rl,.L2
str ro,[r1, #8]
bx I'r
.size add32, $-add32
.align 4

. L2:
. dw inl
.section . bss
.global inl
.align 4

inl: .type object
.Size inl, 4
. ds 4
.global in2
.align 4

in2: .type object
.Size in2, 4
. ds 4
. gl obal out
.align 4

out: .type obj ect
.size out, 4
. ds 4
. endsec
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Example 5: reserving registers

Sometimes an instruction knocks out certain specific registers. The most common example of this is a
function call, where the called function is allowed to do whatever it likes with some registers. If this is the
case, you can list specific registers that get clobbered by an operation after the inputs.

Same as Example 4, but now register r 0 is a reserved register. You can do this by adding a reserved
register list (: "r0"). As you can see in the generated assembly code, register r 0 is not used (the first
register used is r 1).

int inl, in2, out;

voi d add32( void )

{
__asm "add %, %, wR"
"=r" (out)
“r" (inl), "r" (in2)
"ro" )
}
Generated assembly code:
| dr r2,.L2
| dr r2,[r1, #0]
| dr rl, [rl, #4]
add r1, r2, ril
| dr ro,.L2
str rl,[rO, #8]
bx Ir
.size add32, $- add32
.align 4
.L2:
. dw inl

Example 6: use the same register for input and output

As input constraint you can use a humber to refer to an output parameter. This tells the compiler that the
same register can be used for the input and output parameter. When the input and output parameter are
the same C expression, these will effectively be treated as if the input parameter is also used as output.
In that case it is allowed to write to this register. For example:

inline int foo(int parl, int par2, int * par3)

{

int retval ue;

__asm(
"add 92, %, %, 1sl #2\n\t"
"mov 9%, YR\ n\t"
"mov 99, "
"=&" (retvalue), "=r" (parl), "=r" (par2)
"1" (parl), "2" (par2), "r" (par3)
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)
return retval ue;

}

int result,parm

voi d func(void)

{
result = foo(1000, 1000, &arm ;

}

In this example the "1" constraint for the input parameter par 1 refers to the output parameter par 1, and
similar for the "2" constraint and par 2. In the inline assembly %4 (par 1) and %2 (par 2) are written. This
is allowed because the compiler is aware of this.

This results in the following generated assembly code:

mov r 0, #1000

mov rl,r0
ldr r2,.L2
add r1,r0,r0,Isl #2
mov r2,rl
mov r3,rl
ldr r0,.L2+4
str r3,[r0, #0]
bx Ir
.L2:
.dw parm

.dw result

However, when the inline assembly would have been as given below, the compiler would have assumed
that %4 (par 1) and %2 (par 2) were read-only. Because of the i nl i ne keyword the compiler knows that
par 1 and par 2 both contain 1000. Therefore the compiler can optimize and assign the same register to
% and 92. This would have given an unexpected result.

__asn(
"add 92,9, 9, 1sl #2\n\t"

"mov 98, %2\ n\t"
"mov 99, R"
"=&" (retval ue)
"r" (parl), "r" (par2), "r" (par3)
)

Generated assembly code:

ldr ro0,.L2
nmov rl, #1000

10
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add rl1,rl,r1,1sl #2 ; sane register, but is expected read-only
nmv r0,rl
nmv r2,rl
ldr rO,.L2+4
str r2,[r0, #0] ; contains unexpected result
bx Ir
. L2:
.dw parm

.dw result

1.6. Attributes

You can use the keyword __att ri but e__ to specify special attributes on declarations of variables,
functions, types, and fields.

Syntax:
__attribute__((nane,...))
or:

nane

The second syntax allows you to use attributes in header files without being concerned about a possible
macro of the same name.

alias("symbol")

Youcanuse __attribute__((alias("synbol"))) to specify that the function declaration appears
in the object file as an alias for another symbol. For example:

void _ f() { /* function body */; }
void f() __attribute_ ((weak, alias("__f")));

declares 'f ' to be a weak alias for'__ f".

const

Youcanuse __attribute__((const)) to specify that a function has no side effects and will not
access global data. This can help the compiler to optimize code.

The following kinds of functions should not be declared __const __:
« A function with pointer arguments which examines the data pointed to.

» A function that calls a non-const function.

11
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export

Youcanuse __attribute__((export)) to specify that a variable/function has external linkage and
should not be removed. During MIL linking, the compiler treats external definitions at file scope as if they
were declared st at i c. As a result, unused variables/functions will be eliminated, and the alias checking
algorithm assumes that objects with static storage cannot be referenced from functions outside the current
module. During MIL linking not all uses of a variable/function can be known to the compiler. For example
when a variable is referenced in an assembly file or a (third-party) library. With the export attribute the
compiler will not perform optimizations that affect the unknown code.

int i __attribute__((export)); /* '"i' has external |inkage */

flatten

Youcanuse __attribute__ ((flatten)) toforce inlining of all function calls in a function, including
nested function calls.

Unless inlining is impossible or disabled by __attri bute__((noinline)) for one of the calls, the
generated code for the function will not contain any function calls.

format(type,arg_string_index,arg_check_start)

Youcanuse __attribute_ ((format(type,arg_string_index,arg _check_start))) to
specify that functions take format strings as arguments and that calls to these functions must be
type-checked against a format string, similar to the way the compiler checks calls to the functions pri nt f ,
scanf,strftime, and st rf non for errors.

arg_string_index is a constant integral expression that specifies which argument in the declaration of the
user function is the format string argument.

arg_check_start is a constant integral expression that specifies the first argument to check against the
format string. If there are no arguments to check against the format string (that is, diagnostics should only
be performed on the format string syntax and semantics), arg_check_start should have a value of 0. For
strfti me-style formats, arg_check_start must be 0.

Example:
int foo(int i, const char * ny format, ...) __attribute__((format(printf, 2,

The format string is the second argument of the function f oo and the arguments to check start with the
third argument.

leaf

Youcanuse __attribute__((Ieaf)) tospecify that a function is a leaf function. A leaf function is
an external function that does not call a function in the current compilation unit, directly or indirectly. The
attribute is intended for library functions to improve dataflow analysis. The attribute has no effect on
functions defined within the current compilation unit.

12
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malloc

Youcanuse __attribute__((malloc)) toimprove optimization and error checking by telling the
compiler that:

» The return value of a call to such a function points to a memory location or can be a null pointer.

» Onreturn of such a call (before the return value is assigned to another variable in the caller), the memory
location mentioned above can be referenced only through the function return value; e.g., if the pointer
value is saved into another global variable in the call, the function is not qualified for the malloc attribute.

» The lifetime of the memory location returned by such a function is defined as the period of program
execution between a) the point at which the call returns and b) the point at which the memory pointer
is passed to the corresponding deallocation function. Within the lifetime of the memory object, no other
calls to malloc routines should return the address of the same object or any address pointing into that
object.

noinline

Youcanuse __attribute__((noinline)) toprevent afunction from being considered for inlining.
Same as keyword __noi nl i ne or #pr agna noi nl i ne.

always_inline

With __attribute__((always_inline)) you force the compiler to inline the specified function,
regardless of the optimization strategy of the compiler itself. Same as keyword i nl i ne or #pr agna
i nline.

noreturn

Some standard C function, such as abort and exit cannot return. The C compiler knows this automatically.
Youcanuse __attribute__((noreturn)) to tell the compiler that a function never returns. For
example:

void fatal () __attribute_ ((noreturn));

void fatal ( /* ... */ )

{
/* Print error nessage */
exit(1);

}

The function f at al cannot return. The compiler can optimize without regard to what would happen if
f at al ever did return. This can produce slightly better code and it helps to avoid warnings of uninitialized
variables.

13
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protect

Youcanuse__attribute_ ((protect)) toexclude avariable/function from the duplicate/unreferenced
section removal optimization in the linker. When you use this attribute, the compiler will add the "protect”
section attribute to the symbol's section. Example:

int i __attribute__ ((protect));

Note that the protect attribute will not prevent the compiler from removing an unused variable/function
(see the used symbol attribute).

This attribute is the same as #pr agna pr ot ect/ endpr ot ect .

pure

Youcanuse __attribute__((pure)) to specify that a function has no side effects, although it may
read global data. Such pure functions can be subject to common subexpression elimination and loop
optimization.

section("section_name")

Youcanuse __attribute__((section("nanme"))) to specify that a function must appear in the
object file in a particular section. For example:

extern void foobar(void) _ attribute_ ((section("bar")));

puts the function f oobar in the section named bar .

See also #pragnma secti on.

used

Youcanuse __attribute__ ((used)) toprevent an unused symbol from being removed, by both the
compiler and the linker. Example:

static const char copyright[] _ attribute_ ((used)) = "Copyright 2010 Altium BV";
When there is no C code referring to the copyr i ght variable, the compiler will normally remove it. The

__attribute__((used)) symbol attribute prevents this. Because the linker should also not remove
this symbol, __attribute__ ((used)) implies__attribute__ ((protect)).

unused

Youcanuse __attribute__((unused)) to specify that a variable or function is possibly unused. The
compiler will not issue warning messages about unused variables or functions.

weak

Youcanuse __attribute__((weak)) tospecify that the symbol resulting from the function declaration
or variable must appear in the object file as a weak symbol, rather than a global one. This is primarily

14
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useful when you are writing library functions which can be overwritten in user code without causing
duplicate name errors.

See also #pragnma weak.

1.7. Pragmas to Control the Compiler

Pragmas are keywords in the C source that control the behavior of the compiler. Pragmas overrule
compiler options. Put pragmas in your C source where you want them to take effect. Unless stated
otherwise, a pragma is in effect from the point where it is included to the end of the compilation unit or
until another pragma changes its status.

The syntax is:
#pragma [ | abel : ] pragma-spec pragnma-argunents [on | off | default | restore]

or:

_Pragma( "[I|abel :] pragma-spec pragma-argunments [on | off | default | restore]"” )

Some pragmas can accept the following special arguments:

on switch the flag on (same as without argument)
of f switch the flag off

def aul t set the pragma to the initial value

restore restore the previous value of the pragma

Label pragmas

Some pragmas support a label prefix of the form "label:" between #pr agma and the pragma name. Such
a label prefix limits the effect of the pragma to the statement following a label with the specified name.
The r est or e argument on a pragma with a label prefix has a special meaning: it removes the most
recent definition of the pragma for that label.

You can see a label pragma as a kind of macro mechanism that inserts a pragma in front of the statement
after the label, and that adds a corresponding #pr agma ... rest or e after the statement.

Compared to regular pragmas, label pragmas offer the following advantages:

» The pragma text does not clutter the code, it can be defined anywhere before a function, or even in a
header file. So, the pragma setting and the source code are uncoupled. When you use different header
files, you can experiment with a different set of pragmas without altering the source code.

» The pragma has an implicit end: the end of the statement (can be a loop) or block. So, no need for
pragma restore / endoptimize etc.

Example:

15
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#pragma | abl:optimze P
volatile int v;

voi f( void)

{
int i, a
a = 42;
labl: for( i=1; i<10; i++)
{
/* the entire for loop is part of the pragma optim ze */
a +=i;
}
VvV = a;

}
Supported pragmas

The compiler recognizes the following pragmas, other pragmas are ignored. Pragmas marked with (*)
support a label prefix.

alias symbol=defined_symbol
Define symbol as an alias for defined_symbol. It corresponds to an equate directive (. EQU) at assembly

level. The symbol should not be defined elsewhere, and defined_symbol should be defined with static
storage duration (not extern or automatic).

call {near | far | default | restore} (*)

By default, functions are called with 26-bit PC-relative calls. This near call is directly coded into the
instruction, resulting in higher execution speed and smaller code size. The destination address of a near
call must be located within +/-32 MB from the program counter.

The other call mode is a 32-bit indirect call. With far calls you can address the full range of memory. The
address is first loaded into a register after which the call is executed.

See C compiler option --call (-m).

compactmaxmatch {value | default | restore} (*)

With this pragma you can control the maximum size of a match.

See C compiler option --compact-max-size.

extension isuffix [on | off | default | restore] (*)

Enables a language extension to specify imaginary floating-point constants. With this extension, you can
use an "i" suffix on a floating-point constant, to make the type _| magi nary.
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float 0.5i

extern symbol
Normally, when you use the C keyword ext er n, the compiler generates an . EXTERN directive in the

generated assembly source. However, if the compiler does not find any references to the ext er n symbol
in the C module, it optimizes the assembly source by leaving the . EXTERN directive out.

With this pragma you can force an external reference (. EXTERN assembler directive), even when the
symbol is not used in the module.

inline / noinline / smartinline
See Section 1.10.2, Inlining Functions: inline.
inline_max_incr / inline_max_size {value | default | restore} (*)

With these pragmas you can control the automatic function inlining optimization process of the compiler.
It has only effect when you have enabled the inlining optimization (--optimize=+inline (-Oi)).

See C compiler options --inline-max-incr and --inline-max-size.

macro / nomacro [on | off | default | restore] (*)

Turns macro expansion on or off. By default, macro expansion is enabled.
maxcalldepth {value | default | restore} (*)

With this pragma you can control the maximum call depth. Default is infinite (-1).
See C compiler option --max-call-depth.

message "message" ...

Print the message string(s) on standard output.

nomisrac [nr,...] [default | restore] (*)

Without arguments, this pragma disables MISRA-C checking. Alternatively, you can specify a
comma-separated list of MISRA-C rules to disable.

See C compiler option --misrac and Section 4.7.2, C Code Checking: MISRA-C.
optimize [flags | default | restore] (*) / endoptimize

You can overrule the C compiler option --optimize for the code between the pragmas opt i ni ze and
endopt i m ze. The pragma works the same as C compiler option --optimize.

See Section 4.5, Compiler Optimizations.
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profile [flags | default | restore] (*) / endprofile
Control the profile settings. The pragma works the same as C compiler option --profile. Note that this

pragma will only be checked at the start of a function. endpr of i | e switches back to the previous profiling
settings.

profiling [on | off | default | restore] (*)

If profiling is enabled on the command line (C compiler option --profile), you can disable part of your
source code for profiling with the pragmas profili ng of f and profili ng.

protect [on | off | default | restore] (*) / endprotect
With these pragmas you can protect sections against linker optimizations. This excludes a section from

unreferenced section removal and duplicate section removal by the linker. endpr ot ect restores the
default section protection.

runtime [flags | default | restore] (*)

With this pragma you can control the generation of additional code to check for a number of errors at
run-time. The pragma argument syntax is the same as for the arguments of the C compiler option --runtime.
You can use this pragma to control the run-time checks for individual statements. In addition, objects
declared when the "bounds" sub-option is disabled are not bounds checked. The "malloc" sub-option

cannot be controlled at statement level, as it only extracts an alternative malloc implementation from the
library.

section [name=]{suffix |-f|-m|-fm} [default | restore] (*) / endsection

Rename sections by adding a sulffix to all section names specified with name, or restore default section
naming. If you specify only a suffix (without a name), the suffix is added to all section names. See C
compiler option --rename-sections and assembler directive . SECTI ON for more information.

section_code_init [on | off | default | restore] (*) / section_no_code_init

Copy or do not copy code sections from ROM to RAM at application startup.

section_const_init [on | off | default | restore] (*) / section_no_const_init

Copy or do not copy read-only data sections from ROM to RAM at application startup.

silicon_bug [bug,...] [default | restore] (*)

Without arguments, all silicon bug workarounds are enabled. Alternatively, you can specify a
comma-separated list of silicon bug workarounds.

See C compiler option --silicon-bug and Chapter 19, CPU Problem Bypasses and Checks.
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source [on | off | default | restore] (*) / nosource

With these pragmas you can choose which C source lines must be listed as comments in assembly output.
See C compiler option --source.

stdinc [on | off | default | restore] (*)

This pragma changes the behavior of the #i ncl ude directive. When set, the C compiler options
--include-directory and --no-stdinc are ignored.

linear_switch / jump_switch / binary_switch / smart_switch / tbb_switch
/ tbh_switch / no_tbh_switch

With these pragmas you can overrule the compiler chosen switch method:

| i near_swi tch Force jump chain code. A jump chain is comparable with an if/else-if/else-if/else

construction.

jump_switch Force jump table code. A jump table is a table filled with jump instructions for each
possible switch value. The switch argument is used as an index to jump within this
table.

bi nary_swi tch Force binary lookup table code. A binary search table is a table filled with a value
to compare the switch argument with and a target address to jump to.

smart_switch Let the compiler decide the switch method used.

tbb_switch Force use of the t bb instruction. Uses a table of 8-bit jump offsets.
tbh_switch Force use of the t bh instruction. Uses a table of 8-bit jump offsets.
no_tbh _switch Sameassnmart_swi tch, but do not use thet bh instruction.

See Section 1.9, Switch Statement.
tradeoff {level | default | restore} (*)
Specify tradeoff between speed (0) and size (4). See C compiler option --tradeoff

warning [number,...] [default | restore] (*)

With this pragma you can disable warning messages. If you do not specify a warning number, all warnings
will be suppressed.

weak symbol

Mark a symbol as "weak" (. WEAK assembler directive). The symbol must have external linkage, which
means a global or external object or function. A static symbol cannot be declared weak.

A weak external reference is resolved by the linker when a global (or weak) definition is found in one of
the object files. However, a weak reference will not cause the extraction of a module from a library to
resolve the reference. When a weak external reference cannot be resolved, the null pointer is substituted.
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A weak definition can be overruled by a normal global definition. The linker will not complain about the
duplicate definition, and ignore the weak definition.

1.8. Predefined Preprocessor Macros

The TASKING C compiler supports the predefined macros as defined in the table below. The macros are
useful to create conditional C code.

Macro Description

__ARM__ Expands to 1 for the ARM toolset, otherwise unrecognized as macro.

__BIG_ENDIAN___ Expands to 1 if big-endian mode is selected (option --endianness=big),
otherwise unrecognized as macro.

__BUILD__ Identifies the build number of the compiler, composed of decimal digits for
the build number, three digits for the major branch number and three digits
for the minor branch number. For example, if you use build 1.22.1 of the
compiler, __ BUILD__ expands to 1022001. If there is no branch number,
the branch digits expand to zero. For example, build 127 results in
127000000.

_ CARM__ Expands to 1 for the ARM toolset, otherwise unrecognized as macro.

__CPU__ Expands to the ARM architecture name (option --cpu=arch). When no --cpu
is supplied, this symbol is not defined. For example, if --cpu=ARMvV7M is
specified, the symbol __CPU__ expands to ARM/7M

_ CPU_arch__ A symbol is defined depending on the option --cpu=arch. The arch is
converted to uppercase. For example, if --cpu=ARMV7M is specified, the
symbol __CPU_ARW/7M__ is defined. When no --cpu is supplied, this symbol
__CPU_ARWTM _is the default.

_ DATE__ Expands to the compilation date: “mmm dd yyyy".

_ DOUBLE_FP__ Expands to 1 if you did not use option --no-double (Treat ‘double’ as ‘float’),
otherwise unrecognized as macro.

__DSPC__ Indicates conformation to the DSP-C standard. It expands to 1.

__DSPC_VERSION__

Expands to the decimal constant 200001L.

__FILE__ Expands to the current source file name.

__FPU_fpu__ A symbol is defined depending on the option --fpu=fpu. The fpu is converted
to uppercase and the lowercase “v" and the '-' will be removed. For example,
if --fpu=VFPv3-sp is specified, the symbol __FPU_VFP3SP___ is defined.
When no --fpu is supplied, the symbol __ FPU_NONE__ is the default.

__FPU_VFP__ Expands to 1 if one the options --fpu=fpu is specified and fpu is not NONE.

__LINE__ Expands to the line number of the line where this macro is called.

_ LITTLE_ENDIAN__

Expands to 1 if little-endian mode is selected (option --endianness=little),
otherwise unrecognized as macro. This is the default.

_ PROF_ENABLE__

Expands to 1 if profiling is enabled, otherwise expands to 0.
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Macro Description

_ REVISION__ Expands to the revision number of the compiler. Digits are represented as
they are; characters (for prototypes, alphas, betas) are represented by -1.
Examples: v1.0r1 -> 1, v1.0rb -> -1

__SINGLE_FP__ Expands to 1 if you used option --no-double (Treat ‘double’ as ‘float’),
otherwise unrecognized as macro.

__STDC__ Identifies the level of ANSI standard. The macro expands to 1 if you set
option --language (Control language extensions), otherwise expands to 0.

__STDC_HOSTED__ Always expands to 0, indicating the implementation is not a hosted
implementation.

__STDC_VERSION__ Identifies the 1ISO-C version number. Expands to 199901L for ISO C99 or
199409L for ISO C90.

__TASKING__ Identifies the compiler as a TASKING compiler. Expands to 1 if a TASKING
compiler is used.

__THUMB__ Expands to 1 if you used option --thumb, otherwise unrecognized as macro.

__TIME__ Expands to the compilation time: “hh:mm:ss”

__VERSION__ Identifies the version number of the compiler. For example, if you use version

3.0r1 of the compiler, _ VERSION__ expands to 3000 (dot and revision
number are omitted, minor version number in 3 digits).

Example

#i fdef _ CARM _
/* this part is only conpiled for the ARM */

#endi f

1.9. Switch Statement

The TASKING C compiler supports three ways of code generation for a switch statement: a jump chain
(linear switch), a jump table or a binary search table.

A jump chain is comparable with an if/else-if/else-if/else construction. A jump table is a table filled with
jump instructions for each possible switch value. The switch argument is used as an index to jump within
this table. A binary search table is a table filled with a value to compare the switch argument with and a
target address to jump to.

#pragma snmart _swi t ch is the default of the compiler. The compiler will automatically choose the most
efficient switch implementation based on code and data size and execution speed. With the C compiler
option --tradeoff you can tell the compiler to put more emphasis on speed than on memory size.

For a switch with a long type argument, only linear code is used.

For an int type argument, a jump table switch is only used when the table of cases is not too sparse.
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Especially for large switch statements, the jump table approach executes faster than the binary search
table approach. Also the jump table has a predictable behavior in execution speed: independent of the
switch argument, every case is reached in the same execution time. However, when the case labels are
distributed far apart, the jump table becomes sparse, wasting code memory. The compiler will not use
the jump table method when the waste becomes excessive.

With a small number of cases, the jump chain method can be faster in execution and shorter in size.

For ARMvV7M a switch using the t bh instruction gets priority over a normal switch table implementation.
How to overrule the default switch method
You can overrule the compiler chosen switch method by using a pragma:

#pragma |inear_switch force jump chain code
#pragma junp_swi tch force jump table code
#pragma bi nary_switch force binary search table code

#pragnma smart_switch let the compiler decide the switch method used
#pragma tbb_swi tch force use of t bb instruction (uses a table of 8-bit jump offsets)
#pragma tbh_swi tch force use of t bh instruction (uses a table of 16-bit jump offsets)

#pragma no_tbh_switch sameassmart_swi t ch, but do not use t bh instruction

Using a pragma cannot overrule the restrictions as described earlier.

The switch pragmas must be placed before the swi t ch statement. Nested swi t ch statements use the
same switch method, unless the nested swi t ch is implemented in a separate function which is preceded
by a different switch pragma.

Example:
/* place pragma before function body */
#pragnma junp_swi tch

voi d test(unsigned char val)
{ /I'* function containing the switch */
switch (val)

{
}

/* use junp table */
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1.10. Functions

1.10.1. Calling Convention

Parameter passing

A lot of execution time of an application is spent transferring parameters between functions. The fastest
parameter transport is via registers. Therefore, function parameters are first passed via registers. If no
more registers are available for a parameter, the compiler pushes parameters on the stack.

Registers available for parameter passing are r0, r1, r2 and r3.

Parameter type Registers used for parameters

_Bool, char, short, int, long, float, 32-bit |RO, R1, R2, R3
pointer, 32—bit struct

long long, double, 64—bit struct ROR1, R1R2, R2R3

The parameters are processed from left to right. The first not used and fitting register is used. Registers
are searched for in the order listed above. When a parameter is > 64 bit, or all registers are used, parameter
passing continues on the stack. The stack grows from higher towards lower addresses. The first parameter
is pushed at the lowest stack address. The alignment on the stack depends on the data type as listed in
Section 1.1, Data Types.

Examples:
void funcl( int a, char * b, char c ); /* RORL R */
void func2( long long d, char e ); /* RORL R2 */

void func4( double f, long long g, char h);
/* ROR1 R2R3 stack */

Function return values

The C compiler uses registers to store C function return values, depending on the function return types.

Return type Register

_Bool, char, short, int, long, float, 32—hit |RO
pointer, 32—bit struct

long long, double, 64—bit struct ROR1

Obijects larger than 64 bits are returned via the stack.

1.10.2. Inlining Functions: inline

With the C compiler option --optimize=+inline, the C compiler automatically inlines small functions in
order to reduce execution time (smart inlining). The compiler inserts the function body at the place the
function is called. The C compiler decides which functions will be inlined. You can overrule this behavior
with the two keywords i nl i ne (ISO-C) and __noi nl i ne.
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With the i nl i ne keyword you force the compiler to inline the specified function, regardless of the
optimization strategy of the compiler itself:

inline unsigned int abs(int val)

{
unsi gned int abs_val = val;
if (val < 0) abs_val = -val;
return abs val;

}

If a function with the keyword i nl i ne is not called at all, the compiler does not generate code for it.

You must define inline functions in the same source module as in which you call the function, because
the compiler only inlines a function in the module that contains the function definition. When you need to
call the inline function from several source modules, you must include the definition of the inline function
in each module (for example using a header file).

With the __noi nl i ne keyword, you prevent a function from being inlined:

__noinline unsigned int abs(int val)

{
unsi gned int abs_val = val;
if (val < 0) abs_val = -val;
return abs_val;

}

Using pragmas: inline, noinline, smartinline

Instead of the i nl i ne qualifier, you can also use #pr agnma i nl i ne and #pr agnma noi nl i ne to inline
a function body:

#pragma inline
unsi gned int abs(int val)

{
unsi gned int abs_val = val;
if (val < 0) abs_val = -val;
return abs val;

}

#pragma noi nline
void main( void )
{ . .

int i;

i = abs(-1);
}

If a function has an i nl i ne/__noi nl i ne function qualifier, then this qualifier will overrule the current
pragma setting.

With the #pr agma noi nl i ne /#pragma smarti nl i ne you can temporarily disable the default behavior

that the C compiler automatically inlines small functions when you turn on the C compiler option
--optimize=+inline.
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With the C compiler options --inline-max-incr and --inline-max-size you have more control over the
automatic function inlining process of the compiler.

Combining inline with __asm to create intrinsic functions

With the keyword __asmit is possible to use assembly instructions in the body of an inline function.
Because the compiler inserts the (assembly) body at the place the function is called, you can create your
own intrinsic function. See Section 1.10.4.1, Writing Your Own Intrinsic Function.

1.10.3. Interrupt Functions / Exception Handlers

The TASKING C compiler supports a number of function qualifiers and keywords to program exception
handlers. An exception handler (or: interrupt function) is called when an exception occurs.

The ARM supports seven types of exceptions. The next table lists the types of exceptions and the processor
mode that is used to process that exception. When an exception occurs, execution is forced from a fixed
memory address corresponding to the type of exception. These fixed addresses are called the exception
vectors.

Exception type Mode Normal address |High vector Function type qualifier
address

Reset Supervisor 0x00000000 OxFFFF0000

Undefined Undefined 0x00000004 OxFFFF0004 __interrupt_und

instructions

Supervisor call Supervisor 0x00000008 OxFFFF0008 __interrupt_svc

(software interrupt)

Prefetch abort Abort 0x0000000C OxFFFF0O00C __interrupt_iabt

Data abort Abort 0x00000010 OxFFFF0010 __interrupt_dabt

IRQ (interrupt) IRQ 0x00000018 OxFFFF0018 __interrupt_irq

FIQ (fast interrupt) |FIQ 0x0000001C OxFFFF001C __interrupt_fiq

ARMv6-M and ARMv7-M (M-profile architectures) have a different exception model. Read the
ARM Architecture Reference Manual for details.

1.10.3.1. Defining an Exception Handler: __interrupt Keywords

You can define six types of exception handlers with the function type qualifiers __i nt errupt _und,
__interrupt_svc,__interrupt_iabt, interrupt_dabt,_ _interrupt_irqgand
__interrupt_fiqg.You can also use the general __i nt errupt () function qualifier.

Interrupt functions and other exception handlers cannot return anything and must have a void argument

type list:
void __interrupt_xxx
isr( void)

{
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void __interrupt(n)

isr2( void)

{

Example

void __interrupt_irq serial _receive( void)

{
}

Vector symbols

When you use one or more of these __i nt err upt _xxx function qualifiers, the compiler generates a
corresponding vector symbol to designate the start of an exception handler function. The linker uses this

symbol to automatically generate the exception vector.

Function type qualifier

Vector symbol

Vector symbol M-profile

__interrupt_und _vector_1 -
__interrupt_svc _vector_2 _vector_11
__interrupt_iabt _vector_3 -
__interrupt_dabt _vector_4 -
_interrupt_irq _vector_6 -
__interrupt_fiq _vector_7 -

i nterrupt(n) _vector_n _vector_n

Note that the reset handler is designated by the symbol _START instead of _vect or _0 (_vect or _1 for
M-profile architectures).

You can prevent the compiler from generating the _vect or _n symbol by specifying the function qualifier
__novect or . This can be necessary if you have more than one interrupt handler for the same exception,
for example for different IRQ's or for different run-time phases of your application. Without the __novect or
function qualifier the compiler generates the _vect or _n symbol multiple times, which results in a link

error.

void __interrupt_irgq

{
}
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Enable interrupts in exception handlers (not for M-profile architectures)

Normally interrupts are disabled when an exception handler is entered. With the function qualifier
__nesting_enabl ed you can force that the link register (LR) is saved and that interrupts are enabled.
For example:

void __interrupt_svc __nesting_enabled svc( int n)
{ if (n==2)
__sve(3);
}
, o

1.10.3.2. Interrupt Frame: __frame()

With the function type qualifier __f rane() you can specify which registers and SFRs must be saved for
a particular interrupt function. Only the specified registers will be pushed and popped from the stack. If
you do not specify the function qualifier __f rame() , the C compiler determines which registers must be
pushed and popped. The syntax is:

void __interrupt_xxx

_ frame(reg[, reg]...) isr( void)
{
}

where, reg can be any register defined as an SFR. The compiler generates a warning if some registers
are missing which are normally required to be pushed and popped in an interrupt function prolog and
epilog to avoid run-time problems.

Example

_interrupt_irq _ frame(R4,R5,R6) void alarn{ void )

1.10.4. Intrinsic Functions

Some specific assembly instructions have no equivalence in C. Intrinsic functions give the possibility to
use these instructions. Intrinsic functions are predefined functions that are recognized by the compiler.
The compiler generates the most efficient assembly code for these functions.

The compiler always inlines the corresponding assembly instructions in the assembly source (rather than
calling it as a function). This avoids parameter passing and register saving instructions which are normally
necessary during function calls.
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Intrinsic functions produce very efficient assembly code. Though it is possible to inline assembly code by
hand, intrinsic functions use registers even more efficiently. At the same time your C source remains very
readable.

You can use intrinsic functions in C as if they were ordinary C (library) functions. All intrinsics begin with
a double underscore character (__).

The TASKING ARM C compiler recognizes the following intrinsic functions:

__alloc
void * volatile __alloc( __size t size);

Allocate memory. Returns a pointer to space of si ze bytes on the stack of the calling function. Memory
allocated through this function is freed when the calling function returns. This function is used internally
for variable length arrays, it is not to be used by end users.

_ free
void volatile _ _free( void * p);

Deallocate the memory pointed to by p. p must point to memory earlier allocated by acallto __al | oc() .

__hop

void __nop( void );
Generate a NOP instruction.
__get_return_address

__codeptr volatile __get_return_address( void );

Used by the compiler for profiling when you compile with the option --profile. Returns the return address
of a function.

__remap_pc
void volatile __remap_pc( void );

Load the 'real' program address. This intrinsic is used in the startup code to assure that the reset handler
is immune for any ROM/RAM remapping.

__setsp

void volatile __setsp( __data void * stack );
Initialize the stack pointer with 'stack’.

__getspsr

unsigned int volatile __getspsr( void );
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Get the value of the SPSR status register. Returns the value of the status register SPSR.
__setspsr

unsigned int volatile __setspsr( int set, int clear);

Set or clear bits in the SPSR status register. Returns the new value of the SPSR status register.

Example:

#defi ne SR_F 0x00000040
#define SR | 0x00000080

i = _ _setspsr (0, SRF | SRI);

if (i &(SRF| SRI))

{
exit (6); /* Interrupt flags not correct */
}
if (__getspsr () & (SR F | SR1))
{
exit (7); /* Interrupt flags not correct */
}
__getcpsr

unsigned int volatile __getcpsr( void );

Get the value of the CPSR status register. Returns the value of the status register CPSR.

__setcpsr
unsigned int volatile __setcpsr( int set, int clear);

Set or clear bits in the CPSR status register. Returns the new value of the CPSR status register.

__getapsr
unsigned int volatile __getapsr( void );

Get the value of the APSR status register (ARMv6-M and ARMv7-M). Returns the value of the status
register APSR.

__setapsr
unsigned int volatile _ setapsr( int set, int clear);

Set or clear bits in the APSR status register (ARMv6-M and ARMv7-M). Returns the new value of the
APSR status register.
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__getipsr
unsigned int volatile __getipsr( void );

Get the value of the IPSR status register (ARMv6-M and ARMv7-M). Returns the value of the status
register IPSR.

__sve

void volatile __svc(int nunber);

Generate a supervisor call (software interrupt). Number must be a constant value.

CMSIS intrinsics

The TASKING VX-toolset for ARM supports the Cortex Micro-controller Software Interface Standard
(CMSIS). You can find details about this standard on www.onarm.com.

The required functions as defined in the CMSIS are supported by the compiler as intrinsic functions and

do not have any implementation in the CMSIS header files cor e_cn®. h and core_cn8B. h. The
implemented intrinsic functions are:

__enable_irq

void volatile __enable_irq( void );

Global Interrupt enable (using the instruction CPSI E i ).
__disable_irq

void volatile __disable_irq( void );

Global Interrupt disable (using the instruction CPSI D i ).

__set_ PRIMASK

void volatile __set_ PRI MASK( unsigned int value );
Assign value to Priority Mask Register (using the instruction MSR).
__get_PRIMASK

unsigned int _ get PRI MASK( void );

Return Priority Mask Register (using the instruction MRS).
__enable_fault_irq

void volatile __enable_fault_irqg( void );

Global Fault exception and Interrupt enable (using the instruction CPSI E f).
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__disable_fault_irq

void volatile __disable_fault_irqg( void );

Global Fault exception and Interrupt disable (using the instruction CPSI D f).
__set_ FAULTMASK

void volatile __set FAULTMASK( unsigned int value );
Assign value to Fault Mask Register (using the instruction MSR).
__get_FAULTMASK

unsigned int _ get FAULTMASK( void );

Return Fault Mask Register (using the instruction MRS).

__set_ BASEPRI

void volatile __set BASEPRI ( unsigned int value );
Set Base Priority (using the instruction VSR).

__get_BASEPRI

unsigned int _ get BASEPRI( void );

Return Base Priority (using the instruction MRS).
__set_CONTROL

void volatile __set CONTROL( unsigned int value );
Set CONTROL register value (using the instruction VSR).
__get_CONTROL

unsigned int _ _get CONTROL( void );

Return Control Register Value (using the instruction MRS).

__set PSP

void volatile __set_ PSP( unsigned int value );

Set Process Stack Pointer value (using the instruction MSR).
__get_PSP

unsigned int _ get PSP( void );
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Return Process Stack Pointer (using the instruction MRS).

__set_MSP
void volatile __set_ MSP( unsigned int value );

Set Main Stack Pointer (using the instruction MSR).

__get_MSP
unsigned int _ get MSP( void );
Return Main Stack Pointer (using the instruction MRS).

__WFI
void volatile __ WI( void );
Wait for Interrupt.

__WFE

void volatile __ WFE( void );
Wait for Event.

__SEV

void volatile _ SEV( void );
Set Event.

__IsB

void volatile __ISB( void );

Instruction Synchronization Barrier.

__DSB

void volatile __DSB( void );
Data Synchronization Barrier.
__DMB

void volatile _ DVMB( void );

Data Memory Barrier.
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__REV

unsigned int _ REV( unsigned int value );

Reverse byte order in integer value.

_ REV16

unsigned int _ REV16( unsigned short value );

Reverse byte order in unsigned short value.

_ REVSH

signed int __REVSH( signed int value );

Reverse byte order in signed short value with sign extension to integer.

_ RBIT

unsigned int _ RBIT( unsigned int value );

Reverse bit order of value.

_ LDREXB

unsi gned vol atile char __LDREXB( unsigned char * addr );
Load exclusive byte.

__ LDREXH

unsi gned vol atile short _ LDREXH( unsigned short * addr );
Load exclusive half-word.

__ LDREXW

unsigned int volatile __ LDREXW unsigned int * addr );
Load exclusive word.

_ STREXB

unsigned int volatile _ STREXB( unsigned char value, unsigned char * addr );
Store exclusive byte.

_ STREXH

unsigned int volatile _ STREXH( unsigned short value, unsigned short * addr );
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Store exclusive half-word.

_ STREXW
unsigned int volatile __ STREXW unsigned int value, unsigned int * addr );

Store exclusive word.

__ CLREX
void volatile __ CLREX( void );

Remove the exclusive lock created by _ LDREXB, __ LDREXH, or __ LDREXW

1.10.4.1. Writing Your Own Intrinsic Function

Because you can use any assembly instruction with the __asm() keyword, you can use the __asn{)
keyword to create your own intrinsic functions. The essence of an intrinsic function is that it is inlined.

1. First write a function with assembly in the body using the keyword __asn{ ) . See Section 1.5, Using
Assembly in the C Source: __asm()

2. Next make sure that the function is inlined rather than being called. You can do this with the function
qualifier i nl i ne.This qualifier is discussed in more detail in Section 1.10.2, Inlining Functions: inline.

inline int __nmy_pow int base, int power )

{
int result;
__asn( "nov %, %\ n"
"1:\n\t"
"subs 9%, %,#1\n\t"
"mul ne %9, %0, %d\n\t"
"bne Ip\n\it", 9"
"=&r"(result)
"r"(base), "r"(power) );
return result;
}
voi d nai n(voi d)
{
int result;
/1 call to function __ny_pow
result = __ny_pow 3, 2);
}

Generated assembly code:
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mai n: .type func
; __ny_pow code is inlined here
nov ro, #2
nov ri, #3

nmov r2,rl
subs r0,r0, #1

mulne r2,r2,r1
bne 1p

C Language

As you can see, the generated assembly code for the function __ny_powis inlined rather than called.

Numeric labels are used for the loop.
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Chapter 2. C++ Language

The TASKING C++ compiler (cparm) offers a new approach to high-level language programming for your
ARM architecture. The C++ compiler accepts the C++ language as defined by the ISO/IEC 14882:2003
standard. It also accepts the language extensions of the C compiler (see Chapter 1, C Language).

This chapter describes the C++ language implementation and some specific features.

Note that the C++ language itself is not described in this document. For more information on the C++
language, see

» The C++ Programming Language (second edition) by Bjarne Straustrup (1991, Addison Wesley)

* ISO/IEC 14882:1998 C++ standard [ANSI] More information on the standards can be found at
http://www.ansi.org/

2.1. C++ Language Extension Keywords

The C++ compiler supports the same language extension keywords as the C compiler. When option
--strict is used, the extensions will be disabled.

pragmas

The C++ compiler supports the pragmas as explained in Section 2.8, Pragmas to Control the C++ Compiler.
Pragmas give directions to the code generator of the compiler.

2.2. C++ Dialect Accepted

The C++ compiler accepts the C++ language as defined by the ISO/IEC 14882:2003 standard.

Command line options are also available to enable and disable anachronisms and strict
standard-conformance checking.

2.2.1. Standard Language Features Accepted

The following features not in traditional C++ (the C++ language of "The Annotated C++ Reference Manual"
by Ellis and Stroustrup (ARM)) but in the standard are implemented:

» The dependent statement of an i f, whi | e, do- whi | e, or f or is considered to be a scope, and the
restriction on having such a dependent statement be a declaration is removed.

» The expression tested inani f, whi | e, do-whi | e, or f or, as the first operand of a "?" operator, or
as an operand of the "&&", ": ", or "! "operators may have a pointer-to-member type or a class type that
can be converted to a pointer-to-member type in addition to the scalar cases permitted by the ARM.

* Qualified names are allowed in elaborated type specifiers.

A global-scope qualifier is allowed in member references of the form x. : : A : Band p->:: A: : B.
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» The precedence of the third operand of the "?" operator is changed.

« If control reaches the end of the mai n() routine, and nai n() has an integral return type, it is treated
asifareturn 0; statement were executed.

 Pointers to arrays with unknown bounds as parameter types are diagnosed as errors.

» A functional-notation cast of the form A() can be used even if Ais a class without a (nontrivial)
constructor. The temporary created gets the same default initialization to zero as a static object of the
class type.

» A cast can be used to select one out of a set of overloaded functions when taking the address of a
function.

» Template friend declarations and definitions are permitted in class definitions and class template
definitions.

» Type template parameters are permitted to have default arguments.

» Function templates may have nontype template parameters.

» Areference to const vol ati | e cannot be bound to an rvalue.

 Qualification conversions, such as conversion from T** to T const * const * are allowed.
 Digraphs are recognized.

» Operator keywords (e.g., not , and, bi t and, etc.) are recognized.

* Static data member declarations can be used to declare member constants.

* When option --wchar_t-keyword is set, wchar _t is recognized as a keyword and a distinct type.
* bool is recognized.

* RTTI (run-time type identification), including dynami c_cast andthet ypei d operator, is implemented.
» Declarations in tested conditions (ini f, swi t ch, f or, and whi | e statements) are supported.

» Array newand del et e are implemented.

* New-style casts (stati c_cast,rei nterpret_cast, and const _cast) are implemented.
 Definition of a nested class outside its enclosing class is allowed.

* nut abl e is accepted on non-static data member declarations.

» Namespaces are implemented, including usi ng declarations and directives. Access declarations are
broadened to match the corresponding usi ng declarations.

» Explicit instantiation of templates is implemented.

* The t ypenane keyword is recognized.
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explicit is accepted to declare non-converting constructors.

The scope of a variable declared inthe f or -i ni t - st at enent of af or loop is the scope of the loop
(not the surrounding scope).

Member templates are implemented.
The new specialization syntax (using "t enpl at e <>") is implemented.
Cv-qualifiers are retained on rvalues (in particular, on function return values).

The distinction between trivial and nontrivial constructors has been implemented, as has the distinction
between PODs and non-PODs with trivial constructors.

The linkage specification is treated as part of the function type (affecting function overloading and
implicit conversions).

ext ern inline functions are supported, and the default linkage for i nl i ne functions is external.
A typedef name may be used in an explicit destructor call.

Placement delete is implemented.

An array allocated via a placement new can be deallocated via delete.

Covariant return types on overriding virtual functions are supported.

enumtypes are considered to be non-integral types.

Partial specialization of class templates is implemented.

Partial ordering of function templates is implemented.

Function declarations that match a function template are regarded as independent functions, not as
"guiding declarations" that are instances of the template.

It is possible to overload operators using functions that take enumtypes and no cl ass types.
Explicit specification of function template arguments is supported.

Unnamed template parameters are supported.

The new lookup rules for member references of the form x. A: : B and p- >A: : B are supported.
The notation : : tenpl at e (and - >t enpl at e, etc.) is supported.

In a reference of the form f () - >g() , with g a static member function, f () is evaluated. The ARM
specifies that the left operand is not evaluated in such cases.

enumtypes can contain values larger than can be contained in ani nt .

Default arguments of function templates and member functions of class templates are instantiated only
when the default argument is used in a call.
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* String literals and wide string literals have const type.
» Class name injection is implemented.
» Argument-dependent (Koenig) lookup of function names is implemented.

» Class and function names declared only in unqualified friend declarations are not visible except for
functions found by argument-dependent lookup.

» Avoi d expression can be specified on a return statement in a voi d function.

» Function-try-blocks, i.e., try-blocks that are the top-level statements of functions, constructors, or
destructors, are implemented.

» Universal character set escapes (e.g., \ uabcd) are implemented.

» On acall in which the expression to the left of the opening parenthesis has class type, overload resolution
looks for conversion functions that can convert the class object to pointer-to-function types, and each
such pointed-to "surrogate function" type is evaluated alongside any other candidate functions.

» Dependent name lookup in templates is implemented. Nondependent names are looked up only in the
context of the template definition. Dependent names are also looked up in the instantiation context, via
argument-dependent lookup.

» Value-initialization is implemented. This form of initialization is indicated by an initializer of "()" and
causes zeroing of certain POD-typed members, where the usual default-initialization would leave them
uninitialized.

» A partial specialization of a class member template cannot be added outside of the class definition.
 Qualification conversions may be performed as part of the template argument deduction process.

* The export keyword for templates is implemented.

2.2.2. C++0x Language Features Accepted

The following features added in the working paper for the next C++ standard (expected to be completed
in 2011) are enabled in C++0x mode (with option --c++0x). Several of these features are also enabled
in default (nonstrict) C++ mode.

* A "right shift token" (>>) can be treated as two closing angle brackets. For example:

tenpl ate<typenane T> struct S {};
S<S<int>>s; // OK No whitespace needed
/1l between closing angl e brackets.

» The static_assert construct is supported. For example:

tenpl at e<typenane T> struct S {
static_assert(sizeof (T) > 1, "Type T too small");

H
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S<§[ 2] > s; Il K
S<char> s2; // Instantiation error due to failing static_assert.

The friend class syntax is extended to allow nonclass types as well as class types expressed through
a typedef or without an elaborated type name. For example:

typedef struct S ST,

class C {
friend S; /1l OK (requires S to be in scope).
friend ST; /1 OK (same as "friend S;").
friend int; /1 OK (no effect).

friend S const; // Error: cv-qualifiers cannot
/| appear directly.

b
Mixed string literal concatenations are accepted (a feature carried over from C99):

wchar _t *str = "a" L"b"; // OK, sane as L"ab".

Variadic macros and empty macro arguments are accepted, as in C99.

In function bodies, the reserved identifier __f unc__ refers to a predefined array containing a string
representing the function's name (a feature carried over from C99).

A trailing comma in the definition of an enumeration type is silently accepted (a feature carried over
from C99):

enumE { e, };

If the command line option --long-long is specified, the type | ong | ong is accepted. Unsuffixed integer
literals that cannot be represented by type | ong, but could potentially be represented by type unsi gned
| ong, have type | ong | ong instead (this matches C99, but not the treatment of the | ong | ong
extension in C89 or default C++ mode).

An explicit instantiation directive may be prefixed with the ext er n keyword to suppress the instantiation
of the specified entity.

The keyword t ypenane followed by a qualified-id can appear outside a template declaration.

struct S { struct N {}; };
typename S:: N *p; // Silently accepted
/! in C++0x node

The keyword aut o can be used as a type specifier in the declaration of a variable or reference. In such
cases, the actual type is deduced from the associated initializer. This feature can be used for variable
declarations, for inclass declarations of static const members, and for new-expressions.
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auto x = 3.0; /] Same as "double x = 3.0;"
auto p = new auto(x); /1 Same as "double *p = new doubl e(x);"
struct S {

static auto const m=3; // Sane as "static int const m= 3;"

I

* Trailing return types are allowed in top-level function declarators. These must be paired with the aut o
type specifier.

auto f()->int*; // Same as: int *f();

» The keyword decl t ype is supported: It allows types to be described in terms of expressions. For
example:

tenpl at e<typenane T> struct S {
decl type(f(T())) *p; // A pointer to the return type of f.

H

» The constraints on the code points implied by universal character names (UCNs) are slightly different:
UCN: s for surrogate code points (0xD00O through OXDFFF) are never permitted, and UCN corresponding
to control characters or to characters in the basic source character set are permitted in string literals.

» Scoped enumeration types (defined with the keyword sequence enum cl ass) and explicit underlying
integer types for enumeration types are supported. For example:

enumclass Primary { red, green, blue };
enum cl ass Danger { green, yellow, red }; // No conflict on "red".
enum Code: unsigned char { yes, no, maybe };
void f() {

Primary p = Primary::red; // Enumaqualifier is required to access

/| scoped enunerator constants.

Code c = Code::maybe; // Enumqualifier is allowed (but not required)

} /1 for unscoped enuneration types.

» Lambdas are supported. For example:

tenpl ate<class F>int z(F f) { return f(0); }

int g() {
int v =7;
return z([v](int x)->int { return x+v; });

» The C99-style _Pr agma operator is supported.
» Rvalue references are supported. For example:
int f(int);
int &rr = f(3);
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Functions can be "deleted". For example:

int f(int) = delete;

short f(short);

int x f(3); /1 Error: selected function is del eted.
inty f((short)3); [/ K

Special member functions can be explicitly "defaulted"” (i.e., given a default definition). For example:

struct S { S(S const& = default; };
struct T { T(T const&); };
T:.:T(T const& = default;

The operand of si zeof , t ypei d, or decl t ype can refer directly to a non-static data member of a
class without using a member access expression. For example:

struct S {
int i;
H
decltype(S::i) j = sizeof (S::i);

The keyword nul | pt r can be used as both a null pointer constant and a null pointer-to-member
constant. Variables and other expressions whose type is that of the nul | pt r keyword (conventionally
known by its standard typedef, st d: : nul | pt r _t ) can also be used as null pointer(-to-member)
constants, although they are only constant expressions if they otherwise would be. For example:

#i ncl ude <cstddef> // To get std::nullptr_t
struct S { };

tenplate <int *> struct X { };
std::nullptr_t null();

void f() {
void *p = null ptr; /1 Initializes p to null pointer
int Ss:* np =nullptr; // Initializes np to null ptr-to-nmenber
p =null(); /1 Sets p to null pointer
X<nul I ptr> xnul | 0; /1 Instantiates X with null int * val ue
X<nul | ()> xnul|1; /1 Error: tenplate argument not a
/1 constant expression
}
Attributes delimited by double square brackets ([[ ... ]]) are accepted in declarations. The standard

attributes al i gn, nor et ur n, not hrow, fi nal , and carri es_dependency are supported. For
example:
[[nothrow]] void f();

Alias and alias template declarations are supported. For example:
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using X = int;

X x; [/l equivalent to "int x"

tenpl ate <typename T> using Y = T*;
Y<int>yi; // equivalent to "int* yi"

2.2.3. Anachronisms Accepted

The following anachronisms are accepted when anachronisms are enabled (with --anachronisms):

over | oad is allowed in function declarations. It is accepted and ignored.

Definitions are not required for static data members that can be initialized using default initialization.
The anachronism does not apply to static data members of template classes; they must always be
defined.

The number of elements in an array may be specified in an array del et e operation. The value is
ignored.

A single oper at or ++() and oper at or - - () function can be used to overload both prefix and postfix
operations.

The base class hame may be omitted in a base class initializer if there is only one immediate base
class.

Assignment to t hi s in constructors and destructors is allowed. This is allowed only if anachronisms
are enabled and the "assignment to t hi s" configuration parameter is enabled.

A bound function pointer (a pointer to a member function for a given object) can be cast to a pointer to
a function.

A nested class name may be used as a non-nested class hame provided no other class of that name
has been declared. The anachronism is not applied to template classes.

A reference to a non-const type may be initialized from a value of a different type. A temporary is
created, it is initialized from the (converted) initial value, and the reference is set to the temporary.

A reference to a non-const class type may be initialized from an rvalue of the class type or a derived
class thereof. No (additional) temporary is used.

A function with old-style parameter declarations is allowed and may participate in function overloading
as though it were prototyped. Default argument promotion is not applied to parameter types of such
functions when the check for compatibility is done, so that the following declares the overloading of
two functions named f :

int f(int);
int f(x) char x; { return x; }

Note that in C this code is legal but has a different meaning: a tentative declaration of f is followed by
its definition.
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* When option --nonconst-ref-anachronism is set, a reference to a non-const class can be bound to a
class rvalue of the same type or a derived type thereof.

struct A {
A(int);
A oper at or =(Ag&) ;
A operat or +(const A&);

b
mai n () {

b(l)

= A(1) + A(2); /] Alowed as anachroni sm
}

2.2.4. Extensions Accepted in Normal C++ Mode

The following extensions are accepted in all modes (except when strict ANSI/ISO violations are diagnosed
as errors or were explicitly noted):

« Afri end declaration for a class may omit the cl ass keyword:

class A {
friend B; // Should be "friend class B"

I

» Constants of scalar type may be defined within classes:

class A {
const int size = 10;
int a[size];

I

* In the declaration of a class member, a qualified name may be used:

struct A {
int A:f(); // Should be int f();

b
e Therestrict keyword is allowed.

» Aconst qualified object with file scope or namespace scope andthe __at () attribute will have external
linkage, unless explicitly declared st at i ¢c. Examples:

const int i = 5; /1 internal |inkage
const int j __at( 0x1234 ) = 10; /1 external |inkage
static const int k __at( 0x1236 ) = 15; // internal |inkage

Note that no warning is generated when 'j ' is not used.

45



TASKING VX-toolset for ARM User Guide

* Implicit type conversion between a pointer to an ext ern " C' function and a pointer to an ext er n
" C++" function is permitted. Here's an example:

extern "C" void f(); // f's type has extern "C' |inkage
void (*pf)() // pf points to an extern "C++" function
= &f; /1 error unless inmplicit conversion is
/1 allowed

This extension is allowed in environments where C and C++ functions share the same calling
conventions. It is enabled by default.

« A"?" operator whose second and third operands are string literals or wide string literals can be implicitly
converted to "char *"or"wchar _t *".(Recall that in C++ string literals are const . There is a
deprecated implicit conversion that allows conversion of a string literal to "char *", dropping the const .
That conversion, however, applies only to simple string literals. Allowing it for the result of a "?" operation
is an extension.)

char *p = x ? "abc" : "def";
» Default arguments may be specified for function parameters other than those of a top-level function

declaration (e.g., they are accepted on t ypedef declarations and on pointer-to-function and
pointer-to-member-function declarations).

» Non-static local variables of an enclosing function can be referenced in a non-evaluated expression
(e.g., asi zeof expression) inside a local class. A warning is issued.

« In default C++ mode, the friend class syntax is extended to allow nonclass types as well as class types
expressed through a typedef or without an elaborated type name. For example:

typedef struct S ST,

class C{
friend S /1 OK (requires S to be in scope).
friend ST; /1 K (sanme as "friend S;").
friend int; /1 OK (no effect).

friend S const; // Error: cv-qualifiers cannot
/1 appear directly.
}

* In default C++ mode, mixed string literal concatenations are accepted. (This is a feature carried over
from C99 and also available in GNU modes).

wchar t *str = "a" L"b"; // OK, sanme as L"ab".

* In default C++ mode, variadic macros are accepted. (This is a feature carried over from C99 and also
available in GNU modes.)
* In default C++ mode, empty macro arguments are accepted (a feature carried over from C99).

A trailing comma in the definition of an enumeration type is silently accepted (a feature carried over
from C99):
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enumE { e, };

2.3. GNU Extensions

The C++ compiler can be configured to support the GNU C++ mode (command line option --g++). In this
mode, many extensions provided by the GNU C++ compiler are accepted. The following extensions are
provided in GNU C++ mode.

Attributes, introduced by the keyword __attri but e__, can be used on declarations of variables,
functions, types, and fields. The al i as, al i gned, al | oc_si ze, al ways_i nline,artificial,
conmon, const, const ruct or, depr ecat ed, destructor, error,external | y_vi sibl e,
flatten,format,format _arg,gnu_inline, hot,init_priority, nall oc, node,
no_check_nenory_usage, no_i nstrunent _functi on, noconmon, noi nl i ne, nonnul |,
nor et ur n, not hr ow, packed, pur e, secti on, senti nel , strong, unused, used, vol ati | e,
war n_unused_r esul t, war ni ng, weak, and weakr ef attributes are supported.

Extended designators are accepted
Compound literals are accepted.
Non-standard anonymous unions are accepted

The t ypeof operator is supported. This operator can take an expression or a type (like the si zeof
operator, but parentheses are always required) and expands to the type of the given entity. It can be
used wherever a typedef name is allowed

typeof (2*2.3) d; // Declares a "double"
typeof (int) i; /! Declares an "int"

This can be useful in macro and template definitions.

The __ext ensi on__ keyword is accepted preceding declarations and certain expressions. It has no
effect on the meaning of a program.

_extension__ __inline__ int f(int a) {
return a >0 ? a/2: f(__extension__ 1-a);

In all GNU C modes and in GNU C++ modes with gnu_version < 30400, the type modifiers signed,
unsigned, long and short can be used with t ypedef types if the specifier is valid with the underlying
type of the typedefin ANSI C. E.g.:

typedef int I;

unsigned | *pui; // OKin GNU C++ node;
/! same as "unsigned int *pui"

If the command line option --long-long is specified, the extensions for the | ong | ong and unsi gned
| ong | ong types are enabled.
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» Zero-length array types (specified by [0]) are supported. These are complete types of size zero.

» C99-style flexible array members are accepted. In addition, the last field of a class type have a class
type whose last field is a flexible array member. In GNU C++ mode, flexible array members are treated
exactly like zero-length arrays, and can therefore appear anywhere in the class type.

» The C99 _Pr agna operator is supported.

» The gcc built-in <st dar g. h> and <var ar gs. h> facilities (__builtin_va_list, __builtin_va_arg, ...) are
accepted.

» The si zeof operator is applicable to voi d and to function types and evaluates to the value one.

» Variables can be redeclared with different top-level cv-qualifiers (the new qualification is merged into
existing qualifiers). For example:

extern int volatile x;
int const x = 32; /1 x is now const volatile
» The "assembler name" of variables and routines can be specified. For example:

int counter __asm_("counter_v1") = 0;

» Register variables can be mapped on specific registers using the as mkeyword.
register int i asn("eax");
/1 Map "i" onto register eax.
» The keyword i nl i ne is ignored (with a warning) on variable declarations and on block-extern function
declarations.
» Excess aggregate initializers are ignored with a warning.
struct S{ int a, b; };
struct Sal ={ 1, 2, 3 };
/1 "3" ignored with a warning; no error

int a2[2] ={ 7, 8 91};
/1 "9" ignored with a warning; no error

» Expressions of types voi d*, voi d const*,void volatil e* andvoid const vol atil e* can
be dereferenced; the result is an Ivalue.

 The __restrict__ keyword is accepted. It is identical to the C99 rest ri ct keyword, except for its
spelling.

» Out-of-range floating-point values are accepted without a diagnostic. When IEEE floating-point is being
used, the "infinity" value is used.

» Extended variadic macros are supported.
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Dollar signs ($) are allowed in identifiers.
Hexadecimal floating point constants are recognized.

The __asm__ keyword is recognized and equivalent to the asmtoken. Extended syntax is supported
to indicate how assembly operands map to C/C++ variables.

asm("fsinx %,%" : "=f"(x) : "f"(a));
/1 Map the output operand on "x",
/1 and the input operand on "a".

The \ e escape sequence is recognized and stands for the ASCII "ESC" character.

The address of a statement label can be taken by use of the prefix "&&" operator, e.g., void *a =
&&L . A transfer to the address of a label can be done by the "goto *" statement, e.g., got o *a.

Multi-line strings are supported, e.g.,

char *p = "abc

def";

ASCII "NULL" characters are accepted in source files.

A source file can end with a backslash ("\") character.

Case ranges (e.g., "case 'a' ... 'z":") are supported.

A number of macros are predefined in GNU mode. See Section 2.9, Predefined Macros.
A predefined macro can be undefined.

If a directory is specified as both a normal include directory and a system include directory, the normal
directory entry is ignored.

A large number of special functions of the form __bui I ti n_xyz (e.g., __builtin_all oca) are
predeclared.

Some expressions are considered to be constant-expressions even though they are not so considered
in standard C and C++. Examples include "((char *)&((struct S *)0)->c[0]) - (char
*)0"and"(int)"Hello" & 0"

The macro ___GNUC__is predefined to the major version number of the emulated GNU compiler.
Similarly, the macros __ GNUC_M NOR__ and __GNUC_PATCHLEVEL___ are predefined to the
corresponding minor version number and patch level. Finally, __VERSI ON__is predefined to a string
describing the compiler version.

The __t hr ead specifier can be used to indicate that a variable should be placed in thread-local storage
(requires gnu_version >= 30400).

An extern inline function that is referenced but not defined is permitted (with a warning).
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 Trigraphs are ignored (with a warning).

» Non-standard casts are allowed in null pointer constants, e.g., (i nt) (i nt *) 0 is considered a null
pointer constant in spite of the pointer cast in the middle.

» Statement expressions, e.g., ({int j; j = f(); j,;)} are accepted. Branches into a statement
expression are not allowed. In C++ mode, branches out are also not allowed. Variable-length arrays,
destructible entities, try, catch, local non-POD class definitions, and dynamically-initialized local static
variables are not allowed inside a statement expression.

 Labels can be declared to be local in statement expressions by introducing them with a __| abel __
declaration.

({ _label__ lab; int i =4; lab: i =2*i-1; if (!(i%7)) goto lab; i; })

» Not-evaluated parts of constant expressions can contain non-constant terms:

int i;
int a[ 1 || i ]; // Accepted in g++ node

» Casts on an Ivalue that don't fall under the usual "Ivalue cast" interpretation (e.g., because they cast
to a type having a different size) are ignored, and the operand remains an Ivalue. A warning is issued.

int i;
(short)i = 0; // Accepted,cast is ignored; entire int is set

 Variable length arrays (VLAs) are supported. GNU C also allows VLA types for fields of local structures,
which can lead to run-time dependent sizes and offsets. The C++ compiler does not implement this,
but instead treats such arrays as having length zero (with a warning); this enables some popular
programming idioms involving fields with VLA types.

void f(int n) {
struct {
int a[n]; // Warning: n ignored and
/'l replaced by zero

s

» Complex type extensions are supported (these are the same as the C99 complex type features, with
the elimination of _| magi nary and the addition of __conpl ex, __real , __i mag, the use of "~" to
denote complex conjugation, and complex literals such as "1. 2i ).

« If an explicit instantiation directive is preceded by the keyword ext er n, no (explicit or implicit)
instantiation is for the indicated specialization.

« If an explicit instantiation directive for a class is preceded by the keyword i nl i ne, the virtual function
table for the class (if any) will be emitted by the compilation.
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An explicit instantiation directive that names a class may omit the cl ass keyword, and may refer to a
typedef.

An explicit instantiation or ext er n t enpl at e directive that names a class is accepted in an invalid
namespace.

std: :type_i nf o does not need to be introduced with a special pragma.

A special keyword __nul | expands to the same constant as the literal "0", but is expected to be used
as a null pointer constant.

When gnu_version < 30400, names from dependent base classes are ignored only if another name
would be found by the lookup.

const int n = 0O;
tenplate <class T> struct B {
static const int m= 1; static const int n = 2;
b
templ ate <class T> struct D : B<T> {
int f() { return m+ n; }
// B::m+ ::n in g++ node

H

A non-static data member from a dependent base class, which would usually be ignored as described
above, is found if the lookup would have otherwise found a nonstatic data member of an enclosing
class (when gnu_version is < 30400).

tenplate <class T> struct C{

struct A{ int i; };
struct B: public A{
void f() {
i =0; // g++ uses A::i not C :i
}
b
int i;

A new operation in a template is always treated as dependent (when gnu_version >= 30400).

tenplate <class T > struct A {
void f() {
void *p = 0;
new (&) int(0); // calls operator new
/'l decl ared bel ow
}
b

voi d* operator new(size_t, void* p);

When doing name lookup in a base class, the injected class name of a template class is ignored.
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nanespace N {
tenplate <class T> struct A {};

}
struct A {
int i;
}
struct B: N:A<int> {
B() { Ax; x.i =1; } [/l g++ uses ::A not N:A
}

* The injected class name is found in certain contexts in which the constructor should be found instead.

struct A {
ACint) {};

b

A A a(l);

* In a constructor definition, what should be treated as a template argument list of the constructor is
instead treated as the template argument list of the enclosing class.

tenplate <int ul> struct A{ };
tenplate <> struct A<1> {

tenplate<class T> A(T i, int j);
}

tenplate <> A<1>::A<1>(int i, int j) { }
/1 accepted in g++ node
» A difference in calling convention is ignored when redeclaring a typedef.

typedef void F();

extern "C' {
typedef void F(); // Accepted in GNU C++ node
/1 (error otherw se)

* The macro __GNUG__ is defined identically to __ GNUC___ (i.e., the major version number of the GNU
compiler version that is being emulated).

» The macro _GNU_SOURCE is defined as "1".

» Guiding declarations (a feature present in early drafts of the standard, but not in the final standard) are
disabled.

* Namespace st d is predeclared.

» No connection is made between declarations of identical names in different scopes even when these
names are declared extern "C'.E.g.,
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extern "C' { void f(int); }
nanespace N {
extern "C' {
void f() {} // Warning (not error) in g++ node
}
}

int min() { f(1); }

This example is accepted by the C++ compiler, but it will emit two conflicting declarations for the function
f.

When a using-directive lookup encounters more than one ext ern " C' declaration (created when
more than one namespace declares an ext ern " C" function of a given name, as described above),
only the first declaration encountered is considered for the lookup.

extern "C'" int f(void);

extern "C' int g(void);

nanespace N {
extern "C' int f(void); // sane type
extern "C' void g(void); // different type

b

usi ng nanespace N,

int i =f(); // calls ::f

int j =g(); // calls ::f

The definition of a member of a class template that appears outside of the class definition may declare
a nontype template parameter with a type that is different than the type used in the definition of the
class template. A warning is issued (GNU version 30300 and below).

tenplate <int I> struct A{ void f(); };
tenplate <unsigned int 1> void A<I> :f(){}

The definition of a member of a nested class of a class template that appears outside of the class
definition may use an incorrect template argument list. A warning is issued.

tenplate <class T, class V> struct Quter {
struct Inner {
void f();
b
b
tenplate <class T, class V> void Quter<T, int>:lnner::f() { }
N shoul d be V

A class template may be redeclared with a nontype template parameter that has a type that is different
than the type used in the earlier declaration. A warning is issued.

tenplate <int I> class A
tenpl ate <unsigned int I> class A {};
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« Afri end declaration may refer to a member typedef.

class A {
class B {};
typedef B ny_b;
friend class mnmy_b;

H

» When a friend class is declared with an unqualified name, the lookup of that name is not restricted to
the nearest enclosing namespace scope.

struct S;
nanespace N {
class C {
friend struct S; // ::S in g++ node,
/1 N:Sin default node
b

» Afriend class declaration can refer to names made visible by using-directives.

nanespace N { struct A{ }; }
usi ng namespace N;
struct B {
void f() { Aa; }
friend struct A; // in g++ node N :A
}; // not a new declaration of ::A

 Friend injection is enabled if gnu_version is < 40100 and disabled otherwise.

class X {
friend void f(X*);
friend class Y;

int main() {
Y* y; [/ Y not declared without friend injection
f(0); [// f not declared without friend injection

* When friend names are not injected, they can still be used in qualified declarator names when
gnu_version < 40300.

nanespace N {
class A {
friend int f();

H
}

int NN:f() { return O; } // OK when gnu_version < 40300
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An inherited type name can be used in a class definition and later redeclared as a typedef.

struct A { typedef int I; };
struct B : A {

typedef 1 J; /1 Refers to A :l
typedef double I; // Accepted in g++ node
}; /1 (introduces B::1)

In a catch clause, an entity may be declared with the same name as the handler parameter.

try { }
catch(int e) {

char e;
}

The diagnostic issued for an exception specification mismatch is reduced to a warning if the previous
declaration was found in a system header.

The exception specification for an explicit template specialization (for a function or member function)
does not have to match the exception specification of the corresponding primary template.

A template argument list may appear following a constructor name in constructor definition that appears
outside of the class definition:

tenplate <class T> struct A {
AQ)

b

templ ate <class T> A<T>::A<T>(){}

When gnu_version < 30400, an incomplete type can be used as the type of a nonstatic data member
of a class template.

cl ass B;

tenplate <class T> struct A {
B b;

}s

A constructor need not provide an initializer for every nonstatic const data member (but a warning is
still issued if such an initializer is missing).

struct S {
int const ic;
S() {} /1 Warning only in GNU C++ node
/1 (error otherw se).

I

Exception specifications are ignored on function definitions when support for exception handling is
disabled (normally, they are only ignored on function declarations that are not definitions).
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A friend declaration in a class template may refer to an undeclared template.

tenplate <class T> struct A {
friend void f<>(A<T>);

b
A friend class template declaration in which the template parameter list does not match the original
declaration is accepted if the class template name is specified as a qualified name.

nanespace N {
tenpl ate <typename T, typenanme U> struct A{ };

}
struct B {

tenpl ate<typenane T> friend struct N :A;
}

When gnu_version is < 30400, the semantic analysis of a friend function defined in a class template is
performed only if the function is actually used and is done at the end of the translation unit (instead of
at the point of first use).

A function template default argument may be redeclared. A warning is issued and the default from the
initial declaration is used.

tenpl ate<class T> void f(int i
tenpl ate<class T> void f(int i
int main() {

f<voi d>();
}

1);
2){}

A definition of a member function of a class template that appears outside of the class may specify a
default argument.

tenmplate <class T> struct A{ void f(T); };
tenplate <class T> void A<T>::f(T value = T() ) { }
Function declarations (that are not definitions) can have duplicate parameter names.

void f(int i, int i); // Accepted in GNU C++ node

Default arguments are retained as part of deduced function types.
A namespace member may be redeclared outside of its namespace.
A template may be redeclared outside of its class or namespace.

nanespace N {
tenpl ate< typenane T > struct S {};
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}
tenpl ate< typenane T > struct N :S;

The injected class name of a class template can be used as a template argument.

tenmpl ate <tenpl ate <class> class T> struct A {};
tenplate <class T> struct B {

A<B> a;
b

A partial specialization may be declared after an instantiation has been done that would have used the
partial specialization if it had been declared earlier. A warning is issued.

tenplate <class T> class X {};
X<int*> xi;
tenplate <class T> class X<T*> {};

A static data member may be explicitly specialized after it has been used. A warning is issued.

tenplate <class T> struct A {
static int i;

I

int j = Aint>::i;

template <> int A<int>::i = 1;

The "." or "->" operator may be used in an integral constant expression if the result is an integral or
enumeration constant:

struct A{ enum{ el =1 }; };

int min () {
A a;
int x[a.el]; // Accepted in GNU C++ node
return O;

Strong using-directives are supported.

usi ng nanmespace debug __attribute__((strong));

Partial specializations that are unusable because of nondeductible template parameters are accepted
and ignored.

tenpl ate<class T> struct A {class C{ };};
tenpl ate<class T> struct B {enum {e = 1}; };
tenplate <class T> struct B<typename A<T>.:C {enum{e = 2}; };
int main(int argc, char **argv) {
printf("%l\n", B<int>::e);
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printf("%l\n", B<A<int>.:C>: :e);

» Anincorrect number of t enpl at e <> clauses is allowed on a full specialization (i.e., one with no
remaining template parameters). A warning is issued.

tenplate <class T> struct A {

templ ate <class U> struct B { };
b
template <> struct A<int> {

templ ate <class U> struct B { };
b

template <> tenplate <> struct A<int>::B<double> { };

» Anincorrect number of t enpl at e <> clauses is allowed on a friend class template declaration. A
warning is issued.

tenpl ate <typenane T> struct A {
tenmpl ate <typename U> class B {
tenmpl ate <typename V> friend cl ass B;
b
b

» Template parameters that are not used in the signature of a function template are not ignored for partial
ordering purposes (i.e., the resolution of core language issue 214 is not implemented) when gnu_version
is < 40100.

tenplate <class S, class T> void f(T t);
tenplate <class T> void f(T t);
int main() {
f<int>(3); // not anbi guous when gnu_version
/1 is < 40100

* Prototype instantiations of functions are deferred until the first actual instantiation of the function to
allow the compilation of programs that contain definitions of unusable function templates (gnu_version
30400 and above). The example below is accepted when prototype instantiations are deferred.

class A {};
tenplate <class T> struct B {
B () {}; // error: noinitializer for
/'l reference menber "B<T>::a"
A& a;
b
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* When doing nonclass prototype instantiations (e.g., gnu_version 30400 and above), the severity of the
diagnostic issued if a const template static data member is defined without an initializer is reduced to
a warning.

tenplate <class T> struct A {
static const int i;
b

tenpl ate <class T> const int A<T>::i;

* When doing nonclass prototype instantiations (e.g., gnu_version 30400 and above), a template static
data member with an invalid aggregate initializer is accepted (the error is diagnosed if the static data
member is instantiated).

struct A {
A(doubl e val);

}s

tenplate <class T> struct B {
static const A I[1];

}s

tenplate <class T> const A B<T>::1[1]={
{1.,0.,0.,0.}

}s

» A storage class may appear in a declaration that also has a “direct” linkage specification. For example,
extern "C' static void f();

is treated as equivalent to

extern "C' { static void f(); }

» A storage class (st ati c or ext er n) is accepted on an explicit function template specialization.
» The storage class specifier ext er n is accepted on definitions of static data members.

» The lookup of a name that precedes a “: : " ignores enum types and nonclass typedefs (gnu_version
30400 and above).

nanespace N {
const int a = 42;
enum N { e };
int i =N:a; // refers to nanespace N in g++ node

}

nanespace M {
const int a = 42;
typedef int M
int i = M:a; // refers to nanmespace Min g++ node
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» A call of a dependent function template without the use of the t enpl at e keyword is accepted if a
normal lookup in the scope of the reference finds a function template or an overload set containing a
function template (even though that function template will not end up being the one that is actually
called).

tenpl ate <typenane T> struct A {
templ ate <typename U> void f(U);
b
tenpl ate <typenane T> struct B {
templ ate <typename U> void f(U);
void f(){}
A<T> a;
void g(Tt) {
a.f<T>(t); // accepted in g++ node - should be witten as:
/1 minpl.f tenplate <T>(t)

b

» The t enpl at e keyword may be omitted in a dependent member class template reference when the
template argument list matches the implied template argument list of the prototype instantiation. In the
example below, in the reference to A<T>: : B<. .. >the template parameter T has the same coordinates
(position and nesting depth) as the T of the prototype instantiation of A, so the template keyword can
be omitted.

tenpl ate <class T> struct A {
tenpl ate <class T2> struct B {};
h
tenplate <class T, class U> struct C {
A<T>::B<T> abl; // g++ accepts
A<T>::B<U> ab2; // g++ accepts
A<U>::B<T> ab3; // g++ gives error
typename A<U>::tenplate B<T> ab4; // correct syntax
h

« Partial ordering in non-call contexts does not include the return type in the partial ordering process.

tenplate <class T> T f(const T* p);

tenplate <class T> int f(T* p);

/| ambi guous specialization, but accepted in g++ node
tenmplate <> int f(const int*){return 0;}

» A pointer to function is considered to be compatible with a reference to function for partial ordering
purposes (gnu_version 40100 and above).

) 11 #1

)

tenplate <typenane T> void f(T** p, void (*)(
(&()): 11 #2

tenpl ate <typename T> void f(T* p, void
void x(){}
void g(int** p) {

~— ~—

60



C++ Language

f(p, x); // calls #1

« Astatic_cast inwhich the operand is a pointer to a base class that is neither const- nor
volatile-qualified and the target type is a pointer to a const- and/or volatile-qualified derived class drops
the qualification from the result type when gnu_version is 30400 or higher.

struct B { };
struct D0 B { };
D *f(B *p) {
return static_cast<const D *>(p); // accepted in g++ npde with
/'l gnu_version >= 30400

The following GNU extensions are not currently supported:

» The forward declaration of function parameters (so they can participate in variable-length array
parameters).

» GNU-style complex integral types (complex floating-point types are supported)
» Nested functions

 Local structs with variable-length array fields.

2.4. Namespace Support

Namespaces are enabled by default. You can use the command line option --no-namespaces to disable
the features.

When doing name lookup in a template instantiation, some names must be found in the context of the
template definition while others may also be found in the context of the template instantiation. The C++
compiler implements two different instantiation lookup algorithms: the one mandated by the standard
(referred to as "dependent name lookup"), and the one that existed before dependent name lookup was
implemented.

Dependent name lookup is done in strict mode (unless explicitly disabled by another command line option)
or when dependent name processing is enabled by either a configuration flag or command line option.

Dependent Name Processing

When doing dependent name lookup, the C++ compiler implements the instantiation name lookup rules
specified in the standard. This processing requires that non-class prototype instantiations be done. This
in turn requires that the code be written using the t ypenane and t enpl at e keywords as required by
the standard.
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Lookup Using the Referencing Context

When not using dependent name lookup, the C++ compiler uses a name lookup algorithm that
approximates the two-phase lookup rule of the standard, but does so in such a way that is more compatible
with existing code and existing compilers.

When a name is looked up as part of a template instantiation but is not found in the local context of the
instantiation, it is looked up in a synthesized instantiation context that includes both names from the
context of the template definition and names from the context of the instantiation. Here's an example:

namespace N {
int g(int);
int x = 0;
tenpl ate <class T> struct A {
TFf(Tt) { return g(t); }
Tf() { return x; }

3
}
namespace M {
int x = 99;
doubl e g(doubl e);
N : A<int> ai;
int i =ai.f(0); Il N:A<int>:f(int) calls
/1 N :g(int)
int i2 =ai.f(); Il N:A<int>:f() returns
Il 0 (= N:x)
N: : A<doubl e> ad;
double d = ad.f(0); // N :A<doubl e>::f(doubl e)
/1 calls M:g(double)
double d2 = ad.f(); // N :A<double>: :f() also
/1l returns 0 (= N :x)
}

The lookup of names in template instantiations does not conform to the rules in the standard in the
following respects:

 Although only names from the template definition context are considered for names that are not functions,
the lookup is not limited to those names visible at the point at which the template was defined.

» Functions from the context in which the template was referenced are considered for all function calls
in the template. Functions from the referencing context should only be visible for "dependent” function
calls.

Argument Dependent Lookup

When argument-dependent lookup is enabled (this is the default), functions made visible using
argument-dependent lookup overload with those made visible by normal lookup. The standard requires
that this overloading occurs even when the name found by normal lookup is a block ext er n declaration.
The C++ compiler does this overloading, but in default mode, argument-dependent lookup is suppressed
when the normal lookup finds a block ext er n.
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This means a program can have different behavior, depending on whether it is compiled with or without
argument-dependent lookup --no-arg-dep-lookup, even if the program makes no use of namespaces.
For example:

struct A { };
A operator+(A, double);
void f() {
A al;
A operator+(A, int);
al + 1.0; // calls operator+(A, double)
/1l with arg-dependent | ookup enabl ed but
/1 otherwise calls operator+(A, int);

2.5. Template Instantiation

The C++ language includes the concept of templates. A template is a description of a class or function
that is a model for a family of related classes or functions.® For example, one can write a template for a
St ack class, and then use a stack of integers, a stack of floats, and a stack of some user-defined type.
In the source, these might be written St ack<i nt >, St ack<f | oat >, and St ack<X>. From a single
source description of the template for a stack, the compiler can create instantiations of the template for
each of the types required.

The instantiation of a class template is always done as soon as it is needed in a compilation. However,
the instantiations of template functions, member functions of template classes, and static data members
of template classes (hereafter referred to as template entities) are not necessarily done immediately, for
several reasons:

» One would like to end up with only one copy of each instantiated entity across all the object files that
make up a program. (This of course applies to entities with external linkage.)

* The language allows one to write a specialization of a template entity, i.e., a specific version to be used
in place of a version generated from the template for a specific data type. (One could, for example,
write a version of St ack<i nt >, or of just St ack<i nt >: : push, that replaces the template-generated
version; often, such a specialization provides a more efficient representation for a particular data type.)
Since the compiler cannot know, when compiling a reference to a template entity, if a specialization for
that entity will be provided in another compilation, it cannot do the instantiation automatically in any
source file that references it.

» C++templates can be exported (i.e., declared with the keyword expor t ). Such templates can be used
in a translation unit that does not contain the definition of the template to instantiate. The instantiation
of such a template must be delayed until the template definition has been found.

» The language also dictates that template functions that are not referenced should not be compiled,
that, in fact, such functions might contain semantic errors that would prevent them from being compiled.
Therefore, a reference to a template class should not automatically instantiate all the member functions
of that class.

ISince templates are descriptions of entities (typically, classes) that are parameterizable according to the types they operate upon,
they are sometimes called parameterized types.
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(It should be noted that certain template entities are always instantiated when used, e.g., inline functions.)

From these requirements, one can see that if the compiler is responsible for doing all the instantiations
automatically, it can only do so on a program-wide basis. That is, the compiler cannot make decisions
about instantiation of template entities until it has seen all the source files that make up a complete
program.

This C++ compiler provides an instantiation mechanism that does automatic instantiation at link time. For
cases where you want more explicit control over instantiation, the C++ compiler also provides instantiation
modes and instantiation pragmas, which can be used to exert fine-grained control over the instantiation
process.

2.5.1. Automatic Instantiation

The goal of an automatic instantiation mode is to provide painless instantiation. You should be able to
compile source files to object code, then link them and run the resulting program, and never have to worry
about how the necessary instantiations get done.

In practice, this is hard for a compiler to do, and different compilers use different automatic instantiation
schemes with different strengths and weaknesses:

» AT&T/USL/Novell's cfront product saves information about each file it compiles in a special directory
called pt r eposi t ory. It instantiates nothing during normal compilations. At link time, it looks for
entities that are referenced but not defined, and whose mangled names indicate that they are template
entities. For each such entity, it consults the pt r eposi t or y information to find the file containing the
source for the entity, and it does a compilation of the source to generate an object file containing object
code for that entity. This object code for instantiated objects is then combined with the "normal” object
code in the link step.

If you are using cfront you must follow a particular coding convention: all templates must be declared
in . h files, and for each such file there must be a corresponding . cc file containing the associated
definitions. The compiler is never told about the . cc files explicitly; one does not, for example, compile
them in the normal way. The link step looks for them when and if it needs them, and does so by taking
the . h filename and replacing its suffix.?

This scheme has the disadvantage that it does a separate compilation for each instantiated function
(or, at best, one compilation for all the member functions of one class). Even though the function itself
is often quite small, it must be compiled along with the declarations for the types on which the instantiation
is based, and those declarations can easily run into many thousands of lines. For large systems, these
compilations can take a very long time. The link step tries to be smart about recompiling instantiations
only when necessary, but because it keeps no fine-grained dependency information, it is often forced
to "recompile the world" for a minor change in a . h file. In addition, cfront has no way of ensuring that
preprocessing symbols are set correctly when it does these instantiation compilations, if preprocessing
symbols are set other than on the command line.

» Borland's C++ compiler instantiates everything referenced in a compilation, then uses a special linker
to remove duplicate definitions of instantiated functions.

>The actual implementation allows for several different suffixes and provides a command line option to change the suffixes sought.
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If you are using Borland's compiler you must make sure that every compilation sees all the source code
it needs to instantiate all the template entities referenced in that compilation. That is, one cannot refer
to a template entity in a source file if a definition for that entity is not included by that source file. In
practice, this means that either all the definition code is put directly in the . h files, or that each . h file
includes an associated . cc (actually, . cpp) file.

Our approach is a little different. It requires that, for each instantiation of a non-exported template, there
is some (normal, top-level, explicitly-compiled) source file that contains the definition of the template
entity, a reference that causes the instantiation, and the declarations of any types required for the
instantiation. This requirement can be met in various ways:

» The Borland convention: each . h file that declares a template entity also contains either the definition
of the entity or includes another file containing the definition.

 Implicit inclusion: when the compiler sees a template declaration in a . h file and discovers a need to
instantiate that entity, it is given permission to go off looking for an associated definition file having the
same base name and a different suffix, and it implicitly includes that file at the end of the compilation.
This method allows most programs written using the cfront convention to be compiled with our approach.
See Section 2.5.4, Implicit Inclusion.

» The ad hoc approach: you make sure that the files that define template entities also have the definitions
of all the available types, and add code or pragmas in those files to request instantiation of the entities
there.

Exported templates are also supported by our automatic instantiation method, but they require additional
mechanisms explained further on.

The automatic instantiation mode is enabled by default. It can be turned off by the command line option
--no-auto-instantiation. If automatic instantiation is turned off, the extra information about template
entities that could be instantiated in a file is not put into the object file.

2.5.2. Instantiation Modes

Normally, when a file is compiled, template entities are instantiated everywhere where they are used.
The overall instantiation mode can, however, be changed by a command line option:

--instantiate=used

Instantiate those template entities that were used in the compilation. This will include all static data
members for which there are template definitions. This is the default.

--instantiate=all

Instantiate all template entities declared or referenced in the compilation unit. For each fully instantiated
template class, all of its member functions and static data members will be instantiated whether or not
they were used. Non-member template functions will be instantiated even if the only reference was a
declaration.

3Isn't this always the case? No. Suppose that file A contains a definition of class X and a reference to St ack<X>: : push, and that
file B contains the definition for the member function push. There would be no file containing both the definition of push and the
definition of X.

65



TASKING VX-toolset for ARM User Guide

--instantiate=local

Similar to --instantiate=used except that the functions are given internal linkage. This is intended to
provide a very simple mechanism for those getting started with templates. The compiler will instantiate
the functions that are used in each compilation unit as local functions, and the program will link and run
correctly (barring problems due to multiple copies of local static variables.) However, one may end up
with many copies of the instantiated functions, so this is not suitable for production use. --instantiate=local
cannot be used in conjunction with automatic template instantiation. If automatic instantiation is enabled
by default, it will be disabled by the --instantiate=local option.

In the case where the ccarm command is given a single file to compile and link, e.g.,
ccarmtest.cc

the compiler knows that all instantiations will have to be done in the single source file. Therefore, it uses
the --instantiate=used mode and suppresses automatic instantiation.

2.5.3. Instantiation #pragma Directives

Instantiation pragmas can be used to control the instantiation of specific template entities or sets of
template entities. There are three instantiation pragmas:

» The instantiate pragma causes a specified entity to be instantiated.

» The do_not_instantiate pragma suppresses the instantiation of a specified entity. It is typically used
to suppress the instantiation of an entity for which a specific definition will be supplied.

* The can_instantiate pragma indicates that a specified entity can be instantiated in the current
compilation, but need not be; it is used in conjunction with automatic instantiation, to indicate potential
sites for instantiation if the template entity turns out to be required.

The argument to the instantiation pragma may be:

» atemplate class name A<i nt >

» atemplate class declaration cl ass A<i nt >

» a member function name A<i nt >: : f

 a static data member name A<i nt >: : i

* a static data declaration i nt A<i nt>::i

» a member function declaration voi d A<i nt>::f (int, char)

» atemplate function declaration char* f (i nt, float)

A pragma in which the argument is a template class name (e.g., A<i nt >orcl ass A<i nt >)is equivalent
to repeating the pragma for each member function and static data member declared in the class. When

instantiating an entire class a given member function or static data member may be excluded using the

do_not_instantiate pragma. For example,
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#pragnma i nstantiate A<int>
#pragma do_not _instantiate A<int>::f

The template definition of a template entity must be present in the compilation for an instantiation to occur.
If an instantiation is explicitly requested by use of the instantiate pragma and no template definition is
available or a specific definition is provided, an error is issued.

tenplate <class T> void f1(T); // No body provided
tenplate <class T> void g1(T); // No body provided

void f1(int) {} // Specific definition
voi d mai n()
{ . .
int i;
doubl e d;
f1(i);
f1(d);
g1(i);
gl(d);
}

#pragma instantiate void f1(int) // error - specific
/1 definition

#pragma instantiate void gl(int) // error - no body
/1 provided

f 1(doubl e) and g1( doubl e) will not be instantiated (because no bodies were supplied) but no errors
will be produced during the compilation (if no bodies are supplied at link time, a linker error will be
produced).

A member function name (e.g., A<i nt >: : f ) can only be used as a pragma argument if it refers to a
single user defined member function (i.e., not an overloaded function). Compiler-generated functions are
not considered, so a name may refer to a user defined constructor even if a compiler-generated copy
constructor of the same name exists. Overloaded member functions can be instantiated by providing the
complete member function declaration, as in

#pragnma i nstantiate char* A<int>::f(int, char?*)

The argument to an instantiation pragma may not be a compiler-generated function, an inline function,
or a pure virtual function.

2.5.4. Implicit Inclusion

When implicit inclusion is enabled, the C++ compiler is given permission to assume that if it needs a
definition to instantiate a template entity declared in a . h file it can implicitly include the corresponding

. cc file to get the source code for the definition. For example, if a template entity ABC: : f is declared in
file xyz. h, and an instantiation of ABC: : f is required in a compilation but no definition of ABC: : f appears
in the source code processed by the compilation, the compiler will look to see if a file xyz. cc exists, and
if so it will process it as if it were included at the end of the main source file.
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To find the template definition file for a given template entity the C++ compiler needs to know the path
name specified in the original include of the file in which the template was declared and whether the file
was included using the system include syntax (e.g., #i ncl ude <fi | e. h>).This information is not
available for preprocessed source containing #l i ne directives. Consequently, the C++ compiler will not
attempt implicit inclusion for source code containing #| i ne directives.

The file to be implicitly included is found by replacing the file suffix with each of the suffixes specified in
the instantiation file suffix list. The normal include search path mechanism is then used to look for the file
to be implicitly included.

By default, the list of definition-file suffixes tried is . ¢, . cc, . cpp, and . cxx.

Implicit inclusion works well alongside automatic instantiation, but the two are independent. They can be
enabled or disabled independently, and implicit inclusion is still useful when automatic instantiation is not
done.

The implicit inclusion mode can be turned on by the command line option --implicit-include. If this option
is turned on, you cannot use exported templates.

Implicit inclusions are only performed during the normal compilation of a file, (i.e., not when doing only
preprocessing). A common means of investigating certain kinds of problems is to produce a preprocessed
source file that can be inspected. When using implicit inclusion it is sometimes desirable for the
preprocessed source file to include any implicitly included files. This may be done using the command
line option --no-preprocessing-only. This causes the preprocessed output to be generated as part of a
normal compilation. When implicit inclusion is being used, the implicitly included files will appear as part
of the preprocessed output in the precise location at which they were included in the compilation.

2.5.5. Exported Templates

Exported templates are templates declared with the keyword expor t . Exporting a class template is
equivalent to exporting each of its static data members and each of its non-inline member functions. An
exported template is special because its definition does not need to be present in a translation unit that
uses that template. In other words, the definition of an exported (non-class) template does not need to
be explicitly or implicitly included in a translation unit that instantiates that template. For example, the
following is a valid C++ program consisting of two separate translation units:

/1 File 1:
#i ncl ude <stdio. h>
static void trace() { printf("File 1\n"); }

export tenplate<class T> T const& min(T const& T const&);

int main()
{
trace();
return mn(2, 3);
}
/Il File 2:

#i ncl ude <stdio. h>
static void trace() { printf("File 2\n"); }
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export tenplate<class T> T const& mn(T const &, T const &b)
{

trace();

return a<b? a: b;

}

Note that these two files are separate translation units: one is not included in the other. That allows the
two functions t r ace() to coexist (with internal linkage).

Support for exported templates is enabled by default, but you can turn it off with command line option
--no-export.

You cannot use exported templates together with the command line option --implicit-include.

2.5.5.1. Finding the Exported Template Definition

The automatic instantiation of exported templates is somewhat similar (from a user's perspective) to that
of regular (included) templates. However, an instantiation of an exported template involves at least two
translation units: one which requires the instantiation, and one which contains the template definition.

When a file containing definitions of exported templates is compiled, a file with a . et suffix is created
and some extra information is included in the associated . ti file. The . et files are used later by the C++
compiler to find the translation unit that defines a given exported template.

When a file that potentially makes use of exported templates is compiled, the compiler must be told where
to look for . et files for exported templates used by a given translation unit. By default, the compiler looks
in the current directory. Other directories may be specified with the command line option
--template-directory. Strictly speaking, the . et files are only really needed when it comes time to generate
an instantiation. This means that code using exported templates can be compiled without having the
definitions of those templates available. Those definitions must be available when explicit instantiation is
done.

The . et files only inform the C++ compiler about the location of exported template definitions; they do
not actually contain those definitions. The sources containing the exported template definitions must
therefore be made available at the time of instantiation. In particular, the export facility is not a mechanism
for avoiding the publication of template definitions in source form.

2.5.5.2. Secondary Translation Units

An instantiation of an exported template can be triggered by an explicit instantiation directive, or by the
command line option --instantiate=used. In each case, the translation unit that contains the initial point
of instantiation will be processed as the primary translation unit. Based on information it finds in the . et
files, the C++ compiler will then load and parse the translation unit containing the definition of the template
to instantiate. This is a secondary translation unit. The simultaneous processing of the primary and
secondary translation units enables the C++ compiler to create instantiations of the exported templates
(which can include entities from both translation units). This process may reveal the need for additional
instantifltions of exported templates, which in turn can cause additional secondary translation units to be
loaded".

‘Asa consequence, using exported templates may require considerably more memory that similar uses of regular (included)
templates.
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When secondary translation units are processed, the declarations they contain are checked for consistency.
This process may report errors that would otherwise not be caught. Many these errors are so-called "ODR
violations" (ODR stands for "one-definition rule"). For example:

/Il File 1:
struct X {
int x;

}s

int main() {
return mn(2, 3);

}
/1 File 2:
struct X {
unsigned x; // Error: X :x declared differently
/'l inFile 1
s

export tenplate<class T> T const& min(T const &, T const &b)

{
}

If there are no errors, the instantiations are generated in the output associated with the primary translation
unit. This may also require that entities with internal linkage in secondary translation units be "externalized"
so they can be accessed from the instantiations in the primary translation unit.

return a<b? a: b;

2.5.5.3. Libraries with Exported Templates

Typically a (non-export) library consists of an i ncl ude directory and a | i b directory. The i ncl ude
directory contains the header files required by users of the library and the | i b directory contains the
object code libraries that client programs must use when linking programs.

With exported templates, users of the library must also have access to the source code of the exported
templates and the information contained in the associated . et files. This information should be placed

in a directory that is distributed along with the i ncl ude and | i b directories: This is the expor t directory.
It must be specified using the command line option --template-directory when compiling client programs.

The recommended procedure to build the export directory is as follows:
1. Foreach. et fileinthe original source directory, copy the associated source file to the export directory.

2. Concatenate all of the . et files into a single . et file (e.g., myl i b. et) in the export directory. The
individual . et files could be copied to the export directory, but having all of the . et information in one
file will make use of the library more efficient.

3. Create an export _i nf o file in the expor t directory. The export _i nf o file specifies the include
search paths to be used when recompiling files in the export directory. If no export _i nf o file is
provided, the include search path used when compiling the client program that uses the library will
also be used to recompile the library exported template files.
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The export _i nf o file consists of a series of lines of the form
i ncl ude=x

or

sys_i ncl ude=x

where x is a path name to be placed on the include search path. The directories are searched in the order
in which they are encountered in the export _i nf o file. The file can also contain comments, which begin
with a "#", and blank lines. Spaces are ignored but tabs are not currently permitted. For example:

# The include directories to be used for the xyz library

i nclude = /diskl/xyz/include
sys_include = /disk2/abc/include
i ncl ude=/di sk3/j kl /include

The include search path specified for a client program is ignored by the C++ compiler when it processes
the source in the export library, except when no export _i nf o file is provided. Command line macro
definitions specified for a client program are also ignored by the C++ compiler when processing a source
file from the export library; the command line macros specified when the corresponding . et file was
produced do apply. All other compilation options (other than the include search path and command line
macro definitions) used when recompiling the exported templates will be used to compile the client
program.

When a library is installed on a new system, it is likely that the expor t _i nf o file will need to be adapted
to reflect the location of the required headers on that system.

2.6. Inlining Functions

The C++ compiler supports a minimal form of function inlining. When the C++ compiler encounters a call
of a function declared i nl i ne it can replace the call with the body of the function with the parameters
replaced by the corresponding arguments. When a function call occurs as a statement, the statements
of the function body are inserted in place of the call. When the function call occurs within an expression,
the body of the function is rewritten as one large expression and that expression is inserted in the proper
place in the containing expression. It is not always possible to do this sort of inlining: there are certain
constructs (e.g. loops and inline assembly) that cannot be rendered in expression form. Even when inlining
is done at the statement level, there are certain constructs that are not practical to inline. Calls that cannot
be inlined are left in their original call form, and an out-of-line copy of the function is used. When enabled,
a remark is issued.

When the C++ compiler decides not to inline a function, the keyword i nl i ne is passed to the generated
C file. This allows for the C compiler to decide again whether to inline a function or not.

A function is disqualified for inlining immediately if any of the following are true:
« The function has local static variables.

» The function has local constants.
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The function has local types.

» The function has block scopes.

The function includes pragmas.

» The function has a variable argument list.

2.7. Extern Inline Functions

Depending on the way in which the C++ compiler is configured, out-of-line copies of extern i nli ne
functions are either implemented using static functions, or are instantiated using a mechanism like the
template instantiation mechanism. Note that out-of-line copies of inline functions are only required in
cases where the function cannot be inlined, or when the address of the function is taken (whether explicitly
by the user, by implicitly generated functions, or by compiler-generated data structures such as virtual
function tables or exception handling tables).

When static functions are used, local static variables of the functions are promoted to global variables
with specially encoded names, so that even though there may be multiple copies of the code, there is
only one copy of such global variables. This mechanism does not strictly conform to the standard because
the address of an extern inline function is not constant across translation units.

When the instantiation mechanism is used, the address of an extern inline function is constant across
translation units, but at the cost of requiring the use of one of the template instantiation mechanisms,
even for programs that don't use templates. Definitions of extern inline functions can be provided either
through use of the automatic instantiation mechanism or by use of the --instantiate=used or
--instantiate=all instantiation modes. There is no mechanism to manually control the definition of extern
inline function bodies.

2.8. Pragmas to Control the C++ Compiler

Pragmas are keywords in the C++ source that control the behavior of the compiler. Pragmas overrule
compiler options.

The syntax is:

#pragma pragnma- spec

The C++ compiler supports the following pragmas:

instantiate / do_not_instantiate / can_instantiate

These are template instantiation pragmas. They are described in detail in Section 2.5.3, Instantiation
#pragma Directives.

hdrstop / no_pch

These are precompiled header pragmas. They are described in detail in Section 2.10, Precompiled
Headers.
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When placed at the beginning of a header file, indicates that the file is written in such a way that including
it several times has the same effect as including it once. Thus, if the C++ compiler sees #pr agma once
at the start of a header file, it will skip over it if the file is #included again.

A typical idiom is to place an #ifndef guard around the body of the file, with a #define of the guard variable

after the #ifndef:

#pragma once /1 optional
#i f ndef FILE_H
#define FILE H
body of the header file ...
#endi f

The #pragna once is marked as optional in this example, because the C++ compiler recognizes the
#ifndef idiom and does the optimization even in its absence. #pr agma once is accepted for compatibility
with other compilers and to allow the programmer to use other guard-code idioms.

ident

This pragma is given in the form:
#pragma ident "string"

or

#i dent "string"

2.9. Predefined Macros

The C++ compiler defines a number of preprocessing macros. Many of them are only defined under
certain circumstances. This section describes the macros that are provided and the circumstances under

which they are defined.

Macro

Description

__ABI_COMPATIBILITY_VERSION

Defines the ABI compatibility version being
used. This macro is set to 9999, which means
the latest version. This macro is used when
building the C++ library.

__ABI_CHANGES_FOR_RTTI

This macro is set to TRUE, meaning that the
ABI changes for RTTI are implemented. This
macro is used when building the C++ library.

__ABI_CHANGES_FOR_ARRAY_NEW_AND_DELETE

This macro is set to TRUE, meaning that the
ABI changes for array new and delete are
implemented. This macro is used when
building the C++ library.
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Macro

Description

__ABI_CHANGES_FOR_PLACEMENT_DELETE

This macro is set to TRUE, meaning that the
ABI changes for placement delete are
implemented. This macro is used when
building the C++ library.

__ARRAY_OPERATORS

Defined when array newand del et e are
enabled. This is the default.

__BASE_FILE__

Similarto __FILE__ but indicates the primary
source file rather than the current one (i.e.,
when the current file is an included file).

_ BIG_ENDIAN__

Expands to 1 if big-endian mode is selected
(option --endianness=big), otherwise
unrecognized as macro.

_BOOL

Defined when bool is a keyword. This is the
default.

__BUILD__

Identifies the build number of the C++
compiler, composed of decimal digits for the
build number, three digits for the major branch
number and three digits for the minor branch
number. For example, if you use build 1.22.1
of the compiler, _ BUILD___ expands to
1022001. If there is no branch number, the
branch digits expand to zero. For example,
build 127 results in 127000000.

__CHAR_MIN/__ CHAR_MAX

Usedinlimts. h to define the
minimum/maximum value of a plain char
respectively.

_ CPARM__

Identifies the C++ compiler. You can use this
symbol to flag parts of the source which must
be recognized by the cparm C++ compiler
only. It expands to 1.

__cplusplus

Always defined.

CPU__

Expands to a string with the CPU supplied with
the option --cpu. When no --cpu is supplied,
this symbol is not defined.

__DATE__

Defined to the date of the compilation in the
form "Mmm dd yyyy".

_ DELTA_TYPE

Defines the type of the offset field in the virtual
function table. This macro is used when
building the C++ library.

__DOUBLE_FP__

Expands to 1 if you did not use option
--no-double (Treat ‘double’ as ‘float’),
otherwise unrecognized as macro.

__embedded_cplusplus

Defined as 1 in Embedded C++ mode.

74




C++ Language

Macro Description

__EXCEPTIONS Defined when exception handling is enabled
(--exceptions).

__FILE__ Expands to the current source file name.

__FUNCTION___ Defined to the name of the current function.
An error is issued if it is used outside of a
function.

__func__ Same as __FUNCTION__ in GNU mode.

__IMPLICIT_USING_STD

Defined when the standard header files should
implicitly do a using-directive on the st d
namespace (--using-std).

__JMP_BUF_ELEMENT_TYPE

Specifies the type of an element of the setjmp
buffer. This macro is used when building the
C++ library.

__JMP_BUF_NUM_ELEMENTS

Defines the number of elements in the setjmp
buffer. This macro is used when building the
C++ library.

__ LINE__

Expands to the line number of the line where
this macro is called.

__LITTLE_ENDIAN__

Expands to 1 if little-endian mode is selected
(option --endianness=little), otherwise
unrecognized as macro. This is the default.

__ NAMESPACES

Defined when namespaces are supported (this
is the default, you can disable support for
namespaces with --no-namespaces).

__NO_LONG_LONG

Defined when the | ong | ong type is not
supported. This is the default.

__NULL_EH_REGION_NUMBER

Defines the value used as the null region
number value in the exception handling tables.
This macro is used when building the C++
library.

_ PLACEMENT_DELETE

Defined when placement delete is enabled.

_ PRETTY_FUNCTION__

Defined to the name of the current function.
This includes the return type and parameter
types of the function. An error is issued if it is
used outside of a function.

__PTRDIFF_MIN/__PTRDIFF_MAX

Used in st di nt . h to define the
minimum/maximum value of apt rdi ff _t
type respectively.

__PTRDIFF_TYPE__

Defined to be the type of pt rdi ff _t.

__ REGION_NUMBER_TYPE

Defines the type of a region number field in
the exception handling tables. This macro is
used when building the C++ library.
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Macro

Description

__REVISION__

Expands to the revision number of the C++
compiler. Digits are represented as they are;
characters (for prototypes, alphas, betas) are
represented by -1. Examples: v1.0r1 -> 1,
v1.0rb ->-1

__RTTI

Defined when RTTI is enabled (--rtti).

_ RUNTIME_USES_NAMESPACES

Defined when the run-time uses namespaces.

__SIGNED_CHARS__

Defined when plain char is signed.

__SINGLE_FP__

Expands to 1 if you used option --no-double
(Treat ‘double’ as ‘float’), otherwise
unrecognized as macro.

__SIZE_MIN/ _SIZE_MAX

Used in st di nt . h to define the
minimum/maximum value of a si ze_t type
respectively.

__SIZE_TYPE__

Defined to be the type of si ze_t.

_ STDC__

Always defined, but the value may be
redefined.

_ STDC_VERSION__

Identifies the ISO-C version number. Expands
to 199901L for ISO C99, but the value may be
redefined.

_STLP_NO_IOSTREAMS

Defined when option --io-streams is not used.
This disables 1/0 stream functions in the
STLport C++ library.

_ TASKING__ Always defined for the TASKING C++
compiler.

__THUMB___ Expands to 1 if you used option --thumb,
otherwise unrecognized as macro.

__TIME__ Expands to the compilation time: “hh:mm:ss”

__TYPE_TRAITS_ENABLED

Defined when type traits pseudo-functions (to
ease the implementation of ISO/IEC TR
19768; e.g., __i s_uni on) are enabled. This
is the default in C++ mode.

__VAR_HANDLE_TYPE

Defines the type of the variable-handle field
in the exception handling tables. This macro
is used when building the C++ library.

__VERSION__

Identifies the version number of the C++
compiler. For example, if you use version 2.1r1
of the compiler, _ VERSION___ expands to
2001 (dot and revision number are omitted,
minor version number in 3 digits).
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Macro Description

_ VIRTUAL_FUNCTION_INDEX_TYPE Defines the type of the virtual function index
field of the virtual function table. This macro
is used when building the C++ library.

__VIRTUAL_FUNCTION_TYPE Defines the type of the virtual function field of
the virtual function table. This macro is used
when building the C++ library.

__ WCHAR_MIN/__WCHAR_MAX Used in st di nt. h to define the
minimum/maximum value of awchar _t type
respectively.

_WCHAR_T Defined when wehar _t is a keyword.

2.10. Precompiled Headers

It is often desirable to avoid recompiling a set of header files, especially when they introduce many lines
of code and the primary source files that #i ncl ude them are relatively small. The C++ compiler provides
a mechanism for, in effect, taking a snapshot of the state of the compilation at a particular point and writing
it to a disk file before completing the compilation; then, when recompiling the same source file or compiling
another file with the same set of header files, it can recognize the "snapshot point", verify that the
corresponding precompiled header (PCH) file is reusable, and read it back in. Under the right
circumstances, this can produce a dramatic improvement in compilation time; the trade-off is that PCH
files can take a lot of disk space.

2.10.1. Automatic Precompiled Header Processing

When --pch appears on the command line, automatic precompiled header processing is enabled. This
means the C++ compiler will automatically look for a qualifying precompiled header file to read in and/or
will create one for use on a subsequent compilation.

The PCH file will contain a snapshot of all the code preceding the "header stop" point. The header stop
point is typically the first token in the primary source file that does not belong to a preprocessing directive,
but it can also be specified directly by #pragma hdrstop (see below) if that comes first. For example:

#i ncl ude "xxx.h"
#i ncl ude "yyy. h"
int i;

The header stop pointisi nt (the first non-preprocessor token) and the PCH file will contain a snapshot
reflecting the inclusion of xxx. h and yyy. h. If the first non-preprocessor token or the #pr agrma hdr st op
appears within a #i f block, the header stop point is the outermost enclosing #i f . To illustrate, heres a
more complicated example:

#i ncl ude "xxx.h"
#i f ndef YYY_H
#define YYY H 1
#i nclude "yyy. h"
#endi f
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#if TEST
int i;
#endi f

Here, the first token that does not belong to a preprocessing directive is again i nt , but the header stop
point is the start of the #i f block containing it. The PCH file will reflect the inclusion of xxx. h and
conditionally the definition of YYY_Hand inclusion of yyy. h; it will not contain the state produced by #i f
TEST.

A PCH file will be produced only if the header stop point and the code preceding it (mainly, the header
files themselves) meet certain requirements:

The header stop point must appear at file scope -- it may not be within an unclosed scope established
by a header file. For example, a PCH file will not be created in this case:

/1 xxx.h
class A {

/1l xxx.C
#i ncl ude "xxx.h"
int i; };

The header stop point may not be inside a declaration started within a header file, nor (in C++) may it
be part of a declaration list of a linkage specification. For example, in the following case the header
stop point is int, but since it is not the start of a new declaration, no PCH file will be created:

/'l yyy.h
static

/1 yyy.C
#i ncl ude "yyy. h"

int i;
Similarly, the header stop point may not be inside a #i f block or a #def i ne started within a header
file.

The processing preceding the header stop must not have produced any errors. (Note: warnings and
other diagnostics will not be reproduced when the PCH file is reused.)

No references to predefined macros __DATE__ or __TI ME__ may have appeared.
No use of the #l i ne preprocessing directive may have appeared.
#pragma no_pch (see below) must not have appeared.

The code preceding the header stop point must have introduced a sufficient number of declarations to
justify the overhead associated with precompiled headers. The minimum number of declarations required
is 1.
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When the host system does not support memory mapping, so that everything to be saved in the
precompiled header file is assigned to preallocated memory (MS-Windows), two additional restrictions
apply:

» The total memory needed at the header stop point cannot exceed the size of the block of preallocated
memory.

* No single program entity saved can exceed 16384, the preallocation unit.

When a precompiled header file is produced, it contains, in addition to the snapshot of the compiler state,
some information that can be checked to determine under what circumstances it can be reused. This
includes:

» The compiler version, including the date and time the compiler was built.
» The current directory (i.e., the directory in which the compilation is occurring).
* The command line options.

» The initial sequence of preprocessing directives from the primary source file, including #i ncl ude
directives.

» The date and time of the header files specified in #i ncl ude directives.

This information comprises the PCH prefix. The prefix information of a given source file can be compared
to the prefix information of a PCH file to determine whether the latter is applicable to the current compilation.

As an illustration, consider two source files:

/] a.cc
#i ncl ude "xxx. h"
/] Start of code
/1l b.cc
#i ncl ude "xxx.h"
/] Start of code

When a. cc is compiled with --pch, a precompiled header file named a. pch is created. Then, when b. cc
is compiled (or when a. cc is recompiled), the prefix section of a. pch is read in for comparison with the
current source file. If the command line options are identical, if xxx. h has not been modified, and so
forth, then, instead of opening xxx. h and processing it line by line, the C++ compiler reads in the rest of
a. pch and thereby establishes the state for the rest of the compilation.

It may be that more than one PCH file is applicable to a given compilation. If so, the largest (i.e., the one
representing the most preprocessing directives from the primary source file) is used. For instance, consider
a primary source file that begins with

#i ncl ude "xxx.h"
#i ncl ude "yyy. h"
#i nclude "zzz. h"

If there is one PCH file for xxx. h and a second for xxx. h and yyy. h, the latter will be selected (assuming

both are applicable to the current compilation). Moreover, after the PCH file for the first two headers is
read in and the third is compiled, a new PCH file for all three headers may be created.
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When a precompiled header file is created, it takes the name of the primary source file, with the suffix
replaced by an implementation-specified suffix (pch by default). Unless --pch-dir is specified (see below),
it is created in the directory of the primary source file.

When a precompiled header file is created or used, a message such as
"test.cc": creating preconpiled header file "test.pch"
is issued. The user may suppress the message by using the command line option --no-pch-messages.

When the option --pch-verbose is used the C++ compiler will display a message for each precompiled
header file that is considered that cannot be used giving the reason that it cannot be used.

In automatic mode (i.e., when --pch is used) the C++ compiler will deem a precompiled header file obsolete
and delete it under the following circumstances:

« if the precompiled header file is based on at least one out-of-date header file but is otherwise applicable
for the current compilation; or

« ifthe precompiled header file has the same base name as the source file being compiled (e.g., xxx. pch
and xxx. cc) but is not applicable for the current compilation (e.g., because of different command line
options).

This handles some common cases; other PCH file clean-up must be dealt with by other means (e.g., by
the user).

Support for precompiled header processing is not available when multiple source files are specified in a
single compilation: an error will be issued and the compilation aborted if the command line includes a
request for precompiled header processing and specifies more than one primary source file.

2.10.2. Manual Precompiled Header Processing

Command line option --create-pch=file-name specifies that a precompiled header file of the specified
name should be created.

Command line option --use-pch=file-name specifies that the indicated precompiled header file should
be used for this compilation; if it is invalid (i.e., if its prefix does not match the prefix for the current primary
source file), a warning will be issued and the PCH file will not be used.

When either of these options is used in conjunction with --pch-dir, the indicated file name (which may
be a path name) is tacked on to the directory name, unless the file name is an absolute path name.

The options --create-pch, --use-pch, and --pch may not be used together. If more than one of these
options is specified, only the last one will apply. Nevertheless, most of the description of automatic PCH
processing applies to one or the other of these modes -- header stop points are determined the same
way, PCH file applicability is determined the same way, and so forth.

2.10.3. Other Ways to Control Precompiled Headers

There are several ways in which the user can control and/or tune how precompiled headers are created
and used.
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» #pragma hdrstop may be inserted in the primary source file at a point prior to the first token that does
not belong to a preprocessing directive. It enables you to specify where the set of header files subject
to precompilation ends. For example,

#i ncl ude "xxx. h"
#i ncl ude "yyy. h"
#pragma hdr st op
#i nclude "zzz. h"

Here, the precompiled header file will include processing state for xxx. h and yyy. h but not zzz. h.
(This is useful if the user decides that the information added by what follows the #pragma hdrstop
does not justify the creation of another PCH file.)

» #pragma no_pch may be used to suppress precompiled header processing for a given source file.

« Command line option --pch-dir=directory-name is used to specify the directory in which to search for
and/or create a PCH file.

Moreover, when the host system does not support memory mapping and preallocated memory is used
instead, then one of the command line options --pch, --create-pch, or --use-pch, if it appears at all, must
be the first option on the command line.

2.10.4. Performance Issues

The relative overhead incurred in writing out and reading back in a precompiled header file is quite small
for reasonably large header files.

In general, it does not cost much to write a precompiled header file out even if it does not end up being
used, and if it is used it almost always produces a significant speedup in compilation. The problem is that
the precompiled header files can be quite large (from a minimum of about 250K bytes to several megabytes
or more), and so one probably does not want many of them sitting around.

Thus, despite the faster recompilations, precompiled header processing is not likely to be justified for an
arbitrary set of files with nonuniform initial sequences of preprocessing directives. Rather, the greatest
benefit occurs when a number of source files can share the same PCH file. The more sharing, the less
disk space is consumed. With sharing, the disadvantage of large precompiled header files can be
minimized, without giving up the advantage of a significant speedup in compilation times.

Consequently, to take full advantage of header file precompilation, users should expect to reorder the
#i ncl ude sections of their source files and/or to group #i ncl ude directives within a commonly used
header file.

Below is an example of how this can be done. A common idiom is this:

#i ncl ude "commfile.h"
#pragma hdr st op
#i nclude ...

where comfi | e. h pulls in, directly and indirectly, a few dozen header files; the #pr agma hdr st op is
inserted to get better sharing with fewer PCH files. The PCH file produced for connfi | e. h can be a bit
over a megabyte in size. Another idiom, used by the source files involved in declaration processing, is
this:
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#include "comfile.h"
#i ncl ude "decl _hdrs. h"
#pragma hdrstop

#i nclude ...

decl _hdr s. h pulls in another dozen header files, and a second, somewhat larger, PCH file is created.
In all, the source files of a particular program can share just a few precompiled header files. If disk space
were at a premium, you could decide to make commfi | e. h pull in all the header files used -- then, a
single PCH file could be used in building the program.

Different environments and different projects will have different needs, but in general, users should be

aware that making the best use of the precompiled header support will require some experimentation
and probably some minor changes to source code.
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This chapter describes the most important aspects of the TASKING assembly language for ARM and
contains a detailed description of all built-in assembly functions and assembler directives. For a complete
overview of the architecture you are using and a description of the assembly instruction set, refer to the
target's core reference manual (for example the ARM Architecture Reference Manual ARM DDI 0100l
[2005, ARM Limited]).

3.1. Assembly Syntax

An assembly program consists of statements. A statement may optionally be followed by a comment.
Any source statement can be extended to more lines by including the line continuation character (\) as
the last character on the line. The length of a source statement (first line and continuation lines) is only
limited by the amount of available memory.

Mnemonics, directives and other keywords are case insensitive. Labels, symbols, directive arguments,
and literal strings are case sensitive.

The syntax of an assembly statement is:

[label [:]] [instruction | directive | macro_call] [;conmment]

label A label is a special symbol which is assigned the value and type of the current
program location counter. A label can consist of letters, digits and underscore
characters (). The first character cannot be a digit. The label can also be a
number. A label which is prefixed by whitespace (spaces or tabs) has to be
followed by a colon (:). The size of an identifier is only limited by the amount of
available memory.

number is a number ranging from 1 to 255. This type of label is called a numeric
label or local label. To refer to a numeric label, you must put an n (next) or p
(previous) immediately after the label. This is required because the same label
number may be used repeatedly.

Examples:
LABl1: ; This label is followed by a colon and
; can be prefixed by whitespace
LAB1 ; This label has to start at the beginning
;o of aline
1: b 1p ; This is an endl ess | oop

; using nuneric |abels
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instruction

directive

macro_call

comment

An instruction consists of a mnemonic and zero, one or more operands. It must
not start in the first column.

All instructions of the ARM Unified Assembler Language (UAL) are supported.
With assembler option --old-syntax you can specify to use the pre-UAL syntax.
VFP instructions are only supported in the UAL syntax.

Operands are described in Section 3.3, Operands of an Assembly Instruction.
The instructions are described in the target's core Architecture Reference Manual.

The instruction can also be a so-called 'generic instruction'. Generic instructions
are pseudo instructions (no instructions from the instruction set). Depending on
the situation in which a generic instruction is used, the assembler replaces the
generic instruction with appropriate real assembly instruction(s). For a complete
list, see Section 3.11, Generic Instructions.

With directives you can control the assembler from within the assembly source.
Except for preprocessing directives, these must not start in the first column.
Directives are described in Section 3.9, Assembler Directives.

A call to a previously defined macro. It must not start in the first column. See
Section 3.10, Macro Operations.

Comment, preceded by a ; (semicolon).

You can use empty lines or lines with only comments.

3.2. Assembler Significant Characters

You can use all ASCII characters in the assembly source both in strings and in comments. Also the
extended characters from the 1ISO 8859-1 (Latin-1) set are allowed.

Some characters have a special meaning to the assembler. Special characters associated with expression
evaluation are described in Section 3.6.3, Expression Operators. Other special assembler characters

are:

Character |Description

; Start of a comment

\ Line continuation character or macro operator: argument concatenation
? Macro operator: return decimal value of a symbol

% Macro operator: return hex value of a symbol

N Macro operator: override local label

" Macro string delimiter or quoted string . DEFI NE expansion character
' String constants delimiter

@ Start of a built-in assembly function

$ Location counter substitution

# Immediate addressing
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Character |Description

++ String concatenation operator

[] Load and store addressing mode

3.3. Operands of an Assembly Instruction

In an instruction, the mnemonic is followed by zero, one or more operands. An operand has one of the
following types:

Operand Description

symbol A symbolic name as described in Section 3.4, Symbol Names. Symbols can also occur
in expressions.

register Any valid register as listed in Section 3.5, Registers.

expression Any valid expression as described in Section 3.6, Assembly Expressions.

address A combination of expression, register and symbol.

Addressing modes

The ARM assembly language has several addressing modes. These are described in detail in the target's
core Architecture Reference Manual.

3.4. Symbol Names

User-defined symbols
A user-defined symbol can consist of letters, digits and underscore characters (). The first character
cannot be a digit. The size of an identifier is only limited by the amount of available memory. The case

of these characters is significant. You can define a symbol by means of a label declaration or an equate
or set directive.

Predefined preprocessor symbols

These symbols start and end with two underscore characters, __symbol__, and you can use them in your
assembly source to create conditional assembly. See Section 3.4.1, Predefined Preprocessor Symbols.

Labels

Symbols used for memory locations are referred to as labels. It is allowed to use reserved symbols as
labels as long as the label is followed by a colon or starts at the first column.
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Reserved symbols

Symbol names and other identifiers beginning with a period (.) are reserved for the system (for example
for directives or section names). Instructions and registers are also reserved. The case of these built-in
symbols is insignificant.

Examples
Valid symbol names:

| oop_1
ENTRY
a_B c
_aBC

Invalid symbol names:

1 | oop ; starts with a nunber
. DEFI NE ; reserved directive nane

3.4.1. Predefined Preprocessor Symbols

The TASKING assembler knows the predefined symbols as defined in the table below. The symbols are
useful to create conditional assembly.

Symbol Description
__ASARM__ Expands to 1 for the ARM toolset, otherwise unrecognized as macro.
__BUILD__ Identifies the build number of the assembler, composed of decimal digits for

the build number, three digits for the major branch number and three digits
for the minor branch number. For example, if you use build 1.22.1 of the
assembler, _ BUILD___ expands to 1022001. If there is no branch number,
the branch digits expand to zero. For example, build 127 results in
127000000.

_ REVISION__ Expands to the revision number of the assembler. Digits are represented
as they are; characters (for prototypes, alphas, betas) are represented by
-1. Examples: v1.0r1 -> 1, v1.0rb -> -1

__TASKING__ Identifies the assembler as a TASKING assembler. Expands to 1 if a
TASKING assembler is used.
__VERSION__ Identifies the version number of the assembler. For example, if you use

version 2.1r1 of the assembler, _ VERSION__ expands to 2001 (dot and
revision number are omitted, minor version number in 3 digits).

Example

i f @lefined(' __ASARM ')
; this part is only for the asarm assenbl er

.endif
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3.5. Registers

The following register names, either uppercase or lowercase, should not be used for user-defined symbol
names in an assembly language source file:

RO .. Ri15 (general purpose registers)
IP (alias for R12)
SP (alias for R13)
LR (alias for R14)
PC (alias for R15)

3.6. Assembly Expressions

An expression is a combination of symbols, constants, operators, and parentheses which represent a
value that is used as an operand of an assembler instruction (or directive).

Expressions can contain user-defined labels (and their associated integer or floating-point values), and
any combination of integers, floating-point numbers, or ASCII literal strings.

Expressions follow the conventional rules of algebra and boolean arithmetic.

Expressions that can be evaluated at assembly time are called absolute expressions. Expressions where
the result is unknown until all sections have been combined and located, are called relocatable or relative
expressions.

When any operand of an expression is relocatable, the entire expression is relocatable. Relocatable
expressions are emitted in the object file and evaluated by the linker. Relocatable expressions can only
contain integral functions; floating-point functions and numbers are not supported by the ELF/DWARF
object format.

The assembler evaluates expressions with 64-bit precision in two's complement.
The syntax of an expression can be any of the following:

* numeric constant

* string

* symbol

» expression binary_operator expression

* unary_operator expression

» (expression)

« function call

All types of expressions are explained in separate sections.
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3.6.1. Numeric Constants

Numeric constants can be used in expressions. If there is no prefix, by default the assembler assumes

the number is a decimal number. Prefixes can be used in either lowercase or uppercase.

Base Description Example

Binary A 0Ob prefix followed by binary digits (0,1). Or use a b suffix. 0B1101
11001010b

Hexadecimal A 0x prefix followed by hexadecimal digits (0-9, A-F, a-f). Or use |Ox12FF

a h suffix. 0x45
0f al0h
Decimal integer Decimal digits (0-9). 12
1245
Decimal Decimal digits (0-9), includes a decimal point, or an 'E' or ‘e’ 6E10
floating-point followed by the exponent. .6
3.14
2.7e10

3.6.2. Strings

ASCII characters, enclosed in single (') or double (") quotes constitute an ASCII string. Strings between
double quotes allow symbol substitution by a . DEFI NE directive, whereas strings between single quotes
are always literal strings. Both types of strings can contain escape characters.

Strings constants in expressions are evaluated to a number (each character is replaced by its ASCII
value). Strings in expressions can have a size of up to 8 characters or less depending on the operand of
an instruction or directive; any subsequent characters in the string are ignored. In this case the assembler
issues a warning. An exception to this rule is when a string is used in a . DB assembler directive; in that
case all characters result in a constant value of the specified size. Null strings have a value of 0.

Examples
' ABCD 7 (0x41424344)
79 ; to enclose a quote double it
"Al"BC ; or to enclose a quote escape it
"AB' +1 ; (0x4143) string used in expression
v ; null string
. DW " abcdef" ; (0x64636261) 'ef' are ignored

; warning: string value truncated
"ab' ++' cd' ; you can concatenate
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3.6.3. Expression Operators

Assembly Language

The next table shows the assembler operators. They are ordered according to their precedence. Operators
of the same precedence are evaluated left to right. Parenthetical expressions have the highest priority
(innermost first).

Valid operands include numeric constants, literal ASCII strings and symbols.

Most assembler operators can be used with both integer and floating-point values. If one operand has
an integer value and the other operand has a floating-point value, the integer is converted to a floating-point
value before the operator is applied. The result is a floating-point value.

Type Operator Name Description

O parenthesis Expressions enclosed by parenthesis are evaluated
first.

Unary + plus Returns the value of its operand.

- minus Returns the negative of its operand.

~ one's complement Integer only. Returns the one’s complement of its
operand. It cannot be used with a floating-point
operand.

! logical negate Returns 1 if the operands' value is O; otherwise 0.
For example, if buf is 0 then ! buf is 1. If buf has
a value of 1000 then ! buf is 0.

Arithmetic * multiplication Yields the product of its operands.

/ division Yields the quotient of the division of the first operand
by the second. For integer operands, the divide
operation produces a truncated integer result.

% modulo Integer only. This operator yields the remainder from
the division of the first operand by the second.

+ addition Yields the sum of its operands.

- subtraction Yields the difference of its operands.

Shift << shift left Integer only. Causes the left operand to be shifted
to the left (and zero-filled) by the number of bits
specified by the right operand.

>> shift right Integer only. Causes the left operand to be shifted
to the right by the number of bits specified by the
right operand. The sign bit will be extended.
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Type Operator Name Description
Relational < less than Returns an integer 1 if the indicated condition is
-— less than or equal TRUE or an integer 0 if the indicated condition is
FALSE.
> greater than
- greater than or equal For example, if D has a value of 3 qnd E ha; avalue
of 5, then the result of the expression D<Eis 1, and
== equal the result of the expression D>E is 0.
I= not equal o ) ) )
Use tests for equality involving floating-point values
with caution, since rounding errors could cause
unexpected results.
Bitwise & AND Integer only. Yields the bitwise AND function of its
operand.
[ OR Integer only. Yields the bitwise OR function of its
operand.
A exclusive OR Integer only. Yields the bitwise exclusive OR function
of its operands.
Logical && logical AND Returns an integer 1 if both operands are non-zero;
otherwise, it returns an integer 0.
[ logical OR Returns an integer 1 if either of the operands is
non-zero; otherwise, it returns an integer 1

The relational operators and logical operators are intended primarily for use with the conditional assembly
. i f directive, but can be used in any expression.

3.7.Working with Sections

Sections are absolute or relocatable blocks of contiguous memory that can contain code or data. Some
sections contain code or data that your program declared and uses directly, while other sections are
created by the compiler or linker and contain debug information or code or data to initialize your application.
These sections can be named in such a way that different modules can implement different parts of these
sections. These sections are located in memory by the linker (using the linker script language, LSL) so
that concerns about memory placement are postponed until after the assembly process.

All instructions and directives which generate data or code must be within an active section. The assembler
emits a warning if code or data starts without a section definition. The compiler automatically generates
sections. If you program in assembly you have to define sections yourself.

For more information about locating sections see Section 8.7.8, The Section Layout Definition: Locating
Sections.

Section definition

Sections are defined with the . SECTI ON. ENDSEC directive and have a name. The names have a special
meaning to the locating process and have to start with a predefined name, optionally extended by a dot
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"."and a user defined name. Optionally, you can specify the at () attribute to locate a section at a specific
address.

. SECTI ON nane[, at (addr ess) ]
; instructions etc.
. ENDSEC

See the description of the . SECTI ON directive for more information.
Examples
. SECTION . dat a ; Declare a .data section
. ENDSEC

. SECTI ON . data. abs, at(0x0) ; Declare a .data.abs section at

; an absol ute address

. ENDSEC

3.8. Built-in Assembly Functions

The TASKING assembler has several built-in functions to support data conversion, string comparison,
and math computations. You can use functions as terms in any expression.

Syntax of an assembly function
@ unction_nanme([argunent[,argunment]...])
Functions start with the '@' character and have zero or more arguments, and are always followed by

opening and closing parentheses. White space (a blank or tab) is not allowed between the function name
and the opening parenthesis and between the (comma-separated) arguments.

The names of assembly functions are case insensitive.

Overview of assembly functions

Function Description

@ALUPCREL ( expr,group[,check]) PC-relative ADD/SUB with operand split

@\RGE ' symbol' | expr) Test whether macro argument is present

@3l GENDI AN() Test if assembler generates code for big-endian mode
@CNT() Return number of macro arguments

@CPU( " architecture' ) Test if current CPU matches architecture

@EFI NED( ' symbol' | symbol) Test whether symbol exists

@.-SB( expr) Least significant byte of the expression

@-SH( expr) Least significant half word of the absolute expression
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Function Description

@ SW expr) Least significant word of the expression

@/BB( expr) Most significant byte of the expression

@vBH( expr) Most significant half word of the absolute expression

@/BW expr) Most significant word of the expression

@PRE_UAL() Test if the assembler runs in pre-UAL syntax mode or in UAL
syntax mode by default (option --old-syntax)

@TRCAT( strl, str2) Concatenate strl and str2

@TRCMP( strl, str2) Compare strl with str2

@TRLEN( string) Return length of string

@BTRPOS( strl, str2[ , start] ) Return position of str2 in strl

@ TRSUB( str, exprl, expr2) Return substring

@rHUVB( ) Test if the assembiler runs in Thumb mode or in ARM mode by
default (option --thumb)

Detailed Description of Built-in Assembly Functions

@ALUPCREL (expression,group[,check])

This function is used internally by the assembler with the generic instructions ADR, ADRL and ADRLL.
This function returns the PC-relative address of the expression for use in these generic instructions. group
is 0 for ADR,1 for ADRL or 2 for ADRLL.

With check you can specify to check for overflow (1 means true, 0 means false). If check is omitted, the
default is 1.

Example:

; The instruction "ADRAL R1, | abel" expands to
ADRAL R1, PC, GALUPCREL( | abel, 0, 1)

@ARG('symbol' | expression)
Returns integer 1 if the macro argument represented by symbol or expression is present, 0 otherwise.

You can specify the argument with a symbol name (the hame of a macro argument enclosed in single
guotes) or with expression (the ordinal number of the argument in the macro formal argument list). If you
use this function when macro expansion is not active, the assembler issues a warning.

Example:

I F @G\RGE' TWDDLE' ) ;is argunment tw ddl e present?
I F @GARE(1) ;is first argunent present?
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@BIGENDIAN()

Returns 1 if the assembler generates code for big-endian mode, returns 0 if the assembler generates
code for little-endian mode (this is the default).

@CNT()

Returns the number of macro arguments of the current macro expansion as an integer. If you use this
function when macro expansion is not active, the assembler issues a warning.

Example:

ARGCOUNT . SET @NT() ; reserve argunent count

@CPU(‘architecture’)

Returns 1 if architecture corresponds to the architecture that was specified with the option
--cpu=architecture; 0 otherwise. See also assembler option --cpu (Select architecture).

Example:

I F @PY(' ARM7EM ) ; true if you specified option --cpu=ARM/7EM
;. code for the ARWT7EM

.ELIF @PU(' ARMW6M ) ; true if you specified option --cpu=ARM/6M
;. code for the ARW6-M

. ELSE
; code for other architectures

. ENDI F

@DEFINED('symbol' | symbol)

Returns 1 if symbol has been defined, O otherwise. If symbol is quoted, it is looked up as a . DEFI NE
symbol; if it is not quoted, it is looked up as an ordinary symbol, macro or label.

Example:
.| F @EFI NED(' ANGLE' ) :is synbol ANGLE defi ned?
. | F @EFI NED( ANGLE) ; does | abel ANGLE exist?

@LSB(expression)

Returns the least significant byte of the result of the expression. The result of the expression is calculated
as 16 bits.

Example:
.DB  @.SB(0x1234) ;. stores 0x34
.DB @BB(0x1234) ;. stores 0x12
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@LSH(expression)

Returns the least significant half word (bits 0..15) of the result of the absolute expression. The result of
the expression is calculated as a word (32 bits).

@LSW(expression)

Returns the least significant word (bits 0..31) of the result of the expression. The result of the expression
is calculated as a double-word (64 bits).

Example:
.DW @QSW 0x12345678) ; stores 0x5678
.DW @/BW 0x123456) ; stores 0x0012

@MSB (expression)

Returns the most significant byte of the result of the expression. The result of the expression is calculated
as 16 hits.

@MSH(expression)
Returns the most significant half word (bits 16..31) of the result of the absolute expression. The result of

the expression is calculated as a word (32 bits). @/SH( expr essi on) is equivalent to
((expression>>16) & Oxffff).

@MSW(expression)

Returns the most significant word of the result of the expression. The result of the expression is calculated
as a double-word (64 bits).

@PRE_UAL()

Returns 1 if the assembler runs in pre-UAL syntax mode by default, or O if the assembler runs in UAL
syntax mode (default). This function reflects the setting of the assembler option --old-syntax.

Example:
.1 F @RE_UAL() ; true if you specified option --old-syntax
; old code
. ELSE
. ; new code, UAL syntax
. ENDI F

@STRCAT(string1,string2)

Concatenates stringl and string2 and returns them as a single string. You must enclose stringl and
string2 either with single quotes or with double quotes.

Example:
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.DEFINE I D "@TRCAT(' TAS' ,"KING )" ; ID = "'TASKI NG

@STRCMP(stringl,string2)

Compares string1 with string2 by comparing the characters in the string. The function returns the difference
between the characters at the first position where they disagree, or zero when the strings are equal:

<0 if string1 < string2
0 if stringl == string2
>0 if stringl > string2
Example:

.IF (@TRCWP(STR 'MAIN ))==0 ; does STR equal 'MAIN ?

@STRLEN(string)

Returns the length of string as an integer.
Example:

SLEN . SET @TRLEN(' string') . SLEN = 6

@STRPOS(string1,string?2[,start])

Returns the position of string2 in string1 as an integer. If string2 does not occur in stringl, the last string
position + 1 is returned.

With start you can specify the starting position of the search. If you do not specify start, the search is
started from the beginning of string1.

Example:
ID.set @TRPOS(' TASKING ,"ASK') ; ID=1
ID.set @TRPOS(' TASKING ,'BUG) ; ID=7

@STRSUB(string,expressionl,expression?2)

Returns the substring from string as a string. expressionl is the starting position within string, and
expression?2 is the length of the desired string. The assembler issues an error if either expressionl or
expression2 exceeds the length of string. Note that the first position in a string is position 0.

Example:

.DEFINE ID "@TRSUB(' TASKING ,3,4)" ;ID = "KING
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@THUMB()

Returns 1 if the assembler runs in Thumb mode by default or O if the assembler runs in ARM mode
(default). This function reflects the setting of the assembler option --thumb. So, it does not depend on
the . CODE16, . CODE32, . ARMor . THUVB directive.

If you are in a . CODE32 part and you specified --thumb, @'HUMB( ) still returns 1.

3.9. Assembler Directives

An assembler directive is simply a message to the assembler. Assembler directives are not translated
into machine instructions. There are three main groups of assembler directives.

Assembler directives that tell the assembler how to go about translating instructions into machine code.
This is the most typical form of assembly directives. Typically they tell the assembler where to put a
program in memory, what space to allocate for variables, and allow you to initialize memory with data.
When the assembly source is assembled, a location counter in the assembler keeps track of where
the code and data is to go in memory.

The following directives fall under this group:

» Assembly control directives

« Symbol definition and section directives

« Data definition / Storage allocation directives
» High Level Language (HLL) directives

Directives that are interpreted by the macro preprocessor. These directives tell the macro preprocessor
how to manipulate your assembly code before it is actually being assembled. You can use these
directives to write macros and to write conditional source code. Parts of the code that do not match the
condition, will not be assembled at all. Unlike other directives, preprocessor directives can start in the
first column.

Some directives act as assembler options and most of them indeed do have an equivalent assembler
(command line) option. The advantage of using a directive is that with such a directive you can overrule
the assembler option for a particular part of the code. Directives of this kind are called controls. A typical
example is to tell the assembler with an option to generate a list file while with the directives . NOLI ST
and . LI ST you overrule this option for a part of the code that you do not want to appear in the list file.
Directives of this kind sometimes are called controls.

Each assembler directive has its own syntax. Some assembler directives can be preceded with a label.
If you do not precede an assembler directive with a label, you must use white space instead (spaces or
tabs). You can use assembler directives in the assembly code as pseudo instructions. The assembler
recognizes both uppercase and lowercase for directives.
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3.9.1. Overview of Assembler Directives

The following tables provide an overview of all assembler directives. For a detailed description of these
directives, refer to Section 3.9.2, Detailed Description of Assembler Directives.

Overview of assembly control directives

Directive Description

. END Indicates the end of an assembly module
. I NCLUDE Include file

. MESSACGE Programmer generated message

Overview of symbol definition and section directives

Directive Description

. EQU Set permanent value to a symbol

. EXTERN Import global section symbol

. GLOBAL Declare global section symbol

. SECTI QN, . ENDSEC Start a new section

. SET Set temporary value to a symbol

. Sl ZE Set size of symbol in the ELF symbol table
. SOURCE Specify name of original C source file

. TYPE Set symbol type in the ELF symbol table

. IEAK Mark a symbol as 'weak’

Overview of data definition / storage allocation directives

Directive

Description

.ALI GN

. BS, . BSB, . BSH, . BSW
. BSD

Align location counter
Define block storage (initialized)

. DB Define byte

. DH Define half word (16 bits)

. Dw Define word (32 bits)

. DD Define double-word (64 bits)

. DOUBLE Define a 64-bit floating-point constant

. DS, . DSB, . DSH, . DSW
. bDSD

. FLOAT
. OFFSET

Define storage

Define a 32-bit floating-point constant
Move location counter forwards
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Overview of macro preprocessor directives

.1 F, .ELIF, .ELSE
. ENDI F

. MACRO, . ENDM

. UNDEF

Directive Description

. DEFI NE Define substitution string

. BREAK Break out of current macro expansion

. REPEAT, . ENDREP Repeat sequence of source lines

. FOR, . ENDFOR Repeat sequence of source lines n times

Conditional assembly directive

End of conditional assembly directive
Define macro

Undefine . DEFI NE symbol or macro

Overview of listing control directives

Directive Description

. LI ST, . NOLI ST Print / do not print source lines to list file

. PAGE Set top of page/size of page

. TITLE Set program title in header of assembly list file

Overview of HLL directives

Directive Description
. CALLS Pass call tree information and/or stack usage information
. M SRAC Pass MISRA-C information

Overview of ARM specific directives

Directive Description

. CCDE16, . CODE32 Treat instructions as Thumb or ARM instructions using pre-UAL syntax
. THUMB, . ARM Treat instructions as Thumb or ARM instructions using UAL syntax

. LTORG Assemble current literal pool immediately

3.9.2. Detailed Description of Assembler Directives
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ALIGN

Syntax

. ALI GN expression

Description

With the . ALI GNdirective you instruct the assembler to align the location counter. By default the assembler
aligns on one byte.

When the assembler encounters the . ALI GN directive, it advances the location counter to an address
that is aligned as specified by expression and places the next instruction or directive on that address.
The alignment is in minimal addressable units (MAUs). The assembler fills the ‘gap’ with NOP instructions
for code sections or with zeros for data sections. If the location counter is already aligned on the specified
alignment, it remains unchanged. The location of absolute sections will not be changed.

The expression must be a power of two: 2, 4, 8, 16, ... If you specify another value, the assembler changes
the alignment to the next higher power of two and issues a warning.

The assembler aligns sections automatically to the largest alignment value occurring in that section.
A label is not allowed before this directive.
Example

. SECTI ON . text

.ALIGN 4 ; the assenbler aligns
instruction ; this instruction at 4 MAUs and

; fills the "gap' with NOP instructions.
. ENDSEC
. SECTION .text
.ALIGN 3 ; WRONG not a power of two, the
instruction ; assenbler aligns this instruction at

; 4 MAUs and issues a warning.
. ENDSEC
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.BREAK

Syntax

. BREAK

Description

The . BREAK directive causes immediate termination of a macro expansion, a . FORloop expansion or a
. REPEAT loop expansion. In case of nested loops or macros, the . BREAK directive returns to the previous
level of expansion.

The . BREAK directive is, for example, useful in combination with the . | F directive to terminate expansion
when error conditions are detected.

The assembler does not allow a label with this directive.

Example

. FOR MYWVAR I N 10 TO 20

; assenbly source lines
.IF MYVAR > 15
. BREAK

. ENDI F
. ENDFOR
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.BS, .BSB, .BSH, .BSW, .BSD

Syntax

[label] .BS count[, val ue]

[l abel] .BSB count[, val ue]
[l abel] .BSH count[, val ue]
[l abel] .BSW count[, val ue]
[l abel] .BSD count[, val ue]

Description

With the . BS directive the assembler reserves a block of memory. The reserved block of memory is
initialized to the value of value, or zero if omitted.

With count you specify the number of minimum addressable units (MAUs) you want to reserve, and how
much the location counter will advance. The expression must be an integer greater than zero and cannot
contain any forward references to address labels (labels that have not yet been defined).

With value you can specify a value to initialize the block with. Only the least significant MAU of value is
used. If you omit value, the default is zero.

If you specify the optional label, it gets the value of the location counter at the start of the directive
processing.

You cannot initialize of a block of memory in sections with prefix . bss. In those sections, the
assembler issues a warning and only reserves space, just as with . DS.

The . BSB, . BSH, . BSWand . BSDdirectives are variants of the . BS directive. The difference is the number
of bits that are reserved for the count argument:

Directive Reserved bits
. BSB 8

. BSH 16

. BSwW 32

. BSD 64

Example

The . BSB directive is for example useful to define and initialize an array that is only partially filled:

.section .data

.DB 84,101, 115,116 ; initialize 4 bytes
. BSB 96, OxFF ; reserve another 96 bytes, initialized with OxFF
. endsec
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Related Information
. DB (Define Memory)

. DS (Define Storage)
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.CALLS

Syntax
.CALLS "caller’,’ callee’
or

.CALLS "caller’,’’, stack_usage[,...]

Description

The first syntax creates a call graph reference between caller and callee. The linker needs this information
to build a call graph. caller and callee are names of functions.

The second syntax specifies stack information. When callee is an empty name, this means we define the
stack usage of the function itself. The value specified is the stack usage in bytes at the time of the call
including the return address. A function can use multiple stacks.

This information is used by the linker to compute the used stack within the application. The information
is found in the generated linker map file within the Memory Usage.

This directive is generated by the C compiler. Use the . CALLS directive in hand-coded assembly when
the assembly code calls a C function. If you manually add . CALLS directives, make sure they connect
to the compiler generated . CALLS directives: the name of the caller must also be named as a callee in
another directive.

A label is not allowed before this directive.

Example
. CALLS 'nmin', ' nfunc'

Indicates that the function mai n calls the function nf unc.
. CALLS 'main','",8

The function mai n uses 8 bytes on the stack.
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.CODE16, .CODE32, .THUMB, .ARM

Syntax

. CODE16
. CODE32
. THUMB
. ARM

Description

With the . CODE16 directive you instruct the assembler to interpret subsequent instructions as 16-bit
Thumb instructions using the pre-UAL syntax until it encounters another mode directive or till it reaches
the end of the active section. This directive causes an implicit alignment of two bytes.

The . THUMB directive is the same as the . CODE16 directive except that the UAL syntax is expected.

With the . CODE32 directive you instruct the assembler to interpret subsequent instructions as 32-bit ARM
instructions using the pre-UAL syntax until it encounters another mode directive or till it reaches the end
of the active section. This directive causes an implicit alignment of four bytes. The assembler issues an
error message if . CODE32 is used in combination with option --cpu=ARMv7M.

The . ARMdirective is the same as the . CODE32 directive except that the UAL syntax is expected.

These directives are useful when you have files that contain both ARM and Thumb instructions. The
directive must appear before the instruction change and between a . SECTI ON. ENDSEC. The default
instruction set at the start of a section depends on the use of assembler option --thumb.

Example
.section .text
. code32
;following instructions are ARMinstructions
. endsec

Related Information

Assembler option --thumb (Treat input as Thumb instructions)
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.DB, .DH, .DW, .DD

Syntax

[label] .DB argument[,argunent]. ..
[label] .DH argument[,argunent]. ..
[label] .DWargument[,argument]. ..
[label] .DD argument[,argument]. ..

Description

With these directive you can define memory. With each directive the assembler allocates and initializes
one or more bytes of memory for each argument.

If you specify the optional label, it gets the value of the location counter at the start of the directive
processing.

An argument can be a single- or multiple-character string constant, an expression or empty. Multiple
arguments must be separated by commas with no intervening spaces. Empty arguments are stored as
0 (zero).

The following table shows the number of bits initialized.

Directive Bits
. DB 8

. DH 16

. DW 32

. DD 64

The value of the arguments must be in range with the size of the directive; floating-point numbers are not
allowed. If the evaluated argument is too large to be represented in a half word / word / double-word, the
assembler issues a warning and truncates the value.

String constants

Single-character strings are stored in a byte whose lower seven bits represent the ASCII value of the
character, for example:

.DB 'R ;= 0x52

Multiple-character strings are stored in consecutive byte addresses, as shown below. The standard C
language escape characters like \n’ are permitted.

.DB "AB',,'C ; = 0x41420043 (second argunent is enpty)
Example

When a string is supplied as argument of a directive that initializes multiple bytes, each character in the
string is stored in consecutive bytes whose lower seven bits represent the ASCII value of the character.
For example:
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HTBL: .DH'ABC,,'D
WIBL: .DW'ABC

; results in 0x424100004400
; results in 0x43424100

, the "C is truncated

Related Information
. BS (Block Storage)

. DS (Define Storage)
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.DEFINE

Syntax

. DEFI NE synmbol string

Description

With the . DEFI NE directive you define a substitution string that you can use on all following source lines.
The assembler searches all succeeding lines for an occurrence of symbol, and replaces it with string. If
the symbol occurs in a double quoted string it is also replaced. Strings between single quotes are not
expanded.

This directive is useful for providing better documentation in the source program. A symbol can consist
of letters, digits and underscore characters (_), and the first character cannot be a digit.

Macros represent a special case. . DEFI NE directive translations will be applied to the macro definition
as it is encountered. When the macro is expanded, any active . DEFI NE directive translations will again
be applied.

The assembler issues a warning if you redefine an existing symbol.

A label is not allowed before this directive.

Example

Suppose you defined the symbol LEN with the substitution string "32":
. DEFI NE LEN " 32"

Then you can use the symbol LEN for example as follows:

. DS LEN
. MESSACE "The length is: LEN'

The assembler preprocessor replaces LEN with "32" and assembles the following lines:

.DS 32
. MESSACE "The length is: 32"

Related Information
. UNDEF (Undefine a .DEFINE symbol)

. MACRO, . ENDM(Define a macro)
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.DS, .DSB, .DSH, .DSW, .DSD

Syntax

[l abel] .DS expression

[l abel] .DSB expression
[l abel] .DSH expression
[1abel ] .DSW expression
[l abel] .DSD expression

Description

With the . DS directive the assembler reserves a block in memory. The reserved block of memory is not
initialized to any value.

With the expression you specify the number of MAUs (Minimal Addressable Units) that you want to
reserve, and how much the location counter will advance. The expression must evaluate to an integer
greater than zero and cannot contain any forward references (symbols that have not yet been defined).

If you specify the optional label, it gets the value of the location counter at the start of the directive
processing.

The . DSB, . DSH, . DSWand . DSDdirectives are variants of the . DS directive. The difference is the number
of bits that are reserved per expression argument:

Directive Reserved bits
. DSB 8

. DSH 16

. DSwW 32

. bSD 64

Example

.section .bss
RES: .DS 5+3 ; allocate 8 bytes
. endsec

Related Information
. BS (Block Storage)

. DB (Define Memory)
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.END

Syntax

. END

Description

With the optional . END directive you tell the assembler that the end of the module is reached. If the
assembler finds assembly source lines beyond the . END directive, it ignores those lines and issues a
warning.

You cannot use the . END directive in a macro expansion.

The assembler does not allow a label with this directive.

Example

.section .text
; source |lines
. endsec
. END ; End of assenbly nodul e
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.EQU

Syntax

synmbol . EQU expression

Description

With the . EQU directive you assign the value of expression to symbol permanently. The expression can
be relative or absolute. Once defined, you cannot redefine the symbol. With the . GLOBAL directive you
can declare the symbol global.

Example

To assign the value 0x400 permanently to the symbol MYSYMBOL:

MYSYMBOL . EQU 0x4000

You cannot redefine the symbol MYSYMBOL after this.

Related Information

. SET (Set temporary value to a symbol)
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.EXTERN
Syntax

. EXTERN synbol [, synbol ]. ..
Description

With the . EXTERNdirective you define an external symbol. It means that the specified symbol is referenced
in the current module, but is not defined within the current module. This symbol must either have been
defined outside of any module or declared as globally accessible within another module with the . GLOBAL
directive.

If you do not use the . EXTERN directive and the symbol is not defined within the current module, the
assembler issues a warning and inserts the . EXTERN directive.

A label is not allowed with this directive.

Example

. EXTERN AA, CC, DD ;defined el sewhere
Related Information

. GLOBAL (Declare global section symbol)
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.FLOAT, .DOUBLE

Syntax
[l abel ]. FLOAT expression[, expression]...

[l abel ] . DOUBLE expression[, expression]...

Description

With the . FLOAT or . DOUBLE directive the assembler allocates and initializes a floating-point number
(32 hits) or a double (64 bits) in memory for each argument.

An expression can be:
« afloating-point expression
* NULL (indicated by two adjacent commas: ,,)

You can represent a constant as a signed whole number with fraction or with the 'e' format as used in the
C language. For example, 12. 457 and +0. 27E- 13 are legal floating-point constants.

If the evaluated argument is too large to be represented in a single word / double-word, the assembler
issues an error and truncates the value.

If you specify label, it gets the value of the location counter at the start of the directive processing.

Example

FLT: .FLOAT  12.457,+0.27E-13
DBL: .DOUBLE 12.457,+0.27E-13

Related Information

. DS (Define Storage)
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.FOR, .ENDFOR

Syntax

[label] .FOR var IN expression[,expression]...
. ENDFOR
or:

[label] .FOR var IN start TO end [ STEP st ep]
. ENDFOR
Description

With the . FOR/ . ENDFOR directive you can repeat a block of assembly source lines with an iterator. As
shown by the syntax, you can use the . FOR/ . ENDFOR in two ways.

1. In the first method, the block of source statements is repeated as many times as the number of
arguments following | N. If you use the symbol var in the assembly lines between . FORand . ENDFOR,
for each repetition the symbol var is substituted by a subsequent expression from the argument list. If
the argument is a null, then the block is repeated with each occurrence of the symbol var removed. If
an argument includes an embedded blank or other assembler-significant character, it must be enclosed
with single quotes.

2. In the second method, the block of source statements is repeated using the symbol var as a counter.
The counter passes all integer values from start to end with a step. If you do not specify step, the
counter is increased by one for every repetition.

If you specify label, it gets the value of the location counter at the start of the directive processing.

Example

In the following example the block of source statements is repeated 4 times (there are four arguments).
With the . DB directive you allocate and initialize a byte of memory for each repetition of the loop (a word
for the . DWdirective). Effectively, the preprocessor duplicates the . DB and . DWdirectives four times in
the assembly source.

.FOR VARL IN 1,2+3, 4,12
. DB VARL
. DW ( VARL* VAR1)

. ENDFOR

In the following example the loop is repeated 16 times. With the . DWdirective you allocate and initialize
four bytes of memory for each repetition of the loop. Effectively, the preprocessor duplicates the . DW
directive 16 times in the assembled file, and substitutes VAR2 with the subsequent numbers.

.FOR VAR2 IN 1 to 0x10

. DW ( VARL* VAR1)
. ENDFOR
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Related Information

. REPEAT, . ENDREP (Repeat sequence of source lines)
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.GLOBAL

Syntax

. GLOBAL synbol [, synbol ]. ..

Description

All symbols or labels defined in the current section or module are local to the module by default. You can
change this default behavior with assembler option --symbol-scope=global.

With the . GLOBAL directive you declare one of more symbols as global. It means that the specified
symbols are defined within the current section or module, and that those definitions should be accessible
by all modules.

To access a symbol, defined with . GLOBAL, from another module, use the . EXTERN directive.

Only program labels and symbols defined with . EQU can be made global.

If the symbols that appear in the operand field are not used in the module, the assembler gives a warning.
The assembler does not allow a label with this directive.

Example

LOOPA .EQU 1 ; definition of synmbol LOOPA
.GLOBAL LOCOPA ; LOCOPA will be globally
; accessi bl e by other nodul es

Related Information

. EXTERN (Import global section symbol)
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IF, .ELIF, .ELSE, .ENDIF

Syntax

.1 F expression

[.ELIF expression] ; the .ELIF directive is optional
[ . ELSE] ; the .ELSE directive is optional
. ENDI F

Description

With the . | F/. ENDI F directives you can create a part of conditional assembly code. The assembler
assembles only the code that matches a specified condition.

The expression must evaluate to an absolute integer and cannot contain forward references. If expression
evaluates to zero, the IF-condition is considered FALSE, any non-zero result of expression is considered
as TRUE.

If the optional . ELSE and/or . ELI F directives are not present, then the source statements following the
. | Fdirective and up to the next . ENDI F directive will be included as part of the source file being assembled
only if the expression had a non-zero result.

If the expression has a value of zero, the source file will be assembled as if those statements between
the . | F and the . ENDI F directives were never encountered.

If the . ELSE directive is present and expression has a nonzero result, then the statements between the
. | Fand . ELSE directives will be assembled, and the statement between the . ELSE and . ENDI F directives
will be skipped. Alternatively, if expression has a value of zero, then the statements between the . | F and
. ELSE directives will be skipped, and the statements between the . ELSE and . ENDI F directives will be
assembled.

You can nest . | F directives to any level. The . ELSE and . ELI F directive always refer to the nearest
previous . | F directive.

A label is not allowed with this directive.
Example

Suppose you have an assemble source file with specific code for a test version, for a demo version and
for the final version. Within the assembly source you define this code conditionally as follows:

I F TEST
; code for the test version
. ELI F DEMO

; code for the denp version
. ELSE
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; code for the final version
. ENDI F

Before assembling the file you can set the values of the symbols TEST and DEMOin the assembly source
before the . | F directive is reached. For example, to assemble the demo version:

TEST .SET 0O
DEMO . SET 1

Related Information

Assembler option --define (Define preprocessor macro)
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INCLUDE

Syntax

. I NCLUDE "fil ename" | <fil enane>

Description

With the . | NCLUDE directive you include another file at the exact location where the . | NCLUDE occurs.
This happens before the resulting file is assembled. The . | NCLUDE directive works similarly to the

#i ncl ude statement in C. The source from the include file is assembled as if it followed the point of the
. | NCLUDE directive. When the end of the included file is reached, assembly of the original file continues.

The string specifies the filename of the file to be included. The filename must be compatible with the
operating system (forward/backward slashes) and can contain a directory specification. If you omit a
filename extension, the assembler assumes the extension . asm

If an absolute pathname is specified, the assembler searches for that file. If a relative path is specified
or just a filename, the order in which the assembler searches for include files is:

1. The current directory if you use the "filename" construction.
The current directory is not searched if you use the <filename> syntax.
2. The path that is specified with the assembler option --include-directory.
3. The path that is specified in the environment variable ASARM NC when the product was installed.
4. The default i ncl ude directory in the installation directory.
The assembler does not allow a label with this directive.

The state of the assembler is not changed when an include file is processed. The lines of the include file
are inserted just as if they belong to the file where it is included.

Example
Suppose that your assembly source file t est . sr ¢ contains the following line:
. I NCLUDE "c:\ nyi ncl udes\ nyi nc. i nc"
The assembler issues an error if it cannot find the file at the specified location.
. I NCLUDE "nyi nc.inc"
The assembler searches the file myi nc. i nc according to the rules described above.
Related Information

Assembler option --include-directory (Add directory to include file search path)
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.LIST, .NOLIST
Syntax
. NOLI ST

; assenbly source lines
.LIST

Description

If you generate a list file with the assembler option --list-file, you can use the directives . LI ST and
. NOLI ST to specify which source lines the assembler must write to the list file. Without the assembler
option --list-file these directives have no effect. The directives take effect starting at the next line.

The assembler prints all source lines to the list file, until it encounters a . NOLI ST directive. The assembler
does not print the . NOLI ST directive and subsequent source lines. When the assembler encounters the
. LI ST directive, it resumes printing to the list file.

It is possible to nest the . LI ST/. NOLI ST directives.
Example

Suppose you assemble the following assembly code with the assembler option --list-file:

. SECTI ON . t ext
.. ; source line 1
. NOLI ST

.. ; source line 2
.LIST

.. ; source line 3
. ENDSEC

The assembler generates a list file with the following lines:

. SECTI ON . t ext

; source line 1
.. ; source line 3
. ENDSEC

Related Information

Assembler option --list-file (Generate list file)
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.LTORG

Syntax

. LTORG

Description

With this directive you force the assembler to generate a literal pool (data pocket) at the current location.
All literals from the LDR= pseudo-instructions (except those which could be translated to MOV or MVN
instructions) between the previous literal pool and the current location will be assembled in a new literal

pool using . DWdirectives.

By default, the assembler generates a literal pool at the end of a code section, i.e. the . ENDSEC directive
at the end of a code section causes an implicit . LTORG directive. However, the default literal pool may
be out-of-reach of one or more LDR= pseudo-instructions in the section. In that case the assembler issues
an error message and you should insert . LTORGdirectives at proper locations in the section.

Example

.section .text

LDR r1, =0x12345678

; code
.ltorg ; literal pool contains the literal &0x12345678
. endsec ; default literal pool is empty

Related Information
LDR= ARM generic instruction

LDR= Thumb generic instruction
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.MACRO, .ENDM

Syntax

macr o_nhame . MACRO [argument [, argument]...]
rracr o_definition_statenents
. ENDM

Description

With the . MACROdirective you define a macro. Macros provide a shorthand method for handling a repeated
pattern of code or group of instructions. You can define the pattern as a macro, and then call the macro
at the points in the program where the pattern would repeat.

The definition of a macro consists of three parts:

» Header, which assigns a name to the macro and defines the arguments (. MACRO directive).
» Body, which contains the code or instructions to be inserted when the macro is called.

« Terminator, which indicates the end of the macro definition (. ENDMdirective).

The arguments are symbolic names that the macro processor replaces with the literal arguments when
the macro is expanded (called). Each formal argument must follow the same rules as symbol names: the
name can consist of letters, digits and underscore characters (_). The first character cannot be a digit.
Argument names cannot start with a percent sign (%).

Macro definitions can be nested but the nested macro will not be defined until the primary macro is
expanded.

You can use the following operators in macro definition statements:

Operator [Name Description

\ Macro argument concatenation | Concatenates a macro argument with adjacent
alphanumeric characters.

? Return decimal value of symbol | Substitutes the ?symbol sequence with a character string
that represents the decimal value of the symbol.

% Return hex value of symbol Substitutes the %symbol sequence with a character string
that represents the hexadecimal value of the symbol.

“ Macro string delimiter Allows the use of macro arguments as literal strings.

A Macro local label override Prevents name mangling on labels in macros.

Example
The macro definition:

macro_a .MACRO argl, arg2 ; header
.db argl ; body
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.dw (argl*arg2)
. ENDM
The macro call:
.section far
macro_a 2,3
. endsec

The macro expands as follows:

.db 2
Cdw (2*3)

Related Information
Section 3.10, Macro Operations

. DEFI NE (Define a substitution string)
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.MESSAGE

Syntax

. MESSACGE type [{str]|exp}[,{str]|exp}]...]

Description

With the . MESSAGE directive you tell the assembiler to print a message to st der r during the assembling
process.

With type you can specify the following types of messages:

| Information message. Error and warning counts are not affected and the assembler continues
the assembling process.

W Warning message. Increments the warning count and the assembler continues the assembling
process.

Error message. Increments the error count and the assembler continues the assembling process.

F Fatal error message. The assembler immediately aborts the assembling process and generates
no object file or list file.

An arbitrary number of strings and expressions, in any order but separated by commas with no intervening
white space, can be specified to describe the nature of the generated message. If you use expressions,
the assembler outputs the result. The assembler outputs a space between each argument.

The error and warning counts will not be affected. The . MESSAGE directive is for example useful in
combination with conditional assembly to indicate which part is assembled. The assembling process
proceeds normally after the message has been printed.

This directive has no effect on the exit code of the assembler.
A label is not allowed with this directive.
Example

. MESSAGE | 'Generating tables'

ID.EQU 4
.MESSAGE E ' The value of IDis',ID

. DEFI NE LONG " SHORT"
.MESSACE | 'This is a LONG string'
.MESSACE | "This is a LONG string"

Within single quotes, the defined symbol LONGis not expanded. Within double quotes the symbol LONG
is expanded so the actual message is printed as:

This is a LONG string
This is a SHORT string
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.MISRAC

Syntax

.M SRAC string

Description

The C compiler can generate the . M SRACdirective to pass the compiler's MISRA-C settings to the object
file. The linker performs checks on these settings and can generate a report. It is not recommended to
use this directive in hand-coded assembly.

Example

.M SRAC ' M SRA- C: 2004, 64, e2, Ob, e, el1, 27, 6, ef 83, el, ef , 66, cb75, af 1, ef f, e7,
e7f, 8d, 63, 87ff7,6ff3, 4

Related Information
Section 4.7.2, C Code Checking: MISRA-C

C compiler option --misrac
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.OFFSET

Syntax

. OFFSET expressi on

Description

With the . OFFSET directive you tell the assembler to give the location counter a new offset relative to the
start of the section.

When the assembler encounters the . OFFSET directive, it moves the location counter forwards to the
specified address, relative to the start of the section, and places the next instruction on that address. If
you specify an address equal to or lower than the current position of the location counter, the assembler
issues an error.

A label is not allowed with this directive.

Example

. SECTI ON . t ext
nop
nop
nop
. OFFSET 0x20 ; the assenbl er places
nop ; this instruction at address 0x20
; relative to the start of the section.
. ENDSEC

. SECTI ON .t ext

nop

nop

nop

. OFFSET 0x02 ; WRONG the current position of the
nop ; location counter is 0xOC.

. ENDSEC

Related Information

. SECTI ON (Start a new section)
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.PAGE

Syntax

. PACGE [ pagewi dt h[, pagel engt h[, bl ankt op[, bl ankbt n{, bl ankl eft]]]]
Default

. PAGE 132,72,0,0,0
Description

If you generate a list file with the assembler option --list-file, you can use the directive . PAGE to format
the generated list file.

The arguments may be any positive absolute integer expression, and must be separated by commas.

pagewidth Number of columns per line. The default is 132, the minimum is 40.

pagelength Total number of lines per page. The default is 72, the minimum is 10.
As a special case, a page length of 0 turns off page breaks.

blanktop Number of blank lines at the top of the page. The default is 0, the
minimum is 0 and the maximum must be a value so that (blanktop +
blankbtm) < (pagelength - 10).

blankbtm Number of blank lines at the bottom of the page. The default is 0, the
minimum is 0 and the maximum must be a value so that (blanktop +
blankbtm) < (pagelength - 10).

blankleft Number of blank columns at the left of the page. The default is 0, the
minimum is 0, and the maximum must maintain the relationship: blankleft
< pagewidth.

If you use the . PAGE directive without arguments, it causes a 'formfeed': the next source line is printed
on the next page in the list file. The . PAGE directive itself is not printed.

You can omit an argument by using two adjacent commas. If the remaining arguments after an argument
are all empty, you can omit them.

Example
. PAGE ; fornfeed, the next source line is printed
; on the next page in the list file.
. PACGE 96 ; set page width to 96. Note that you can

; omt the last four arguments.
.PAGE ,,3,3 ; use 3 line top/bottom nargins.

Related Information

. TI TLE (Set program title in header of assembler list file)
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Assembler option --list-file
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.REPEAT, .ENDREP

Syntax

[l abel ] . REPEAT expression
. ENDREP

Description

With the . REPEAT/. ENDREP directive you can repeat a sequence of assembly source lines. With expression
you specify the number of times the loop is repeated. If the expression evaluates to a number less than
or equal to 0, the sequence of lines will not be included in the assembler output. The expression result
must be an absolute integer and cannot contain any forward references (symbols that have not already
been defined). The . REPEAT directive may be nested to any level.

If you specify label, it gets the value of the location counter at the start of the directive processing.
Example

In this example the loop is repeated 3 times. Effectively, the preprocessor repeats the source lines (. DB
10) three times, then the assembler assembles the result:

. REPEAT 3
.DB 10 ; assenbly source |lines
. ENDFOR

Related Information

. FOR, . ENDFOR (Repeat sequence of source lines n times)
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.SECTION, .ENDSEC

Syntax
. SECTI ON nane[, at ( address)]
. ENDSEC

Description

With the . SECTI ON directive you define a new section. Each time you use the . SECTI ON directive, a
new section is created. It is possible to create multiple sections with exactly the same name.

If you define a section, you must always specify the section name. The names have a special meaning
to the locating process and have to start with a predefined name, optionally extended by a dot'." and a
user defined name. The predefined section name also determines the type of the section (code, data or
debug). Optionally, you can specify the at () attribute to locate a section at a specific address.

You can use the following predefined section names:

Section name |Description Section type
text Code sections code

.data Initialized data data

.bss Uninitialized data (cleared) data

.rodata ROM data (constants) data

.debug Debug sections debug

Sections of a specified type are located by the linker in a memory space. The space names are defined
in a so-called 'linker script file' (files with the extension . | sl ) delivered with the product in the directory
installation-dir\include.lsl.

Example
. SECTI ON . dat a ; Declare a .data section
: ENiJéEC
. SECTI ON . dat a. abs, at(0x0) ; Declare a .data.abs section at
; an absol ute address
: ENiJéEC

Related Information

. OFFSET (Move location counter forwards)
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SET

Syntax

symbol . SET expression
.SET synbol expression

Description

With the . SET directive you assign the value of expression to symbol temporarily. If a symbol was defined
with the . SET directive, you can redefine that symbol in another part of the assembly source, using the
. SET directive again. Symbols that you define with the . SET directive are always local: you cannot define
the symbol global with the . GLOBAL directive.

The . SET directive is useful in establishing temporary or reusable counters within macros. expression
must be absolute and cannot include a symbol that is not yet defined (no forward references are allowed).

Example

COUNT .SET O ; Initialize count. Later on you can
; assign other values to the synbol

Related Information

. EQU (Set permanent value to a symbol)
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SIZE

Syntax
.Sl ZE synbol , expression
Description
With the . SI ZE directive you set the size of the specified symbol to the value represented by expression.

The . Sl ZE directive may occur anywhere in the source file unless the specified symbol is a function. In
this case, the . S| ZE directive must occur after the function has been defined.

Example
.section . text
. gl obal main
.arm
.align 4
; Function main
mai n: .type func

. SI ZE mai n, $- mai n
. endsec

Related Information

. TYPE (Set symbol type)
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.SOURCE
Syntax

. SOURCE string
Description

With the . SOURCE directive you specify the name of the original C source module. This directive is
generated by the C compiler. You do not need this directive in hand-written assembly.

Example

. SOURCE "nai n. c"
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.TITLE
Syntax

.TITLE ["string"]
Default

.TITLE "*"

Description

If you generate a list file with the assembler option --list-file, you can use the . TI TLE directive to specify
the program title which is printed at the top of each page in the assembler list file.

If you use the . Tl TLE directive without the argument, the title becomes empty. This is also the default.
The specified title is valid until the assembler encounters a new . Tl TLE directive.

The . Tl TLE directive itself will not be printed in the source listing.
If the page width is too small for the title to fit in the header, it will be truncated.
Example
.TITLE "This is the title"
Related Information
. PAGE (Format the assembler list file)

Assembler option --list-file
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.TYPE
Syntax
synmbol . TYPE typeid

Description

With the . TYPE directive you set a symbol's type to the specified value in the ELF symbol table. Valid
symbol types are:

FUNC The symbol is associated with a function or other executable code.
OBJECT The symbol is associated with an object such as a variable, an array, or a structure.
FILE The symbol name represents the filename of the compilation unit.

Labels in code sections have the default type FUNC. Labels in data sections have the default type OBJECT.
Example
Afunc: .type func

Related Information

. Sl ZE (Set symbol size)
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.UNDEF

Syntax

. UNDEF synmbol

Description

With the . UNDEF directive you can undefine a substitution string that was previously defined with the
. DEFI NE directive. The substitution string associated with symbol is released, and symbol will no longer
represent a valid . DEFI NE substitution or macro.

The assembler issues a warning if you redefine an existing symbol.
The assembler does not allow a label with this directive.
Example

The following example undefines the LEN substitution string that was previously defined with the . DEFI NE
directive:

. UNDEF LEN
Related Information
. DEFI NE (Define a substitution string)

. MACRO, . ENDM (Define a macro)
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WEAK

Syntax

. EAK synbol [, synbol ] . ..

Description

With the . VEAK directive you mark one or more symbols as 'weak'. The symbol can be defined in the
same module with the . GLOBAL directive or the . EXTERN directive. If the symbol does not already exist,
it will be created.

A 'weak' external reference is resolved by the linker when a global (or weak) definition is found in one of
the object files. However, a weak reference will not cause the extraction of a module from a library to
resolve the reference.

You can overrule a weak definition with a . G_LOBAL definition in another module. The linker will not
complain about the duplicate definition, and ignore the weak definition.

Only program labels and symbols defined with . EQU can be made weak.
Example

LOOPA . EQU 1 ; definition of synbol LOOPA
.GLOBAL LOOPA ; LOOPA will be globally
; accessi bl e by other nodul es
. VEAK LOGPA ; mark synmbol LOOPA as weak

Related Information
. EXTERN (Import global section symbol)

. GLOBAL (Declare global section symbol)
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3.10. Macro Operations

Macros provide a shorthand method for inserting a repeated pattern of code or group of instructions. You
can define the pattern as a macro, and then call the macro at the points in the program where the pattern
would repeat.

Some patterns contain variable entries which change for each repetition of the pattern. Others are subject
to conditional assembly.

When a macro is called, the assembler executes the macro and replaces the call by the resulting in-line
source statements. 'In-line' means that all replacements act as if they are on the same line as the macro
call. The generated statements may contain substitutable arguments. The statements produced by a
macro can be any processor instruction, almost any assembler directive, or any previously-defined macro.
Source statements resulting from a macro call are subject to the same conditions and restrictions as any
other statements.

Macros can be nested. The assembler processes nested macros when the outer macro is expanded.

3.10.1. Defining a Macro
The first step in using a macro is to define it.
The definition of a macro consists of three parts:
» Header, which assigns a name to the macro and defines the arguments (. MACROdirective).
» Body, which contains the code or instructions to be inserted when the macro is called.
» Terminator, which indicates the end of the macro definition (. ENDMdirective).
A macro definition takes the following form:
macr o_nanme . MACRO [argunent[, argunent]...]
lm.a;:ro_defi nition_statenments
- ENDM
For more information on the definition see the description of the . MACRO directive.

3.10.2. Calling a Macro

To invoke a macro, construct a source statement with the following format:

[l abel] macro_name [argunent[,argunent]...] [; conment]

where,

label An optional label that corresponds to the value of the location counter
at the start of the macro expansion.

macro_name The name of the macro. This may not start in the first column.
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argument One or more optional, substitutable arguments. Multiple arguments
must be separated by commas.

comment An optional comment.

The following applies to macro arguments:

» Each argument must correspond one-to-one with the formal arguments of the macro definition. If the

macro call does not contain the same number of arguments as the macro definition, the assembler
issues a warning.

« If an argument has an embedded comma or space, you must surround the argument by single quotes

().

» You can declare a macro call argument as null in three ways:

enter delimiting commas in succession with no intervening spaces

macr onane ARGL, , ARG3 ; the second argunent is a null argunent

terminate the argument list with a comma, the arguments that normally would follow, are now
considered null

macr onane ARGL, ; the second and all follow ng argunents are null

declare the argument as a null string

» No character is substituted in the generated statements that reference a null argument.

3.10.3. Using Operators for Macro Arguments

The

assembler recognizes certain text operators within macro definitions which allow text substitution of

arguments during macro expansion. You can use these operators for text concatenation, numeric
conversion, and string handling.

Operator [Name Description

\

Macro argument concatenation | Concatenates a macro argument with adjacent
alphanumeric characters.

that represents the decimal value of the symbol.

% Return hex value of symbol Substitutes the %symbol sequence with a character string
that represents the hexadecimal value of the symbol.

“ Macro string delimiter Allows the use of macro arguments as literal strings.

n Macro local label override Prevents name mangling on labels in macros.
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Example: Argument Concatenation Operator -\
Consider the following macro definition:

MAC A . MACRO reg, val
sub r\reg, r\reg, #val
. ENDM

The macro is called as follows:

MAC A 2,1

The macro expands as follows:
sub r2,r2,#1

The macro preprocessor substitutes the character '2' for the argument r eg, and the character '1' for the
argument val . The concatenation operator (\) indicates to the macro preprocessor that the substitution
characters for the arguments are to be concatenated with the characters 'r'.

Without the '\' operator the macro would expand as:
sub rreg,rreg, #1

which results in an assembler error (invalid operand).

Example: Decimal Value Operator - ?

Instead of substituting the formal arguments with the actual macro call arguments, you can also use the
value of the macro call arguments.

Consider the following source code that calls the macro MAC_A after the argument AVAL has been set to
1.

AVAL .SET 1
MAC_A 2, AVAL

If you want to replace the argument val with the value of AVAL rather than with the literal string ' AVAL' ,
you can use the ? operator and modify the macro as follows:

MAC_A . MACRO reg, val

sub r\reg, r\reg, #?val
. ENDM

Example: Hex Value Operator - %

The percent sign (%) is similar to the standard decimal value operator (?) except that it returns the
hexadecimal value of a symbol.
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Consider the following macro definition:

GEN_LAB . MACRO LAB, VAL, STMI
LAB\ %/AL  STMI
. ENDM

The macro is called after NUMhas been set to 10:

NUM . SET 10
GEN_LAB  HEX, NUM NCP

The macro expands as follows:
HEXA NOP

The %/AL argument is replaced by the character 'A’ which represents the hexadecimal value 10 of the
argument VAL.

Example: Argument String Operator - "

To generate a literal string, enclosed by single quotes ('), you must use the argument string operator (*)
in the macro definition.

Consider the following macro definition:

STR_MAC . MACRO STRI NG
. DB " STRI NG’
. ENDM

The macro is called as follows:
STR_MAC ABCD

The macro expands as follows:
. DB ' ABCD

Within double quotes . DEFI NE directive definitions can be expanded. Take care when using constructions
with single quotes and double quotes to avoid inappropriate expansions. Since . DEFI NE expansion
occurs before macro substitution, any . DEFI NE symbols are replaced first within a macro argument string:

. DEFI NE LONG 'short'

STR_MAC . MACRO STRI NG
.MESSAGE | 'This is a LONG STRI NG
.MESSAGE | "This is a LONG STRI NG'
. ENDM

If the macro is called as follows:

STR_MAC sentence
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it expands as:

.MESSAGE | 'This is a LONG STRI NG
.MESSAGE | 'This is a short sentence'

Macro Local Label Override Operator -~

If you use labels in macros, the assembler normally generates another unique name for the labels (such
as LOCAL__M_L000001).

The macro ~-operator prevents name mangling on macro local labels.
Consider the following macro definition:

INNT . MACRO addr
LOCAL: |dr r 0, ~addr
. ENDM

The macro is called as follows:

LOCAL:
INI T LOCAL

The macro expands as:
LOCAL__M L0O00001: |dr  rO, LOCAL

If you would not have used the * operator, the macro preprocessor would choose another name for LOCAL
because the label already exists. The macro would expand like:

LOCAL__M L000001: Idr  rO, LOCAL__M LO00001

3.11. Generic Instructions

The assembler supports so-called 'generic instructions'. Generic instructions are pseudo instructions (no
instructions from the instruction set). Depending on the situation in which a generic instruction is used,
the assembler replaces the generic instruction with appropriate real assembly instruction(s).

3.11.1. ARM Generic Instructions

The ARM assembler recognizes the following generic instructions in ARM mode:

ADR, ADRL, ADRLL ARM generics

Load a PC-relative address into a register. The address is specified as a target label. The assembler
generates one (ADR), two (ADRL) or three (ADRLL) generic DPR instruction (called ADR) and one, two
or three PC-relative relocation types for the target label. The linker evaluates the relocation types (calculate
the PC-relative offset) and generates one, two or three add or sub instructions each with an 8-bitimmediate
operand plus a 4-bit rotation. If the offset cannot be encoded the linker generates an error message.
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Instruction Replacement
ADRcond Rd,label |ADRcond Rd, PC, @ALUPCREL(label,0,1)

ADRLcond Rd,label |ADRcond Rd, PC, @ALUPCREL(label,0,0)
ADRcond Rd, Rd, @ALUPCREL(label,1,1)

ADRLLcond Rd,label[ADRcond Rd, PC, @ALUPCREL(label,0,0)
ADRcond Rd, Rd, @ALUPCREL(label,1,0)
ADRcond Rd, Rd, @ALUPCREL(label,2,1)

3.11.2. ARM and Thumb-2 32-bit Generic Instructions

LDR= ARM and Thumb-2 generic

Load an address or a 32-bit constant value into a register. If the constant or its bitwise negation can be
encoded, then the assembler will generate a MOV or a MVN instruction. Otherwise the assembler places
the constant or the address in a literal pool and generates a PC-relative LDR instruction that loads the
value from the literal pool.

Instruction Replacement Remarks
LDRcond MOVcond Rd, #expr If expr can be encoded
Rd,=expr MVNcond Rd,#@LSW(~(expr)) If ~expr can be encoded
LDRcond Rd, | t pool If expr is external or PC-relative, or cannot
;; code be encoded
| t pool :
. DW expr

The PC-relative offset from the LDR instruction to the value in the literal pool must be positive and less
than 4 kB. By default the assembler will place a literal pool at the end of each code section. If the default
literal pool is out-of-range you will have to ensure that there is another literal pool within range by means
of the . LTORG directive.

VLDR= ARM and Thumb-2 generic

Load a 32-bit or 64-bit floating-point constant value into a register. The assembler places the constant in
a literal pool and generates a PC-relative VLDR instruction that loads the value from the literal pool.

Instruction Replacement
VLDRcond Sd,=expr VLDRcond Sd, | t pool
;; code
|t pool :
. FLOAT expr
VLDRcond Dd,=expr VLDRcond Dd, |t pool
;; code
|t pool :
. DOUBLE expr
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Instruction

Replacement

Remarks

MOV32cond Rd,=expr [MOVWcond Rd, #@LSH(expr)
MOVTcond Rd, #@MSH(expr)

If expr is internal and absolute

MOVWcond Rd, #expr
MOVTcond Rd, #expr

If expr is external or relocatable

ARM and Thumb-2 generic DPR inversions for immediate operands

For data processing instructions (DPR) which operate on an immediate operand, the operand value must
be encoded as an 8-bit value plus a 4-bit even rotation value. If a value does not fit in such an encoding,
it could be possible that the negated value (-value) or the bitwise negated value (~value) does fit in such
an encoding. In that case the assembler will replcace the DPR instruction by its inverse DPR instruction
operating on the negated value.

Instruction

Replacement (if #imm or #~imm can be encoded)

ADDcond Rd,Rn,#imm32

SUBcond Rd,Rn,#- (imm32)

ADDcondS Rd,Rn,#imm32

SUBcondS Rd,Rn,#- (imm32)

ADDWcond Rd,Rn,#imm12

SUBWocond Rd,Rn,#- (imm12)

SUBcond Rd,Rn,#imm32

ADDcond Rd,Rn,#- (imm32)

SUBcondS Rd,Rn,#imm32

ADDcondS Rd,Rn,#- (imm32)

SUBWcond Rd,Rn,#imm12

ADDWcond Rd,Rn #- (imm12)

ADCcond Rd,Rn,#imm32

SBCcond Rd,Rn #- (imm32)

ADCcondS Rd,Rn,#imm32

SBCcondS Rd,Rn,#- (imm32)

SBCcond Rd,Rn,#imm32

ADCcond Rd,Rn,#- (imm32)

SBCcondS Rd,Rn,#imm32

ADCcondS Rd,Rn,#- (imm32)

ANDcond Rd,Rn,#imm32

BICcond Rd,Rn#@LSW(~(imm32))

ANDcondS Rd,Rn,#imm32

BICcondS Rd,Rn,#@LSW(~(imm32))

BICcond Rd,Rn,#imm32

ANDcond Rd,Rn,#@LSW/(~(imm32))

BICcondS Rd,Rn,#imm32

ANDcondS Rd,Rn,#@LSW(~(imm32))

CMNcond Rn,#imm32

CMPcond Rn,#- (imm)

CMPcond Rn,#imm32

CMNcond Rn,#- (imm)

MOVcond Rd,#mm32

MVNcond Rd,#@LSW(~(imm32))

MOVcondS Rd,#imm32

MVNcondS Rd,#@LSW(~(imm32))

MVNcond Rd,#imm32

MOVcond Rd,#@LSW(~(imm32))

MVNcondS Rd,#mm32

MOVcondS Rd,#@LSW(~(imm32))
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Note that the built-in function @LSW/() must be used on the bitwise negated immediate value because
all values are interpreted by the assembler as 64-bit signed values. The @LSW() function returns the
lowest 32 bits.

3.11.3. Thumb 16-bit Generic Instructions

The ARM assembler recognizes the following generic instructions in Thumb mode:

ADR Thumb 16-bit generic

Load a PC-relative address into a low register. The address is specified as a target label. The PC-relative
offset must be less than 1 kB. The target label must be defined locally, must be word-aligned and must
be in the same code section as the instruction. The assembler will not emit a relocation type for the target
label. If the offset is out-of-range or the target label is external or in another section, then the assembler
generates an error message.

LDR=Thumb 16-bit generic

Load an address or a 32-bit constant value into a low register. If the constant is in the range [0,255] the
assembler will generate a MOV instruction. Otherwise the assembler places the constant or the address
in a literal pool and generates a PC-relative LDR instruction that loads the value from the literal pool.

Instruction |[Replacement Remarks
LDR Rd,=expr|MOV Rd, #expr If expr is in range
LDR Rd, | t pool If expr is external or PC-relative, or not in
;; code range
It pool :
. DW expr

The PC-relative offset from the LDR instruction to the value in the literal pool must be positive and less
than 1 kB. By default the assembler will place a literal pool at the end of each code section. If the default
literal pool is out-of-range you will have to ensure that there is another literal pool within range by means
of the . LTORG directive.

Bcond inversion Thumb 16-bit generic

The PC-relative conditional branch instruction has a range of (-256,+255) bytes. The unconditional version
has a range of (-2048,+2047) bytes. If the conditional branch target is out-of-range, the assembler will
rewrite the conditional branch instruction with an inversed conditional branch and an unconditional branch.

Instruction |[Replacement Remarks

Bcond label Bi nv_cond ~1

B | abel

If target label out-of-range

~1:
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ADD, SUB inversions Thumb 16-bit generic

For the following six instructions the assembler accepts negative values for the immediate operand. If a
negative value is specified, the assembler inverts the instruction from ADD to SUB or vice versa. For
example: ADD R1,#-4 will be rewritten as SUB R1,#4.

Instruction Replacement

ADD Rd,Rn#imm|SUB Rd,Rn,#- (imm)
ADD Rd,#imm SUB Rd,#- (imm)
ADD SP#imm SUB SP#- (imm)
SUB Rd,Rn,#mm |ADD Rd,Rn #- (imm)
SUB Rd,#imm ADD Rd,#- (imm)
SUB SP#imm ADD SP#- (imm)
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Chapter 4. Using the C Compiler

This chapter describes the compilation process and explains how to call the C compiler.

The TASKING VX-toolset for ARM under Eclipse can use the internal builder (default) or the TASKING
makefile generator (external builder) to build your entire embedded project, from C source till the final
ELF/DWARF object file which serves as input for the debugger.

Although in Eclipse you cannot run the C compiler separately from the other tools, this section discusses
the options that you can specify for the C compiler.

On the command line it is possible to call the C compiler separately from the other tools. However, it is
recommended to use the control program for command line invocations of the toolset (see Section 10.1,
Control Program). With the control program it is possible to call the entire toolset with only one command
line.

The C compiler takes the following files for input and output:

Csource file
.C
1 .
compiler
Ccompiler intermediate file
| ] - .mil
assembly file

. 8IC

This chapter first describes the compilation process which consists of a frontend and a backend part.
Next it is described how to call the C compiler and how to use its options. An extensive list of all options
and their descriptions is included in Section 13.2, C Compiler Options. Finally, a few important basic tasks
are described, such as including the C startup code and performing various optimizations.

4.1. Compilation Process

During the compilation of a C program, the C compiler runs through a number of phases that are divided
into two parts: frontend and backend.

The backend part is not called for each C statement, but starts after a complete C module or set of modules
has been processed by the frontend (in memory). This allows better optimization.

The C compiler requires only one pass over the input file which results in relative fast compilation.
Frontend phases
1. The preprocessor phase:

The preprocessor includes files and substitutes macros by C source. It uses only string manipulations

on the C source. The syntax for the preprocessor is independent of the C syntax but is also described
in the ISO/IEC 9899:1999(E) standard.

147



TASKING VX-toolset for ARM User Guide

. The scanner phase:

The scanner converts the preprocessor output to a stream of tokens.

. The parser phase:

The tokens are fed to a parser for the C grammar. The parser performs a syntactic and semantic
analysis of the program, and generates an intermediate representation of the program. This code is
called MIL (Medium level Intermediate Language).

. The frontend optimization phase:

Target processor independent optimizations are performed by transforming the intermediate code.

Backend phases

1.

Instruction selector phase:

This phase reads the MIL input and translates it into Low level Intermediate Language (LIL). The LIL
objects correspond to a processor instruction, with an opcode, operands and information used within
the C compiler.

. Peephole optimizer/instruction scheduler/software pipelining phase:

This phase replaces instruction sequences by equivalent but faster and/or shorter sequences, rearranges
instructions and deletes unnecessary instructions.

. Register allocator phase:

This phase chooses a physical register to use for each virtual register.

. The backend optimization phase:

Performs target processor independent and dependent optimizations which operate on the Low level
Intermediate Language.

. The code generation/formatter phase:

This phase reads through the LIL operations to generate assembly language output.

4.2. Calling the C Compiler

The TASKING VX-toolset for ARM under Eclipse can use the internal builder (default) or the TASKING
makefile generator (external builder) to build your entire project. After you have built your project, the
output files are available in a subdirectory of your project directory, depending on the active configuration
you have set in the C/C++ Build » Settings page of the Project » Properties for dialog.

Building a project under Eclipse

You have several ways of building your project:
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Build Selected File(s) (). This compiles and assembles the selected file(s) without calling the linker.
1. In the C/C++ Projects view, select the files you want to compile.

2. Right-click in the C/C++ Projects view and select Build Selected File(s).

Build Individual Project (1),

To build individual projects incrementally, select Project » Build project.

Rebuild Project (“2). This builds every file in the project whether or not a file has been modified since
the last build. A rebuild is a clean followed by a build.

1. Select Project » Clean...
2. Enable the option Start a build immediately and click OK.

Build Automatically. This performs a build of all projects whenever any project file is saved, such as
your makefile.

This way of building is not recommended for C/C++ development, but to enable this feature select
Project » Build Automatically and ensure there is a check mark beside the Build Automatically
menu item. In order for this option to work, you must also enable option Build on resource save (Auto
build) on the Behaviour tab of the C/C++ Build page of the Project » Properties for dialog.

Select a target processor (core)

Processor options affect the invocation of all tools in the toolset. In Eclipse you only need to set them
once. Based on the target processor, the compiler includes a special function register file. This is a regular
include file which enables you to use virtual registers that are located in memory.

1.

3.

From the Project menu, select Properties for

The Properties dialog appears.

In the left pane, expand C/C++ Build and select Processor.
In the right pane the Processor page appears.

From the Processor selection list, select a processor.

To access the C/C++ compiler options

1.

From the Project menu, select Properties for

The Properties dialog appears.

In the left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.

On the Tool Settings tab, select C/C++ Compiler.
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4. Select the sub-entries and set the options in the various pages.

Note that the C/C++ compiler options are used to create an object file from a C or C++ file. The
options you enter in the Assembler page are not only used for hand-coded assembly files, but
also for intermediate assembly files.

You can find a detailed description of all C compiler options in Section 13.2, C Compiler Options.

Invocation syntax on the command line (Windows Command Prompt):

carm[ [option]... [file]... ...

4.3. How the Compiler Searches Include Files

When you use include files (with the #i ncl ude statement), you can specify their location in several ways.
The compiler searches the specified locations in the following order:

1. If the #i ncl ude statement contains an absolute pathname, the compiler looks for this file. If no path
or a relative path is specified, the compiler looks in the same directory as the source file. This is only
possible for include files that are enclosed in ™.

This first step is not done for include files enclosed in <>.

2. When the compiler did not find the include file, it looks in the directories that are specified in the C/C++
Compiler » Include Paths page in the C/C++ Build » Settings » Tool Settings tab of the Project
Properties dialog (equivalent to the -1 command line option). If the option Add CMSIS include paths
is enabled, this path is search first.

3. When the compiler did not find the include file (because it is not in the specified include directory or
because no directory is specified), it looks in the path(s) specified in the environment variable CARM NC.

4. When the compiler still did not find the include file, it finally tries the default include directory relative
to the installation directory (unless you specified option --no-stdinc).

Example
Suppose that the C source file t est . ¢ contains the following lines:

#i ncl ude <stdio. h>
#i ncl ude "nyinc. h"

You can call the compiler as follows:

carm -1l nmyinclude test.c
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First the compiler looks for the file st di 0. h in the directory nyi ncl ude relative to the current directory.
If it was not found, the compiler searches in the environment variable CARM NC and then in the default
i ncl ude directory.

The compiler now looks for the file nyi nc. h, in the directory where t est . c is located. If the file is not
there the compiler searches in the directory nyi ncl ude. If it was still not found, the compiler searches
in the environment variable CARM NC and then in the default i ncl ude directory.

4.4. Compiling for Debugging

Compiling your files is the first step to get your application ready to run on a target. However, during
development of your application you first may want to debug your application.

To create an object file that can be used for debugging, you must instruct the compiler to include symbolic
debug information in the source file.

To include symbolic debug information
1. From the Project menu, select Properties for
The Properties dialog appears.
2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.
3. On the Tool Settings tab, select C/C++ Compiler » Debugging.

4. Select Default in the Generate symbolic debug information box.

Debug and optimizations

Due to different compiler optimizations, it might be possible that certain debug information is optimized
away. Therefore, if you encounter strange behavior during debugging it might be necessary to reduce

the optimization level, so that the source code is still suitable for debugging. For more information on
optimization see Section 4.5, Compiler Optimizations.

Invocation syntax on the command line (Windows Command Prompt)
The invocation syntax on the command line is:

carm-g file.c

4.5. Compiler Optimizations

The compiler has a number of optimizations which you can enable or disable.

1. From the Project menu, select Properties for
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The Properties dialog appears.
2. Inthe left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.
3. On the Tool Settings tab, select C/C++ Compiler » Optimization.
4. Select an optimization level in the Optimization level box.

or:

In the Optimization level box select Custom optimization and enable the optimizations you want
on the Custom optimization page.

Optimization levels

The TASKING C compiler offers four optimization levels and a custom level, at each level a specific set
of optimizations is enabled.

» Level 0 - No optimization: No optimizations are performed. The compiler tries to achieve a 1-to-1
resemblance between source code and produced code. Expressions are evaluated in the order written
in the source code, associative and commutative properties are not used.

* Level 1 - Optimize: Enables optimizations that do not affect the debug-ability of the source code. Use
this level when you encounter problems during debugging your source code with optimization level 2.

* Level 2 - Optimize more (default): Enables more optimizations to reduce the memory footprint and/or
execution time. This is the default optimization level.

» Level 3 - Optimize most: This is the highest optimization level. Use this level when your
program/hardware has become too slow to meet your real-time requirements.

» Custom optimization: you can enable/disable specific optimizations on the Custom optimization page.
Optimization pragmas
If you specify a certain optimization, all code in the module is subject to that optimization. Within the C

source file you can overrule the C compiler options for optimizations with #pr agma opti m ze fl ag
and #pragnma endopti m ze. Nesting is allowed:

#pragma optim ze e /* Enabl e expression
sinplification */
C source ...
#pragma optim ze c /* Enabl e common expression
elim nation. Expression
C source ... sinplification still enabled */

#pragma endoptim ze /* Di sabl e cormon expressi on
elimnation */
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#pragnma endoptimze /* Disable expression
sinplification */
The compiler optimizes the code between the pragma pair as specified.

You can enable or disable the optimizations described in the following subsection. The command line
option for each optimization is given in brackets.

4.5.1. Generic Optimizations (frontend)

Common subexpression elimination (CSE) (option -Oc/-OC)

The compiler detects repeated use of the same (sub-)expression. Such a "common" expression is replaced
by a variable that is initialized with the value of the expression to avoid recomputation. This method is
called common subexpression elimination (CSE).

Expression simplification (option -Oe/-OE)

Multiplication by 0 or 1 and additions or subtractions of 0 are removed. Such useless expressions may
be introduced by macros or by the compiler itself (for example, array subscripting).

Constant propagation (option -Op/-OP)
A variable with a known value is replaced by that value.
Automatic function inlining (option -Oi/-Ol)

Small functions that are not too often called, are inlined. This reduces execution time at the cost of code
size.

Control flow simplification (option -Of/-OF)

A number of techniques to simplify the flow of the program by removing unnecessary code and reducing
the number of jumps. For example:

» Switch optimization: A number of optimizations of a switch statement are performed, such as removing
redundant case labels or even removing an entire switch.

» Jump chaining: A (conditional) jump to a label which is immediately followed by an unconditional jump
may be replaced by a jump to the destination label of the second jump. This optimization speeds up
execution.

» Conditional jump reversal: A conditional jump over an unconditional jump is transformed into one
conditional jump with the jump condition reversed. This reduces both the code size and the execution
time.

» Dead code elimination: Code that is never reached, is removed. The compiler generates a warning
messages because this may indicate a coding error.
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Subscript strength reduction (option -Os/-OS)

An array or pointer subscripted with a loop iterator variable (or a simple linear function of the iterator
variable), is replaced by the dereference of a pointer that is updated whenever the iterator is updated.

Loop transformations (option -Ol/-OL)

Transform a loop with the entry point at the bottom, to a loop with the entry point at the top. This enables
constant propagation in the initial loop test and code motion of loop invariant code by the CSE optimization.

Forward store (option -Oo/-00)

A temporary variable is used to cache multiple assignments (stores) to the same non-automatic variable.

MIL linking (Control program option --mil-link)

The frontend phase performs its optimizations on the MIL code. When all C modules and/or MIL modules
of an application are given to the C compiler in a single invocation, the C compiler will link MIL code of
the modules to a complete application automatically. Next, the frontend will run its optimizations again
with application scope. After this, the MIL code is passed on to the backend, which will generate a single
. sr ¢ file for the whole application. Linking with the run-time library, floating-point library and C library is
still necessary. Linking with the C library is required because this library contains some hand-coded
assembly functions, that are not linked in at MIL level.

In the ISO C99 standard a "translation unit" is a preprocessed source file together with all the headers
and source files included via the preprocessing directive #i ncl ude. After MIL linking the compiler will
treat the linked sources files as a single translation unit, allowing global optimizations to be performed,
that otherwise would be limited to a single module.

Cfile1 Cfile2 [ Cfile &
'!—\_,-F'"—'_'_'_ '!—\_,-F'"—'_'_'_

=== _*._._ ..... _..*._ ............. *._._._.
il C compiler (FE) i C compiler (FE)
]

! MIL file 1 MIL file 2

linker
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MIL splitting (option --mil-split)

When you specify that the C compiler has to use MIL splitting, the C compiler will first link the application
at MIL level as described above. However, after rerunning the optimizations the MIL code is not passed
on to the backend. Instead the frontend writes a . ns file for each input module. A . ns file has the same
formatasa. nm | file. Only . ns files that really change are updated. The advantage of this approach is

that it is possible to use the make utility to translate only those parts of the application to a . sr c file that
really have changed. MIL splitting is therefore a more efficient build process than MIL linking. The penalty
for this is that the code compaction optimization in the backend does not have application scope. As with
MIL linking, it is still required to link with the normal libraries to build an ELF file.

MIL file 1

MIL split
file 1

MIL split
file 2

MIL split
file &

asm
source 1

asm
source 2

ssembler ssembler ssembler

ohject I
lihs

To read more about how MIL linking influences the build process of your application, see Section 4.6,
Influencing the Build Time.

4.5.2. Core Specific Optimizations (backend)

Coalescer (option -Oa/-OA)

The coalescer seeks for possibilities to reduce the number of moves (MOV instruction) by smart use of
registers. This optimizes both speed and code size.

Interprocedural register optimization (option -Ob/-OB)

Register allocation is improved by taking note of register usage in functions called by a given function.
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Peephole optimizations (option -Oy/-QY)

The generated assembly code is improved by replacing instruction sequences by equivalent but faster
and/or shorter sequences, or by deleting unnecessary instructions.

Instruction Scheduler (option -Ok/-OK)

The instruction scheduler is a backend optimization that acts upon the generated instructions. When two
instructions need the same machine resource - like a bus, register or functional unit - at the same time,

they suffer a structural hazard, which stalls the pipeline. This optimization tries to rearrange instructions
to avoid structural hazards, for example by inserting another non-related instruction.

First the instruction stream is partitioned into basic blocks. A new basic block starts at a label, or right
after a jump instruction. Unschedulable instructions and, when -Av is enabled, instructions that access
volatile objects, each get their own basic block. Next, the scheduler searches the instructions within a
basic block, looking for places where the pipeline stalls. After identifying these places it tries to rebuild
the basic block using the existing instructions, while avoiding the pipeline stalls. In this process data
dependencies between instructions are honoured.

Note that the function inlining optimization happens in the frontend of the compiler. The instruction
scheduler has no knowledge about the origin of the instructions.

Unroll small loops (option -Ou/-OU)
To reduce the number of branches, short loops are eliminated by replacing them with a number of copies.
Software pipelining (option -Ow/-OW)

A number of techniques to optimize loops. For example, within a loop the most efficient order of instructions
is chosen by the pipeline scheduler and it is examined what instructions can be executed parallel.

Code compaction (reverse inlining) (option -Or/-OR)

Compaction is the opposite of inlining functions: chunks of code that occur more than once, are transformed
into a function. This reduces code size at the cost of execution speed. The size of the chunks of code to
be inlined depends on the setting of the C compiler option --tradeoff (-t). See the subsection Code
Compaction in Section 4.5.3, Optimize for Size or Speed.

Generic assembly optimizations (option -Og/-OG)

A set of target independent optimizations that increase speed and decrease code size.

Cluster global variables (option -O+cluster/-O-cluster)

Global variables are accessed by first loading their address into a register and then accessing them via
this register. Each address will result in an entry in the constant pool. By clustering global variables it is

possible to access multiple variables using the same base register, which means we can lower the amount

of entries in the constant pool. It also means that potentially we need less base registers. Clustering
ensures that the linker locates the global variables together.

156



Using the C Compiler

4.5.3. Optimize for Size or Speed

You can tell the compiler to focus on execution speed or code size during optimizations. You can do this
by specifying a size/speed trade-off level from O (speed) to 4 (size). This trade-off does not turn optimization
phases on or off. Instead, its level is a weight factor that is used in the different optimization phases to
influence the heuristics. The higher the level, the more the compiler focusses on code size optimization.
To choose a trade-off value read the description below about which optimizations are affected and the
impact of the different trade-off values.

Note that the trade-off settings are directions and there is no guarantee that these are followed. The
compiler may decide to generate different code if it assessed that this would improve the result.

Optimization hint: Optimizing for size has a speed penalty and vice versa. The advice is to
optimize for size by default and only optimize those areas for speed that are critical for the
application with respect to speed. Using the tradeoff options -t0, -t1 and -t2 globally for the
application is not recommended.

To specify the size/speed trade-off optimization level:
1. From the Project menu, select Properties for
The Properties dialog appears.
2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.
3. On the Tool Settings tab, select C/C++ Compiler » Optimization.
4. Select a trade-off level in the Trade-off between speed and size box.
See also C compiler option --tradeoff (-t)
Instruction Selection
Trade-off levels 0, 1 and 2: the compiler selects the instructions with the smallest number of cycles.

Trade-off levels 3 and 4: the compiler selects the instructions with the smallest number of bytes.
Switch Jump Chain versus Jump Table
Instruction selection for the swi t ch statements follows different trade-off rules. A switch statement can

result in a jump chain or a jump table. The compiler makes the decision between those by measuring
and weighing bytes and cycles. This weigh is controlled with the trade-off values:

Trade-off value Time Size
0 100% 0%

1 75% 25%
2 50% 50%
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Trade-off value Time Size
3 25% 75%
4 0% 100%

Loop Optimization

For a top-loop, the loop is entered at the top of the loop. A bottom-loop is entered at the bottom. Every
loop has a test and a jump at the bottom of the loop, otherwise it is not possible to create a loop. Some
top-loops also have a conditional jump before the loop. This is only necessary when the number of loop
iterations is unknown. The number of iterations might be zero, in this case the conditional jump jumps

over the loop.

Bottom loops always have an unconditional jump to the loop test at the bottom of the loop.

Trade-off value Try to rewrite top-loops to [Optimize loops for
bottom-loops size/speed
0 no speed
1 yes speed
2 yes speed
3 yes size
4 yes size
Example:
int a;
voidi(int I, int m)
{
int i;
for (i =m i <|1; i++)
{
a++;
}
return;
}
Coded as a bottom loop (compiled with --tradeoff=4) is:
| dr r2,.L4
b . L2 ;; unconditional junp to |oop test at
. L3:
| dr r3,[r2, #0]
add ril,ri, #1
add r3,r3, #1
str r3,[r2, #0]
.L2: ;; loop entry point
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cnp ri, r0
bl t . L3

Coded as a top loop (compiled with --tradeoff=0) is:

cnmp ri,r0 ;; test for at least one loop iteration
| dr r2,.L4 ;; can be om tted when nunber of iterations is known
| dr r3,[r2, #0]
bge . L2
sub ro,ro,rl
. L3: ;; loop entry point

subs r0,r0, #1
add ro, ro, #1
bgt . L3

.L2:
str r3,[r2, #0]

Automatic Function Inlining

You can enable automatic function inlining with the option --optimize=+inline (-Oi) or by using #pr agna
optim ze +inline.This option is also part of the -O3 predefined option set.

When automatic inlining is enabled, you can use the options --inline-max-incr and --inline-max-size (or
their corresponding pragmas i nl i ne_max_i ncr / inline_max_si ze) to control automatic inlining.
By default their values are set to -1. This means that the compiler will select a value depending upon the
selected trade-off level. The defaults are:

Trade-off value inline-max-incr inline-max-size
0 100 50

1 50 25

2 20 20

3 10 10

4 0 0

For example with trade-off value 1, the compiler inlines all functions that are smaller or equal to 25 internal
compiler units. After that the compiler tries to inline even more functions as long as the function will not
grow more than 50%.

When these options/pragmas are set to a value >= 0, the specified value is used instead of the values
from the table above.

Static functions that are called only once, are always inlined, independent of the values chosen for
inline-max-incr and inline-max-size.

Code Compaction

Trade-off levels 0 and 1: code compaction is disabled.

Trade-off level 2: only code compaction of matches outside loops.
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Trade-off level 3: code compaction of matches outside loops, and matches inside loops of patterns that
have an estimate execution frequency lower or equal to 10.

Trade-off level 4: code compaction of matches outside loops, and matches inside loops of patterns that
have an estimate execution frequency lower or equal to 100.

For loops where the iteration count is unknown an iteration count of 10 is assumed.
For the execution frequency the compiler also accounts nested loops.

See C compiler option --compact-max-size

Cluster global variables

Clustering of global variables is only done for trade-off level 4.

4.6. Influencing the Build Time

In general many settings have influence on the build time of a project. Any change in the tool settings of
your project source will have more or less impact on the build time. The following sections describe several
issues that can have significant influence on the build time.

MIL Linking

With MIL linking it is possible to let the compiler apply optimizations application wide. This can yield
significant optimization improvements, but the build times can also be significantly longer. MIL linking
itself can require significant time, but also the changed build process implies longer build times. The MIL
linking settings in Eclipse are:

» Build for application wide optimizations (MIL linking)

This enables MIL linking. The build process changes: the C files are translated to intermediate code
(MIL files) and the generated MIL files of the whole project are linked together by the C compiler. The
next step depends on the setting of the option below.

» Application wide optimization mode: Optimize more/Build slower

When this option is enabled, the compiler runs the code generator immediately on the completely linked
MIL stream, which represents the entire application. This way the code generator can perform several
optimizations, such as "code compaction”, at application scope. But this also requires significantly more
memory and requires more time to generate code. Besides that, it is no longer possible to do incremental
builds. With each build the full MIL linking phase and code generation has to be done, even with the
smallest change that would in a normal build (not MIL linking) require only a single module to be
translated.

» Application wide optimization mode: Optimize less/Build faster

When this option is disabled, the compiler splits the MIL stream after MIL linking in separate modules.
This allows the code generation to be performed for the modified modules only, and will therefore be
faster than with the other option enabled. Although the MIL stream is split in separate modules after
MIL linking, it still may happen that modifying a single C source file results in multiple MIL files to be
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compiled. This is a natural result of global optimizations, where the code generated for multiple modules
was affected by the change.

In general, if you do not need code compaction, for example because you are optimizing fully for speed,
it is recommended to choose Optimize less/Build faster.

Optimization Options

In general any optimization may require more work to be done by the compiler. But this does not mean
that disabling all optimizations (level 0) gives the fastest compilation time. Disabling optimizations may
resultin more code being generated, resulting in more work for other parts of the compiler, like for example
the register allocator.

Automatic Inlining

Automatic inlining is an optimization which can result in significant longer build time. The overall functions
will get bigger, often making it possible to do more optimizations. But also often resulting in more registers
to be in use in a function, giving the register allocation a tougher job.

Code Compaction

When you disable the code compaction optimization, the build times may be shorter. Certainly when MIL
linking is used where the full application is passed as a single MIL stream to the code generation. Code
compaction is however an optimization which can make a huge difference when optimizing for code size.
When size matters it makes no sense to disable this option. When you choose to optimize for speed
(--tradeoff=0) the code compaction is automatically disabled.

Compiler Cache

The C compiler has support for caching intermediate results to avoid full compilations. When the source
code after preprocessing and relevant compiler options and the compiler version are the same as in a
previous invocation, the previous result is copied to the output file. The cache only works when there is
a single C input file and a single output file (no --mil-split).

To enable caching from Eclipse:
1. From the Project menu, select Properties for
The Properties dialog appears.
2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.
3. On the Tool Settings tab, select C/C++ Compiler » Optimization » Compilation Speed.
4. Enable the option Cache generated code to improve the compilation speed.
5. Inthe Directory for cached files field, enter the name for the location of the cache.

By default this is the .cache directory under your project directory.
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6. Specify the Maximum days files will live in the cache.
7. (Optional) Enable the option Clear cache upon project clean.
Each time you use Project » Clean... the cache is cleared.

Eclipse calls the C compiler with option --cache. The cache directory may be shared, for instance by
placing it on a network drive. The compiler creates a directory car ntache in the specified directory.

When a result from the cache is used, the C compiler generates a comment line in the assembly source
file to notify that. In that case be aware of the following:

 In case source merging is enabled an older version of the source is still shown. As long as a source
change has no effect on the preprocessed code, the cached version of the output file is used.

» Some options, like --define, --include-directory and --output are not part of the hash used for the
cache. As long as a change in these options has no influence on the preprocessed code, the cached
version of the output is used. This means that the options listed as comments in the generated assembly
file might not match the options actually used.

With every compilation of a file that results in a cache miss, a new file is stored in the cache. Old files are
not removed from the cache automatically because that would slow down the compiler too much. To keep
the cache size reasonable specify a maximum number of days the files will live in the cache. Eclipse use
the utility expirearm for this. It is recommended to run this utility frequently, for example with each time
the project is linked. For more information on this utility see Section 10.6, Expire Cache Utility.

Header Files

Many applications include all header files in each module, often by including them all within a single
include file. Processing header files takes time. It is a good programming practice to only include the
header files that are really required in a module, because:

* itis clear what interfaces are used by a module
» an incremental build after modifying a header file results in less modules required to be rebuild

* it reduces compile time

Parallel Build

The make utility amk, which is used by Eclipse, has a feature to build jobs in parallel. This means that
multiple modules can be compiled in parallel. With today's multi-core processors this means that each
core can be fully utilized. In practice even on single core machines the compile time decreases when
using parallel jobs. On multi-core machines the build time even improves further when specifying more
parallel jobs than the number of cores.

In Eclipse you can control the parallel build behavior:
1. From the Project menu, select Properties for

The Properties dialog appears.
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2. Inthe left pane, select C/C++ Build.
In the right pane the C/C++ Build page appears.
3. Onthe Behaviour tab, select Use parallel build.

4. You can specify the number of parallel jobs, or you can use an optimal number of jobs. In the last
case, amk will fork as many jobs in parallel as cores are available.

Number of Sections

The linker speed depends on the number of sections in the object files. The more sections, the longer
the locating will take. You can decrease the link time by creating output sections in the LSL file. For
example:

Use compiler option --rename-sections=.text={name}

section_layout ::linear

{
group (ordered)

{

section "code_outputl" ( size = 64k, attributes = x, fill=0xFF,
overflow = "code_out put2")
{
sel ect "*__cocofun*";
}

}
}

4.7. Static Code Analysis

Static code analysis (SCA) is a relatively new feature in compilers. Various approaches and algorithms
exist to perform SCA, each having specific pros and cons.

SCA Implementation Design Philosophy
SCA is implemented in the TASKING compiler based on the following design criteria:

* An SCA phase does not take up an excessive amount of execution time. Therefore, the SCA can be
performed during a normal edit-compile-debug cycle.

» SCA is implemented in the compiler front-end. Therefore, no new makefiles or work procedures have
to be developed to perform SCA.

» The number of emitted false positives is kept to a minimum. A false positive is a message that indicates
that a correct code fragment contains a violation of a rule/recommendation. A number of warnings is
issued in two variants, one variant when it is guaranteed that the rule is violated when the code is
executed, and the other variant when the rules is potentially violated, as indicated by a preceding
warning message.
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For example see the following code fragment:

extern int some_condition(int);
voi d f(void)
{

char buf[10];

int i;

for (i =0; i <= 10; i++)
{

if (some_condition(i))

buf[i] = 0; /* subscript may be out of bounds */

}

As you can see in this example, if i =10 the array buf [ ] might be accessed beyond its upper boundary,
depending on the result of sone_condi ti on(i).If the compiler cannot determine the result of this
function at run-time, the compiler issues the warning "subscript is possibly out of bounds" preceding
the CERT warning "ARR35: do not allow loops to iterate beyond the end of an array”. If the compiler
can determine the result, or ifthe i f statement is omitted, the compiler can guarantee that the "subscript
is out of bounds".

» The SCA implementation has real practical value in embedded system development. There are no real
objective criteria to measure this claim. Therefore, the TASKING compilers support well known standards
for safety critical software development such as the MISRA guidelines for creating software for safety
critical automotive systems and secure "CERT C Secure Coding Standard" released by CERT. CERT
is founded by the US government and studies internet and networked systems security vulnerabilities,
and develops information to improve security.

Effect of optimization level on SCA results

The SCA implementation in the TASKING compilers has the following limitations:

» Some violations of rules will only be detected when a particular optimization is enabled, because they
rely on the analysis done for that optimization, or on the transformations performed by that optimization.
In particular, the constant propagation and the CSE/PRE optimizations are required for some checks.
It is preferred that you enable these optimizations. These optimizations are enabled with the default
setting of the optimization level (-O2).

» Some checks require cross-module inspections and violations will only be detected when multiple
source files are compiled and linked together by the compiler in a single invocation.

4.7.1. C Code Checking: CERT C

The CERT C Secure Coding Standard provides rules and recommendations for secure coding in the C
programming language. The goal of these rules and recommendations is to eliminate insecure coding
practices and undefined behaviors that can lead to exploitable vulnerabilities. The application of the secure
coding standard will lead to higher-quality systems that are robust and more resistant to attack.
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For details about the standard, see the CERT C Secure Coding Standard web site. For general information
about CERT secure coding, see www.cert.org/secure-coding.

Versions of the CERT C standard

Version 1.0 of the CERT C Secure Coding Standard is available as a book by Robert C. Seacord
[Addison-Wesley]. Whereas the web site is a wiki and reflects the latest information, the book serves as
a fixed point of reference for the development of compliant applications and source code analysis tools.

The rules and recommendations supported by the TASKING compiler reflect the version of the CERT
web site as of June 1 2009.

The following rules/recommendations implemented by the TASKING compiler, are not part of the book:
PRE11-C, FLP35-C, FLP36-C, MSC32-C

For a complete overview of the supported CERT C recommendations/rules by the TASKING compiler,
see Chapter 20, CERT C Secure Coding Standard.

Priority and Levels of CERT C

Each CERT C rule and recommendation has an assigned priority. Three values are assigned for each
rule on a scale of 1 to 3 for

* severity - how serious are the consequences of the rule being ignored
1. low (denial-of-service attack, abnormal termination)
2. medium (data integrity violation, unintentional information disclosure)
3. high (run arbitrary code)

« likelihood - how likely is it that a flaw introduced by ignoring the rule could lead to an exploitable
vulnerability

1. unlikely
2. probable
3. likely
» remediation cost - how expensive is it to comply with the rule
1. high (manual detection and correction)
2. medium (automatic detection and manual correction)
3. low (automatic detection and correction)

The three values are then multiplied together for each rule. This product provides a measure that can be
used in prioritizing the application of the rules. These products range from 1 to 27. Rules and
recommendations with a priority in the range of 1-4 are level 3 rules (low severity, unlikely, expensive to
repair flaws), 6-9 are level 2 (medium severity, probable, medium cost to repair flaws), and 12-27 are
level 1 (high severity, likely, inexpensive to repair flaws).
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The TASKING compiler checks most of the level 1 and some of the level 2 CERT C recommendations/rules.

For a complete overview of the supported CERT C recommendations/rules by the TASKING compiler,
see Chapter 20, CERT C Secure Coding Standard.

To apply CERT C code checking to your application
1. From the Project menu, select Properties for
The Properties dialog appears.
2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.
3. On the Tool Settings tab, select C/C++ Compiler » CERT C Secure Coding.
4. Make a selection from the CERT C secure code checking list.

5. If you selected Custom, expand the Custom CERT C entry and enable one or more individual
recommendations/rules.

On the command line you can use the option --cert.
carm--cert={all | nane [-nane],...]

With --diag=cert you can see a list of the available checks, or you can use a three-letter mnemonic to
list only the checks in a particular category. For example, --diag=pre lists all supported checks in the
preprocessor category.

4.7.2. C Code Checking: MISRA-C

The C programming language is a standard for high level language programming in embedded systems,
yet it is considered somewhat unsuitable for programming safety-related applications. Through enhanced
code checking and strict enforcement of best practice programming rules, TASKING MISRA-C code
checking helps you to produce more robust code.

MISRA-C specifies a subset of the C programming language which is intended to be suitable for embedded
automotive systems. It consists of a set of rules, defined in MISRA-C:2004, Guidelines for the Use of the
C Language in Critical Systems (Motor Industry Research Association (MIRA), 2004).

The compiler also supports MISRA-C:1998, the first version of MISRA-C. You can select this version with
the following C compiler option:

--m srac-versi on=1998

For a complete overview of all MISRA-C rules, see Chapter 21, MISRA-C Rules.
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Implementation issues

The MISRA-C implementation in the compiler supports nearly all rules. Only a few rules are not supported
because they address documentation, run-time behavior, or other issues that cannot be checked by static
source code inspection, or because they require an application-wide overview.

During compilation of the code, violations of the enabled MISRA-C rules are indicated with error messages
and the build process is halted.

MISRA-C rules are divided in required rules and advisory rules. If rules are violated, errors are generated
causing the compiler to stop. With the following options warnings, instead of errors, are generated for
either or both the required rules and the advisory rules:

--m srac-required-warni ngs

--m srac-advi sory-warni ngs

Note that not all MISRA-C violations will be reported when other errors are detected in the input
source. For instance, when there is a syntax error, all semantic checks will be skipped, including
some of the MISRA-C checks. Also note that some checks cannot be performed when the
optimizations are switched off.

Quality Assurance report

To ensure compliance to the MISRA-C rules throughout the entire project, the TASKING linker can
generate a MISRA-C Quality Assurance report. This report lists the various modules in the project with
the respective MISRA-C settings at the time of compilation. You can use this in your company's quality
assurance system to provide proof that company rules for best practice programming have been applied
in the particular project.

To apply MISRA-C code checking to your application
1. From the Project menu, select Properties for
The Properties dialog appears.
2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.
3. On the Tool Settings tab, select C/C++ Compiler » MISRA-C.
4. Select the MISRA-C version (2004 or 1998).

5. Inthe MISRA-C checking box select a MISRA-C configuration. Select a predefined configuration
for conformance with the required rules in the MISRA-C guidelines.

6. (Optional) In the Custom 2004 or Custom 1998 entry, specify the individual rules.
On the command line you can use the option --misrac.

carm--msrac={all | nunber [-nunber],...]
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4.8. C Compiler Error Messages

The C compiler reports the following types of error messages in the Problems view of Eclipse.

F ( Fatal errors)

After a fatal error the compiler immediately aborts compilation.

E (Errors)

Errors are reported, but the compiler continues compilation. No output files are produced unless you have
set the C compiler option --keep-output-files (the resulting output file may be incomplete).

W (Warnings)

Warning messages do not result into an erroneous assembly output file. They are meant to draw your
attention to assumptions of the compiler for a situation which may not be correct. You can control warnings
in the C/C++ Build » Settings » Tool Settings » C/C++ Compiler » Diagnostics page of the Project
» Properties for menu (C compiler option --no-warnings).

| (Information)

Information messages are always preceded by an error message. Information messages give extra
information about the error.

S (System errors)

System errors occur when internal consistency checks fail and should never occur. When you still receive
the system error message

SO##: internal consistency check failed - please report

please report the error number and as many details as possible about the context in which the error
occurred.

Display detailed information on diagnostics

1. From the Window menu, select Show View » Other » TASKING » Problems.
The Problems view is added to the current perspective.

2. Inthe Problems view right-click on a message.
A popup menu appears.

3. Select Detailed Diagnostics Info.

A dialog box appears with additional information.

168



Using the C Compiler

On the command line you can use the C compiler option --diag to see an explanation of a diagnostic
message:

carm--diag=[format:]{all | nunber,...]
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Chapter 5. Using the C++ Compiler

This chapter describes the compilation process and explains how to call the C++ compiler. You should
be familiar with the C++ language and with the ISO C language.

The C++ compiler can be seen as a preprocessor or front end which accepts C++ source files or sources
using C++ language features. The output generated by the C++ compiler (cparm) is intermediate C,
which can be translated with the C compiler (carm).

The C++ compiler is part of a complete toolset, the TASKING VX-toolset for ARM. For details about the
C compiler see Chapter 4, Using the C Compiler.

The C++ compiler takes the following files for input and output:

CHsource file
.CC
1

CH+ campiler

I
intermediate Cfile
Jic

Although in Eclipse you cannot run the C++ compiler separately from the other tools, this section discusses
the options that you can specify for the C++ compiler.

On the command line it is possible to call the C++ compiler separately from the other tools. However, it
is recommended to use the control program for command line invocations of the toolset (see Section 10.1,
Control Program). With the control program it is possible to call the entire toolset with only one command
line. Eclipse also uses the control program to call the C++ compiler. Files with the extensions . cc, . cpp
or . cxx are seen as C++ source files and passed to the C++ compiler.

The C++ compiler accepts the C++ language of the ISO/IEC 14882:2003 C++ standard, with some minor
exceptions documented in Chapter 2, C++ Language. It also accepts embedded C++ language extensions.

The C++ compiler does no optimization. Its goal is to produce quickly a complete and clean parsed form
of the source program, and to diagnose errors. It does complete error checking, produces clear error
messages (including the position of the error within the source line), and avoids cascading of errors. It
also tries to avoid seeming overly finicky to a knowledgeable C or C++ programmer.

5.1. Calling the C++ Compiler
Under Eclipse you cannot run the C++ compiler separately. However, you can set options specific for the
C++ compiler. After you have built your project, the output files are available in a subdirectory of your

project directory, depending on the active configuration you have set in the C/C++ Build » Settings page
of the Project » Properties for dialog.

Building a project under Eclipse

You have several ways of building your project:
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Build Selected File(s) (). This compiles and assembles the selected file(s) without calling the linker.
1. In the C/C++ Projects view, select the files you want to compile.

2. Right-click in the C/C++ Projects view and select Build Selected File(s).

Build Individual Project (1),

To build individual projects incrementally, select Project » Build project.

Rebuild Project (“). This builds every file in the project whether or not a file has been modified since
the last build. A rebuild is a clean followed by a build.

1. Select Project » Clean...
2. Enable the option Start a build immediately and click OK.

Build Automatically. This performs a build of all projects whenever any project file is saved, such as
your makefile.

This way of building is not recommended for C/C++ development, but to enable this feature select
Project » Build Automatically and ensure there is a check mark beside the Build Automatically
menu item. In order for this option to work, you must also enable option Build on resource save (Auto
build) on the Behaviour tab of the C/C++ Build page of the Project » Properties for dialog.

Select a target processor (core)

Processor options affect the invocation of all tools in the toolset. In Eclipse you only need to set them
once. Based on the target processor, the compiler includes a special function register file. This is a regular
include file which enables you to use virtual registers that are located in memory.

1.

3.

From the Project menu, select Properties for

The Properties dialog appears.

In the left pane, expand C/C++ Build and select Processor.
In the right pane the Processor page appears.

From the Processor selection list, select a processor.

To access the C/C++ compiler options

1.

3.

From the Project menu, select Properties for

The Properties dialog appears.

In the left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.

On the Tool Settings tab, select C/C++ Compiler.
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4. Select the sub-entries and set the options in the various pages.

Note that C++ compiler options are only enabled if you have added a C++ file to your project, a
file with the extension . cc, . cpp or. cxX.

Note that the options you enter in the Assembler page are also used for intermediate assembly
files.

You can find a detailed description of all C++ compiler options in Section 13.3, C++ Compiler Options.

Invocation syntax on the command line (Windows Command Prompt):

cparm|[ [option]... [file]... ]...

5.2. How the C++ Compiler Searches Include Files

When you use include files (with the #i ncl ude statement), you can specify their location in several ways.
The C++ compiler searches the specified locations in the following order:

1. If the #i ncl ude statement contains an absolute pathname, the C++ compiler looks for this file. If no
path or a relative path is specified, the C++ compiler looks in the same directory as the source file.
This is only possible for include files that are enclosed in .

This first step is not done for include files enclosed in <>.

2. When the C++ compiler did not find the include file, it looks in the directories that are specified in the
C/C++ Compiler » Include Paths page in the C/C++ Build » Settings » Tool Settings tab of the
Project Properties dialog (equivalent to the --include-directory (-I) command line option).

3. When the C++ compiler did not find the include file (because it is not in the specified include directory
or because no directory is specified), it looks in the path(s) specified in the environment variable
CPARM NC.

4. When the C++ compiler still did not find the include file, it finally tries the default i ncl ude. cpp and
i ncl ude directory relative to the installation directory.

5. If the include file is still not found, the directories specified in the --sys-include option are searched.

If the include directory is specified as -, e.g., -I-, the option indicates the point in the list of - or
--include-directory options at which the search for file names enclosed in <. . . > should begin. That is,
the search for <. . . > names should only consider directories named in -l or --include-directory options
following the -1-, and the directories of items 3 and 4 above. -I- also removes the directory containing the
current input file (item 1 above) from the search path for file names enclosed in". .. ".

An include directory specified with the --sys-include option is considered a "system" include directory.
Warnings are suppressed when processing files found in system include directories.
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If the filename has no suffix it will be searched for by appending each of a set of include file suffixes.
When searching in a given directory all of the suffixes are tried in that directory before moving on to the
next search directory. The default set of suffixes is, no extension and . st dh. The default can be overridden
using the --incl-suffixes command line option. A null file suffix cannot be used unless it is present in the
suffix list (that is, the C++ compiler will always attempt to add a suffix from the suffix list when the filename
has no suffix).

Example

Suppose that the C++ source file t est . cc contains the following lines:

#i ncl ude <stdio. h>
#i ncl ude "nyinc. h"

You can call the C++ compiler as follows:
cparm -1 nyinclude test.cc

First the C++ compiler looks for the file st di 0. h in the directory myi ncl ude relative to the current
directory. If it was not found, the C++ compiler searches in the environment variable CPARM NC and then
in the default i ncl ude directory.

The C++ compiler now looks for the file myi nc. h, in the directory where t est . cc is located. If the file
is not there the C++ compiler searches in the directory nyi ncl ude. If it was still not found, the C++

compiler searches in the environment variable CPARM NC and then in the defaulti ncl ude. cpp and
i ncl ude directories.

5.3. C++ Compiler Error Messages

The C++ compiler reports the following types of error messages in the Problems view of Eclipse.

F ( Fatal errors)
Catastrophic errors, also called 'fatal errors', indicate problems of such severity that the compilation cannot

continue. For example: command-line errors, internal errors, and missing include files. If multiple source
files are being compiled, any source files after the current one will not be compiled.

E (Errors)

Errors indicate violations of the syntax or semantic rules of the C++ language. Compilation continues,
but object code is not generated.

W (Warnings)
Warnings indicate something valid but questionable. Compilation continues and object code is generated
(if no errors are detected). You can control warnings in the C/C++ Build » Settings » Tool Settings »

C/C++ Compiler » Diagnostics page of the Project » Properties for menu (C++ compiler option
--no-warnings).
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R (Remarks)

Remarks indicate something that is valid and probably intended, but which a careful programmer may
want to check. These diagnostics are not issued by default. Compilation continues and object code is
generated (if no errors are detected). To enable remarks, enable the option Issue remarks on C++ code
in the C/C++ Build » Settings » Tool Settings » C/C++ Compiler » Diagnostics page of the Project
» Properties for menu (C++ compiler option --remarks).

S (Internal errors)

Internal compiler errors are caused by failed internal consistency checks and should never occur. However,
if such a 'SYSTEM' error appears, please report the occurrence to Altium. Please include a small C++
program causing the error.

Message format

By default, diagnostics are written in a form like the following:

cparm E0020: ["test.cc" 3] identifier "nanme" is undefined

With the command line option --error-file=file you can redirect messages to a file instead of st derr .

Note that the message identifies the file and line involved. Long messages are wrapped to additional lines
when necessary.

With the option C/C++ Build » Settings » Tool Settings » Global Options » Treat warnings as errors
(option --warnings-as-errors) you can change the severity of warning messages to errors.

With the command line option --diag you can see a list of all messages.
For some messages, a list of entities is useful; they are listed following the initial error message:

cparm E0308: ["test.cc" 4] nore than one instance of overl oaded
function "f" matches the argunent |ist:
function "f(int)"
function "f(float)"
argunment types are: (double)

In some cases, some additional context information is provided; specifically, such context information is
useful when the C++ compiler issues a diagnostic while doing a template instantiation or while generating
a constructor, destructor, or assignment operator function. For example:

cparm E0265: ["test.cc" 7] "A:A()" is inaccessible
detected during inplicit generation of "B::B()" at line 7

Without the context information, it is very hard to figure out what the error refers to.

Termination Messages

The C++ compiler writes sign-off messages to st der r (the Problems view in Eclipse) if errors are detected.
For example, one of the following forms of message
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n errors detected in the conpilation of "file".
1 catastrophic error detected in the conpilation of "file".

n errors and 1 catastrophic error detected in the conpilation of "file".

is written to indicate the detection of errors in the compilation. No message is written if no errors were
detected. The following message

Error limt reached.

is written when the count of errors reaches the error limit (see the option --error-limit); compilation is
then terminated. The message

Conpi | ation term nated.

is written at the end of a compilation that was prematurely terminated because of a catastrophic error.
The message

Conpi | ati on aborted

is written at the end of a compilation that was prematurely terminated because of an internal error. Such
an error indicates an internal problem in the compiler. If such an internal error appears, please report the
occurrence to Altium. Please include a small C++ program causing the error.
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Chapter 6. Profiling

Profiling is the process of collecting statistical data about a running application. With these data you can
analyze which functions are called, how often they are called and what their execution time is. This chapter
describes the TASKING profiling method with code instrumentation techniques and static profiling.

6.1. What is Profiling?

Profiling is a collection of methods to gather data about your application which helps you to identify code
fragments where execution consumes the greatest amount of time.

TASKING supplies a number of profiler tools each dedicated to solve a particular type of performance
tuning problem. Performance problems can be solved by:

« Identifying time-consuming algorithms and rewrite the code using a more time-efficient algorithm.

« Identifying time-consuming functions and select the appropriate compiler optimizations for these functions
(for example, enable loop unrolling or function inlining).

« Identifying time consuming loops and add the appropriate pragmas to enable the compiler to further
optimize these loops.

A profiler helps you to find and identify the time consuming constructs and provides you this way with
valuable information to optimize your application.

TASKING employs various schemes for collecting profiling data, depending on the capabilities of the
target system and different information needs.

6.1.1. Methods of Profiling

There are several methods of profiling: recording by an instruction set simulator, profiling with code
instrumentation techniques (dynamic profiling) and profiling by the C compiler at compile time (static
profiling). Each method has its advantages and disadvantages.

Profiling by an instruction set simulator

One way to gather profiling information is built into the instruction set simulator (ISS). The ISS records
the time consumed by each instruction that is executed. The debugger then retrieves this information and
correlates the time spent for individual instructions to C source statements.

Advantages
« it gives (cycle) accurate information with extreme fine granularity
« the executed code is identical to the non-profiled code

Disadvantages

» the method requires an ISS as execution environment
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Profiling using code instrumentation techniques (Dynamic Profiling)

The TASKING C compiler has an option to add code to your application which takes care of the profiling
process. This is called code instrumentation. The gathered profiling data is first stored in the target's
memory and will be written to a file when the application finishes execution or when the function
__prof_cl eanup() is called.

Advantages

* it can give a complete call graph of the application annotated with the time spent in each function and
basic block

« this profiling method is execution environment independent
« the application is profiled while it executes on its aimed target taking real-life input

Disadvantage

* instrumentation code creates a significant run-time overhead, and instrumentation code and gathered
data take up target memory

This method provides a valuable complement to the other two methods and is described into more detail
below.

Profiling estimation by the C compiler (Static Profiling)

The TASKING C compiler has an option to generate static profile information through various heuristics
and estimates. The profiling data produced this way at compile time is stored in an XML file, which can
be processed and displayed using the same tools used for dynamic (run-time) profiling.

Advantages

* it can give a give a quick estimation of the time spent in each function and basic block
« this profiling method is execution environment independent

« the application is profiled at compile time

* it requires no extra code instrumentation, so no extra run-time overhead
Disadvantage

* itis an estimation by the compiler and therefore less accurate than dynamic profiling

This method also is described into more detail below.

6.2. Profiling using Code Instrumentation (Dynamic Profiling)

Profiling can be used to determine which parts of a program take most of the execution time.

Once the collected data are presented, it may reveal which pieces of your code execute slower than
expected and which functions contribute most to the overall execution time of a program. It gives you

178



Profiling

also information about which functions are called more or less often than expected. This information not
only reveal design flaws or bugs that had otherwise been unnoticed, it also reveals parts of the program
which can be effectively optimized.

Important considerations

The dynamic profiling method adds code to your original application which is needed to gather the profiling
data. Therefore, the code size of your application increases. Furthermore, during the profiling process,
the gathered data is initially stored into dynamically allocated memory of the target. The heap of your
application should be large enough to store this data. Since code instrumentation is done by the compiler,
assembly functions used in your program do not show up in the profile.

The profiling information is collected during the actual execution of the program. Therefore, the input of
the program influences the results. If a part/function of the program is not activated while the program is
profiled, no profile data is generated for that part/function.

When you use dynamic profiling on a target board, function cl ock() must be added to the application
to get profiling timer results. You can add the file ¢l ock. ¢ from the example pr of i | i ng- st nB2f 1xx
project to your project as a starting point.

It is not possible to profile applications that are compiled with the optimization code compaction (C compiler
option --optimize=+compact). Therefore, when you turn profiling on, the compiler automatically disables
parts of the code compaction optimization.

Overview of steps to perform

To obtain a profile using code instrumentation, perform the following steps:
1. Compile and link your program with profiling enabled

2. Execute the program to generate the profile data

3. Display the profile

First you need a completed project. If you are not using your own project, use the pr of i | i ng example
as described below.

1. From the File menu, select Import...
The Import dialog appears.
2. Select TASKING C/C++ » TASKING ARM Example Projects and click Next.
3. Inthe Example projects box, disable all projects except profiling.
4. Click Finish.

The profi |l i ng project should now be visible in the C/C++ view.
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6.2

The

.1. Step 1: Build your Application for Profiling

first step is to add the code that takes care of the profiling, to your application. This is done with C

compiler options:

1.
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From the Project menu, select Properties for

The Properties for profiling dialog box appears.

In the left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

On the Tool Settings tab, expand the C/C++ Compiler entry and select Debugging.

Enable one or more of the following Generate profiling information options (the sample pr of i | i ng
project already has profiling options enabled).

» for block counters (not in combination with Call graph or Function timers)
 to build a call graph (not in combination with Block counters)
« for function counters
 for function timers (not in combination with Block counters/Function counters)
Note that the more detailed information you request, the larger the overhead in terms of

execution time, code size and heap space needed. The option Generate symbolic debug
information (--debug) does not affect profiling, execution time or code size.

Block counters (not in combination with Call graph or Function timers)

This will instrument the code to perform basic block counting. As the program runs, it will count how
many time it executed each branch of each if statement, each iteration of a for loop, and so on. Note
that though you can combine Block counters with Function counters, this has no effect because
Function counters is only a subset of Block counters.

Call graph (not in combination with Block counters)

This will instrument the code to reconstruct the run-time call graph. As the program runs it associates
the caller with the gathered profiling data.

Function counters

This will instrument the code to perform function call counting. This is a subset of the basic Block
counters.

Function timers (not in combination with Block counters/Function counters)

This will instrument the code to measure the time spent in a function. This includes the time spent
in all called functions (callees).
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For the command line, see the C compiler option --profile (-p).
Profiling is only possible with optimization levels 0, 1 and 2. So:

5. Open the Optimization page and set the Optimization level to 2 - Optimize more.
Click OK to apply the new option settings and rebuild the project (%1).
6.2.1.1. Profiling Modules and C Libraries

Profiling individual modules

It is possible to profile individual C modules. In this case only limited profiling data is gathered for the
functions in the modules compiled without the profiling option. When you use the suboption Call graph,
the profiling data reveals which profiled functions are called by non-profiled functions. The profiling data
does not show how often and from where the non-profiled functions themselves are called. Though this
does not affect the flat profile, it might reduce the usefulness of the call graph.

Profiling C library functions

Eclipse and/or the control program will link your program with the standard version of the C library.
Functions from this library which are used in your application, will not be profiled. If you do want to
incorporate the library functions in the profile, you must set the appropriate C compiler options in the C
library makefiles and rebuild the library.

6.2.1.2. Linking Profiling Libraries

When building your application, the application must be linked against the corresponding profile library.

Eclipse (or the control program) automatically select the correct library based on the profiling options you
specified. However, if you compile, assemble and link your application manually, make sure you specify

the correct library.

See Section 8.3, Linking with Libraries for an overview of the (profiling) libraries.

6.2.2. Step 2: Execute the Application

Once you have compiled and linked the application for profiling, it must be executed to generate the
profiling data. Run the program as usual: the program should run normally taking the same input as usual
and producing the same output as usual. The application will run somewhat slower than normal because
of the extra time spent on collecting the profiling data.

Follow the steps below to run the application on the TASKING simulator, using the debugger. (In fact,
you can run the application also on a target board.)

1. From the Debug menu, select Debug Configurations...

The Debug Configurations dialog appears.

2. select TASKING C/C++ Debugger and click the New launch configuration button (L) to add a
new configuration.
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3. Inthe Name field enter the name of the configuration. By default, this is the name of the project, but
you can give your configuration any name you want to distinguish it from the project name. For
example enter profi | i ng. si mul at or to identify the simulator debug configuration.

4. Onthe Target tab, select the ARM Simulator.
5. Click the Apply button.
6. Click the Debug button to start the debugger and launch the profiling application.

Eclipse will open the TASKING Debug perspective (as specified in the configuration) and asks for
confirmation.

7. Click Yes to open the TASKING Debug perspective.

The TASKING Debug perspective opens while the application has stopped before it enters main()

8 Inthe Debug view, click on the I® (Resume) button.
A file system simulation (FSS) view appears in which the application outputs the results.

When the program has finished, the collected profiling data is saved (for details see 'After execution'
below).

Startup code

The startup code initializes the profiling functions by calling the function __prof _i ni t () . Eclipse will
automatically make the required modifications to the startup code. Or, when you use the control program,
this extracts the correct startup code from the C library.

If you use your own startup code, you must manually insert a call to the function __pr of _i ni t just before
the call to mai n and its stack setup.

An application can have multiple entry points, such as mai n() and other functions that are called by
interrupt. This does not affect the profiling process.

Small heap problem

When the program does not run as usual, this is typically caused by a shortage of heap space. In this
case a message is issued (when running with file system simulation, it is displayed on the Debug console).
To solve this problem, increase the size of the heap. Information about the heap is stored in the linker
script file (.Isl) file which is automatically added when a project is created.

1. From the Project menu, select Properties for
The Properties dialog appears.

2. Inthe left pane, expand C/C++ Build and select Stack/Heap.
In the right pane the Stack/Heap property page appears.

3. Enter larger values for heap and click OK.
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The project LSL file is updated automatically according to the new settings.

Presumable incorrect call graph

The call graph is based on the compiled source code. Due to compiler optimizations the call graph may
therefor seem incorrect at first sight. For example, the compiler can replace a function call immediately
followed by a return instruction by a jump to the callee, thereby merging the callee function with the caller
function. In this case the time spent in the callee function is not recorded separately anymore, but added
to the time spent in the caller function (which, as said before, now holds the callee function). This represents
exactly the structure of your source in assembly but may differ from the structure in the initial C source.

After execution

When the program has finished (returning from mai n() ), the exit code calls the function

__prof_cl eanup(voi d) . This function writes the gathered profiling data to a file on the host system
using the debugger's file system simulation features. If your program does not return from nai n() , you
can force this by inserting a call to the function __pr of _cl eanup() in your application source code.
Please note the double underscores when calling from C code!

The resulting profiling data file is named anon. prf.
If your program does not run under control of the debugger and therefore cannot use the file
system simulation (FSS) functionality to write a file to the host system, you must implement a way
to pass the profiling data gathered on the target to the host. Adapt the function
__prof _cl eanup() in the profiling libraries or the underlying 1/O functions for this purpose.

6.2.3. Step 3: Displaying Profiling Results

After the function __pr of _cl eanup() has been executed, the result of the profiler can be displayed in
the TASKING Profiler perspective. The profiling data in the file anon. prf is then converted to an XML
file. This file is read and its information is displayed. To view the profiling information, open the TASKING
Profiler perspective:

1. From the Window menu, select Open Perspective » Other...
The Select Perspective dialog appears.
2. Select the TASKING Profiler perspective and click OK.

The TASKING Profiler perspective opens.
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W TASKING Profiler - profiling/profiling.c - TASKING ¥X-toolset for, ARM

File Edit Source Refactor Mawigate Search Project Debug Window Help
il A LA C i R =S R ‘ =R | Qe Taskmng pror.., || 7
B& cjc++ Projects 52 T Navigator = B/ [ profiing.c &2 =0
= he
T /% main routine calls both the critical and non critical path */
[= 1= profiling [ Active - Debug ] : : .
. void mainivoid)
%z, Binaries ‘
[rlH Includes printf( "Profiling examplein™ ):
(= Debug irdi .
@ rofiing.c non_ericicall| 3 j:
@p .g. criticall( 3 )
prafiing. s printf{ "Done\n" )
= profiling. simulator.Jaunch v
D readme. bxt =
2 Profiler &3 e~ =08
Module: #line | Function Tartal Time Self Time % in Function | Calls #Callers | #Callees
_START 0.000000 1
_lorofiing.c | FU N
J\profiling.c 58 non_criticall 1,200200 0,400000 1 1 1
profiing.c 65 nion_criticalz 1.200200 0.400000 1 1 1
CAprofiling.c 43 criticall 3.200300 0.800000 1 1 2
\profiling.c 51 critical2 1,200200 0,800000 1 1 1
CA\profiling.c 72 non_critical3  1.600400 0.800000 2 H 1
J\profiling.c 79 print_result 1,200500 1,200500 3 z
Qg Callers | Callees 232 H‘“”B ¥ =0
Module #line | Caller Total Time Self Time Contribution % | Calls Calls %
_aTART 4.400500 0.000300 100.00% 1 100.0...
Module: #line | Callee Tartal Time Self Time Contribution % | Calls Calls %
.\profiling.c 58 nion_criticall 1.200200 0.400000 27.27% 1 50.00%:
CAprofiling.c 43 criticall 3.200300 0.800000 72T 1 50.00%
me
The TASKING Profiler perspective
The TASKING Profiler perspective contains the following Views:
Profiler view Shows the profiling information of all functions in all C source modules belonging

to your application.

Callers / Callees The first table in this view, the callers table, shows the functions that called the
view focus function.

The second table in this view, the callees table, shows the functions that are called
by the focus function.

* Clicking on a function (or on its table row) makes it the focus function.

» Double-clicking on a function, opens the appropriate C source module in the Editor view at the location
of the function definition.

» To sort the rows in the table, click on one of the column headers.
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The profiling information

Based on the profiling options you have set before compiling your application, some profiling data may
be present and some may be not. The columns in the tables represent the following information:

Module
#Line
Function

Total Time

Self Time

% in
Function

Calls
#Callers
#Callees

Contribution
%

Calls %

The C source module in which the function resides.
The line number of the function definition in the C source module.

The function for which profiling data is gathered and (if present) the code blocks in each
function. To show or hide the block counts, in the Profiler view click the Menu button (=)
and select Show Block Counts.

The total amount of time in seconds that was spent in this function and all of its
sub-functions.

The amount of time in seconds that was spent in the function itself. This excludes the
time spent in the sub-functions. So, self time = function's total time - total times of the
called functions.

This is the relative amount of time spent in this function, calculated as a percentage of
the total application time. These should add up to 100%. The total application time is
determined by taking the total time of the call graph. This is usually main. Example:

Total tinme of main: 0.002000
Self tinme of function foo: 0.000100
% n Function = (0.000100 / 0.002000) * 100 = 5%

Number of times the function has been executed.
Number of functions by which the function was called.
Number of functions that was actually called from this function.

In the caller table: shows for which part (in percent) the caller contributes to the time spent
in the focus function.

In the callee table: shows how much time the focus function has spent relatively in each
of its callees.

In the caller table: shows how often each callee was called as a percentage of all calls
from the focus function.

In the callee table: shows how often the focus function was called from a particular caller
as a percentage of all calls to the focus function.

Common toolbar icons

Icon Action Description
) Show/Hide Block [Toggle. If enabled, shows profiling information for block counters.
Counts

=

Select Profiling Opens a dialog where you can specify profiling files for display.
File(s)
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Viewing previously recorded profiling results, combining results

Each time you run your application, new profiling information is gathered and stored in the file amon. prf .
You can store previous results by renaming the file anon. pr f (keep the extension . pr f); this prevents
the existing anon. prf from being overwritten by the new anon. pr f . At any time, you can reload these
profiling results in the profiler. You can even load multiple . pr f files into the Profiler to view the combined
results.

First, open the TASKING Profiler perspective if it is not open anymore:

1. In the Profiler view, click on the & (Select Profiling File(s)) button.

The Select Profiling File(s) dialog appears.
2. Inthe Profiling Type group box, select Dynamic Profiling.
3. Inthe Profiling Files group box, disable the option Use default.
4. Click the Add... button, select the . prf files you want to load and click Open to confirm your choice.
5. Make sure the correct symbol file is selected, in this example pr of i | i ng. abs.

6. Click OK to finish.

6.3. Profiling at Compile Time (Static Profiling)

Just as with dynamic profiling, static profiling can be used to determine which parts of a program take
most of the execution time. It can provide a good alternative if you do not want that your code is affected
by extra code.

Overview of steps to perform

To obtain a profile using code instrumentation, perform the following steps:
1. Compile and link your program with static profiling enabled

2. Display the profile

First you need a completed project. If you are not using your own project, use the pr of i | i ng example
as described in Section 6.2, Profiling using Code Instrumentation (Dynamic Profiling).

6.3.1. Step 1: Build your Application with Static Profiling

The first step is to tell the C compiler to make an estimation of the profiling information of your application.
This is done with C compiler options:

1. From the Project menu, select Properties for
The Properties for profiling dialog box appears.

2. Inthe left pane, expand C/C++ Build and select Settings.
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In the right pane the Settings appear.

On the Tool Settings tab, expand the C/C++ Compiler entry and select Debugging.
Enable Static profiling.

For the command line, see the C compiler option --profile (-p).

Profiling is only possible with optimization levels 0, 1 and 2. So:

Open the Optimization page and set the Optimization level to 2 - Optimize more.

Click OK to apply the new option settings and rebuild the project (%).

6.3.2. Step 2: Displaying Static Profiling Results

After your project has been built with static profiling, the result of the profiler can be displayed in the
TASKING Profiler perspective. The profiling data of each individual file (. sxm ), is combined in the XML
file profi | i ng. xpr of . This file is read and its information is displayed. To view the profiling information,
open the TASKING Profiler perspective:

1.

From the Window menu, select Open Perspective » Other...
The Select Perspective dialog appears.
Select the TASKING Profiler perspective and click OK.

The TASKING Profiler perspective opens. This perspective is explained in Section 6.2.3, Step 3:
Displaying Profiling Results

To display static profiling information in the Profiler view

1.

In the Profiler view, click on the & (Select Profiling File(s)) button.
The Select Profiling File(s) dialog appears.

In the Profiling Type group box, select Static Profiling.

In the Static Profiling File group box, enable the option Use default.

By default, the file project. xpr of is used (profi | i ng. xpr of ). If you want to specify another file,
disable the option Use default and use the edit field and/or Browse button to specify a static profiling
file (. xpr of ).

Click OK to finish.
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Chapter 7. Using the Assembler

This chapter describes the assembly process and explains how to call the assembler.

The assembler converts hand-written or compiler-generated assembly language programs into machine
language, resulting in object files in the ELF/DWARF object format.

The assembler takes the following files for input and output:

assembly file
.SIC

assembly file . asm ﬁ |
thand codedd ——s listfille . 1st
assethbler

[~ —— M EBITOr messages  ers

relocatahle objectfile
.ob]

The following information is described:

* The assembly process.

» How to call the assembler and how to use its options. An extensive list of all options and their descriptions
is included in Section 13.4, Assembler Options.

» How to generate a list file.

» Types of assembler messages.

7.1. Assembly Process

The assembler generates relocatable output files with the extension . obj . These files serve as input for
the linker.

Phases of the assembly process

 Parsing of the source file: preprocessing of assembler directives and checking of the syntax of
instructions

» Generation of the relocatable object file and optionally a list file

The assembler integrates file inclusion and macro facilities. See Section 3.10, Macro Operations for more
information.
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7.2. Assembler Versions

The TASKING VX-toolset for ARM consists of a set of three assemblers. Depending on the architecture
and the selection of the Thumb or mixed ARM/Thumb instruction set Eclipse and the control program
select the correct assembler, which results in faster build times.

asarm supports both ARM and Thumb/Thumb-2 instruction set (full assembler)

asarma [supports ARM instruction set only

asarmt supports Thumb/Thumb-2 instruction set only

All command line options are the same for all three assemblers.

Also see control program option --thumb.

7.3. Calling the Assembler

The TASKING VX-toolset for ARM under Eclipse can use the internal builder (default) or the TASKING
makefile generator (external builder) to build your entire project. After you have built your project, the
output files are available in a subdirectory of your project directory, depending on the active configuration
you have set in the C/C++ Build » Settings page of the Project » Properties for dialog.

Building a project under Eclipse

You have several ways of building your project:

Build Selected File(s) (). This compiles and assembles the selected file(s) without calling the linker.
1. In the C/C++ Projects view, select the files you want to compile.

2. Right-click in the C/C++ Projects view and select Build Selected File(s).

* Build Individual Project (1),

To build individual projects incrementally, select Project » Build project.

Rebuild Project (%), This builds every file in the project whether or not a file has been modified since
the last build. A rebuild is a clean followed by a build.

1. Select Project » Clean...
2. Enable the option Start a build immediately and click OK.

 Build Automatically. This performs a build of all projects whenever any project file is saved, such as
your makefile.

This way of building is not recommended for C/C++ development, but to enable this feature select
Project » Build Automatically and ensure there is a check mark beside the Build Automatically
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menu item. In order for this option to work, you must also enable option Build on resource save (Auto
build) on the Behaviour tab of the C/C++ Build page of the Project » Properties for dialog.

Select a target processor (core)

Processor options affect the invocation of all tools in the toolset. In Eclipse you only need to set them
once. Based on the target processor, the compiler includes a special function register file. This is a regular
include file which enables you to use virtual registers that are located in memory.

1. From the Project menu, select Properties for
The Properties dialog appears.

2. Inthe left pane, expand C/C++ Build and select Processor.
In the right pane the Processor page appears.

3. From the Processor selection list, select a processor.

To access the assembler options

1. From the Project menu, select Properties for
The Properties dialog appears.

2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.

3. On the Tool Settings tab, select Assembler.

4. Select the sub-entries and set the options in the various pages.

Note that the options you enter in the Assembler page are not only used for hand-coded assembly
files, but also for the assembly files generated by the compiler.

You can find a detailed description of all assembler options in Section 13.4, Assembler Options.

Invocation syntax on the command line (Windows Command Prompt):
asarm|[ [option]... [file]... ]...

The input file must be an assembly source file (. asmor . sr c).
7.4. How the Assembler Searches Include Files

When you use include files (with the . | NCLUDE directive), you can specify their location in several ways.
The assembler searches the specified locations in the following order:
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1. If the . | NCLUDE directive contains an absolute path name, the assembler looks for this file. If no path
or a relative path is specified, the assembler looks in the same directory as the source file.

2. When the assembler did not find the include file, it looks in the directories that are specified in the
Assembler » Include Paths page in the C/C++ Build » Settings » Tool Settings tab of the Project
Properties dialog (equivalent to the -1 command line option).

3. When the assembler did not find the include file (because it is not in the specified include directory or
because no directory is specified), it looks in the path(s) specified in the environment variable ASARM NC.

4. When the assembler still did not find the include file, it finally tries the default include directory relative
to the installation directory.

Example

Suppose that the assembly source file t est . asmcontains the following lines:
. I NCLUDE ' nyi nc.inc'

You can call the assembler as follows:

asarm -1 nyi nclude test.asm

First the assembler looks for the file myi nc. asm in the directory where t est . asmis located. If the file
is not there the assembler searches in the directory nyi ncl ude. If it was still not found, the assembler
searches in the environment variable ASARM NC and then in the default i ncl ude directory.

7.5. Generating a List File

The list file is an additional output file that contains information about the generated code. You can
customize the amount and form of information.

If the assembler generates errors or warnings, these are reported in the list file just below the source line
that caused the error or warning.

To generate alist file

1. From the Project menu, select Properties for
The Properties dialog appears.

2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.

3. On the Tool Settings tab, select Assembler » List File.

4. Enable the option Generate list file.

5. (Optional) Enable the options to include that information in the list file.
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Example on the command line (Windows Command Prompt)
The following command generates the list filet est . | st :
asarm-| test.asm

See Section 15.1, Assembler List File Format, for an explanation of the format of the list file.

7.6. Assembler Error Messages

The assembler reports the following types of error messages in the Problems view of Eclipse.

F ( Fatal errors)

After a fatal error the assembler immediately aborts the assembly process.

E (Errors)

Errors are reported, but the assembler continues assembling. No output files are produced unless you
have set the assembler option --keep-output-files (the resulting output file may be incomplete).

W (Warnings)

Warning messages do not result into an erroneous assembly output file. They are meant to draw your
attention to assumptions of the assembler for a situation which may not be correct. You can control
warnings in the C/C++ Build » Settings » Tool Settings » Assembler » Diagnostics page of the Project
» Properties for menu (assembler option --no-warnings).

Display detailed information on diagnostics

1. From the Window menu, select Show View » Other » TASKING » Problems.
The Problems view is added to the current perspective.

2. In the Problems view right-click on a message.
A popup menu appears.

3. Select Detailed Diagnostics Info.
A dialog box appears with additional information.

On the command line you can use the assembler option --diag to see an explanation of a diagnostic
message:

asarm --diag=[format:]{all | number,...]
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Chapter 8. Using the Linker

This chapter describes the linking process, how to call the linker and how to control the linker with a script
file.

The TASKING linker is a combined linker/locator. The linker phase combines relocatable object files

(. obj files, generated by the assembler), and libraries into a single relocatable linker object file (. out ).
The locator phase assigns absolute addresses to the linker object file and creates an absolute object file
which you can load into a target processor. From this point the term linker is used for the combined
linker/locator.

The linker can simultaneously link and locate all programs for all cores available on a target board. The

target board may be of arbitrary complexity. A simple target board may contain one standard processor

with some external memory that executes one task. A complex target board may contain multiple standard
processors and DSPs combined with configurable IP-cores loaded in an FPGA. Each core may execute
a different program, and external memory may be shared by multiple cores.

The linker takes the following files for input and output:
relocatable objectfiles . ohj

relocatahle linker ohjectfile . out —‘ ’— relocatable object library . 1ih
linkerscriptfile .11 — ink == linkermap file . map
inker
----- - errormessages | elk
relocatable linker objectfile . out J I—" memary definition
file .mdf
| 1 '
Intel Hex ELFDWARF 2 Iotorola S-record
ahsolute ohjectfile absolute obhject file absolute obhject file
Chesx .abs . &5re

This chapter first describes the linking process. Then it describes how to call the linker and how to use
its options. An extensive list of all options and their descriptions is included in Section 13.5, Linker Options.

To control the link process, you can write a script for the linker. This chapter shortly describes the purpose
and basic principles of the Linker Script Language (LSL) on the basis of an example. A complete description
of the LSL is included in Linker Script Language.

8.1. Linking Process

The linker combines and transforms relocatable object files (. obj ) into a single absolute object file. This
process consists of two phases: the linking phase and the locating phase.

In the first phase the linker combines the supplied relocatable object files and libraries into a single
relocatable object file. In the second phase, the linker assigns absolute addresses to the object file so it
can actually be loaded into a target.
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Terms used in the linking process

Term

Definition

Absolute object file

Address
Address space

Architecture

Copy table

Core
Derivative

Library

Logical address

LSL file
MAU

Object code
Physical address
Processor

Relocatable object
file

Relocation
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Object code in which addresses have fixed absolute values, ready to load into a
target.

A specification of a location in an address space.

The set of possible addresses. A core can support multiple spaces, for example in
a Harvard architecture the addresses that identify the location of an instruction
refer to code space, whereas addresses that identify the location of a data object
refer to a data space.

A description of the characteristics of a core that are of interest for the linker. This
encompasses the address space(s) and the internal bus structure. Given this
information the linker can convert logical addresses into physical addresses.

A section created by the linker. This section contains data that specifies how the
startup code initializes the data sections. For each section the copy table contains
the following fields:

« action: defines whether a section is copied or zeroed
» destination: defines the section's address in RAM
* source: defines the sections address in ROM

« length: defines the size of the section in MAUs of the destination space

An instance of an architecture.

The design of a processor. A description of one or more cores including internal
memory and any number of buses.

Collection of relocatable object files. Usually each object file in a library contains
one symbol definition (for example, a function).

An address as encoded in an instruction word, an address generated by a core
(CPU).

The set of linker script files that are passed to the linker.

Minimum Addressable Unit. For a given processor the number of bits between an
address and the next address. This is not necessarily a byte or a word.

The binary machine language representation of the C source.
An address generated by the memory system.

An instance of a derivative. Usually implemented as a (custom) chip, but can also
be implemented in an FPGA, in which case the derivative can be designed by the
developer.

Object code in which addresses are represented by symbols and thus relocatable.

The process of assigning absolute addresses.
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Term Definition

Relocation Information about how the linker must modify the machine code instructions when

information it relocates addresses.

Section A group of instructions and/or data objects that occupy a contiguous range of
addresses.

Section attributes  Attributes that define how the section should be linked or located.

Target The hardware board on which an application is executing. A board contains at least
one processor. However, a complex target may contain multiple processors and
external memory and may be shared between processors.

Unresolved A reference to a symbol for which the linker did not find a definition yet.

reference

8.1.1. Phase 1: Linking

The linker takes one or more relocatable object files and/or libraries as input. A relocatable object file, as
generated by the assembler, contains the following information:

» Header information: Overall information about the file, such as the code size, name of the source file
it was assembled from, and creation date.

» Object code: Binary code and data, divided into various named sections. Sections are contiguous
chunks of code that have to be placed in specific parts of the memory. The program addresses start
at zero for each section in the object file.

» Symbols: Some symbols are exported - defined within the file for use in other files. Other symbols are
imported - used in the file but not defined (external symbols). Generally these symbols are names of
routines or names of data objects.

» Relocation information: A list of places with symbolic references that the linker has to replace with
actual addresses. When in the code an external symbol (a symbol defined in another file or in a library)
is referenced, the assembler does not know the symbol's size and address. Instead, the assembler
generates a call to a preliminary relocatable address (usually 0000), while stating the symbol name.

» Debug information: Other information about the object code that is used by a debugger. The assembler
optionally generates this information and can consist of line numbers, C source code, local symbols
and descriptions of data structures.

The linker resolves the external references between the supplied relocatable object files and/or libraries
and combines the files into a single relocatable linker object file.

The linker starts its task by scanning all specified relocatable object files and libraries. If the linker
encounters an unresolved symbol, it remembers its name and continues scanning. The symbol may be
defined elsewhere in the same file, or in one of the other files or libraries that you specified to the linker.
If the symbol is defined in a library, the linker extracts the object file with the symbol definition from the
library. This way the linker collects all definitions and references of all of the symbols.

Next, the linker combines sections with the same section name and attributes into single sections. The
linker also substitutes (external) symbol references by (relocatable) numerical addresses where possible.
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At the end of the linking phase, the linker either writes the results to a file (a single relocatable object file)
or keeps the results in memory for further processing during the locating phase.

The resulting file of the linking phase is a single relocatable object file (. out ). If this file contains unresolved
references, you can link this file with other relocatable object files (. obj ) or libraries (. | i b) to resolve
the remaining unresolved references.

With the linker command line option --link-only, you can tell the linker to only perform this linking phase
and skip the locating phase. The linker complains if any unresolved references are left.

8.1.2. Phase 2: Locating

In the locating phase, the linker assigns absolute addresses to the object code, placing each section in
a specific part of the target memory. The linker also replaces references to symbols by the actual address
of those symbols. The resulting file is an absolute object file which you can actually load into a target
memory. Optionally, when the resulting file should be loaded into a ROM device the linker creates a
so-called copy table section which is used by the startup code to initialize the data sections.

Code modification

When the linker assigns absolute addresses to the object code, it needs to modify this code according
to certain rules or relocation expressions to reflect the new addresses. These relocation expressions are
stored in the relocatable object file. Consider the following snippet of x86 code that moves the contents
of variable a to variable b via the eax register:

Al 3412 0000 nov a, %eax (a defined at 0x1234, byte reversed)
A3 0000 0000 rmov %ax, b (b is inported so the instruction refers to
0x0000 since its |location is unknown)

Now assume that the linker links this code so that the section in which a is located is relocated by 0x10000
bytes, and b turns out to be at 0x9A12. The linker modifies the code to be:

Al 3412 0100 nov a, %eax (0x10000 added to the address)
A3 129A 0000 nov %ax, b (0x9A12 patched in for b)

These adjustments affect instructions, but keep in mind that any pointers in the data part of a relocatable
object file have to be modified as well.

Output formats

The linker can produce its output in different file formats. The default ELF/DWARF format (. abs) contains
an image of the executable code and data, and can contain additional debug information. The Intel-Hex
format (. hex) and Motorola S-record format (. sr €) only contain an image of the executable code and
data. You can specify a format with the options --output (-0) and --chip-output (-c).

Controlling the linker

Via a so-called linker script file you can gain complete control over the linker. The script language is called
the Linker Script Language (LSL). Using LSL you can define:

» The memory installed in the embedded target system:
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To assign locations to code and data sections, the linker must know what memory devices are actually
installed in the embedded target system. For each physical memory device the linker must know its
start-address, its size, and whether the memory is read-write accessible (RAM) or read-only accessible
(ROM).

» How and where code and data should be placed in the physical memory:

Embedded systems can have complex memory systems. If for example on-chip and off-chip memory
devices are available, the code and data located in internal memory is typically accessed faster and
with dissipating less power. To improve the performance of an application, specific code and data
sections should be located in on-chip memory. By writing your own LSL file, you gain full control over
the locating process.

» The underlying hardware architecture of the target processor.

To perform its task the linker must have a model of the underlying hardware architecture of the processor
you are using. For example the linker must know how to translate an address used within the object
file (a logical address) into an offset in a particular memory device (a physical address). In most linkers
this model is hard coded in the executable and can not be modified. For the TASKING linker this
hardware model is described in the linker script file. This solution is chosen to support configurable
cores that are used in system-on-chip designs.

When you want to write your own linker script file, you can use the standard linker script files with
architecture descriptions delivered with the product.

See also Section 8.7, Controlling the Linker with a Script.

8.2. Calling the Linker

In Eclipse you can set options specific for the linker. After you have built your project, the output files are
available in a subdirectory of your project directory, depending on the active configuration you have set
in the C/C++ Build » Settings page of the Project » Properties for dialog.

Building a project under Eclipse

You have several ways of building your project:

* Build Individual Project (&T),

To build individual projects incrementally, select Project » Build project.

Rebuild Project (“). This builds every file in the project whether or not a file has been modified since
the last build. A rebuild is a clean followed by a build.

1. Select Project » Clean...

2. Enable the option Start a build immediately and click OK.
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 Build Automatically. This performs a build of all projects whenever any project file is saved, such as
your makefile.

This way of building is not recommended, but to enable this feature select Project » Build Automatically
and ensure there is a check mark beside the Build Automatically menu item. In order for this option
to work, you must also enable option Build on resource save (Auto build) on the Behaviour tab of
the C/C++ Build page of the Project » Properties for dialog.

To access the linker options
1. From the Project menu, select Properties for
The Properties dialog appears.
2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.
3. On the Tool Settings tab, select Linker.
4. Select the sub-entries and set the options in the various pages.

You can find a detailed description of all linker options in Section 13.5, Linker Options.

Invocation syntax on the command line (Windows Command Prompt):
lkarm[ [option]... [file]... ...

When you are linking multiple files, either relocatable object files (. obj ) or libraries (. | i b), itis important
to specify the files in the right order. This is explained in Section 8.3, Linking with Libraries.

Example:
| karm -darm | sl test.obj

This links and locates the file t est . obj and generates the file t est . abs.

8.3. Linking with Libraries

There are two kinds of libraries: system libraries and user libraries.

System library
System libraries are stored in the directories:

<ARM installation path>\lib\v6MIle (little-endian variant)
<ARM installation path>\1ib\v6M be (bi g-endi an vari ant)
<ARM installation path>\lib\v7i[EM M R \I e

<ARM installation path>\1ib\v7/[EM M R]\ be

<ARM installation path>\Iib\v7R be32 (big-endian 32 variant)
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An overview of the system libraries is given in the following table:

Libraries

Description

carm[s].lib
cthumbs].lib

C libraries for ARM and Thumb instructions respectively
Optional letter:

s = single precision floating-point (compiler option --no-double)

fparm.lib Floating-point libraries for ARM and Thumb
fpthumb.lib

rtarm.lib Run-time library for ARM and Thumb
rtthumb.lib

pbarm.lib / pbthumb.lib
pcarm.lib / pcthumb.lib
pctarm.lib / pctthumb.lib
pdarm.lib / pdthumb.lib
ptarm.lib / ptthumb.lib

Profiling libraries for ARM and Thumb
pb = block/function counter

pc = call graph
pct = call graph and timing
pd = dummy

pt = function timing

dspthumbls].lib

CMSIS DSP libraries
Optional letter:
s = single precision floating-point

cparm[s][x].lib
cpthumb(s][x].lib

C++ libraries for ARM and Thumb
Optional letter:

s = single precision floating-point
X = exception handling

stlarmx.lib
stithumbx.lib

STLport C++ libraries (exception handling variants only)
Optional letter:
s = single precision floating-point

To link the default C (system) libraries

1. From the Project menu, select Properties for

The Properties dialog appears.

2. Inthe left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. On the Tool Settings tab, select Linker » Libraries.

4. Enable the option Link default libraries.

When you want to link system libraries from the command line, you must specify this with the option

--library (-). For example, to specify the system library car m | i b, type:

| karm --1i brary=carm test. obj
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To use the CMSIS DSP library in your Eclipse project

Part of the CMSIS standard is a DSP library. The CMSIS DSP library is included in the TASKING product's
crsi s folder. The library is also available as a pre-built library file in the | i b folders for véM, v7M and
V7EM. The libraries are dspt hunb. | i b (double precision floating point) and dspt hunbs. | i b (single
precision floating point). MIL libraries are present also: dspt hunb. na and dspt hunbs. nma.

1. From the Project menu, select Properties for
The Properties dialog appears.
2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.
3. On the Tool Settings tab, select C/C++ Compiler » Include Paths .
4. Enable the option Add CMSIS include paths.
5. On the Tool Settings tab, select Linker » Libraries.
6. Enable the option Link CMSIS DSP library.

This passes the option --dsp-library of the control program (ccarm) for compilation of C/C++ files
and for linking. With this option the control program sets the compiler macro ARM_MATH_CMO,
ARM_MATH_CM3 or ARM_MATH_CM4, depending on the selected processor. These macros are
required for the CMSIS arm_math.h header file to operate correctly. With --dsp-library the control
program also selects the appropriate library.

User library

You can create your own libraries. Section 10.4, Archiver describes how you can use the archiver to
create your own library with object modules.

To link user libraries

1. From the Project menu, select Properties for
The Properties dialog appears.

2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.

3. On the Tool Settings tab, select Linker » Libraries.

4. Add your libraries to the Libraries box.

When you want to link user libraries from the command line, you must specify their flenames on the
command line:

karm start.obj nylib.lib
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If the library resides in a sub-directory, specify that directory with the library name:
| karmstart.obj nmylibs\nylib.lib

If you do not specify a directory, the linker searches the library in the current directory only.

Library order

The order in which libraries appear on the command line is important. By default the linker processes
object files and libraries in the order in which they appear at the command line. Therefore, when you use
a weak symbol construction, like pri nt f, in an object file or your own library, you must position this
object/library before the C library.

With the option --first-library-first you can tell the linker to scan the libraries from left to right, and extract
symbols from the first library where the linker finds it. This can be useful when you want to use newer
versions of a library routine:

| karm--first-library-first a.lib test.obj b.lib

If the file t est . obj calls a function which is both presentina. | i b and b. | i b, normally the function in
b. |i b would be extracted. With this option the linker first tries to extract the symbol from the first library
a.lib.

Note that routines in b. | i b that call other routines that are present in both a. | i b and b. | i b are now
also resolved from a. | i b.

8.3.1. How the Linker Searches Libraries

System libraries

You can specify the location of system libraries in several ways. The linker searches the specified locations
in the following order:

1. The linker first looks in the Library search path that are specified in the Linker » Libraries page in
the C/C++ Build » Settings » Tool Settings tab of the Project Properties dialog (equivalent to the -L
command line option). If you specify the -L option without a pathname, the linker stops searching after
this step.

2. When the linker did not find the library (because it is not in the specified library directory or because
no directory is specified), it looks in the path(s) specified in the environment variable LI BARM

3. When the linker did not find the library, it tries the default | i b directory relative to the installation
directory (or a processor specific sub-directory).

User library

If you use your own library, the linker searches the library in the current directory only.
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8.3.2. How the Linker Extracts Objects from Libraries

A library built with the TASKING archiver ararm always contains an index part at the beginning of the
library. The linker scans this index while searching for unresolved externals. However, to keep the index
as small as possible, only the defined symbols of the library members are recorded in this area.

When the linker finds a symbol that matches an unresolved external, the corresponding object file is
extracted from the library and is processed. After processing the object file, the remaining library index
is searched. If after a complete search of the library unresolved externals are introduced, the library index
will be scanned again. After all files and libraries are processed, and there are still unresolved externals
and you did not specify the linker option --no-rescan, all libraries are rescanned again. This way you do
not have to worry about the library order on the command line and the order of the object files in the
libraries. However, this rescanning does not work for ‘weak symbols'. If you use a weak symbol construction,
like pri nt f, in an object file or your own library, you must position this object/library before the C library.

The option--verbose (-v) shows how libraries have been searched and which objects have been extracted.

Resolving symbols

If you are linking from libraries, only the objects that contain symbols to which you refer, are extracted
from the library. This implies that if you invoke the linker like:

[karmnylib.lib

nothing is linked and no output file will be produced, because there are no unresolved symbols when the
linker searches through myl i b. | i b.

It is possible to force a symbol as external (unresolved symbol) with the option --extern (-e):
| karm --extern=main nylib.lib

In this case the linker searches for the symbol rmrai n in the library and (if found) extracts the object that
contains nai n.

If this module contains new unresolved symbols, the linker looks again in nyl i b. | i b. This process
repeats until no new unresolved symbols are found.

8.4. Incremental Linking

With the TASKING linker it is possible to link incrementally. Incremental linking means that you link some,
but not all . obj modules to a relocatable object file . out . In this case the linker does not perform the
locating phase. With the second invocation, you specify both new . obj files as the . out file you had
created with the first invocation.

Incremental linking is only possible on the command line.

| karm-darmlsl --incremental testl.obj -otest.out
| karm -darm | sl test2.o0bj test.out
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This links the filet est 1. obj and generates the file t est . out . This file is used again and linked together
witht est 2. obj to create thefilet est . abs (the default name if no output filename is given in the default
ELF/DWARF format).

With incremental linking it is normal to have unresolved references in the output file until all . obj files
are linked and the final . out or . abs file has been reached. The option --incremental (-r) for incremental
linking also suppresses warnings and errors because of unresolved symbols.

8.5. Importing Binary Files

With the TASKING linker it is possible to add a binary file to your absolute output file. In an embedded
application you usually do not have a file system where you can get your data from. With the linker option
--import-object you can add raw data to your application. This makes it possible for example to display
images on a device or play audio. The linker puts the raw data from the binary file in a section. The section
is aligned on a 4-byte boundary. The section name is derived from the filename, in which dots are replaced
by an underscore. So, when importing a file called nmy. np3, a section with the name my_np3 is created.
In your application you can refer to the created section by using linker labels.

For example:

#i ncl ude <stdi o. h>
extern char _lc_ub_ny_np3; /* linker |abels */
extern char _lc_ue_ny_np3;
char* mp3 = & | c_ub_ny_np3;
voi d mai n(voi d)
{
int size = &lc_ue_nmy_m3 - & Ilc_ub_ny_np3;
int i;
for (i=0;i<size;i++)
put char (nmp3[i]);

If you want to use the export functionality of Eclipse, the binary file has to be part of your project.

8.6. Linker Optimizations

During the linking and locating phase, the linker looks for opportunities to optimize the object code. Both
code size and execution speed can be optimized.

To enable or disable optimizations
1. From the Project menu, select Properties for
The Properties dialog appears.

2. Inthe left pane, expand C/C++ Build and select Settings.
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In the right pane the Settings appear.
3. On the Tool Settings tab, select Linker » Optimization.
4. Enable one or more optimizations.

You can enable or disable the optimizations described below. The command line option for each
optimization is given in brackets.

Delete unreferenced sections (option -Oc/-OC)

This optimization removes unused sections from the resulting object file.

First fit decreasing (option -OI/-OL)

When the physical memory is fragmented or when address spaces are nested it may be possible that a
given application cannot be located although the size of the available physical memory is larger than the
sum of the section sizes. Enable the first-fit-decreasing optimization when this occurs and re-link your
application.

The linker's default behavior is to place sections in the order that is specified in the LSL file (that is, working
from low to high memory addresses or vice versa). This also applies to sections within an unrestricted
group. If a memory range is partially filled and a section must be located that is larger than the remainder
of this range, then the section and all subsequent sections are placed in a next memory range. As a result
of this gaps occur at the end of a memory range.

When the first-fit-decreasing optimization is enabled the linker will first place the largest sections in the

smallest memory ranges that can contain the section. Small sections are located last and can likely fit in
the remaining gaps.

Compress copy table (option -Ot/-OT)

The startup code initializes the application's data areas. The information about which memory addresses
should be zeroed and which memory ranges should be copied from ROM to RAM is stored in the copy
table.

When this optimization is enabled the linker will try to locate sections in such a way that the copy table
is as small as possible thereby reducing the application's ROM image.

Delete duplicate code (option -Ox/-OX)

Delete duplicate constant data (option -Oy/-QY)

These two optimizations remove code and constant data that is defined more than once, from the resulting
object file.

Compress ROM sections of copy table items (option -Oz/-OZ)

Reduces the size of the application's ROM image by compressing the ROM image of initialized data
sections. At application startup time the ROM image is decompressed and copied to RAM.
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When this optimization is enabled the linker will try to locate sections in such a way that the copy table
is as small as possible thereby reducing the application's ROM image.

8.7. Controlling the Linker with a Script

With the options on the command line you can control the linker's behavior to a certain degree. From
Eclipse itis also possible to determine where your sections will be located, how much memory is available,
which sorts of memory are available, and so on. Eclipse passes these locating directions to the linker via
a script file. If you want even more control over the locating process you can supply your own script.

The language for the script is called the Linker Script Language, or shortly LSL. You can specify the script
file to the linker, which reads it and locates your application exactly as defined in the script. If you do not
specify your own script file, the linker always reads a standard script file which is supplied with the toolset.

8.7.1. Purpose of the Linker Script Language
The Linker Script Language (LSL) serves three purposes:

1. It provides the linker with a definition of the target's core architecture. This definition is supplied with
the toolset.

2. It provides the linker with a specification of the memory attached to the target processor.

3. It provides the linker with information on how your application should be located in memory. This gives
you, for example, the possibility to create overlaying sections.

The linker accepts multiple LSL files. You can use the specifications of the core architectures that Altium
has supplied in the i ncl ude. | sl directory. Do not change these files.

If you use a different memory layout than described in the LSL file supplied for the target core, you must
specify this in a separate LSL file and pass both the LSL file that describes the core architecture and your
LSL file that contains the memory specification to the linker. Next you may want to specify how sections
should be located and overlaid. You can do this in the same file or in another LSL file.

LSL has its own syntax. In addition, you can use the standard C preprocessor keywords, such as #i ncl ude
and #def i ne, because the linker sends the script file first to the C preprocessor before it starts interpreting
the script.

The complete LSL syntax is described in Chapter 17, Linker Script Language (LSL).

8.7.2. Eclipse and LSL

In Eclipse you can specify the size of the stack and heap; the physical memory attached to the processor;
identify that particular address ranges are reserved; and specify which sections are located where in
memory. Eclipse translates your input into an LSL file that is stored in the project directory under the
name project_name. | sl and passes this file to the linker. If you want to learn more about LSL you can
inspect the generated file project_name. | sl .
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To add a generated Linker Script File to your project
1. From the File menu, select File » New » TASKING VX-toolset for ARM C/C++ Project.
The New C/C++ Project wizard appears.

2. Fillin the project settings in each dialog and click Next > until the following dialog appears.

New C/C++ Project

ARM Project Settings

@ Select a processor to continue |

Processor seleckion:

| Select by Architecture Expand Al
[ Select by Core

[ Energy Micra
[ Fujitsu

[ Infinean
LR

[] 5TMicroelectranics
[] Texas Instruments

Actions:
Add startup filels) to the project
Add linker script file ko the project

@

3. Enable the option Add linker script file to the project and click Finish.
Eclipse creates your project and the file "project_name. | sl " in the project directory.

If you do not add the linker script file here, you can always add it later with File » New » Linker Script
File (LSL)

To change the Linker Script File in Eclipse
There are two ways of changing the LSL file in Eclipse.
» You can change the LSL file directly in an editor.

1. Double-click on the file project_name. | sl .

The project LSL file opens in the editor area.
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jil repraject sl 2 =08

/¢ TLSKING VE-toolset for ARM
/¢ Project linker script file
I
#if defined( PROC 3THM3ZFZ0SEE )
#define  MEMORY
#include "stwIZfixx.lsl"
memory STM3EZFixx_Flash (tag="on-chip™)
i

mau = 5;

type = rom;

size = 128k:

map (dest=bus:iRMN:local bus, dest offset=0x08000000, size=128k];
i
memory 3TH3IZFZxx SRAM (tag="on-chip™)
{

mau = &;
type = ram;
size = 6dk;

map (dest=bus:ARM:local bus, dest off=get=0x20000000, size=64k):
'
T Helse[]

2. You can edit the LSL file directly in the project_name. | sl editor.
A * appears in front of the name of the LSL file to indicate that the file has changes.

3. Click [=] or select File » Save to save the changes.

» You can also make changes to the property pages Memory and Stack/Heap.
1. From the Project menu, select Properties for
The Properties dialog appears.
2. Inthe left pane, expand C/C++ Build and select Memory or Stack/Heap.
In the right pane the corresponding property page appears.
3. Make changes to memory and/or stack/heap and click OK.

The project LSL file is updated automatically according to the changes you make in the pages.

You can quickly navigate through the LSL file by using the Outline view (Window » Show View » Outline).

8.7.3. Structure of a Linker Script File

A script file consists of several definitions. The definitions can appear in any order.
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The architecture definition (required)

In essence an architecture definition describes how the linker should convert logical addresses into
physical addresses for a given type of core. If the core supports multiple address spaces, then for each
space the linker must know how to perform this conversion. In this context a physical address is an offset
on a given internal or external bus. Additionally the architecture definition contains information about items
such as the (hardware) stack and the vector table.

This specification is normally written by Altium. Altium supplies LSL files in the i ncl ude. | sl directory.

The architecture definition of the LSL file should not be changed by you unless you also modify the core's
hardware architecture. If the LSL file describes a multi-core system an architecture definition must be
available for each different type of core.

The linker uses the architecture name in the LSL file to identify the target. For example, the default library
search path can be different for each core architecture.

The derivative definition

The derivative definition describes the configuration of the internal (on-chip) bus and memory system.
Basically it tells the linker how to convert offsets on the buses specified in the architecture definition into
offsets in internal memory. Microcontrollers and DSPs often have internal memory and I/O sub-systems
apart from one or more cores. The design of such a chip is called a derivative.

When you want to use multiple cores of the same type, you must instantiate the cores in a derivative
definition, since the linker automatically instantiates only a single core for an unused architecture.

The processor definition

The processor definition describes an instance of a derivative. A processor definition is only needed in a
multi-processor embedded system. It allows you to define multiple processors of the same type.

If for a derivative 'A' no processor is defined in the LSL file, the linker automatically creates a processor
named 'A’ of derivative 'A'. This is why for single-processor applications it is enough to specify the derivative
in the LSL file.

The memory and bus definitions (optional)

Memory and bus definitions are used within the context of a derivative definition to specify internal memory
and on-chip buses. In the context of a board specification the memory and bus definitions are used to
define external (off-chip) memory and buses. Given the above definitions the linker can convert a logical
address into an offset into an on-chip or off-chip memory device.

The board specification

The processor definition and memory and bus definitions together form a board specification. LSL provides
language constructs to easily describe single-core and heterogeneous or homogeneous multi-core
systems. The board specification describes all characteristics of your target board's system buses, memory
devices, 1/0 sub-systems, and cores that are of interest to the linker. Based on the information provided
in the board specification the linker can for each core:

210



Using the Linker

» convert a logical address to an offset within a memory device
* locate sections in physical memory

* maintain an overall view of the used and free physical memory within the whole system while locating

The section layout definition (optional)

The optional section layout definition enables you to exactly control where input sections are located.
Features are provided such as: the ability to place sections at a given address, to place sections in a
given order, and to overlay code and/or data sections.

Example: Skeleton of a Linker Script File

A linker script file that defines a derivative "X" based on the ARM architecture, its external memory and
how sections are located in memory, may have the following skeleton:

architecture ARM

{
/1 Specification of the ARM core architecture.
/1 Witten by Altium
}
derivative X // derivative nane is arbitrary
{
/1 Specification of the derivative.
/1 Witten by Altium
core ARM /1 always specify the core
{
architecture = ARM
}
bus | ocal _bus /1 local bus
{
/1 maps to bus "local _bus" in "ARM core
}
/1 internal menory
}
processor spe /] processor nane is arbitrary
{
derivative = X
/1 You can omt this part, except if you use a
/1l multi-core system
}

menory ext_name

/1 external menory definition
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}

section_| ayout spe: ARM | i near /1 section |ayout

{ /1 section placenent statenments
/] sections are located in address space 'linear'
/1l of core ' ARM of processor 'spe'

}

Overview of LSL files delivered by Altium

Altium supplies the following LSL files in the directory i ncl ude. | si .

LSL file Description

arm arch. | sl Defines the base architecture (ARM) for all cores.

arm | sl It includes the file ar m_ar ch. | s| and contains a default specification of the
external memory attached to the target processor.

defaul t. | sl Default LSL file. This file includes the file ar m | sl or devi ce. | sl if
__ DEVI CE_LSL_FI LE is defined.

devi ce. | sl This file includes a processor specific LSL file based on the selected processor.

See control program option --cpu.

processor. | sl Processor specific LSL file with a specification of the external memory attached
to the target processor. It includes the file ar m ar ch. | sl .

tenpl ate. | sl This file is used by Eclipse as a template for the project LSL file. It includes
the file devi ce. | sl .

When you select to add a linker script file when you create a project in Eclipse, Eclipse makes a copy of
the file t enpl at e. | sI and names it “project_name. | sl ". On the command line, the linker uses the file
def aul t. | sl , unless you specify another file with the linker option --Isl-file (-d).

8.7.4.The Architecture Definition

Although you will probably not need to write an architecture definition (unless you are building your own
processor core) it helps to understand the Linker Script Language and how the definitions are interrelated.

Within an architecture definition the characteristics of a target processor core that are important for the
linking process are defined. These include:

» space definitions: the logical address spaces and their properties
* bus definitions: the I/O buses of the core architecture

* mappings: the address translations between logical address spaces, the connections between logical
address spaces and buses and the address translations between buses
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Address spaces

A logical address space is a memory range for which the core has a separate way to encode an address
into instructions. Most microcontrollers and DSPs support multiple address spaces. For example, separate
spaces for code and data. Normally, the size of an address space is 2N, with N the number of bits used
to encode the addresses.

The relation of an address space with another address space can be one of the following:
* one space is a subset of the other. These are often used for "small" absolute or relative addressing.

* the addresses in the two address spaces represent different locations so they do not overlap. This
means the core must have separate sets of address lines for the address spaces. For example, in
Harvard architectures we can identify at least a code and a data memory space.

Address spaces (even nested) can have different minimal addressable units (MAU), alignment restrictions,
and page sizes. All address spaces have a number that identifies the logical space (id). The following
table lists the different address spaces for the architecture ARMas defined in ar m_ar ch. | sl .

Space |ld [MAU |Description

linear |1 (8 Linear address space.

The ARM architecture in LSL notation

The best way to write the architecture definition, is to start with a drawing. The following figure shows a
part of the ARM architecture:

space linear s local_bus
00— —
il =1 rad = 8
mau = & width = 32
4G — —

The figure shows one address space called | i near . The address space has attributes like a number
that identifies the logical space (id), a MAU and an alignment. In LSL notation the definition of this address
space looks as follows:

space |inear

{

id = 1;

mau = 8;

map (size=4G dest=bus:|ocal _bus);
}

The keyword map corresponds with the arrows in the drawing. You can map:

» address space => address space (not shown in the drawing)
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» address space => bus

* memory => bus (not shown in the drawing)

* bus => bus (not shown in the drawing)

Next the internal buses, named | ocal _bus must be defined in LSL:

bus | ocal _bus

{

mau

= 8;
width =

32; // there are 32 data lines on the bus

}

This completes the LSL code in the architecture definition. Note that all code above goes into the
architecture definition, thus between:

architecture ARM

/1 Al'l code above goes here.

}
8.7.5.The Derivative Definition

Although you will probably not need to write a derivative definition (unless you are using multiple cores
that both access the same memory device) it helps to understand the Linker Script Language and how
the definitions are interrelated.

A derivative is the design of a processor, as implemented on a chip (or FPGA). It comprises one or more
cores and on-chip memory. The derivative definition includes:

» core definition; an instance of a core architecture
» bus definition: the I/O buses of the core architecture

» memory definitions: internal (or on-chip) memory

Core

Each derivative must have at least one core and each core must have a specification of its core architecture.
This core architecture must be defined somewhere in the LSL file(s).

core ARM
{

}

architecture = ARM

Bus

Each derivative can contain a bus definition for connecting external memory. In this example, the bus
| ocal _bus maps to the bus | ocal _bus defined in the architecture definition of core ARM
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bus | ocal _bus

{

mau = 8§;

w dth = 32;

map (dest=bus: ARM | ocal _bus, dest_offset=0, size=4G;
}
Memory

Memory is usually described in a separate memory definition, but you can specify on-chip memory for a
derivative. For example:

nmenory internal _code_rom

{
mau = 8;
type = rom
size = 2k;
map( dest=bus: ARM | ocal _bus, size = 2k, dest_offset = 0x00100000);
/'l src_offset is zero by default
}

This completes the LSL code in the derivative definition. Note that all code above goes into the derivative
definition, thus between:

derivative X // name of derivative

/1 Al code above goes here

}

8.7.6.The Processor Definition

The processor definition is only needed when you write an LSL file for a multi-processor embedded
system. The processor definition explicitly instantiates a derivative, allowing multiple processors of the
same type.

processor nane

{
}

If no processor definition is available that instantiates a derivative, a processor is created with the same
name as the derivative.

derivative = derivative_nang;

8.7.7.The Memory Definition

Once the core architecture is defined in LSL, you may want to extend the processor with external (or
off-chip) memory. You need to specify the location and size of the physical external memory devices in
the target system.

The principle is the same as defining the core's architecture but now you need to fill the memory definition:
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menory name

{
}

/1 menory definitions

PRy simbatn

-——

. 512k
PRy SimEan

I T
FErOry iy _tvrarm
Suppose your embedded system has 512kB of external ROM, named si nt om 512kB of external RAM,

named si nr amand 32kB of external NVRAM, named ny_nvr am(see figure above.) All memories are
connected to the bus | ocal _bus. In LSL this looks like follows:

nmenory sinrom

{

mau = 8;

type = rom

size = 512k;

map ( size = 512k, dest_offset=0, dest=bus: X |ocal _bus);
}
nmenory sinram
{

mau = 8;

type = ram

size = 512k;

map ( size = 512k, dest_offset=512k, dest=bus: X: | ocal _bus);
}
nMenory ny_nvram
{

mau = 8;

size = 32k;

type = ram

map ( size = 32k, dest_offset=1M dest=bus: X |ocal _bus);
}

If you use a different memory layout than described in the LSL file supplied for the target core, you can
specify this in Eclipse or you can specify this in a separate LSL file and pass both the LSL file that describes
the core architecture and your LSL file that contains the memory specification to the linker.

To add memory using Eclipse
1. From the Project menu, select Properties for

The Properties dialog appears.
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2. Inthe left pane, expand C/C++ Build and select Memory.
In the right pane the Memory page appears.
3. Open the Memory tab and click on the Add... button.
The Add new memory dialog appears.
4. Enter the memory name (for example my_nvr am, type (for example nvr am and size.
5. Click on the Add... button.
The Add new mapping dialog appears.

6. You have to specify at least one mapping. Enter the mapping name (optional), address, size and
destination and click OK.

The new mapping is added to the list of mappings.
7. Click OK.

The new memory is added to the list of memories (user memory).
8. Click OK to close the Properties dialog.

The updated settings are stored in the project LSL file.

If you make changes to the on-chip memory as defined in the architecture LSL file, the memory is copied
to your project LSL file and the line #def i ne __MEMORY is added. If you remove all the on-chip memory
from your project LSL file, also make sure you remove this define.

8.7.8.The Section Layout Definition: Locating Sections

Once you have defined the internal core architecture and optional memory, you can actually define where
your application must be located in the physical memory.

During compilation, the compiler divides the application into sections. Sections have a name, an indication
(section type) in which address space it should be located and attributes like writable or read-only.

In the section layout definition you can exactly define how input sections are placed in address spaces,
relative to each other, and what their absolute run-time and load-time addresses will be.

Example: section propagation through the toolset

To illustrate section placement, the following example of a C program (bat . c) is used. The program
saves the number of times it has been executed in battery back-upped memory, and prints the number.

#def i ne BATTERY_BACKUP_TAG O0xa5f0
#i ncl ude <stdio. h>

int uninitialized data;

int initialized data = 1;
#pragma section "non_vol atile"
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int battery_backup_tag;
int battery_backup_invok;
#pragma endsection

void nmain (void)

{
if (battery_backup_tag != BATTERY_BACKUP_TAG )
{
/1 battery back-upped nenory area contains invalid data
/1 initialize the nenory
battery_backup_tag = BATTERY_BACKUP_TAG
battery_backup_i nvok = 0;
}
printf( "This application has been invoked % tines\n",
battery_backup_i nvok++);
}

The compiler assigns names and attributes to sections. With the #pr agma sect i on and #pr agna
endsect i on the compiler's default section naming convention is overruled and a section with the name
non_vol ati | e appended is defined. In this section the battery back-upped data is stored.

As aresult of the #pragnma secti on "non_vol atil e", the data objects between the pragma pair
are placed in a section with the name ”. bss. non_vol ati | e". Note that". bss" sections are cleared at
startup. However, battery back-upped sections should not be cleared and therefore we will change this
section attribute using the LSL.

Section placement

The number of invocations of the example program should be saved in non-volatile (battery back-upped)
memory. This is the memory my_nvr amfrom the example in Section 8.7.7, The Memory Definition.

To control the locating of sections, you need to write one or more section definitions in the LSL file. At
least one for each address space where you want to change the default behavior of the linker. In our
example, we need to locate sections in the address space | i near:

section_|layout ::linear

{
}

To locate sections, you must create a group in which you select sections from your program. For the
battery back-up example, we need to define one group, which contains the section . bss. non_vol ati | e.
All other sections are located using the defaults specified in the architecture definition. Section

. bss. non_vol ati | e should be placed in non-volatile ram. To achieve this, the run address refers to
our non-volatile memory called ny__nvr am Furthermore, the section should not be cleared and therefore
the attribute s (scratch) is assigned to the group:

/1 Section placenment statements

group ( ordered, run_addr = memmy_nvram attributes = rws )

{
}

select ".bss.non_volatile";
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This completes the LSL file for the sample architecture and sample program. You can now invoke the
linker with this file and the sample program to obtain an application that works for this architecture.

For a complete description of the Linker Script Language, refer to Chapter 17, Linker Script Language
(LSL).

8.8. Linker Labels

The linker creates labels that you can use to refer to from within the application software. Some of these
labels are real labels at the beginning or the end of a section. Other labels have a second function, these
labels are used to address generated data in the locating phase. The data is only generated if the label
is used.

Linker labels are labels starting with _| c¢_. The linker assigns addresses to the following labels when
they are referenced:

Label Description

_lc_ub_name Begin of section name. Also used to mark the begin of the stack or heap or
copy table.

_lc_b_nanme

_lc_ue_nanme End of section name. Also used to mark the end of the stack or heap.

_lc_e_nane

_lc_cb_nane Start address of an overlay section in ROM.

_lc_ce_nane End address of an overlay section in ROM.

_lc_gb_nane Begin of group name. This label appears in the output file even if no reference
to the label exists in the input file.

_lc_ge_nane End of group name. This label appears in the output file even if no reference
to the label exists in the input file.

The linker only allocates space for the stack and/or heap when a reference to either of the section labels
exists in one of the input object files.

If you want to use linker labels in your C source for sections that have a dot (.) in the name, you
have to replace all dots by underscores.
Example: refer to a label with section name with dots from C

Suppose a section has the name . t ext . When you want to refer to the begin of this section you have to
replace all dots in the section name by underscores:

#i ncl ude <stdio. h>
extern void * _|lc_ub_ text;

voi d mai n(voi d)

{
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printf("The function main is |ocated at %\n",
& | c_ub__text);
}

Example: refer to the stack

Suppose in an LSL file a stack section is defined with the name "st ack” (with the keyword st ack). You
can refer to the begin and end of the stack from your C source as follows:

#i ncl ude <stdio. h>

extern char _lc_ub_stack[];
extern char _lc_ue_stack[];
void main()

{
printf( "Size of stack is %\n",
_lc_ub_stack - _Ic_ue_stack );
/* stack grows fromhigh to | ow */
}

From assembly you can refer to the end of the stack with:

.extern _lc_ue_stack ; end of user stack

8.9. Generating a Map File

The map file is an additional output file that contains information about the location of sections and symbols.
You can customize the type of information that should be included in the map file.

To generate a map file
1. From the Project menu, select Properties for
The Properties dialog appears.
2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.
3. On the Tool Settings tab, select Linker » Map File.
4. Enable the option Generate XML map file format (.mapxml) for map file viewer.
5. (Optional) Enable the option Generate map file (.map).

6. (Optional) Enable the options to include that information in the map file.

Example on the command line (Windows Command Prompt)

The following command generates the map file t est . map:
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| karm --map-file test. obj
With this command the map file t est . nap is created.

See Section 15.2, Linker Map File Format, for an explanation of the format of the map file.

8.10. Linker Error Messages

The linker reports the following types of error messages in the Problems view of Eclipse.

F ( Fatal errors)

After a fatal error the linker immediately aborts the link/locate process.

E (Errors)

Errors are reported, but the linker continues linking and locating. No output files are produced unless you
have set the linker option--keep-output-files.

W (Warnings)

Warning messages do not result into an erroneous output file. They are meant to draw your attention to
assumptions of the linker for a situation which may not be correct. You can control warnings in the C/C++
Build » Settings » Tool Settings » Linker » Diagnostics page of the Project » Properties for menu
(linker option --no-warnings).

| (Information)

Verbose information messages do not indicate an error but tell something about a process or the state
of the linker. To see verbose information, use the linker option--verbose.

S (System errors)

System errors occur when internal consistency checks fail and should never occur. When you still receive
the system error message

S6##: message

please report the error number and as many details as possible about the context in which the error
occurred.

Display detailed information on diagnostics
1. From the Window menu, select Show View » Other » TASKING » Problems.
The Problems view is added to the current perspective.

2. In the Problems view right-click on a message.
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A popup menu appears.
3. Select Detailed Diagnostics Info.
A dialog box appears with additional information.
On the command line you can use the linker option --diag to see an explanation of a diagnostic message:

| karm --diag=[format:]{all | nunber,...]
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Chapter 9. Run-time Environment

This chapter describes the startup code used by the TASKING VX-toolset for ARM C Compiler, the vector
table, the stack layout and the heap.

9.1. Startup Code

You need the run-time startup code to build an executable application. The default startup code consists
of the following components:

« Initialization code. This code is executed when the program is initiated and before the function mai n()
is called.

 Exit code. This controls the close down of the application after the program's main function terminates.

The startup code is part of the C library, and the source is present in the file cst art . asm(ARM and
Thumb), or cst art . ¢ (Thumb2 specific) in the directory | i b\ sr c. This code is generic code. It uses
linker generated symbols which you can give target specific or application specific values. These symbols
are defined in the linker script file (i ncl ude. I sl \'arm ar ch. | sl ) and you can specify their values in
Eclipse or on the command line with linker option --define. If the default run-time startup code does not
match your configuration, you need to make a copy of the startup file, modify it and add it to your project.
A typical example for doing this is when nai n() has arguments, typically argc/argv. In this case cstart
needs to be recompiled with the macro __USE_ARGC_ARGV set. When necessary you can use the macro
__ARGCV_BUFSI ZE to define the size of the buffer used to pass arguments to mai n() .

The entry point of the startup code (reset handler) is label _START. This global label should not be
removed, since the linker uses it in the linker script file. It is also used as the default start address of the
application.

Initialization code
The following initialization actions are executed before the application starts:

» Load the 'real' program address. This assures that the reset handler is immune for any ROM/RAM
re-mapping.

« Initialize the stack pointers for each processor mode. The stack pointers are loaded in memory by the
stack address located at a linker generate symbol (for example _| ¢_ub_st ack). These symbols are
defined in the linker script file. See Section 9.4, Stack and Heap, for detailed information on the stack.

 Call a user function which initializes hardware. The startup code calls the function __i ni t _har dwar e.
This function has an empty implementation in the C library, which you should change if certain hardware
initializations, such as ROM/RAM re-mapping or MMU configuration, are required before calling the
main application.

» Copy initialized sections from ROM to RAM, using a linker generated table (also known as the 'copy
table") and clear uninitialized data sections in RAM.
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« Initialize or copy the vector table. The startup code calls the function __i nit _vect or _t abl e. This
function has a default implementation in the C library, which copies the vector table from ROM to RAM
if necessary. You should only change it in very specific situations. For example, in case position
dependent vectors are used (B instructions instead of LDR PC) and the vector table must be generated
in RAM (or copied from ROM to RAM with patched offsets in the B instructions).

» (cstart.asmonly) Switch to the user-defined application mode as defined through the symbol
_APPLI CATI ON_MODE_ in the LSL file. This symbol is used to set the value of the CPSR status register
before calling the function mai n.

* (cstart.asmonly) Switch to Thumb code if you specified command line option --thumb.

« Initialize profiling if profiling is enabled. For an extensive description of profiling refer to Chapter 6,
Profiling.

* Initialize the ar gc and ar gv arguments.

* Call the entry point of your application with a call to function mai n() .

Exit code

When the C application 'returns', which is not likely to happen in an embedded environment, the program
ends with a call to the library function exi t ().

Macro preprocessor symbols

A number of macro preprocessor symbols are used in the startup code. These are enabled when you
use a particular option or you can enable or disable them using the assembler option --define with the
following syntax:

- -defi ne=synbol [ =val ue]

In the startup file (cst art. asmand cst art. c) the following macro preprocessor symbols are used:

Define Description

_ PROF_ENABLE___ If defined, initialize profiling.

__POSIX__ If defined, call posi x_nmai n instead of mai n.

__USE_ARGC_ARGV If defined, pass arguments to mai n:i nt main( int argc, char
*argv[] ).

__ARGCV_BUFSIZE Define buffer size for ar gv. (default: 256 bytes)

The following table shows the linker labels and other labels used in the startup code.

Define Description

_START Start label, mentioned in LSL file (ar m_ arch. | sl)
_Next Real program address. (*)

main Start label user C program.
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Define Description

exit Start label of exi t () function.
_lc_ub_stack User/system mode stack pointer.
_lc_ub_stack_und Undefined mode stack pointer. (*)
_lc_ub_stack_svc Supervisor mode stack pointer. (*)
_lc_ub_stack_abt Abort mode stack pointer. (*)
_lc_ub_stack_irq IRQ mode stack pointer. (*)
_lc_ub_stack_fiq FIQ mode stack pointer. (*)

_lc_ub_table ROM to RAM copy table.
_APPLICATION_MODE_ |Contains the processor mode, and the IRQ/FIQ interrupts mode.”
__init_hardware Start label of hardware initialization routine.
__init_vector_table Start label of vector table initialization.

(*) The labels marked with a * are available in cst art . asmonly.

9.2. Reset Handler and Vector Table

Reset handler

As explained in the previous section the entry point of the startup code (reset handler) is label _START.
The reset handler can have a fixed ROM address (run address). If the reset handler is called from the

vector table, you do not need the specify a fixed address. In this case the linker determines the address
and patches the vector table. There are however situations were you have to specify a fixed ROM address:

 If _START is the entry point upon reset. Typically you would set the ROM address to the address which
is mapped at address 0x00000000. Your initialization code remaps this address during startup. Note
that the reset handler in the run-time library is immune to this remapping because the first instruction
in the startup code sets the program counter to the actual ROM address.

» When the reset handler is called from the vector table with a branch instruction (B _START) and the
linker has located the reset handler at an address that is out-of-range of the branch instruction. When
you specify a fixed ROM address you can make sure that the reset handler can be called from the
vector table. Note however that you can prevent out-of-range branches by using a position independent
vector table, which loads the handler addresses into the program counter by means of a PC-relative
load from a literal pool.

Reset handler on fixed ROM address (all architectures)

To force the reset handler on a fixed ROM address, you need to define the symbol __ START. This symbol
is used in the linker script file ar m_ar ch. | sl . By default, __ START is not defined.
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To define a symbol for the linker script file

1. From the Project menu, select Properties for

The Properties dialog appears.

2. Inthe left pane, expand C/C++ Build and select Settings.

In the right pane the Settings appear.

3. Select Linker » Script File.

The Defined symbols box shows the symbols that are currently defined.

4. To define a new symbol, click on the Add button in the Defined symbols box.

5. Type the symbol definition (for example, __START=0x0).

The following table contains an overview of the defines you can set. The defines are used in

armarch.|sl.

Define

Description

__START

Reset handler ROM address

__PROCESSOR_MODE

Main application execution mode. Default value is Ox1F (SYS
mode).

__IRQ_BIT If 0, IRQ interrupts are enabled. The default value is 0x80 (IRQ
disabled).
__FIQ_BIT If 0, FIQ interrupts are enabled. The default value is 0x40 (FIQ

disabled).

__NO_AUTO_VECTORS

If defined, the vector table will not be generated.

__NO_DEFAULT_AUTO_VECTORS

If defined, the vector table will not be generated.

__NR_OF_VECTORS

Number of vectors (default 16).

__PIC_VECTORS

If defined, position independent vectors are used.

__FIQ_HANDLER_INLINE

If defined, the FIQ handler is located directly at the FIQ vector
(position dependent vector table only).

__VECTOR_TABLE_ROM_ADDR

Address of the vector table in ROM (default 0x00000000).

__VECTOR_TABLE_RAM_SPACE

If defined, space must be reserved for a copy of the vector table
in RAM.

__VECTOR_TABLE_RAM_ADDR

Address of the copy of the vector table in RAM (default
0x00000000).

__VECTOR_TABLE_RAM_COPY

If defined, the linker provides copy address symbols so that the
startup code can copy the vector table from ROM to RAM.
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Main application execution mode (all architectures except M-profile)

With the symbol __ PROCESSOR_MODE you can define the execution mode in which the processor should
run when your application's main program is called. Based on this setting, together with the interrupt
status (FIQ interrupts enabled/disabled, IRQ interrupts enabled/disabled), the linker will generate a symbol
(_APPLI CATI ON_MODE ) which value is used in the startup code in the run-time library to set the value
of the CPSR status register before calling your main function. Available values:

Value Description

0x10 USR mode

0x11 FIQ mode

0x12 IRQ mode

0x13 SVC mode

0x17 ABT mode

0x1B UND mode

Ox1F SYS mode (default)

Interrupt Status (all architectures except M-profile)

Itis common use to start with interrupts disabled (__| RQ Bl T=0x80 and __FI Q Bl T=0x40) and enable
interrupt during run-time after installing all exception handlers and initializing all peripherals. To enable
interrupts during run-time, use the __set cpsr () intrinsic:

__setcpsr (0x00, 0x80); /* Enable IRQinterrupts */
__setcpsr (0x00, 0x40); /* Enable FIQinterrupts */

If you want to start with interrupts enabled, set the define the symbols __| RQ Bl T=0 and/or __FI Q _BI T=0.

Vector table

By default the linker can generate a vector table, unless you define the symbol __ NO_AUTO_VECTORS
or __NO DEFAULT_AUTO VECTORS.

The linker will look for specific symbols designating the start of a handler function. These symbols are
generated by the compiler when one of the following function qualifiers is used:

Function type qualifier |Vector symbol
__interrupt_und _vector_1
__interrupt_svc _vector_2 (¥)
__interrupt_iabt _vector_3
__interrupt_dabt _vector_4
__interrupt_irq _vector_6
__interrupt_fiq _vector_7
__interrupt(n) _vector_n
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(*) For M-profile architecture the __i nt errupt _sw qualifier is mapped to _vect or _11. Function
qualifier __interrupt _sw isequalto__interrupt_svc.

Note that the reset handler is designated by the symbol _START instead of _vect or _0. The fifth vector,
with symbol _vect or _5 is reserved. You should use the same vector symbols in hand-coded assembly
handlers. You may first want to generate an idle handler in C with the compiler and than use the result
as a starting point for your assembly implementation. If the linker does not find the symbol for a handler,
it will generate a loop for the corresponding vector, i.e. a jump to itself.

Note that if you have more than one handler for the same exception, for example for different IRQ's or
for different run-time phases of your application, and you are using the __i nt er r upt _type function
qualifier of the compiler, you will need to specify the __novect or attribute in order to prevent the compiler
from generating the _vect or _nr symbol multiple times, as this would lead to a link error.

Vector table size (M-profile architectures)

The vector table size for M-profile architectures is calculated as 4 times the number of vectors. The default
number of vectors is 16, but you can specify another value by defining the symbol __NR_OF VECTCRS.

Vector table versions (all architectures except M-profile)
You can select between two versions of the vector table: position dependent or position independent.

The position dependent table contains branch instructions to the handlers. The handlers must be located
in-range of the branch instructions. The size of the table is 32 bytes. This is the default.

The position independent table contains PC-relative load instructions of the PC. The handler addresses
are in a literal pool (data pocket) following the vector table. There are no range restrictions. The size of
the table and pool together is 64 bytes.

A position independent table is recommended if the table is copied from ROM to RAM at run-time or if
the ROM table is re-mapped to address 0x00000000 after startup.

To select a position independent vector table, define the symbol __PI C_VECTORS.

FIQ handler at FIQ vector (all architectures except M-profile)

If you selected a position dependent vector table (this is the default), it is possible to locate the FIQ handler
directly at the FIQ vector, since the FIQ vector is the last vector in the table. To do this, define the symbol
__FI Q_HANDLER_I NLI NE. Doing so saves a branch instruction when servicing a fast interrupt. The
generated vector table or the space reserved for the table will be 28 bytes instead of 32.

This option is not available for a position independent vector table. Note that you need to use the __at ()
attribute to specify the actual position of the FIQ handler.

Vector table ROM address (all architectures)
The ROM address of the vector table is usually address 0x00000000. You have to specify an address if

the vector table will be copied from ROM to RAM (address 0x00000000 is mapped to RAM) or if the
hardware uses high vectors at address OxFFFF000O. If you forced the reset handler on address
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0x00000000 then you also have to specify a vector table ROM address to prevent overlapping address
ranges.

By default, the symbol __ VECTOR_TABLE ROM ADDR s defined as 0x00000000.
Reserve RAM space for copy of vector table (all architectures except
M-profile)

You can ask the linker to reserve space in RAM memory for a copy of the vector table at run-time at a
certain address in memory. Typically this would be the address which will be the mapping of address
0x00000000 after ROM/RAM re-mapping. If you reserve space for a copy you can also let the startup
code copy the table automatically from ROM to RAM, but only if position independent vectors are used.

By default, the symbol __ VECTOR_TABLE_RAM SPACE is not defined.

Vector table RAM address (all architectures except M-profile)

With the define __ VECTOR_TABLE_RAM ADDR you can set the address in RAM of the copy of the vector
table (default 0x00000000).

Copy of vector table in RAM (all architectures except M-profile)

If you define the symbol __ VECTOR_TABLE_RAM COPY, the linker will provide copy address symbols
that will be used by the startup code to copy the vector table from ROM to RAM.

Refer to the run-time library implementation of the __i ni t _vect or _t abl e routine in
lib\src\initvectortabl e.asmorinitvectortabl e t hunb. asmfor more information.

9.3. CMSIS Support

The interrupt vector table, required for CMSIS, is defined in device specific LSL files. These LSL files are
available in the i ncl ude. | sl directory of the product installation directory. Device LSL files are similarly
named as the CMSIS header files. For example when you use st n82f 10x. h the LSL file st n82f 10x. | sl
is available. The device LSL files include the file ar m_ar ch. | sl .You can control the allocated amount
of flash and SRAM by using defines for the linker. The names of these defines vary per device.

The following table contains an overview of the defines you can set.

Vector table defines

Define Description

__NO_DEFAULT_AUTO_VECTORS |If defined, the default vector table will not be generated.
__CMSIS_VECTORS If defined, the CMSIS vector table will be generated.
__NR_OF_VECTORS Number of vectors.

__COPY_VECTOR_TABLE If defined, the vector table is copied from ROM to RAM at startup.
_ VECTOR_TABLE_ROM_ADDR Address of the vector table in ROM.
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Define

Description

__VECTOR_TABLE_RAM_SPACE

If defined, space must be reserved for a copy of the vector table
in RAM.

__VECTOR_TABLE_RAM_ADDR

Address of the copy of the vector table in RAM.

__VECTOR_TABLE_RAM_COPY

If defined, the linker provides copy address symbols so that the
startup code can copy the vector table from ROM to RAM.

Memory defines

Define Description

__ROM_SIZE Size of ROM memory to be allocated.

_ RAM_SIZE Size of RAM memory to be allocated.

_ FLASH_SIZE Size of the flash memory to be allocated.
__SRAM_SIZE Size of the SRAM memory to be allocated.

__CPU_SRAM_SIZE |Size of the SRAM memory to be allocated.

is not defined.

__AHB_SRAMO_SIZE |Size of the AHH SRAM bank Omemory. The memory is not allocated if this macro

__AHB_SRAM1_SIZE |Size of the AHH SRAM bank 1 memory. The memory is not allocated if this
macro is not defined.

An example of the invocation of the linker (using the control program):

ccarm - CARM/7M "instal l ati on_dir\include.|sl\stnm32f10x.1sl"

-W-D__FLASH S| ZE=128k

-W-D__SRAM SI ZE=20k fil e. obj

When you create a new project in Eclipse the LSL template file will be copied to the project. Eclipse will
pass device specific macro definitions to the linker, depending on the device selected in the Project »
Properties for » C/C++ Build » Processor properties page. This way the project LSL file will include
the appropriate device LSL file and memories are mapped as required for the selected device.

9.4. Stack and Heap

The stack is used for local automatic variables and function parameters. The following diagram shows

the structure of a stack frame.
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All ARM architectures, except for M-profile architectures, have separate stack pointers for each processor
mode. M-profile architectures have one stack pointer. These stack pointers should be initialized at run-time.
This is taken care of by the startup code in the run-time library, by means of linker-generated symbols
defined in the LSL file. See Section 9.1, Startup Code, for a list of these symbols.

You can define the values of these symbols in Eclipse as follows.

1. From the Project menu, select Properties for

The Properties dialog appears.

In the left pane, expand C/C++ Build and select Stack/Heap.

In the right pane the Stack/Heap property page appears.
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W Properties for myproject

Resource
Builders
= CfC++ Build
Build ¥ariables
Discavery Options
Enviranment
Logging
Memary
Pracessor
Settings

Stack/Heap
CIC++ General
Project References
Refactoring History
RunfDebug Settings

Stack/Heap [=1d -
Configuration: |Debug [ Active ] -
Type Marme Size: Address
[ heap heap 2k
lﬁ skack stack 4k

® Settings are stored in the project Il file: myproject, |s|

Restore Defaults Apply

3. Make your changes and click OK.

The project LSL file is updated automatically according to the changes you make.

You can specify the size and location of the stacks.

The stack size is defined in the linker script file (ar m_ar ch. | sl indirectoryi ncl ude. | sl ) with macros:

Define Description

__STACK Size of user stack.

__STACK_ABT Abort mode stack size. (*)

__STACK_FIQ FIQ mode stack size. (*)

_ STACK_IRQ IRQ mode stack size. (*)

__STACK_SVC Supervisor mode stack size. (*)

__ STACK_UND Undefined mode stack size. (*)

__STACK_FIXED Defined if you do not expand the user stack if space is left.
__STACKADDR User stack start address.

(*) The defines marked with a * are not used for M-profile architectures.
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Heap allocation

The heap is only needed when you use one or more of the dynamic memory management library functions:
mal | oc(),cal loc(),free() andreal |l oc().The heap is a reserved area in memory. Only if you
use one of the memory allocation functions listed above, the linker automatically allocates a heap, as
specified in the linker script file with the keyword heap.

A special section called heap is used for the allocation of the heap area. The size of the heap is defined
in the linker script file (ar m_ar ch. | sl indirectoryi ncl ude. | sl ) with the macro __HEAP, which results
in a section called heap. The linker defined labels _| ¢c_ub_heap and _| c_ue_heap (begin and end of
heap) are used by the library function sbr k() , which is called by mal | oc() when memory is needed
from the heap.

The following heap macros are used in ar m_ar ch. | sl :

Define Description

__HEAP Size of heap.

_ HEAP_FIXED Defined if you do not expand the heap if space is left.
_ _HEAPADDR Heap start address.
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Chapter 10. Using the Utilities

The TASKING VX-toolset for ARM comes with a number of utilities:

ccarm A control program. The control program invokes all tools in the toolset and lets you quickly
generate an absolute object file from C and/or assembly source input files. Eclipse uses
the control program to call the compiler, assembler and linker.

mkarm A utility program to maintain, update, and reconstruct groups of programs. The make utility
looks whether files are out of date, rebuilds them and determines which other files as a
consequence also need to be rebuilt.

amk The make utility which is used in Eclipse. It supports parallelism which utilizes the multiple
cores found on modern host hardware.

ararm An archiver. With this utility you create and maintain library files with relocatable object
modules (. obj ) generated by the assembler.

hldumparm A high level language (HLL) object dumper. With this utility you can dump information about
an absolute object file (. abs) . Key features are a disassembler with HLL source intermixing
and HLL symbol display and a HLL symbol listing of static and global symbols.

expirearm A utility to limit the size of the cache by removing all files older than a few days or by
removing older files until the total size of the cache is smaller than a specified size.

10.1. Control Program

The control program is a tool that invokes all tools in the toolset for you. It provides a quick and easy way
to generate the final absolute object file out of your C/C++ sources without the need to invoke the compiler,
assembler and linker manually.

Eclipse uses the control program to call the C++ compiler, C compiler, assembler and linker, but you can
call the control program from the command line. The invocation syntax is:

ccarm|[ [option]... [file]... ]...

Recognized input files

» Fileswitha. cc, . cxx or. cpp suffix are interpreted as C++ source programs and are passed to the
C++ compiler.

» Files with a . ¢ suffix are interpreted as C source programs and are passed to the compiler.

» Files with a . asmsuffix are interpreted as hand-written assembly source files which have to be passed
to the assembler.

» Files with a . sr ¢ suffix are interpreted as compiled assembly source files. They are directly passed to
the assembler.

» Fileswith a . | i b suffix are interpreted as library files and are passed to the linker.

» Files with a . obj suffix are interpreted as object files and are passed to the linker.
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» Files with a . out suffix are interpreted as linked object files and are passed to the locating phase of
the linker. The linker accepts only one . out file in the invocation.

» Fileswith a . | sl suffix are interpreted as linker script files and are passed to the linker.
Options

The control program accepts several command line options. If you specify an unknown option to the
control program, the control program looks if it is an option for a specific tool. If so, it passes the option
directly to the tool. However, it is recommended to use the control program options --pass-* (-Wcp, -Wc,
-Wa, -WI) to pass arguments directly to tools.

For a complete list and description of all control program options, see Section 13.6, Control Program
Options.

Example with verbose output
ccarm --verbose test.c

The control program calls all tools in the toolset and generates the absolute object file t est . abs. With
option --verbose (-v) you can see how the control program calls the tools:

+ "path\carm -0 cc3248a.src test.c

+ "path\asarn -0 cc3248b. obj cc3248a. src

+ "path\l karm' ¢cc3248b.obj -0 test.abs --map-file
-lcarm-Ilfparm-Ilrtarnt

The control program produces unique filenames for intermediate steps in the compilation process (such

as cc3248a. src and cc3248b. obj in the example above) which are removed afterwards, unless you
specify command line option --keep-temporary-files (-t).

Example with argument passing to a tool
ccarm --pass-conpiler=-Cc test.c

The option -Oc is directly passed to the compiler.
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10.2. Make Utility mkarm

If you are working with large quantities of files, or if you need to build several targets, it is rather
time-consuming to call the individual tools to compile, assemble, link and locate all your files.

You save already a lot of typing if you use the control program and define an options file. You can even
create a batch file or script that invokes the control program for each target you want to create. But with
these methods all files are completely compiled, assembled and linked to obtain the target file, even if
you changed just one C source. This may demand a lot of (CPU) time on your host.

The make utility mkarm is a tool to maintain, update, and reconstruct groups of programs. The make
utility looks which files are out-of-date and only recreates these files to obtain the updated target.

Make process

In order to build a target, the make utility needs the following input:

« the target it should build, specified as argument on the command line
* the rules to build the target, stored in a file usually called makefil e

In addition, the make utility also reads the file mkar m mk which contains predefined rules and
macros. See Section 10.2.2, Writing a Makefile.

The makef i | e contains the relationships among your files (called dependencies) and the commands
that are necessary to create each of the files (called rules). Typically, the absolute object file (. abs) is
updated when one of its dependencies has changed. The absolute file depends on . obj files and libraries
that must be linked together. The . obj files on their turn depend on . sr c files that must be assembled
and finally, . sr c files depend on the C source files (. ¢) that must be compiled. In the nakef i | e this
looks like:

test.src : test.c # dependency
carmtest.c #rule

test.obj : test.src
asarmtest.src

test.abs : test.obj
lkarmtest.obj -o test.abs --map-file -lcarm-Ifparm-Ilrtarm

You can use any command that is valid on the command line as a rule in the makefi | e. So, rules are
not restricted to invocation of the toolset.

Example

To build the target t est . abs, call mkarm with one of the following lines:
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nkarm t est. abs

nkar m - f mymake. mak test. abs

By default the make utility reads the file makef i | e so you do not need to specify it on the command line.
If you want to use another name for the makefile, use the option -f.

If you do not specify a target, mkarm uses the first target defined in the makefile. In this example it would
build t est . src instead of t est . abs.

Based on the sample invocation, the make utility now tries to build t est . abs based on the makefile and
performs the following steps:

1. From the makefile the make utility reads that t est . abs depends ont est. obj .

2. Ift est. obj does not exist or is out-of-date, the make utility first tries to build this file and reads from
the makefile thatt est . obj dependsontest. src.

3. Ift est. src does exist, the make utility now creates t est . obj by executing the rule for it: asar m
test.src.

4. There are no other files necessary to create t est . abs so the make utility now can use t est . obj to
create t est . abs by executing the rule: | karm test. obj -o test.abs ...

The make utility has now built t est . abs but it only used the assembler to update t est . obj and the
linker to create t est . abs.

If you compare this to the control program:
ccarmtest.c

This invocation has the same effect but now all files are recompiled (assembled, linked and located).

10.2.1. Calling the Make Utility

You can only call the make utility from the command line. The invocation syntax is:
nmkarm [ [option]... [target]... [macro=def]... ]
For example:

nkarm t est . abs

target You can specify any target that is defined in the makefile. A target can also be one
of the intermediate files specified in the makefile.

macro=def Macro definition. This definition remains fixed for the mkarm invocation. It overrides
any regular definitions for the specified macro within the makefiles and from the
environment. It is inherited by subordinate mkarm's but act as an environment variable
for these. That is, depending on the -e setting, it may be overridden by a makefile
definition.
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option For a complete list and description of all make utility options, see Section 13.7, Make
Utility Options.

Exit status

The make utility returns an exit status of 1 when it halts as a result of an error. Otherwise it returns an
exit status of 0.

10.2.2. Writing a Makefile

In addition to the standard makefile makef i | e, the make utility always reads the makefile mkar m nk
before other inputs. This system makefile contains implicit rules and predefined macros that you can use
in the makefile makefil e.

With the option -r (Do not read the mkar m rrk file) you can prevent the make utility from reading nmkar m k.

The default name of the makefile is makef i | e in the current directory. If you want to use another makefile,
use the option -f.

The makefile can contain a mixture of:

« targets and dependencies

* rules

« macro definitions or functions

* conditional processing

e comment lines

* include lines

e export lines

To continue a line on the next line, terminate it with a backslash (\):

# this cooment |ine is continued\
on the next line

If a line must end with a backslash, add an empty macro:

# this coment line ends with a backslash \ $( EMPTY)
# this is a newline

10.2.2.1. Targets and Dependencies

The basis of the makefile is a set of targets, dependencies and rules. A target entry in the makefile has
the following format:
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target ... : [dependency ...] [; rule]
[rule]

Target lines must always start at the beginning of a line, leading white spaces (tabs or spaces) are not
allowed. A target line consists of one or more targets, a semicolon and a set of files which are required
to build the target (dependencies). The target itself can be one or more filenames or symbolic names:

all: deno. abs final.abs

deno. abs final . abs: test.obj deno.obj final.obj

You can now can specify the target you want to build to the make utility. The following three invocations
all have the same effect:

nkar m
nkarm al |
nkar m deno. abs final . abs

If you do not specify a target, the first target in the makefile (in this example al | ) is built. The target al |
depends on denp. abs and fi nal . abs so the second and third invocation have the same effect and
the files denp. abs and f i nal . abs are built.

You can normally use colons to denote drive letters. The following works as intended:
c:foo.obj : a:foo.c

If a target is defined in more than one target line, the dependencies are added to form the target's complete
dependency list:

all: deno. abs # These two |ines are equivalent wth:
all: final.abs # all: denp.abs final.abs

Special targets

There are a number of special targets. Their names begin with a period.

Target Description

. DEFAULT If you call the make utility with a target that has no definition in the makefile, this
target is built.

. DONE When the make utility has finished building the specified targets, it continues with
the rules following this target.

. | GNORE Non-zero error codes returned from commands are ignored. Encountering this in a
makefile is the same as specifying the option -i on the command line.

OANT The rules following this target are executed before any other targets are built.

. PRECI QUS Dependency files mentioned for this target are never removed. Normally, if a

command in a rule returns an error or when the target construction is interrupted,
the make utility removes that target file. You can use the option -p on the command
line to make all targets precious.
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Target Description

. SI LENT Commands are not echoed before executing them. Encountering this in a makefile
is the same as specifying the option -s on the command line.

. SUFFI XES This target specifies a list of file extensions. Instead of building a completely specified
target, you now can build a target that has a certain file extension. Implicit rules to
build files with a number of extensions are included in the system makefile mkar m k.

If you specify this target with dependencies, these are added to the existing
. SUFFI XES target in mkar m nk. If you specify this target without dependencies,
the existing list is cleared.

10.2.2.2. Makefile Rules

A line with leading white space (tabs or spaces) is considered as a rule and associated with the most
recently preceding dependency line. A rule is a line with commands that are executed to build the
associated target. A target-dependency line can be followed by one or more rules.

final.src : final.c # target and dependency
nove test.c final.c # rulel
carmfinal.c # rul e2

You can precede a rule with one or more of the following characters:

@ does not echo the command line, except if -n is used.

- the make utility ignores the exit code of the command. Normally the make utility stops if a
non-zero exit code is returned. This is the same as specifying the option -i on the command
line or specifying the special . | GNORE target.

+ The make utility uses a shell or Windows command prompt (cnd. exe) to execute the
command. If the '+' is not followed by a shell line, but the command is an MS-DOS command
or if redirection is used (<, |, >), the shell line is passed to cnd. exe anyway.

You can force mkarm to execute multiple command lines in one shell environment. This is accomplished
with the token combination ;\'. For example:

cd c:\Tasking\bin ;\
nkarm -V

Note that the ;' must always directly be followed by the '\' token. Whitespace is not removed when it is at
the end of the previous command line or when it is in front of the next command line. The use of the '}’
as an operator for a command (like a semicolon ';' separated list with each item on one line) and the '\'
as a layout tool is not supported, unless they are separated with whitespace.

Inline temporary files
The make utility can generate inline temporary files. If a line contains <<LABEL (no whitespaces!) then

all subsequent lines are placed in a temporary file until the line LABEL is encountered. Next, <<LABEL
is replaced by the name of the temporary file. For example:
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[karm-o0 $@-f <<ECF
$(separate "\n" $(match .obj $!))
$(separate "\n" $(match .lib $!))
$( LKFLAGS)

ECF

The three lines between <<EOF and EOF are written to a temporary file (for example nkce4cOa. t np),
and the rule is rewritten as: | karm -0 $@-f nkce4cOa. t np.

Suffix targets

Instead of specifying a specific target, you can also define a general target. A general target specifies the
rules to generate a file with extension . ex1 to a file with extension . ex2. For example:

. SUFFI XES: .C
. C. obj
ccarm-c $<

Read this as: to build a file with extension . obj out of a file with extension . c, call the control program
with -c $<. $< is a predefined macro that is replaced with the name of the current dependency file. The
special target . SUFFI XES: is followed by a list of file extensions of the files that are required to build the
target.

Implicit rules

Implicit rules are stored in the system makefile mkar m nk and are intimately tied to the . SUFFI XES
special target. Each dependency that follows the . SUFFI XES target, defines an extension to a filename
which must be used to build another file. The implicit rules then define how to actually build one file from
another. These files share a common basename, but have different extensions.

If the specified target on the command line is not defined in the makefile or has not rules in the makefile,
the make utility looks if there is an implicit rule to build the target.

Example:

LIB = -lcarm-lfparm-Ilrtarm # macro

prog. abs: prog. obj sub. obj
| kar m prog. obj sub.obj $(LIB) -o prog. abs

prog.obj: prog.c inc.h

carm prog.c
asarm prog. src

sub. obj : sub.c inc.h
carm sub.c
asarm sub. src

This makefile says that pr og. abs depends on two files pr og. obj and sub. obj , and that they in turn
depend on their corresponding source files (pr og. ¢ and sub. ¢) along with the common file i nc. h.

The following makefile uses implicit rules (from mkar m nk) to perform the same job.
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LDFLAGS = -lcarm-Ifparm-lrtarm # macro used by inplicit rules
prog. abs: prog.obj sub. obj # inplicit rule used
prog.obj: prog.c inc.h # inplicit rule used
sub.obj: sub.c inc.h # inplicit rule used

10.2.2.3. Macro Definitions

A macro is a symbol name that is replaced with its definition before the makefile is executed. Although
the macro name can consist of lowercase or uppercase characters, uppercase is an accepted convention.
The general form of a macro definition is:

MACRO = t ext
MACRO += and nore text

Spaces around the equal sign are not significant. With the += operator you can add a string to an existing
macro. An extra space is inserted before the added string automatically.

To use a macro, you must access its contents:

$( MACRO) # you can read this as
${ MACRO} # the contents of macro MACRO

If the macro name is a single character, the parentheses are optional. Note that the expansion is done
recursively, so the body of a macro may contain other macros. These macros are expanded when the
macro is actually used, not at the point of definition:

FOOD = $(EAT) and $( DRI NK)
EAT = neat and/or vegetabl es
DRI NK = wat er

export FOOD

The macro FOODis expanded as neat and/ or veget abl es and wat er atthe momentitis used in
the export line, and the environment variable FOOD is set accordingly.

Predefined macros

Macro Description

MAKE Holds the value mkarm. Any line which uses MAKE, temporarily overrides the option
-n (Show commands without executing), just for the duration of the one line. This way
you can test nested calls to MAKE with the option -n.

MAKEFLAGS Holds the set of options provided to mkarm (except for the options -f and -d). If this
macro is exported to set the environment variable MAKEFLAGS, the set of options is
processed before any command line options. You can pass this macro explicitly to
nested mkarm's, but it is also available to these invocations as an environment variable.
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Macro Description

PRODDI R Holds the name of the directory where mkarm is installed. You can use this macro to
refer to files belonging to the product, for example a library source file.

DOPRI NT = $(PRODDI R)/ i b/src/_doprint.c
When mkarm is installed in the directory c: / Taski ng/ bi n this line expands to:

DOPRI NT = c:/ Tasking/lib/src/_doprint.c

SHELLCMD Holds the default list of commands which are local to the SHELL. If a rule is an
invocation of one of these commands, a SHELL is automatically spawned to handle
it.

$ This macro translates to a dollar sign. Thus you can use "$$" in the makefile to represent
a single "$".

Dynamically maintained macros

There are several dynamically maintained macros that are useful as abbreviations within rules. It is best
not to define them explicitly.

Macro Description

$* The basename of the current target.

$< The name of the current dependency file.

$@ The name of the current target.

$? The names of dependents which are younger than the target.
$! The names of all dependents.

The $< and $* macros are normally used for implicit rules. They may be unreliable when used within
explicit target command lines. All macros may be suffixed with F to specify the Filename components
(e.g. ${*F}, ${ @} ). Likewise, the macros $*, $< and $@ may be suffixed by D to specify the Directory
component.

The result of the $* macro is always without double quotes ("), regardless of the original target having
double quotes (") around it or not.

The result of using the suffix F (Filename component) or D (Directory component) is also always without
double quotes ("), regardless of the original contents having double quotes () around it or not.

10.2.2.4. Makefile Functions

A function not only expands but also performs a certain operation. Functions syntactically look like macros
but have embedded spaces in the macro name, e.g. '$(match argl arg2 arg3)'. All functions are built-in
and currently these are: mat ch, separ at e, pr ot ect, exi st ,nexi st and addpr ef i x.

$(match suffix filename ...)

The mat ch function yields all arguments which match a certain suffix:
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$(match .obj prog.obj sub.obj nylib.lib)
yields:

prog. obj sub. obj

$(separate separator argument ...)

The separ at e function concatenates its arguments using the first argument as the separator. If the first
argument is enclosed in double quotes then \n' is interpreted as a newline character, \t' is interpreted as
atab, "\ooo'is interpreted as an octal value (where, 000 is one to three octal digits), and spaces are taken
literally. For example:

$(separate "\ n" prog.obj sub. obj)
results in:

pr og. obj
sub. obj

Function arguments may be macros or functions themselves. So,

$(separate "\n" $(match .obj $!))

yields all object files the current target depends on, separated by a newline string.
$(protect argument)

The pr ot ect function adds one level of quoting. This function has one argument which can contain white
space. If the argument contains any white space, single quotes, double quotes, or backslashes, it is
enclosed in double quotes. In addition, any double quote or backslash is escaped with a backslash.

Example:

echo $(protect 1'Il show you the "protect" function)
yields:

echo "I'lIl show you the \"protect\" function”

$(exist file | directory argument)

The exi st function expands to its second argument if the first argument is an existing file or directory.
Example:

$(exist test.c ccarmtest.c)

When the file t est . c exists, it yields:

ccarmtest.c

When the file t est . ¢ does not exist nothing is expanded.
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$(nexist file|directory argument)

The nexi st function is the opposite of the exi st function. It expands to its second argument if the first
argument is not an existing file or directory.

Example:

$(nexi st test.src ccarmtest.c)

$(addprefix prefix, argument ...)

The addpr ef i x function adds a prefix to its arguments. It is used in nkar m nk for invocation of the
control program to pass arguments directly to a tool.

Example:

ccarm $(addprefix -W, -gl -Q2) test.c
yields:

ccarm-W-gl -W-Q2 test.c

10.2.2.5. Conditional Processing

Lines containing i f def , i f ndef, el se or endi f are used for conditional processing of the makefile.
They are used in the following way:

i fdef macro-nane

if-lines
el se

el se-1ines
endi f

The if-lines and else-lines may contain any number of lines or text of any kind, even otheri f def ,i f ndef ,
el se and endi f lines, or no lines at all. The el se line may be omitted, along with the else-lines following
it.

First the macro-name after the i f def command is checked for definition. If the macro is defined then
the if-lines are interpreted and the else-lines are discarded (if present). Otherwise the if-lines are discarded;
and if there is an el se line, the else-lines are interpreted; but if there is no else line, then no lines are
interpreted.

When you use the i f ndef line instead of i f def , the macro is tested for not being defined. These
conditional lines can be nested up to 6 levels deep.

You can also add tests based on strings. With i f eq the result is true if the two strings match, with i f neq
the result is true if the two strings do not match. They are used in the following way:

i feq(stringl, string2)

if-lines
el se
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el se-1ines
endi f

10.2.2.6. Comment, Include and Export Lines

Comment lines

Anything after a "#" is considered as a comment, and is ignored. If the "#" is inside a quoted string, it is
not treated as a comment. Completely blank lines are ignored.

test.src : test.c # this is conmment and is
ccarmtest.c # ignored by the nake utility

Include lines

An include line is used to include the text of another makefile (like including a . h file in a C source).
Macros in the name of the included file are expanded before the file is included. You can include several
files. Include files may be nested.

i ncl ude nakefil e2 nakefile3

Export lines

An export line is used to export a macro definition to the environment of any command executed by the
make utility.

GREETING = Hel | 0
export GREETI NG

This example creates the environment variable GREETI NG with the value Hel | 0. The macro is exported
at the moment the export line is read so the macro definition has to precede the export line.
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10.3. Make Utility amk

amk is the make utility Eclipse uses to maintain, update, and reconstruct groups of programs. But you
can also use it on the command line. Its features are a little different from mkarm. The main difference
compared to mkarm and other make utilities, is that amk features parallelism which utilizes the multiple
cores found on modern host hardware, hardening for path names with embedded white space and it has
an (internal) interface to provide progress information for updating a progress bar. It does not use an
external command shell (/ bi n/ sh, cd. exe) but executes commands directly.

The primary purpose of any make utility is to speed up the edit-build-test cycle. To avoid having to build
everything from scratch even when only one source file changes, it is necessary to describe dependencies
between source files and output files and the commands needed for updating the output files. This is
done in a so called "makefile”.

10.3.1. Makefile Rules

A makefile dependency rule is a single line of the form:
[target ...] : [prerequisite ...]

where target and prerequisite are path names to files. Example:
test.obj : test.c

This states that target t est . obj depends on prerequisite t est . c. So, whenever the latter is modified
the first must be updated. Dependencies accumulate: prerequisites and targets can be mentioned in
multiple dependency rules (circular dependencies are not allowed however). The command(s) for updating
a target when any of its prerequisites have been modified must be specified with leading white space
after any of the dependency rule(s) for the target in question. Example:

t est. obj
ccarmtest.c # | eadi ng white space

Command rules may contain dependencies too. Combining the above for example yields:

test.obj : test.c
ccarmtest.c

White space around the colon is not required. When a path name contains special characters such as
"', '#' (start of comment), '=' (macro assignment) or any white space, then the path name must be enclosed
in single or double quotes. Quoted strings can contain anything except the quote character itself and a
newline. Two strings without white space in between are interpreted as one, so it is possible to embed
single and double quotes themselves by switching the quote character.

When a target does not exist, its modification time is assumed to be very old. So, amk will try to make it.
When a prerequisite does not exist possibly after having tried to make it, it is assumed to be very new.
So, the update commands for the current target will be executed in that case. amk will only try to make
targets which are specified on the command line. The default target is the first target in the makefile which
does not start with a dot.
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Static pattern rules

Static pattern rules are rules which specify multiple targets and construct the prerequisite names for each
target based on the target name.

[target ...] : target-pattern : [prerequisite-patterns ...]

The target specifies the targets the rules applies to. The target-pattern and prerequisite-patterns specify
how to compute the prerequisites of each target. Each target is matched against the target-pattern to
extract a part of the target name, called the stem. This stem is substituted into each of the
prerequisite-patterns to make the prerequisite names (one from each prerequisite-pattern).

Each pattern normally contains the character '%' just once. When the target-pattern matches a target,
the '%' can match any part of the target name; this part is called the stem. The rest of the pattern must
match exactly. For example, the target f 00. obj matches the pattern '% obj ', with 'f 0o' as the stem.

The targets f 00. ¢ and f 00. abs do not match that pattern.

The prerequisite names for each target are made by substituting the stem for the '%' in each prerequisite
pattern.

Example:

objects = test.obj filter. obj
all: $(objects)

$(objects): %obj: %c
ccarm-c $< -0 $@
echo the stemis $*

Here '$<' is the automatic variable that holds the name of the prerequisite, '$@is the automatic variable
that holds the name of the target and '$*' is the stem that matches the pattern. Internally this translates
to the following two rules:

test.obj: test.c
ccarm-c test.c -0 test.obj
echo the stemis test

filter.obj: filter.c
ccarm-c filter.c -o filter. obj
echo the stemis filter

Each target specified must match the target pattern; a warning is issued for each target that does not.

249



TASKING VX-toolset for ARM User Guide

Special targets

There are a number of special targets. Their names begin with a period.

Target Description

. DEFAULT If you call the make utility with a target that has no definition in the makefile, this
target is built.

. DONE When the make utility has finished building the specified targets, it continues with
the rules following this target.

JANT The rules following this target are executed before any other targets are built.

. PHONY The prerequisites of this target are considered to be phony targets. A phony target

is a target that is not really the name of a file. The rules following a phony target are
executed unconditionally, regardless of whether a file with that name exists or what
its last-modification time is.

For example:
. PHONY: cl ean
cl ean:
rm *. obj

With ank cl ean, the command is executed regardless of whether there is a file
named cl ean.

10.3.2. Makefile Directives

Directives inside makefiles are executed while reading the makefile. When a line starts with the word

"i ncl ude" or "-i ncl ude" then the remaining arguments on that line are considered filenames whose
contents are to be inserted at the current line. "- i ncl ude" will silently skip files which are not present.
You can include several files. Include files may be nested.

Example:
i ncl ude nakefil e2 nakefile3

White spaces (tabs or spaces) in front of the directive are allowed.

10.3.3. Macro Definitions

A macro is a symbol name that is replaced with its definition before the makefile is executed. Although
the macro name can consist of lowercase or uppercase characters, uppercase is an accepted convention.
When a line does not start with white space and contains the assignment operator '=', ":=' or '+=' then the
line is interpreted as a macro definition. White space around the assignment operator and white space
at the end of the line is discarded. Single character macro evaluation happens by prefixing the name with
'$". To evaluate macros with names longer than one character put the name between parentheses '()' or
curly braces '{}'. Macro names may contain anything, even white space or other macro evaluations.
Example:
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DI NNER = $(FOOD) and $( BEVERAGE)
FOOD = pi zza

BEVERAGE = sparkling water

FOOD += with cheese

With the += operator you can add a string to an existing macro. An extra space is inserted before the
added string automatically.

Macros are evaluated recursively. Whenever $( DI NNER) or ${ DI NNER} is mentioned after the above,

it will be replaced by the text "pi zza wi th cheese and sparkling wat er". The left hand side in

a macro definition is evaluated before the definition takes place. Right hand side evaluation depends on
the assignment operator:

= Evaluate the macro at the moment it is used.

1= Evaluate the replacement text before defining the macro.

Subsequent '+=' assignments will inherit the evaluation behavior from the previous assignment. If there
is none, then '+='is the same as '=". The default value for any macro is taken from the environment. Macro
definitions inside the makefile overrule environment variables. Macro definitions on the amk command
line will be evaluated first and overrule definitions inside the makefile.

Predefined macros

Macro Description

$ This macro translates to a dollar sign. Thus you can use "$$" in the makefile to represent
a single "$".

@ The name of the current target. When a rule has multiple targets, then it is the name

of the target that caused the rule commands to be run.

* The basename (or stem) of the current target. The stem is either provided via a static
pattern rule or is calculated by removing all characters found after and including the
last dot in the current target name. If the target name is 't est . ¢' then the stem is

't est ' (if the target was not created via a static pattern rule).

< The name of the first prerequisite.

MAKE The amk path name (quoted if necessary). Optionally followed by the options -n and
-S.

CRIG N The name of the directory where amk is installed (quoted if necessary).

SUBDI R The argument of option -G. If you have nested makes with -G options, the paths are

combined. This macro is defined in the environment (i.e. default macro value).

The @, * and < macros may be suffixed by 'D' to specify the directory component or by 'F' to specify the
filename component. $( @) evaluates to the directory name holding the file$( @) . $( @) / $( @) is
equivalent to $@ Note that on MS-Windows most programs accept forward slashes, even for UNC path
names.

The result of the predefined macros @, * and < and 'D' and 'F' variants is not quoted, so it may be necessary
to put quotes around it.
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Note that stem calculation can cause unexpected values. For example:

$@ $*

/hone/ . wi ne/test / hone/

/ hone/ test/. project [ hone/ test/
/.. /file /.

Macro string substitution
When the macro name in an evaluation is followed by a colon and equal sign as in
$(MACRO stringl=string2)

then amk will replace stringl at the end of every word in $( MACRO) by string2 during evaluation. When
$( MACRO) contains quoted path names, the quote character must be mentioned in both the original string
and the replacement stringl. For example:

$(MACRQ . obj "=.d")

10.3.4. Makefile Functions

A function not only expands but also performs a certain operation. The following functions are available:

$(filter pattern ...,item ...)

The filter function filters a list of items using a pattern. It returns items that do match any of the pattern
words, removing any items that do not match. The patterns are written using '%,

${filter %c %h, test.c test.h test.obj readnme.txt .project output.c}
results in:

test.c test.h output.c

$(filter-out pattern ...,item ...)

The fil ter-out function returns all items that do not match any of the pattern words, removing the
items that do match one or more. This is the exact opposite of the fi | t er function.

${filter-out %c %h, test.c test.h test.obj readnme.txt .project output.c}
results in:

test.obj readme.txt .project

1Intemally, amk tokenizes the evaluated text, but performs substitution on the original input text to preserve compatibility here with
existing make implementations and POSIX.
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$(foreach var-name, item ..., action)

The f or each function runs through a list of items and performs the same action for each item. The
var-name is the name of the macro which gets dynamically filled with an item while iterating through the
item list. In the action you can refer to this macro. For example:

${foreach T, test filter output, ${T}.c ${T}.h}
results in:

test.c test.h filter.c filter.h output.c output.h

10.3.5. Conditional Processing

Lines containing i f def , i f ndef, el se or endi f are used for conditional processing of the makefile.
They are used in the following way:

i fdef macro-nane

if-lines
el se

el se-1ines
endi f

The if-lines and else-lines may contain any number of lines or text of any kind, even otheri f def ,i f ndef,
el se and endi f lines, or no lines at all. The el se line may be omitted, along with the else-lines following
it. White spaces (tabs or spaces) in front of preprocessing directives are allowed.

First the macro-name after the i f def command is checked for definition. If the macro is defined then
the if-lines are interpreted and the else-lines are discarded (if present). Otherwise the if-lines are discarded;
and if there is an el se line, the else-lines are interpreted; but if there is no else line, then no lines are
interpreted.

When you use the i f ndef line instead of i f def , the macro is tested for not being defined. These
conditional lines can be nested to any level.

You can also add tests based on strings. With i f eq the result is true if the two strings match, with i f neq
the result is true if the two strings do not match. They are used in the following way:

i feq(stringl, string2)

if-lines
el se

el se-1ines
endi f

10.3.6. Makefile Parsing

amk reads and interprets a makefile in the following order:

1. When the last character on a line is a backslash (\) (i.e. without trailing white space) then that line and
the next line will be concatenated, removing the backslash and newline.
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. The unquoted '#' character indicates start of comment and may be placed anywhere on a line. It will

be removed in this phase.

# this cooment line is continued\
on the next line

. Trailing white space is removed.

. When a line starts with white space and it is not followed by a directive or preprocessing directive, then

it is interpreted as a command for updating a target.

. Otherwise, when a line contains the unquoted text '=", '+="' or ":=" operator, then it will be interpreted as

a macro definition.

. Otherwise, all macros on the line are evaluated before considering the next steps.
. When the resulting line contains an unquoted "' the line is interpreted as a dependency rule.

. When the first token on the line is "i ncl ude" or "- i ncl ude" (which by now must start on the first

column of the line), amk will execute the directive.

Otherwise, the line must be empty.

Macros in commands for updating a target are evaluated right before the actual execution takes place
(or would take place when you use the -n option).

10.3.7. Makefile Command Processing

Al

ine with leading white space (tabs or spaces) without a (preprocessing) directive is considered as a

command for updating a target. When you use the option -j or -J, amk will execute the commands for
updating different targets in parallel. In that case standard input will not be available and standard output
and error output will be merged and displayed on standard output only after the commands have finished

for

atarget.

You can precede a command by one or more of the following characters:

@

+

Do not show the command. By default, commands are shown prior to their output.
Continue upon error. This means that amk ignores a non-zero exit code of the command.
Execute the command, even when you use option -n (dry run).

Execute the command on the foreground with standard input, standard output and error
output available.

Built-in commands

Command Description

true This command does nothing. Arguments are ignored.

fal se This command does nothing, except failing with exit code 1. Arguments are
ignored.

254



Using the Utilities

Command Description
echo arg... Display a line of text.
exit code Exit with defined code. Depending on the program arguments and/or the extra

rule options '-' this will cause amk to exit with the provided code. Please note
that 'exi t 0" has currently no result.

argfil e file arg...

Create an argument file suitable for the --option-file (-f) option of all the other
tools. The first ar gf i | e argument is the name of the file to be created.
Subsequent arguments specify the contents. An existing argument file is not
modified unless necessary. So, the argument file itself can be used to create
a dependency to options of the command for updating a target.

r mfoption]... file...

Remove the specified file(s). The following options are available:

-r, --recursive Remove directories and their contents recursively.

-f, --force Force deletion. Ignore non-existent files, never prompt.
-i, --interactive Interactive. Prompt before every removal.

-v, --verbose Verbose mode. Explain what is being done.

-m file Read options from file..

-?, --help Show usage.

10.3.8. Calling the amk Make Utility

The invocation syntax of amk is:

ank [option]...

For example:

ank test.abs

target

macro=def

option

Exit status

[target]... [rmacro=def]...

You can specify any target that is defined in the makefile. A target can also be one
of the intermediate files specified in the makefile.

Macro definition. This definition remains fixed for the amk invocation. It overrides any
regular definitions for the specified macro within the makefiles and from the
environment. It is not inherited by subordinate amk's

For a complete list and description of all amk make utility options, see Section 13.8,
Parallel Make Utility Options.

The make utility returns an exit status of 1 when it halts as a result of an error. Otherwise it returns an

exit status of 0.
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10.4. Archiver

The archiver ararm is a program to build and maintain your own library files. A library file is a file with
extension . | i b and contains one or more object files (. obj ) that may be used by the linker.

The archiver has five main functions:

» Deleting an object module from the library

» Moving an object module to another position in the library file

» Replacing an object module in the library or add a new object module
» Showing a table of contents of the library file

» Extracting an object module from the library

The archiver takes the following files for input and output:

assemhbler

T
l—— relocatable ohjectfile
—= .Dhj

|

archiver

relocatable object library
] linker

The linker optionally includes object modules from a library if that module resolves an external symbol
definition in one of the modules that are read before.

10.4.1. Calling the Archiver

You can create a library in Eclipse, which calls the archiver or you can call the archiver on the command
line.

To create alibrary in Eclipse

Instead of creating an ARM absolute ELF file, you can choose to create a library. You do this when you
create a new project with the New C/C++ Project wizard.

1. From the File menu, select New » TASKING VX-toolset for ARM C/C++ Project.
The New C/C++ Project wizard appears.

2. Enter a project name.

3. Inthe Project type box, select TASKING ARM Library and clickNext >.

4. Follow the rest of the wizard and click Finish.

5. Add the files to your project.
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6. Build the project as usual. For example, select Project » Build Project (1),

Eclipse builds the library. Instead of calling the linker, Eclipse now calls the archiver.

Command line invocation
You can call the archiver from the command line. The invocation syntax is:
ararm key_option [sub_option...] library [object_file]

key_option With a key option you specify the main task which the archiver should perform. You
must always specify a key option.

sub_option Sub-options specify into more detail how the archiver should perform the task that is
specified with the key option. It is not obligatory to specify sub-options.

library The name of the library file on which the archiver performs the specified action. You
must always specify a library name, except for the options -? and -V. When the library
is not in the current directory, specify the complete path (either absolute or relative) to
the library.

object_file The name of an object file. You must always specify an object file name when you
add, extract, replace or remove an object file from the library.

Options of the archiver utility

The following archiver options are available:

Description Option Sub-option
Main functions (key options)

Replace or add an object module -r -a-b-c-u-v
Extract an object module from the library -X -v

Delete object module from library -d -v

Move object module to another position -m -a-b-v
Print a table of contents of the library -t -s0-sl
Print object module to standard output -p

Sub-options

Append or move new modules after existing module name -a name

Append or move new modules before existing module name -b name

Create library without notification if library does not exis -C

Preserve last-modified date from the library -0

Print symbols in library modules -s{0|1}

Replace only newer modules -u

Verbose -v

Miscellaneous

257



TASKING VX-toolset for ARM User Guide

Description Option Sub-option
Display options -?

Display version header -V

Read options from file -f file

Suppress warnings above level n -wn

For a complete list and description of all archiver options, see Section 13.9, Archiver Options.
10.4.2. Archiver Examples

Create a new library

If you add modules to a library that does not yet exist, the library is created. To create a new library with
the name nyl i b. | i b and add the object modules cst art. obj and cal c. obj toit:

ararm-r nylib.lib cstart.obj calc.obj

Add a new module to an existing library

If you add a new module to an existing library, the module is added at the end of the module. (If the
module already exists in the library, it is replaced.)

ararm-r nylib.lib nod3. obj

Print a list of object modules in the library
To inspect the contents of the library:

ararm-t nylib.lib

The library has the following contents:

cstart. obj

cal c. obj
nod3. obj

Move an object module to another position
To move nod3. obj to the beginning of the library, position it just before cst art . obj :

ararm-mnmb cstart.obj mylib.lib nbd3. obj

Delete an object module from the library
To delete the object module cst art . obj from the library nyl i b. |i b:

ararm-d nylib.lib cstart. obj
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Extract all modules from the library
Extract all modules from the library nyl i b. | i b:

ararm-x nmylib.lib
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10.5. HLL Object Dumper

The high level language (HLL) dumper hidumparm is a program to dump information about an absolute
object file (. abs) . Key features are a disassembler with HLL source intermixing and HLL symbol display
and a HLL symbol listing of static and global symbols.

10.5.1. Invocation

Command line invocation

You can call the HLL dumper from the command line. The invocation syntax is:
hl dumparm [option]... file...

The input file must be an ELF file with or without DWARF debug info (. abs).

The HLL dumper can process multiple input files. Files and options can be intermixed on the command
line. Options apply to all supplied files. If multiple files are supplied, the disassembly of each file is preceded
by a header to indicate which file is dumped. For example:

========== f|| e. abs ==========

For a complete list and description of all options, see Section 13.10, HLL Object Dumper Options. With
hl dunpar m - - hel p you will see the options on st dout .

10.5.2. HLL Dump Output Format

The HLL dumper produces output in text format by default, but you can also specify the XML output format
with --output-file-type=xml. The XML output is mainly for use in the Eclipse editor. The output is printed
on st dout , unless you specify an output file with --output=filename.

The parts of the output are dumped in the following order:
1. Module list

2. Section list

3. Section dump (disassembly)

4, HLL symbol table

5. Assembly level symbol table

With the option --dump-format=flag you can control which parts are shown. By default, all parts are
shown.

Example

Suppose we have a simple "Hello World" program in a file called hel | 0. c. We call the control program
as follows:
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ccarm-g -t hello.c

Option -g tells to include DWARF debug information. Option -t tells to keep the intermediate files. This
command results (among other files) in the file hel | 0. abs (the absolute output file).

We can dump information about the absolute object file with the following command:
hl dunpar m hel | 0. abs

---------- Module list ----------

Name Ful | path
hello.c hello.c

---------- Section list ----------

Address Size Al'i gn Nane

00000694 24 4 . text
000400e0 4 4 .data
000006b8 6 4 .rodata
000006ac 11 4 .rodata
---------- Section dunp ----------

.section .data, '[.data]’
.org 000000e8
.db b8, 06, 00, 00 ;

. endsec
.section .text, '.text
00000694 08009f e5 nmin | dr ro, [r15, #+0x8]
00000698 001090e5 | dr rl, [r0, #+0x0]
0000069c 04009f e5 | dr ro, [r15, #+0x4]
000006a0 74ffffea b printf
000006a4 e000 .dh 00e0
000006a6 0400 .dh 0004
000006a8 ac06 .dh 0O6ac
000006aa 0000 ..dh 0000
. endsec
.section .data, '.rodata
.org 000006ac
.db 48, 65, 6c, 6¢c, 6f, 20, 25, 73, 21, 0a, 00 ; Hello %!..
. endsec
.section .data, '.rodata
.org 000006b8
.db 77,6f,72, 6¢, 64, 00 ;o world
. endsec

---------- HLL synbol table ----------
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Addr ess Size HLL Type Nane

00000394 88 void _START()

0000040c 104 void _init()

00000478 64 int printf(const char * format, ...)
00000694 16 void mai n()

00040028 24 struct _dbg_request [dbhg.c]

00040040 80 static char stdin_buf[80] [_iob.c]

00040090 80 static char stdout _buf[80] [_iob.c]

000400e0 4 char * world [hello.c]

000400e4 200 struct _iobuf _iob[10] [_iob.c]

---------- assenbly | evel synbol table ----------

Address Si ze Type Nane

00000000

00000000 $group_. 1.str
00000000 $group_. 2. str
00000000 $group_nai n
00000000 $group_wor | d
00000000 hello.c
00000394 88 code _START
00000478 64 code printf
00000694 16 code main
000400e0 4 data world

Module list

This part lists all modules (C/C++ files) found in the object file(s). It lists the filename and the complete
path name at the time the module was built.

Section list

This part lists all sections found in the object file(s).

Address The start address of the section. Hexadecimal, 8 digits, 32-bit.

Size The size (length) of the section in bytes. Decimal, filled up with spaces.

Align The alignment of the section in number of bytes. Decimal, filled up with spaces.
Name The name of the section.

With option --sections=name[,name]... you can specify a list of sections that should be dumped.

Section dump

This part contains the disassembly. It consists of the following columns:
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address column Contains the address of the instruction or directive that is shown in the disassembly.
If the section is relocatable the section start address is assumed to be 0. The
address is represented in hexadecimal and has a fixed width. The address is
padded with zeros. No Ox prefix is displayed. For example, on a 32-bit architecture,
the address 0x32 is displayed as 00000032.

encoding column Shows the hexadecimal encoding of the instruction (code sections) or it shows the
hexadecimal representation of data (data sections). The encoding column has a
maximum width of eight digits, i.e. it can represent a 32-bit hexadecimal value.
The encoding is padded to the size of the data or instruction. For example, a 16-bit
instruction only shows four hexadecimal digits. The encoding is aligned left and
padded with spaces to fill the eight digits.

label column Displays the label depending on the option --symbols=[hlljasm|none]. The default
is asm, meaning that the low level (ELF) symbols are used. With hll, HLL (DWARF)
symbols are used. With none, no symbols will be included in the disassembly.

disassembly column For code sections the instructions are disassembled. Operands are replaced with
labels, depending on the option --symbols=[hlljasm|none].

With option --data-dump-format=directives (default), the contents of data sections
are represented by directives. A new directive will be generated for each symbol.
ELF labels in the section are used to determine the start of a directive. ROM
sections are represented with . db, . dh, . dw, . dd kind of directives, depending
on the size of the data. RAM sections are represented with . ds directives, with a
size operand depending on the data size. This can be either the size specified in
the ELF symbol, or the size up to the next label.

With option --data-dump-format=hex, no directives will be generated for data sections, but data sections
are dumped as hexadecimal code with ASCII translation. This only applies to ROM sections. The hex
dump has the following format:

AAAAAAAA HO H1 H2 H3 H4 H5 H6 H7 H8 H9 HA HB HC HD HE HF RRRRRRRRRRRRRRRR
where,

A = Address (8 digits, 32-bit)

Hx = Hex contents, one byte (16 bytes max)

R = ASCII representation (16 characters max)

For example:

section 7 (.rodata):
00000000 48 65 6¢ 6C 6f 20 25 73 21 0Oa 00 Hello %! ..

With option --data-dump-format=hex, RAM sections will be represented with only a start address and
a size indicator:

AAAAAAAA Space: 48 bytes

With option --disassembly-intermix you can intermix the disassembly with HLL source code.
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HLL symbol table

This part contains a symbol listing based on the HLL (DWARF) symbols found in the object file(s). The
symbols are sorted on address.

Address The start address of the symbol. Hexadecimal, 8 digits, 32-bit.
Size The size of the symbol from the DWARF info in bytes.

HLL Type The HLL symbol type.

Name The name of the HLL symbol.

HLL arrays are indicated by adding the size in square brackets to the symbol name. For example:
00040040 80 static char stdin_buf[80] [_iob.c]

HLL struct and union symbols are listed by default without fields. For example:

00040028 24 struct _dbg_request [dbg.c]

With option --expand-symbols all struct, union and array fields are included as well. For the fields the
types and names are indented with two spaces. For example:

00040028 24 struct _dbg_request [dbg.c]
00040028 4 i nt _errno

0004002c 4 enum nr

00040030 16 uni on u

00040030 4 struct exit

00040030 4 i nt status
00040030 8 struct open

00040030 4 const char * pat hnanme
00040034 2 unsi gned short int flags

Functions are displayed with the full function prototype. Size is the size of the function. HLL Type is the
return type of the function. For example:

00000480 68 int printf(const char * restrict format,

The local and static symbols get an identification between square brackets. The filename is printed if and
if a function scope is known the function name is printed between the square brackets as well. If multiple
files with the same name exist, the unique part of the path is added. For example:

00040100 4 int count [file.c, somefunc()]
00040104 4 int count [x\a.c]
00040108 4 int count [y\a.c, foo()]

Global symbols do not get information in square brackets.
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Assembly level symbol table

This part contains a symbol listing based on the assembly level (ELF) symbols found in the object file(s).
The symbols are sorted on address.

Address The start address of the symbol. Hexadecimal, 8 digits, 32-bit.

Size The size of the symbol from the ELF info in bytes. If this field is empty, the size is
zero.

Type Code or Data, depending on the section the symbol belongs to. If this field is empty,
the symbol does not belong to a section.

Name The name of the ELF symbol.
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10.6. Expire Cache Utility

With the utility expirearm you can limit the size of the cache (C compiler option --cache) by removing all
files older than a few days or by removing older files until the total size of the cache is smaller than a
specified size. See also section Compiler Cache in Section 4.6, Influencing the Build Time.

The invocation syntax is:
expirearm[option]... cache-directory
The compiler cache is present in the directory car ntache under the specified cache-directory.

For a complete list and description of all options, see Section 13.11, Expire Cache Utility Options. With
expi rearm - - hel p you will see the options on st dout .

Examples

To remove all files older than seven days, enter:

expi rearm --days=7 "installation-dir\nproject\.cache"

To reduce the compiler cache size to 4 MB, enter:

expi rearm - -nmegabytes=4 "installation-dir\nproject\.cache"
Older files are removed until the total size of the cache is smaller than 4 MB.
To clear the compiler cache, enter:

expi rearm - - megabyt es=0 "install ation-dir\nproject\.cache"
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Chapter 11. Using the Debugger

This chapter describes the debugger and how you can run and debug a C or C++ application. This chapter
only describes the TASKING specific parts.

11.1. Reading the Eclipse Documentation

Before you start with this chapter, it is recommended to read the Eclipse documentation first. It provides
general information about the debugging process. This chapter guides you through a number of examples
using the TASKING debugger with simulation as target.

You can find the Eclipse documentation as follows:
1. Start Eclipse.
2. From the Help menu, select Help Contents.
The help screen overlays the Eclipse Workbench.
3. Inthe left pane, select C/C++ Development User Guide.
4. Open the Getting Started entry and select Debugging projects.

This Eclipse tutorial provides an overview of the debugging process. Be aware that the Eclipse
example does not use the TASKING tools and TASKING debugger.

11.2. Creating a Customized Debug Configuration

Before you can debug a project, you need a Debug launch configuration. Such a configuration, identified
by a name, contains all information about the debug project: which debugger is used, which project is
used, which binary debug file is used, which perspective is used, ... and so forth.

If you want to debug on a target board, you have to create a custom debug configuration for your target
board, otherwise you have to create a debug launch configuration for the TASKING simulator.

To debug a project, you need at least one opened and active project in your workbench. In this
chapter, it is assumed that the mypr oj ect is opened and active in your workbench.

See Chapter 12, Target Board Support, for an overview of all supported evaluation boards.

Create or customize your debug configuration
To create or change a debug configuration follow the steps below.
1. From the Debug menu, select Debug Configurations...

The Debug Configurations dialog appears.
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Select TASKING C/C++ Debugger and click the New launch configuration button (L7

) to add a new configuration.

Or: In the left pane, select the configuration you want to change, for example, TASKING C/C++
Debugger » myproject.simulator.

3. Inthe Name field enter the name of the configuration. By default, this is the name of the project, but
you can give your configuration any name you want to distinguish it from the project name. For
example enter mypr oj ect . si mul at or to identify the simulator debug configuration.

4. Onthe Target tab, select the ARM Simulator or any of the target boards.

The dialog shows several tabs.

Target tab

On the Target tab you can select on which target the application should be debugged. An application
can run on an external evaluation board, or on a simulator using your own PC. On this tab you can also
select the connection settings (J-Link, RS-232, TCP/IP). The information in this tab is based on the Debug
Target Configuration (DTC) files as explained in Chapter 18, Debug Target Configuration Files. See
Chapter 12, Target Board Support, for an overview of all supported evaluation boards.

& Debug Configurations 3]

Create, manage, and run configurations
TASKING C/C++ Debugger

MR INCE Name: | mypraject, smulator
F Target &= Iniialization| [5] Project | 8= Arguments | 5 Source | ] Miscellaneous

© #F TASKING C/C++ Debugger Target settings
7 myproject simulator O show all targets © Show targets for ARMYT-M

Target: ARM Simulator

Configuration:

Connection settings
Cannection: | Simulator -

£ Field value

Filter matched 2 of 2 items

h

Initialization tab

On the Initialization tab enable one or more of the following options:
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@ Debug Configurations &3]

Create, manage, and run configurations
TASKING C/C++ Debugger

v B E
X B3 Name: | myproject simulator
¥ Target | 5= Inkislzation 2] Project | 60= Arguments | & Source | £ Miscellaneous
= % TASKING Ce++ Debugger ||| [2] Iitial dowrdaad of program
# myproject simulator Verfy download of program

Reset barget
Goko main

Flash settings

Filter matched 2 of 2 tems

r‘
@

Initial download of program

If enabled, the target application is downloaded onto the target. If disabled, only the debug information
in the file is loaded, which may be useful when the application has already been downloaded (or flashed)
earlier. If downloading fails, the debugger will shut down.

Verify download of program

If enabled, the debugger verifies whether the code and data has been downloaded successfully. This
takes some extra time but may be useful if the connection to the target is unreliable.

Program flash when downloading

If enabled, also flash devices are programmed (if necessary). Flash programming will not work when
you use a simulator.

Reset target
If enabled, the target is immediately reset after downloading has completed.
Goto main

If enabled, only the C startup code is processed when the debugger is launched. The application stops
executing when it reaches the first C instruction in the function mai n() . Usually you enable this option
in combination with the option Reset Target.

Break on exit
If enabled, the target halts automatically when the exi t () function is called.

Reduce target state polling
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If you have set a breakpoint, the debugger checks the status of the target every number of seconds to
find out if the breakpoint is hit. In this field you can change the polling frequency.
* Monitor file (Flash settings)
Filename of the monitor, usually an Intel Hex or S-Record file.
» Sector buffer size (Flash settings)
Specifies the buffer size for buffering a flash sector.
» Workspace address (Flash settings)

The address of the workspace of the flash programming monitor.

Project tab

On the Project tab, you can set the properties for the debug configuration such as a name for the project
and the application binary file which are used when you choose this configuration.

# Debug Configurations X
Create, manage, and run configurations
TASKING C/C-+ Debugger y
2R B3 Name: | mypraject, smulator
F Target | = Intialization | [2] Projact . 09= Arquments | B Source | = Miscellaneous
S ¥ TASKING C/C++ Debugger | | pyoget;
i myproject simulator
CJc++ application
${project_ocH$buid_config}myproject.abs Search Project.
Filter matched 2 of 2 items
P
®

* In the Project field, you can choose the project for which you want to make a debug configuration.
Because the project nypr oj ect is the active project, this project is filled in automatically. Click the
Browse... button to select a different project. Only the opened projects in your workbench are listed.

* Inthe C/C++ Application field, you can choose the binary file to debug. The file nypr oj ect . abs is
automatically selected from the active project.

Arguments tab
If your application's mai n() function takes arguments, you can pass them in this tab. Arguments are

conventionally passed in the ar gv[] array. Because this array is allocated in target memory, make sure
you have allocated sufficient memory space for it.
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@ Debug Configurations 3]
Create, manage, and run configurations
TASKING £/C++ Debugger
E g
TE X B - Hame: | myproject. simator ]
|:| %5 Target | §= Intiskzation | [5] Project | = Arguments %5 Source | £ Miscellanenus
= 5 TASKING CjC++ Debugger s pETET AITES
&5 myproject.simulator
argl arge
arg3 argt
werking drectery

Filter matched 2 of 2 tems

@

Source tab

Using the Debugger

On the Source tab, you can add additional source code locations in which the debugger should search
for debug data.

Create, manage, and run configuratians

TASKING C/C++ Debugger ﬁ\'
TBX B3

@ Debug Configurations &3]

Hame: | myproject. simator

e —

£= Initishzation | [Z] Project | 6d= Arguments | 2 Source =] Miscellaneous
= #% TASKING CJc++ Debugger | | Source Lookup Path:

&5 myproject.simulator

® = Add...

[[Jsearch for duplicate source files on the path

Filter matched 2 of 2 tems

» Usually, the default source code location is correct.

Miscellaneous tab

On the Miscellaneous tab you can specify several file locations
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@ Debug Configurations X
Create, manage, and run configurations ;
TASKING CJC++ Debugger

* @ -
X B 3 Name: | myproject simulator

ion | [2] Project | 69= Arguments | Source | £ Miscellansous

= 3% TASKING C/C++ Debugger Debugge
5. myproject simulator

C:fProgrem Fiies{TASKING/carm vx.yrzfbin
irectory: | ${project _locH f{buid_configh
ORTI file

KSM module:

GDI log file:

Debug instrument log file {F applicable)

Browse. .

[ cachs target access

{.mef) For memory map

Filter matched 2 of 2 items

,\
@

Debugger location

The location of the debugger itself. This should not be changed.

FSS root directory

The initial directory used by file system simulation (FSS) calls. See the description of the FSS view.
ORTI file and KSM module

If you wish to use the debugger's special facilities for kernel-aware debugging, specify the name of a
Kernel Debug Interface (KDI) compatible KSM module (shared library) in the appropriate edit box. The
toolset comes with a KSM suitable for OSEK kernels. If you wish to use this, browse for the file
osek_radm dl | inthe bi n directory of the toolset. See also the description of the RTOS view.

GDl log file and Debug instrument log file

You can use the options GDI log file and Debug instrument log file (if applicable) to control the generation
of internal log files. These are primarily intended for use by or at the request of Altium support personnel.

Cache target access

Except when using a simulator, the debugger's performance is generally strongly dependent on the
throughput and latency of the connection to the target. Depending on the situation, enabling this option
may result in a noticeable improvement, as the debugger will then avoid re-reading registers and
memory while the target remains halted. However, be aware that this may cause the debugger to show
the wrong data if tasks with a higher priority or external sources can influence the halted target's state.

Launch in background
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When this option is disabled you will see a progress bar when the debugger starts. If you do not want
to see the progress bar and want that the debugger launches in the background you can enable this
option.

* Use linker/locator memory map file (mdf) for memory map

You can use this option to find errors in your application that cause access to non-existent memory or
cause an attempt to write to read-only memory. When building your project, the linker/locator creates
a memory description file (. mdf ) file which describes the memory regions of the target you selected
in your project properties. The debugger uses this file to initialize the debugging target.

This option is only useful in combination with a simulator as debug target. The debugger may fail to
start if you use this option in combination with other debugging targets than a simulator.

11.3. Troubleshooting

If the debugger does not launch properly, this is likely due to mistakes in the settings of the execution
environment or to an improper connection between the host computer and the execution environment.
Always read the notes for your particular execution environment.

Some common problems you may check for, are:

Problem Solution

Wrong device name in the launch  |Make sure the specified device name is correct.
configuration

Invalid baud rate Specify baud rate that matches the baud rate the execution
environment is configured to expect.

No power to the execution Make sure the execution environment or attached probe is powered.
environment.

Wrong type of RS—232 cable. Make sure you are using the correct type of RS-232 cable.

Cable connected to the wrong port |Some target machines and hosts have several ports. Make sure
on the execution environment or host. |you connect the cable to the correct port.

Conflict between communication A device driver or background application may use the same
ports. communications port on the host system as the debugger. Disable
any service that uses the same port-number or choose a different
port-number if possible.

Port already in use by another user. | The port may already be in use by another user on some UNIX
hosts, or being allocated by a login process. Some target machines
and hosts have several ports. Make sure you connect the cable to
the correct port.

11.4. TASKING Debug Perspective

After you have launched the debugger, you are either asked if the TASKING Debug perspective should
be opened or it is opened automatically. The Debug perspective consists of several views.
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To open views in the Debug perspective:
1. Make sure the Debug perspective is opened
2. From the Window menu, select Show View »

3. Select a view from the menu or choose Other... for more views.

By default, the Debug perspective is opened with the following views:

W TASKING Debug - myproject/myproject.c - TASKING ¥X-toolset for ARM Cortex
File Edit Source Refactor Wavigate Search Project Debug ‘indow Help

Fre B G EE G W ® R P o G- {7 | %5 TASKING Debug |
T pebug 52 = O |[0d= variables 52 “._©g Breakpoints = O |[ 1848 registers 52 & =0
- 3| & ] | croup: |core -
& O IR Harme: Value Marne: Walue Usage
=i <no storage assigned =
i = RO 0x0 A
R1 0x0
=] x; myproject. simulakar [TASKING CfC++ Debugger] R2 00
= & ARM Simulator - ARMYZ-M (3{14/12 3:34 PM) (Suspend rs 00
(=g Thread [1:1:ARM)] {Suspended: Breakpoint hit.) o o
= 2 main() myproject,c;3 Dx000007a0 i
= 1 _START() 0x00000876 RS o0
< > & o v
[€] myproject.c &2 =g Disassembly &2 EE Qutling =g
#include <stdio.h>
Address: 0x000007a0
| int main|{ void ] int main{ vaid ) ~
{ 0x000007a0 10 hS push {r4,lc}
int i: for (i=1; 1<=3; i++)
for (i=1:; 1i<=3: i++) 0x000007aZ 01 24 mov r4, #O0x1
i printi( "sdin", i ):
printf{ "sdin", i ); Ox000007a4 Oa 48 ldr ro, [pe, #Ox28]
i 0x000007a6 21 46 mov ri, r4
printf({ "Hello world, ™ }; 0x000007a8 00 £0 ic £8 bl printt (000007=4)
princf( "this i= “n" ): for (i=1; i<=3; i++)
printf( "a small sdstin”,i-3 ) 0x000007ac 64 1o add r4, r4, #0xi
princf( "debugging example.in™ ): o 0x000007ae 03 Zo cmp r4, #Ox3
~
E Consale 23 ¥ Tasks A = R = N i N BRI =
Debug [myproject. simulator] Monitors .
Communication: Simulataor A

Debuy Instrument Module: disimarm
Using Java Link Version 1.112
Starting Debugger...
Running startup script...
TASKING Vi-toolser for ARM: debuyger, Build 160 v
< bd
S

11.4.1. Debug View

The Debug view shows the target information in a tree hierarchy shown below with a sample of the
possible icons:

Icon Session item Description
¥ Launch instance |Launch configuration name and launch type
Debugger instance | Debugger name and state

P @ g8 |Thread instance |Thread number and state
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Icon Session item Description
= = |Stack frame Stack frame number, function, file name, and file line number
instance

The number beside the thread label is a reference counter, not a thread identification number (TID).
Stack display

During debugging (running) the actual stack is displayed as it increases or decreases during program
execution. By default, all views present information that is related to the current stack item (variables,
memory, source code etc.). To obtain the information from other stack items, click on the item you want.

The Debug view displays stack frames as child elements. It displays the reason for the suspension beside
the thread, (such as end of stepping range, breakpoint hit, and signal received). When a program exits,
the exit code is displayed.

The Debug view contains numerous functions for controlling the individual stepping of your programs and
controlling the debug session. You can perform actions such as terminating the session and stopping the
program. All functions are available from the right-click menu, though commonly used functions are also
available from the toolbar in the Debug view.

Controlling debug sessions

Icon Action Description
% Remove all Removes all terminated launches.
4 Reset target Resets the target system and restarts the application.
system
&, Restart Restarts the application. The target system is not reset.
b Resume Resumes the application after it was suspended (manually, breakpoint,
signal).
0o Suspend Suspends the application (pause). Use the Resume button to continue.
) Right-click menu. Restarts the selected debug session when it was
elaunc erminated. e debug session is still running, a new debug session is
Q, Rel h t ted. If the deb till deb
launched.
4 Reload current Reloads the current application without restarting the debug session. The
: application application does restart of course.
- Terminate Ends the selected debug session and/or process. Use Relaunch to restart
this debug session, or start another debug session.
[ | Terminate all Right-click menu. As terminate. Ends all debug sessions.
@ |Terminate and Right-click menu. Ends the debug session and removes it from the Debug
*lremove view.
@ |Terminate and Right-click menu. Ends the debug session and relaunches it. This is the
*|Relaunch same as choosing Terminate and then Relaunch.
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Icon Action Description

Detaches the debugger from the selected process (useful for debugging

& Disconnect attached processes).

Stepping through the application

Icon Action Description

2 Step into Steps to the next source line or instruction.

Steps over a called function. The function is executed and the application

Step over suspends at the next instruction after the call.
Executes the current function. The application suspends at the next
i Step return . X .
instruction after the return of the function.
i Instruction Toggle. If enabled, the stepping functions are performed on instruction level
stepping instead of on C source line level.
' Interrupt aware | Toggle. If enabled, the stepping functions do not step into an interrupt when

stepping it occurs.

Miscellaneous

Icon Action Description

Right-click menu. Copies the stack as text to the windows clipboard. You

Copy Stack can paste the copied selection as text in, for example, a text editor.
# Edit project... Right-click menu. O_pens_the debug configuration dialog to let you edit the
current debug configuration.
B Edit Source Right-click menu. Opens the Edit Source Lookup Path window to let you
Lookup... edit the search path for locating source files.

11.4.2. Breakpoints View

You can add, disable and remove breakpoints by clicking in the marker bar (left margin) of the Editor
view. This is explained in the Getting Started manual.

Description

The Breakpoints view shows a list of breakpoints that are currently set. The button bar in the Breakpoints
view gives access to several common functions. The right-most button = opens the Breakpoints menu.

Types of breakpoints

To access the breakpoints dialog, add a breakpoint as follows:

1. Click the Add TASKING Breakpoint button (¢&).

The Breakpoints dialog appears.
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Each tab lets you set a breakpoint of a special type. You can set the following types of breakpoints:

File breakpoint

The target halts when it reaches the specified line of the specified source file. Note that it is possible
that a source line corresponds to multiple addresses, for example when a header file has been included
into two different source files or when inlining has occurred. If so, the breakpoint will be associated with
all those addresses.

Function

The target halts when it reaches the first line of the specified function. If no source file has been specified
and there are multiple functions with the given name, the target halts on all of those. Note that function
breakpoints generally will not work on inlined instances of a function.

Address

The target halts when it reaches the specified instruction address.
Stack

The target halts when it reaches the specified stack level.

Data

The target halts when the given variable or memory location (specified in terms of an absolute address)
is read or written to, as specified.

Instruction

The target halts when the given number of instructions has been executed.
Cycle

The target halts when the given number of clock cycles has elapsed.
Timer

The target halts when the given amount of time elapsed.

In addition to the type of the breakpoint, you can specify the condition that must be met to halt the program.

In the Condition field, type a condition. The condition is an expression which evaluates to 'true' (non-zero)
or ‘false' (zero). The program only halts on the breakpoint if the condition evaluates to 'true'.

In the Ignore count field, you can specify the number of times the breakpoint is ignored before the program
halts. For example, if you want the program to halt only in the fifth iteration of a while-loop, type '4": the
first four iterations are ignored.
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11.4.3. File System Simulation (FSS) View

Description

The File System Simulation (FSS) view is automatically opened when the target requests FSS input or
generates FSS output. The virtual terminal that the FSS view represents, follows the VT100 standard. If
you right-click in the view area of the FSS view, a menu is presented which gives access to some
self-explanatory functions.

VT100 characteristics

The queens example demonstrates some of the VT100 features. (You can find the queens example in
the<ARM i nst al | ati on pat h>\ exanpl es directory from where you can import it into your workspace.)
Per debugging session, you can have more than one FSS view, each of which is associated with a positive
integer. By default, the view "FSS #1" is associated with the standard streams st di n, st dout, st derr
and st daux. Other views can be accessed by opening a file named "terminal window <number>", as
shown in the example below.

FILE * f3 = fopen("term nal wi ndow 3", "rw');
fprintf(f3, "Hello, wi ndow 3.\n");
fcl ose(f3);

You can set the initial working directory of the target application in the Debug configuration dialog (see
also Section 11.2, Creating a Customized Debug Configuration):

1. On the Debugger tab, select the Miscellaneous sub-tab.
2. Inthe FSS root directory field, specify the FSS root directory.

The FSS implementation is designed to work without user intervention. Nevertheless, there are some
aspects that you need to be aware of.

First, the interaction between the C library code (in the files dbg*. ¢ and dbg*. h; see Section 14.2.5,
dbg.h) and the debugger takes place via a breakpoint, which incidentally is not shown in the Breakpoints
view. Depending on the situation this may be a hardware breakpoint, which may be in short supply.

Secondly, proper operation requires certain code in the C library to have debug information. This debug
information should normally be present but might get lost when this information is stripped later in the
development process.

11.4.4. Disassembly View

The Disassembly view shows target memory disassembled into instructions and / or data. If possible, the
associated C / C++ source code is shown as well. The Address field shows the address of the current
selected line of code.

To view the contents of a specific memory location, type the address in the Address field. If the address
is invalid, the field turns red.
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11.4.5. Expressions View
The Expressions view allows you to evaluate and watch regular C expressions.
To add an expression:
Click OK to add the expression.
1. Right-click in the Expressions View and select Add Watch Expression.
The Add Watch Expression dialog appears.
2. Enter an expression you want to watch during debugging, for example, the variable name "i"

If you have added one or more expressions to watch, the right-click menu provides options to Remove
and Edit or Enable and Disable added expressions.

» You can access target registers directly using #NAME. For example "ar r [ #R0 << 3] " or "#TI MER3
= mt+". If a register is memory-mapped, you can also take its address, for example, "&#ADC| N'.

» Expressions may contain target function calls like for example "gl + i nvert (&g2)". Be aware that
this will not work if the compiler has optimized the code in such a way that the original function code
does not actually exist anymore. This may be the case, for example, as a result of inlining. Also, be
aware that the function and its callees use the same stack(s) as your application, which may cause
problems if there is too little stack space. Finally, any breakpoints present affect the invoked code in
the normal way.

11.4.6. Memory View

Use the Memory view to inspect and change process memory. The Memory view supports the same
addressing as the C and C++ languages. You can address memory using expressions such as:

* 0x0847d3c

« (&y)+1024

* *ptr

Monitors

To monitor process memory, you need to add a monitor:

1. Inthe Debug view, select a debug session. Selecting a thread or stack frame automatically selects
the associated session.

2. Click the Add Memory Monitor button in the Memory Monitors pane.
The Monitor Memory dialog appears.

3. Type the address or expression that specifies the memory section you want to monitor and click OK.
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The monitor appears in the monitor list and the Memory Renderings pane displays the contents of
memory locations beginning at the specified address.

To remove a monitor:

1. Inthe Monitors pane, right-click on a monitor.

2. From the popup menu, select Remove Memory Monitor.

Renderings

You can inspect the memory in so-called renderings. A rendering specifies how the output is displayed:
hexadecimal, ASCII, signed integer, unsigned integer or traditional. You can add or remove renderings
per monitor. Though you cannot change a rendering, you can add or remove them:

1. Click the New Renderings... tab in the Memory Renderings pane.

The Add Memory Rendering dialog appears.

2. Select the rendering you want (Hex Integer, Hex, ASCII, Signed Integer, Unsigned Integer or
Traditional) and click Add Rendering(s).

To remove a rendering:

1. Right-click on a memory address in the rendering.
2. From the popup menu, select Remove Rendering.
Changing memory contents

In a rendering you can change the memory contents. Simply type a new value.

Warning: Changing process memory can cause a program to crash.

The right-click popup menu gives some more options for changing the memory contents or to change the
layout of the memory representation.

11.4.7. Compare Application View

You can use the Compare Application view to check if the downloaded application matches the application
in memory. Differences may occur, for example, if you changed memory addresses in the Memory view.

 To check for differences, click the Compare button.

11.4.8. Heap View

With the Heap view you can inspect the status of the heap memory. This can be illustrated with the
following example:
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string = (char *) malloc(100);
strcpy ( string, "abcdefgh" );
free (string);

If you step through these lines during debugging, the Heap view shows the situation after each line has
been executed. Before any of these lines has been executed, there is no memory allocated and the Heap
view is empty.

« After the first line the Heap view shows that memory is occupied, the description tells where the block
starts, how large it is (100 MAUs) and what its content is (0x0, 0x0, ...).

 After the second line, "abcdef gh" has been copied to the allocated block of memory. The description
field of the Heap view again shows the actual contents of the memory block (0x61, 0x62,...).

» The third line frees the memory. The Heap view is empty again because after this line no memory is
allocated anymore.

11.4.9. Logging View

Use the Logging view to control the generation of internal log files. This view is intended mainly for use
by or at the request of Altium support personnel.

11.4.10. RTOS View

The debugger has special support for debugging real-time operating systems (RTOSs). This support is
implemented in an RTOS-specific shared library called a kernel support module (KSM) or RTOS-aware
debugging module (RADM). Specifically, the TASKING VX-toolset for ARM ships with a KSM supporting
the OSEK standard. You have to create your own OSEK Run Time Interface (ORTI) and specify this file
on the Miscellaneous tab while configuring a customized debug configuration (see also Section 11.2,
Creating a Customized Debug Configuration):

1. From the Debug menu, select Debug Configurations...
The Debug Configurations dialog appears.

2. Inthe left pane, select the configuration you want to change, for example, TASKING C/C++ Debugger
» myproject.simulator.

Or: click the New launch configuration button (L) to add a new configuration.
3. Open the Miscellaneous tab
4. Inthe ORTI file field, specify the name of your own ORTI file.

5. If you want to use the supplied KSM suitable for OSEK kernels, in the KSM module field browse for
the file osek_radm dl | in the bi n directory of the toolset.

The debugger supports ORTI specifications v2.0 and v2.1.
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11.4.11. Registers View

In the Registers view you can examine the value of registers while stepping through your application. The
registers are organized in a number of register groups, which together contain all known registers. You
can select a group to see which registers it contains. This view has a number of features:

» While you step through the application, the registers involved in the step turn yellow. If you scroll in the
view or switch groups, some registers may appear on a lighter yellow background, indicating that the
debugger does not know whether the registers have changed because the debugger did not read the
registers before the step began.

i141 Registers 0 ¢ — O
Group: | Core w
Tarme Walue |Jsage
R3 0x0 Las
R4 0x1 Amyproject.ci13i
RS 0x0
R& 0x0
R7 00
RS 00
RS 00
R10 00
R11 00
R12 00
R13 O2000FFFS
= O2000FFFS w

* You can change each register's value.

» For some registers the menu entry Symbolic Representation is available in their right-click popup
menu. This opens a new view which shows the internal fields of the register. (Alternatively, you can
double-click on a register). For example, the XPSR register from the Core group may be shown as
follows:

% ®PSR E2 =g

value: [ Dx41000000 | [wirite |

Bit# | Description Value

0-5 ISR NUMEBER: Exception nu... 0x=0

9-23 - 0=0

24 T: Thumb state bit 0x1

25-26 - 0=0

27 1 Sticky saturation Flag =0

i Wi Owverflow condition code...  0x0

29 s Zero condition code flag =0
30 Z: Zero condition code Flag =l
31 I; Megative condition code...  0x0
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In this view you can set the individual values in the register, either by selecting a value from a drop-down
box or by simply entering a value depending on the chosen field. To update the register with the new
values, click the Write button.

» You can search for a specific register: right-click on a register and from the popup menu select Find
Register.... Enter a group or register name filter, click the register you want to see and click OK. The
register of your interest will be shown in the view.

11.4.12.Trace View

If tracing is enabled, the Trace view shows the code was most recently executed. For example, while you
step through the application, the Trace view shows the executed code of each step. To enable tracing:

* Right-click in the Trace view and select Trace.
A check mark appears when tracing is enabled.

The view has three tabs, Source, Instruction and Raw, each of which represents the trace in a different
way. However, not all target environments will support all three of these. The view is updated automatically
each time the target halts.

When you use the simulator, this works as is. Otherwise, tracing only works when the processor has a
Trace Port Interface Unit (TPIU) and this is supported. See Section 12.43, Trace Port Interface Unit
Support.

When tracing is enabled note the following:

« If the condition associated with a conditional instruction was false, the instruction will still be shown in
the trace, with no distinct visual indication. This applies to conditional branches, but also to instructions
inside an IT block, for example.

« If the target halted due to a software breakpoint, then technically a BKPT instruction was executed and
hence traced. However, for convenience this will not actually be shown in the Trace view.

 For bandwidth and performance reasons, the trace shown may be shorter than what would be expected
considering the amount of data the debug probe can provide.

» The Raw tab shows the trace in its compressed form, i.e. compliant with the Embedded Trace Macrocell
(ETM) signal protocol as defined by ARM Ltd. Usually, you will not need this information, but it may be
useful if you suspect problems with the target communication or the decompression.

11.5. Programming a Flash Device

With the TASKING debugger you can download an application file to flash memory. Before you download
the file, you must specify the type of flash devices you use in your system and the address range(s) used
by these devices.

To program a flash device the debugger needs to download a flash programming monitor to the target
to execute the flash programming algorithm (target-target communication). This method uses temporary
target memory to store the flash programming monitor and you have to specify a temporary data workspace
for interaction between the debugger and the flash programming monitor.
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Two types of flash devices can exist: on-chip flash devices and external flash devices.

Setup an on-chip flash device

When you specify a target configuration board using the New C/C++ wizard, as explained in the Getting
Started manual, any on-chip flash devices are setup automatically.

Setup an external flash device
1. From the Project menu, select Properties for
The Properties for project dialog appears.
2. Inthe left pane, expand Run/Debug Settings and select Flash Programming.

The Flash Programming pane appears.

W Properties for myproject

[sestirtee ] | Fash Programming

Resource
Builders

= CHCH+ Build Configuration; |Debug [ Active ] | [Manage Corfigurations. .
Build ¥ariables
Discavery Options
Environment. On-chip flash devices
Logging
Memary Device Size Address width Chips hin] Unused
STM3ZF2XX AR IZEEK 756k 03000000 & 1 00 o

Pracessor
Settings
Stack/Heap
CIC++ General
Project References
Refactoring History
(= RunDeb

External flash devices

Device Size: Address Width Chips e} Unused

Restare Defaults Apply
S
®

3. Click Add... to specify an external flash device.

The Select a New Flash Device dialog appears.
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¥ Select a New Flash Device ﬁ

Hash device

Select a flash device

Device kype: Sector map:

m ~ Sectar Size Start address
Infinean

Micron

Macronix

Intel

Alliance Semiconductor

Fuijitsu

Hymiix

Actel

Luminary Micro

Spansion

Abmel

MEC

AMD

Sk

AMIC

STMicroelectronics 2

Easz address:
Chip width: hd
Mumber of chips:

Number of unused address lines:

@

4. Inthe Device type box, expand the name of the manufacturer of the device and select a device.
The Sector map displays the memory layout of the flash device(s). Each sector has a size and

5. Inthe Base address field enter the start address of the memory range that will be covered by the
flash device. Any following addresses separated by commas are considered mirror addresses. This
allows the flash device to be programmed through its mirror address before switching the flash to its
base address.

6. Inthe Chip width field select the width of the flash device.

7. Inthe Number of chips field, enter the number of flash devices that are located in parallel. For
example, if you have two 8-bit devices in parallel attached to a 16-bit data bus, enter 2.

8. Fillinthe Number of unused address lines field, if necessary.

The flash memory is added to the linker script file automatically with the tag "f | ash=flash-id".
To program a flash device
1. From the Debug menu, select Debug Configurations...

The Debug Configurations dialog appears.

2. Inthe left pane, select the configuration you want to change, for example, TASKING C/C++ Debugger
» myproject.board.

285



TASKING VX-toolset for ARM User Guide

3. Onthe Debugger tab, select the Initialization tab
4. Enable the option Program flash when downloading.
The Flash settings group box becomes active.

5. Inthe Monitor file field, specify the filename of the flash programming monitor, usually an Intel Hex
or S-Record file.

6. Inthe Sector buffer size field, specify the buffer size for buffering a flash sector.

7. Specify the data Workspace address used by the flash programming monitor. This address may
not conflict with the addresses of the flash devices.

8. Click Debug to program the flash device and start debugging.
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Chapter 12. Target Board Support

This chapter describes the different target boards that are supported by the tool set. It describes how to
prepare your target board and how to connect it. This chapter also describes support for the Trace Port
Interface Unit (TPIU), which can be used for tracing purposes.

12.1. Overview of Supported Boards

The following tables contains an overview of the target boards (sorted by manufacturer) that are currently
supported by the TASKING VX-toolset for ARM Cortex.

Energy Micro

Name MCU Remarks

EFM32TG-STK3300, Tiny Gecko Starter Kit EFM32TG840F32
(Cortex-M3)

EFM32-G8XX-STK, Gecko Starter Kit EFM32G890F128
(Cortex-M3)
EFM32-G2XX-DK, Gecko Development Kit EFM32G290F128 On-board J-Link

(Cortex-M3)

EFM32GG-STK3700, Giant Gecko Starter Kit  |EFM32GG990F1024
(Cortex-M3)

EFM32LG-STK3600, Leopard Gecko Starter Kit | EFM32LG990F256
(Cortex-M3)

Fujitsu

Name MCU Remarks
SK-FM3-64PMC1|MB9AF314L 512 KB flash
SK-FM3-100PMC |MB9BF506N 512 KB flash
Hitex

Name MCU Remarks

XMC-HiLight|XMC4500-1024
(Cortex-M4)

Infineon
Name MCU Remarks
XMC1100 Boot Kit XMC1100

(Cortex-M0)
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Name MCU Remarks
XMC1200 Boot Kit XMC1200
(Cortex-M0)
XMC1300 Boot Kit XMC1300
(Cortex-M0)
Hexagon Application Kit XMC4200 Series | XMC4200
(Cortex-M4)
Hexagon Application Kit XMC4400 Series | XMC4400
(Cortex-M4)
Hexagon Application Kit XMC4500 Series | XMC4500
(Cortex-M4)
XMC4500 Relax Kit XMC4500
(Cortex-M4)

Keil
Name MCU Remarks
MCB1760 |NXP LPC1768 Board is powered via a separate USB cable.

Luminary Micro

Name MCU Remarks

Stellaris LM3S1968 Evaluation Kit LM3S1968
(Cortex-M3)

Stellaris LM3S2965 Evaluation Kit LM3S2965 Kit includes LM3S2110 CAN Device
(Cortex-M3) Board

Stellaris LM3S3748 Evaluation Kit LM3S3748
(Cortex-M3)

Stellaris LM3S6965 Evaluation Kit LM3S6965
(Cortex-M3)

Stellaris LM3S8962 Evaluation Kit LM3S8962 Kit includes LM3S2110 CAN Device
(Cortex-M3) Board

Stellaris LM3S2110 CAN Device Board

LM3S2110
(Cortex-M3)

This board is included in the LM3S2965
and LM3S8962 evaluation kits.

STMicroelectronics

Name MCU Remarks
MB525-Eval board STM32F103VB
(Cortex-M3)
STM320518-Eval board STM32F051R8 On-board ST-LINK/V2.
(Cortex-M0)
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Name MCU Remarks

STM32FO0-Discovery STM32F051R8 On-board ST-LINK/V2.
(Cortex-M0)

STM3210B-Eval board STM32F10x 128 KB flash
(Cortex-M3)

STM3210C-Eval board STM32F107VCT 256 KB flash
(Cortex-M3)

STM3210E-Eval board STM32F103zZD 512 KB flash
(Cortex-M3)

STM32 Value line discovery STM32F100RB 128 KB flash. On-board ST-LINK.
(Cortex-M3)

STM32L152-Eval board STM32L152VB 128 KB flash
(Cortex-M3)

STM32L152D-Eval board STM32L152ZD 384 KB flash. On-board ST-LINK/V2.
(Cortex-M3)

STM32L-Discovery STM32L152RB 128 KB flash. On-board ST-LINK/V2.
(Cortex-M3)

STM3220G-Eval board STM32F2xxxx On-board ST-LINK/V2.
(Cortex-M3)

STM3221G-Eval board STM32F2xxxx On-board ST-LINK/V2.
(Cortex-M3)

STM32303C-Eval board STM32F303VC On-board ST-LINK/V2.
(Cortex-M4)

STM32373C-Eval board STM32F373VC On-board ST-LINK/V2.

(Cortex-M4)

STM3240G-Eval board

STM32F4571G
(Cortex-M4)

On-board ST-LINK/V2.

STM32437I-Eval board STM32F437I1 On-board ST-LINK/V2.
(Cortex-M4)

STM32F4-Discovery STM32F407VG 1 MB flash. On-board ST-LINK/V2.
(Cortex-M4)

STM32W108B-SK Starter Kit STM32W108xx 2.4 GHz, IEEE 802.15.4-compliant
(Cortex-M3) transceiver

STM32W108B-KEXT Extension Kit| STM32W108xx 2.4 GHz, IEEE 802.15.4-compliant
(Cortex-M3) transceiver

STM32W RF Control Kit STM32W108xx 2.4 GHz, IEEE 802.15.4-compliant

(Cortex-M3)

transceiver

You can use the following debugger probes to connect a board to the host computer:
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Debugger probes

Name Manufacturer Interface Remarks

J-Link SEGGER USB Equal to IAR's J-Link.

J-Link Pro SEGGER USB/Ethernet |For Ethernet use USB power
supply.

J-Link Ultra SEGGER uUsB

J-Link Lite SEGGER USB

J-Link Lite CortexM SEGGER USB

J-Link EDU SEGGER USB

J-Link OB SEGGER UsB On-board on eval board

J-Trace ARM SEGGER USB

J-Trace ARM Cortex-M3 SEGGER USB

ST-LINK STMicroelectronics |[USB

ST-LINK/V2 STMicroelectronics [USB

J-Link is a USB powered JTAG emulator for a wide variety of CPU cores.

J-Trace for Cortex-M3 is a JTAG emulator designed for Cortex-M3 cores which includes trace support.
See Section 12.43, Trace Port Interface Unit Support. It can also be used as a J-Link.

12.2. Updating the SEGGER J-Link Interface DLL

You can download the latest software for J-Link from www.segger.com/download_jlink.html.

The file JLi nk ARM DLL in the TASKING product's bi n folder is a DLL from SEGGER, which is used by
the debugger. When you update or install the SEGGER software package it is recommended to update
this DLL in the TASKING product as well. Note that the program JLinkDLLUpdater in the SEGGER
software does not detect the TASKING toolset. You can update the DLL by copying the DLL by hand.

* Copy JLi nkARM DLL from the folder where the SEGGER software is installed (usually C: \ Pr ogr am
Fi | es\ SEGGER) to the bi n folder in the TASKING product (by default C: \ Pr ogr am
Fi | es\ TASKI NG\ car m vversion\ bi n).

If you start the debugger and the required debug probe drivers are not found, Eclipse can ask you if you
want to install these drivers. You can change this behavior in the Debugger Startup Preferences:

1. From the Window menu, select Preferences.
The Preferences dialog appears.

2. Select TASKING » Debugger Startup.
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3. Inthe Allow starting when the required debug probe drivers are not found field, select Prompt
if Eclipse should ask to install new drivers, or select Always to start the debugger without installing
up-to-date drivers.

12.3. Using the EFM32TG-STK3300, Tiny Gecko Starter Kit

The EFM32TG-STK3300 is a starter kit for evaluation, prototyping and application development for the
EFM32TG MCU family with the ARM Cortex-M3 CPU core. Read the Starter Kit EFM32TG-STK3300
User Manual, for detailed information.

Installing driver software

Before you connect J-Link to the board, first make sure you have installed the latest driver software. You
can download the latest software for J-Link from www.segger.com/download_jlink.html.

Connecting the board
1. Connect any of the J-Link debugger probes with the 20-pin JTAG/SWD cable to the board.
2. Connect J-Link to a PC with a USB cable.

3. Connect the board to a PC with the USB cable for power supply. If Windows asks to search for
drivers, you can ignore this.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target Energy Micro Tiny Gecko Starter Kit
Configuration Default

Connection J-Link over USB (JTAG or SWD)
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12.4. Using the EFM32-G8XX-STK, Gecko Starter Kit

The EFM32-G8XX-STK is a starter kit for evaluation, prototyping and application development for the
EFM32 Gecko MCU family with the ARM Cortex-M3 CPU core. Read the Starter Kit EFM32-G8XX-STK
User Manual, for detailed information.

Installing driver software

Before you connect J-Link to the board, first make sure you have installed the latest driver software. You
can download the latest software for J-Link from www.segger.com/download_jlink.html.

Connecting the board
1. Connect any of the J-Link debugger probes with the 20-pin JTAG/SWD cable to the board.
2. Connect J-Link to a PC with a USB cable.

3. Connect the board to a PC with the USB cable for power supply. If Windows asks to search for
drivers, you can ignore this.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target Energy Micro Gecko Starter Kit
Configuration Default

Connection J-Link over USB (JTAG or SWD)
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12.5. Using the EFM32-G2XX-DK, Gecko Development Kit

The EFM32-G2XX-DK is a development kit with an EFM32G290F128 MCU plugin board for evaluation,
prototyping and application development for the EFM32 Gecko MCU family with the ARM Cortex-M3
CPU core. Read the Development Kit EFM32-G2XX-DK User Manual, for detailed information.

Installing driver software

This board uses on-board J-Link, but you can also use an external J-Link. First make sure you have
installed the latest driver software. You can download the latest software for J-Link from
www.segger.com/download_jlink.html.

Connecting the board

If you want to use the on-board J-Link:

» Connect the board to a PC with a USB cable.

If you want to use an external J-Link debugger probe:

1. Connect any of the J-Link debugger probes with the 20-pin JTAG/SWD cable to the board.
2. Connect J-Link to a PC with a USB cable.

3. Connect the board to a PC with the USB cable for power supply. If Windows asks to search for
drivers, you can ignore this.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target Energy Micro Gecko Development Kit
Configuration Default

Connection J-Link over USB (JTAG or SWD)
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12.6. Using the EFM32GG-STK3700, Giant Gecko Starter Kit

The EFM32GG-STK3700 is a starter kit for evaluation, prototyping and application development for the
EFM32 Giant Gecko MCU family with the ARM Cortex-M3 CPU core. Read the Starter Kit
EFM32GG-STK3700 User Manual, for detailed information.

Installing driver software

Before you connect J-Link to the board, first make sure you have installed the latest driver software. You
can download the latest software for J-Link from www.segger.com/download_jlink.html.

Connecting the board
1. Connect any of the J-Link debugger probes with the 20-pin JTAG/SWD cable to the board.
2. Connect J-Link to a PC with a USB cable.

3. Connect the board to a PC with the USB cable for power supply. If Windows asks to search for
drivers, you can ignore this.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target Energy Micro Giant Gecko Starter Kit
Configuration Default

Connection J-Link over USB (JTAG or SWD)
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12.7. Using the EFM32LG-STK3600, Leopard Gecko Starter Kit

The EFM32LG-STK3600 is a starter kit for evaluation, prototyping and application development for the
EFM32LG MCU family with the ARM Cortex-M3 CPU core. Read the Starter Kit EFM32LG-STK3600
User Manual, for detailed information.

Installing driver software

Before you connect J-Link to the board, first make sure you have installed the latest driver software. You
can download the latest software for J-Link from www.segger.com/download_jlink.html.

Connecting the board
1. Connect any of the J-Link debugger probes with the 20-pin JTAG/SWD cable to the board.
2. Connect J-Link to a PC with a USB cable.

3. Connect the board to a PC with the USB cable for power supply. If Windows asks to search for
drivers, you can ignore this.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target Energy Micro Leopard Gecko Starter Kit
Configuration Default

Connection J-Link over USB (JTAG or SWD)
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12.8. Using the Fujitsu SK-FM3-64PMC1 Evaluation Board

The Fujitsu SK-FM3-64PMCL1 is an evaluation board for Fujitsu Cortex-M3 core-based MB9A310 series
microcontrollers. Read the Readme.pdf on the CD, for detailed information about the board.

Installing driver software

Before you connect J-Link to the board, first make sure you have installed the latest driver software. You
can download the latest software for J-Link from www.segger.com/download_jlink.html.

Jumper settings

Set jumper JP5 to USBPWR1 for power through the USB port (X5).

Connecting the board
1. Connect any of the J-Link debugger probes with the 20-pin JTAG/SWD cable to the board.
2. Connect J-Link to a PC with a USB cable.

3. Connect the board to a PC with the USB cable for power supply. If Windows asks to search for
drivers, you can ignore this.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target Fujitsu SK-FM3-64PMC1
Configuration Default

Connection J-Link over USB (JTAG or SWD)
Flash settings: monitor file mb9xf_paired.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000
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12.9. Using the Fujitsu SK-FM3-100PMC Evaluation Board

The Fujitsu SK-FM3-100PMC is an evaluation board for Fujitsu Cortex-M3 core-based MB9B500A series
microcontrollers. Read the Readme.pdf on the CD, for detailed information about the board.

Installing driver software

Before you connect J-Link to the board, first make sure you have installed the latest driver software. You
can download the latest software for J-Link from www.segger.com/download_jlink.html.

Jumper settings

Set jumper JP5 to USBPWR1 for power through the USB port (X5).

Connecting the board

1. Connect any of the J-Link debugger probes with the 20-pin JTAG/SWD cable to the board or use
J-Trace.

2. Connect J-Link to a PC with a USB cable.

3. Connect the board to a PC with the USB cable for power supply. If Windows asks to search for
drivers, you can ignore this.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target Fujitsu SK-FM3-100PMC
Configuration Default

Connection J-Link over USB (JTAG or SWD)
Flash settings: monitor file mb9xf_paired.sre

Flash settings: sector buffer size 4096
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Target board debug configuration |Setting

Flash settings: workspace address |0x20000000

12.10. Using the Hitex XMC-HiLight

The XMC-HiLight from Hitex is an evaluation board for Infineon XMC4500 series microcontrollers. The
board is hardware compatible to the Infineon Hexagon Evaluation Board. Read the User Manual for
detailed information about the board.

Installing driver software

Before you connect J-Link to the board, first make sure you have installed the latest driver software. You
can download the latest software for J-Link from www.segger.com/download_jlink.html.

Connecting the board
1. Connect any of the J-Link debugger probes with the 20-pin JTAG/SWD cable to the board.
2. Connect J-Link to a PC with a USB cable.

3. Connect the board to a PC with the USB cable for power supply.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target Hitex XMC-HiLight

Configuration Default

Connection J-Link over USB (JTAG or SWD)
Universal Debug Access Server

Flash settings: monitor file fARMv7M.sre

Flash settings: sector buffer size 4096
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Target board debug configuration |Setting
Flash settings: workspace address |0x20000000

12.11. Using the Infineon XMC1100, XMC1200, XMC1300 Boot
Kit

The XMC1100, XMC1200 and XMC1300 Boot Kit are evaluation boards for Infineon XMC1100, XMC1200
and XMC1300 series microcontrollers, respectively.

Installing driver software

These boards support J-Link Lite embedded on the board. First make sure you have installed the latest
driver software. You can download the latest software for J-Link from www.segger.com/download_jlink.html.

Connecting the board

» Connect the board to a PC with a USB cable.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target Infineon Boot Kit for XMC1100, XMC1200 or XMC1300
Configuration Default

Connection J-Link over USB (JTAG or SWD)

Flash settings: monitor file fARMV6M.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000
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12.12. Using the Infineon Hexagon Application Kit XMC4200

The CPU Board XMC4200 is an evaluation board for Infineon XMC4200 series microcontrollers. The
board is part of the Hexagon Application Kit. Read the CPU Board XMC4200 General Purpose Board
User's Manual for detailed information about the board.

Installing driver software

Before you connect J-Link to the board, first make sure you have installed the latest driver software. You
can download the latest software for J-Link from www.segger.com/download_jlink.html.

Connecting the board

1. Connect any of the J-Link debugger probes with the 20-pin JTAG/SWD cable to the board.
2. Connect J-Link to a PC with a USB cable.

3. Connect the board to a PC with the USB cable for power supply.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target Infineon Hexagon Application Kit XMC4200 Series
Configuration Default
Connection J-Link over USB (JTAG or SWD)
Universal Debug Access Server
Flash settings: monitor file fARMV7M.sre

Flash settings: sector buffer size 4096
Flash settings: workspace address |0x20000000
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12.13. Using the Infineon Hexagon Application Kit XMC4400

The CPU Board XMC4400 is an evaluation board for Infineon XMC4400 series microcontrollers. The
board is part of the Hexagon Application Kit. Read the CPU Board XMC4400 General Purpose Board
User's Manual for detailed information about the board.

Installing driver software

Before you connect J-Link to the board, first make sure you have installed the latest driver software. You
can download the latest software for J-Link from www.segger.com/download_jlink.html.

Connecting the board

1. Connect any of the J-Link debugger probes with the 20-pin JTAG/SWD cable to the board.
2. Connect J-Link to a PC with a USB cable.

3. Connect the board to a PC with the USB cable for power supply.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting
Target Infineon Hexagon Application Kit XMC4400 Series
Configuration Default
Connection J-Link over USB (JTAG or SWD)
Universal Debug Access Server
Flash settings: monitor file fARMV7M.sre
Flash settings: sector buffer size 4096
Flash settings: workspace address |0x20000000
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12.14. Using the Infineon Hexagon Application Kit XMC4500

The CPU Board XMC4500 is an evaluation board for Infineon XMC4500 series microcontrollers. The
board is part of the Hexagon Application Kit. Read the CPU Board XMC4500 General Purpose Board
User's Manual for detailed information about the board.

Installing driver software

Before you connect J-Link to the board, first make sure you have installed the latest driver software. You
can download the latest software for J-Link from www.segger.com/download_jlink.html.

Connecting the board

1. Connect any of the J-Link debugger probes with the 20-pin JTAG/SWD cable to the board.
2. Connect J-Link to a PC with a USB cable.

3. Connect the board to a PC with the USB cable for power supply.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target Infineon Hexagon Application Kit XMC4500 Series
Configuration Default
Connection J-Link over USB (JTAG or SWD)
Universal Debug Access Server
Flash settings: monitor file fARMV7M.sre

Flash settings: sector buffer size 4096
Flash settings: workspace address |0x20000000
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12.15. Using the Infineon XMC4500 Relax Kit

The XMC4500 Relax Kit is an evaluation board for Infineon XMC4500 series microcontrollers. Read the
XMC4500 Relax Kit & XMC4500 Relax Lite Kit Board User's Manual for detailed information about the
board.

Installing driver software
Before you connect J-Link to the board or use the on-board J-Link, first make sure you have installed the

latest driver software. You can download the latest software for J-Link from
www.segger.com/download_jlink.html.

Connecting the board

If you want to use a J-Link probe, first make sure a 10-pin debug connector is soldered on the board.
1. Connect any of the J-Link debugger probes with a 10-pin JTAG/SWD cable to the board.

2. Connect J-Link to a PC with a USB cable.

3. Connect the board to a PC with the USB cable for power supply.

Instead of a J-Link probe, you can use the J-Link that is embedded on the board. In this case connect
the board as follows.

» Connect the board (USB Debug) to a PC with a USB cable.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target Infineon XMC4500 Relax Kit
Configuration Default
Connection J-Link over USB (JTAG or SWD)

Universal Debug Access Server
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Target board debug configuration |Setting

Flash settings: monitor file fARMV7M.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000

12.16. Using the Stellaris LM3S1968 Evaluation Board

The Stellaris LM3S1968 Evaluation Board is part of a kit that comes with a USB cable, a 20-pin JTAG/SWD
(Serial Wire Debug) target cable and a CD. Read the Stellaris LM3S1968 Evaluation Board User’'s Manual
on the CD, for detailed information about the board.

Installing driver software

Before you connect J-Link to the board, first make sure you have installed the latest driver software. You
can download the latest software for J-Link from www.segger.com/download_jlink.html.

Connecting the board
1. Connect any of the J-Link debugger probes with the 20-pin JTAG/SWD cable to the board.
2. Connect J-Link to a PC with a USB cable.

3. Connect the board to a PC with the USB cable for power supply. If Windows asks to search for
drivers, you can ignore this.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target Luminary Micro Stellaris LM3S1968 Evaluation Kit

Configuration Default
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Target board debug configuration |Setting

Connection J-Link over USB (JTAG or SWD)
Flash settings: monitor file fluminaryonchip.sre
Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000

12.17. Using the Stellaris LM3S2965 Evaluation Board

The Stellaris LM3S2965 Evaluation Board is part of a kit that comes with a LM3S2110 CAN device board,
a USB cable, a 20-pin JTAG/SWD (Serial Wire Debug) target cable, a 10-pin CAN cable and a CD. Read
the Stellaris LM3S2965 Evaluation Board User’'s Manual on the CD, for detailed information about the

board.

Installing driver software

Before you connect J-Link to the board, first make sure you have installed the latest driver software. You
can download the latest software for J-Link from www.segger.com/download_jlink.html.

Connecting the board
1. Connect any of the J-Link debugger probes with the 20-pin JTAG/SWD cable to the board.
2. Connect J-Link to a PC with a USB cable.

3. Connect the board to a PC with the USB cable for power supply. If Windows asks to search for
drivers, you can ignore this.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting
Target Luminary Micro Stellaris LM3S2965 Evaluation Kit
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Target board debug configuration |Setting

Configuration Default

Connection J-Link over USB (JTAG or SWD)
Flash settings: monitor file fluminaryonchip.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000

12.18. Using the Stellaris LM3S3748 Evaluation Board

The Stellaris LM3S3748 Evaluation Board is part of a kit that comes with USB cables (debugger USB
cable and device USB cable), USB flash memory stick, four oscilloscope test leads, a 20-pin JTAG/SWD
(Serial Wire Debug) target cable and a CD. Read the Stellaris LM3S3748 Evaluation Board User’'s Manual
on the CD, for detailed information about the board.

Installing driver software

Before you connect J-Link to the board, first make sure you have installed the latest driver software. You
can download the latest software for J-Link from www.segger.com/download_jlink.html.

Connecting the board
1. Connect any of the J-Link debugger probes with the 20-pin JTAG/SWD cable to the board.
2. Connect J-Link to a PC with a USB cable.

3. The board has several ways to be powered. If you set the USB Power switch (SW3) in the SELF
position, you can power the board from the Debug USB connector (J7) or from the DC power jack
(J5). Do not apply power to both of them at the same time. For more information, read the manual
that came with the board. We connect the board via the Debug USB connector to a PC with the USB
cable. If Windows asks to search for drivers, you can ignore this.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:
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Target board debug configuration |Setting

Target Luminary Micro Stellaris LM3S3748 Evaluation Kit
Configuration Default

Connection J-Link over USB (JTAG or SWD)

Flash settings: monitor file fluminaryonchip.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000

12.19. Using the Stellaris LM3S6965 Evaluation Board

The Stellaris LM3S6965 Evaluation Board is part of a kit that comes with a USB cable, a 20-pin JTAG/SWD
(Serial Wire Debug) target cable and a CD. Read the Stellaris LM3S6965 Evaluation Board User’s Manual
on the CD, for detailed information about the board.

Installing driver software

Before you connect J-Link to the board, first make sure you have installed the latest driver software. You
can download the latest software for J-Link from www.segger.com/download_jlink.html.

Connecting the board
1. Connect any of the J-Link debugger probes with the 20-pin JTAG/SWD cable to the board.
2. Connect J-Link to a PC with a USB cable.

3. Connect the board to a PC with the USB cable for power supply. If Windows asks to search for
drivers, you can ignore this.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:
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Target board debug configuration |Setting

Target Luminary Micro Stellaris LM3S6965 Evaluation Kit
Configuration Default

Connection J-Link over USB (JTAG or SWD)

Flash settings: monitor file fluminaryonchip.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000

12.20. Using the Stellaris LM3S8962 Evaluation Board

The Stellaris LM3S8962 Evaluation Board is part of a kit that comes with a LM3S2110 CAN device board,
a USB cable, a 20-pin JTAG/SWD (Serial Wire Debug) target cable, a 10-pin CAN cable and a CD. Read
the Stellaris LM3S8962 Evaluation Board User’'s Manual on the CD, for detailed information about the
board.

Installing driver software

Before you connect J-Link to the board, first make sure you have installed the latest driver software. You
can download the latest software for J-Link from www.segger.com/download_jlink.html.

Connecting the board
1. Connect any of the J-Link debugger probes with the 20-pin JTAG/SWD cable to the board.
2. Connect J-Link to a PC with a USB cable.

3. Connect the board to a PC with the USB cable for power supply. If Windows asks to search for
drivers, you can ignore this.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:
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Target board debug configuration |Setting

Target Luminary Micro Stellaris LM3S8962 Evaluation Kit
Configuration Default

Connection J-Link over USB (JTAG or SWD)

Flash settings: monitor file fluminaryonchip.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000

12.21. Using the Stellaris LM35S2110 CAN Device Board

The Stellaris LM3S2110 CAN device board is delivered with the LM3S8962 Evaluation kit and the
LM3S2965 Evaluation kit. Read the Stellaris LM3S8962 or LM352965 Evaluation Board User's Manual
on the CD, for detailed information about the CAN device board.

Installing driver software

Before you connect J-Link to the board, first make sure you have installed the latest driver software. You
can download the latest software for J-Link from www.segger.com/download_jlink.html.

Connecting the board

1. Connect any of the J-Link debugger probes with the 20-pin JTAG/SWD cable to the CAN device
board.

2. The CAN device board receives its power from the CAN bus, therefore, connect the CAN device
board to the LM3S8962 evaluation board or the LM3S2965 evaluation board with the 10-pin CAN
cable.

3. Connect J-Link to a PC with a USB cable.

4., Connectthe LM3S8962 or LM3S2965 evaluation board to a PC with the USB cable for power supply.
If Windows asks to search for drivers, you can ignore this.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.
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Use the following settings:

Target board debug configuration |Setting

Target Luminary Micro Stellaris LM3S2110 Evaluation Kit
Configuration Default

Connection J-Link over USB (JTAG or SWD)

Flash settings: monitor file fluminaryonchip.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000

12.22. Using the STMicroelectronics MB525-Eval Board

The STMicroelectronics MB525-Eval evaluation board is part of a kit that comes with a USB cable, a
20-pin JTAG/SWD (Serial Wire Debug) target cable, a 5V DC power adapter and a CD. Read the
STMicroelectronics MB525-Eval evaluation board User Manual on the CD, for detailed information about
the board.

Installing driver software
Before you connect J-Link or ST-LINK to the board, first make sure you have installed the latest driver
software. You can download the latest software for J-Link from www.segger.com/download_jlink.html.

You can download the latest software for ST-LINK from
http:/Amww.st.com/internet/com/SOFTWARE._RESOURCES/SW_COMPONENT/SW_DRIVER/stlink_v2_ushdriver.zip.

Jumper settings

Set jumper POWER SEL (JP4) to PSU for power through the 5V DC power jack.

Connecting the board

1. Connect any of the J-Link or ST-LINK debugger probes with the 20-pin JTAG/SWD cable to the
board.

2. Connect J-Link or ST-LINK to a PC with a USB cable.

3. Power the board with the 5V DC power adapter connected to the power jack on the board (PSU).
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Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target STMicroelectronics MB525-Eval board

Configuration Default

Connection J-Link over USB (JTAG or SWD) /
ST-LINK over USB (JTAG or SWD)

Flash settings: monitor file fstm32f10x.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000

12.23. Using the STMicroelectronics STM320518-EVAL Board

The STM320518-EVAL is an evaluation board for STMicroelectronics ARM Cortex-MO core-based
STM32F051R8 microcontrollers. Read the STM320518-EVAL evaluation board User Manual, for detailed
information about the board.

Installing driver software

Before you connect J-Link or ST-LINK to the board or if you want to use the ST-LINK/V2 that is embedded
on the board, first make sure you have installed the latest driver software. You can download the latest
software for J-Link from www.segger.com/download_jlink.html. You can download the latest software for

ST-LINK and ST-LINK/V2 from
http:/Amww.st.com/internet/com/SOFTWARE_RESOURCES/SW_COMPONENT/SW_DRIVER/stlink_v2_ushdriver.zip.

Jumper settings

Set jumper JP8 to PSU for power through the 5V DC power jack.
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Connecting the board

1. Connect any of the J-Link or ST-LINK debugger probes with the 20-pin JTAG/SWD cable to the
board. Alternatively, you can use the ST-LINK/V2 that is embedded on the board. In this case, connect
a USB cable from CN21 to a PC.

2. (Only if a debugger probe is connected) Connect J-Link or ST-LINK to a PC with a USB cable.

3. Power the board with the 5V DC power adapter connected to the power jack on the board.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target STMicroelectronics STM320518-EVAL

Configuration Default

Connection J-Link over USB (JTAG or SWD) /
ST-LINK over USB (JTAG or SWD)

Flash settings: monitor file fstm32f051xx.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000

12.24. Using the STMicroelectronics STM32F0 Discovery

The STM32F0 Discovery is an evaluation board for STMicroelectronics ARM Cortex-MO core-based
STM32F051R8 microcontrollers.

Installing driver software

Before you connect ST-LINK to the board or if you want to use the ST-LINK/V2 that is embedded on the
board, first make sure you have installed the latest driver software. You can download the latest software
for ST-LINK and ST-LINK/V2 from

http:/Amwwv.st.com/internet/com/SOFTWARE._RESOURCES/SW_COMPONENT/SW_DRIVER/stink_v2_ushdriver.zip.
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Connecting the board

¢ Connect the board to a PC with a USB cable.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target STMicroelectronics STM32F0 Discovery Kit
Configuration Default

Connection ST-LINK over USB (SWD)

Flash settings: monitor file fstm32f051xx.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000

12.25. Using the STMicroelectronics STM3210B-Eval Board

The STM3210B-EVAL is an evaluation board for STMicroelectronics ARM Cortex-M3 core-based
STM32F10x 128 Kbyte microcontrollers. Read the STM3210B-EVAL evaluation board User Manual
(UMO0426) on the CD, for detailed information about the board.

Installing driver software
Before you connect J-Link or ST-LINK to the board, first make sure you have installed the latest driver
software. You can download the latest software for J-Link from www.segger.com/download_jlink.html.

You can download the latest software for ST-LINK from
http:/Amwww.st.com/internet/com/SOFTWARE._RESOURCES/SW_COMPONENT/SW_DRIVER/stink_v2_ushdriver.zip.

Jumper settings

Set jumper POWER SEL (JP4) to PSU for power through the 5V DC power jack.
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Connecting the board

1. Connect any of the J-Link or ST-LINK debugger probes with the 20-pin JTAG/SWD cable to the
board.

2. Connect J-Link or ST-LINK to a PC with a USB cable.

3. Power the board with the 5V DC power adapter connected to the power jack on the board (CN4).

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target STMicroelectronics STM3210B-Eval board

Configuration Default

Connection J-Link over USB (JTAG or SWD) /
ST-LINK over USB (JTAG or SWD)

Flash settings: monitor file fstm32f10x.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000

12.26. Using the STMicroelectronics STM3210C-Eval Board

The STM3210C-EVAL is an evaluation board for STMicroelectronics ARM Cortex-M3 core-based
STM32F107VCT microcontrollers. Read the STM3210C-EVAL evaluation board User Manual (UM0600),
for detailed information about the board.

Installing driver software

Before you connect J-Link or ST-LINK to the board, first make sure you have installed the latest driver
software. You can download the latest software for J-Link from www.segger.com/download_jlink.html.
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You can download the latest software for ST-LINK from
http:/Amww.st.com/internet/com/SOFTWARE._RESOURCES/SW_COMPONENT/SW_DRIVER/st-link_v2_ushdriver.zip.

Jumper settings

Set jumper JP25 to PSU for power through the 5V DC power jack.

Connecting the board

1. Connect any of the J-Link or ST-LINK debugger probes with the 20-pin JTAG/SWD cable to the
board.

2. Connect J-Link or ST-LINK to a PC with a USB cable.

3. Power the board with the 5V DC power adapter connected to the power jack on the board (CN18).

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target STMicroelectronics STM3210C-Eval board

Configuration Default

Connection J-Link over USB (JTAG or SWD) /
ST-LINK over USB (JTAG or SWD)

Flash settings: monitor file fstm32f10x.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000

12.27. Using the STMicroelectronics STM3210E-Eval Board

The STM3210E-EVAL is an evaluation board for STMicroelectronics ARM Cortex-M3 core-based
STM32F103Z microcontrollers. Read the STM3210E-EVAL evaluation board User Manual (UM0488),
for detailed information about the board.
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Installing driver software
Before you connect J-Link or ST-LINK to the board, first make sure you have installed the latest driver
software. You can download the latest software for J-Link from www.segger.com/download _jlink.html.

You can download the latest software for ST-LINK from
http:/Amww.st.com/internet/com/SOFTWARE _RESOURCES/SW_COMPONENT/SW_DRIVER/st-ink_v2_ushdriver.zip.

Jumper settings

Set jumper JP13 to PSU for power through the 5V DC power jack.

Connecting the board

1. Connect any of the J-Link or ST-LINK debugger probes with the 20-pin JTAG/SWD cable to the
board.

2. Connect J-Link or ST-LINK to a PC with a USB cable.

3. Power the board with the 5V DC power adapter connected to the power jack on the board (CN17).

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target STMicroelectronics STM3210E-Eval board

Configuration Default

Connection J-Link over USB (JTAG or SWD) /
ST-LINK over USB (JTAG or SWD)

Flash settings: monitor file fstm32f10x.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000
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12.28. Using the STMicroelectronics STM32 Value Line
Discovery
The STM32 Value Line Discovery is an evaluation board for STMicroelectronics ARM Cortex-M3 core-based

STM32F100RB microcontrollers. Read the STM32 Value Line Discovery User Manual (UM0919), for
detailed information about the board.

e

Driver software

This board uses on-board ST-LINK. Except for Windows XP, no special driver software is needed. For
Windows XP, install the ST-LINK/V2 software. You can download the latest software for ST-LINK from
http:/Amww.st.com/internet/com/SOFTWARE_RESOURCES/SW_COMPONENT/SW_DRIVER/st-ink_v2_usbdriver.zip
Connecting the board

» Connect the board to a PC with a USB cable.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target STMicroelectronics STM32 Value line discovery
Configuration Default

Connection Embedded ST-LINK over USB

Flash settings: monitor file fstm32f10x.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000
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12.29. Using the STMicroelectronics STM32L152-Eval Board

The STM32L152-EVAL is an evaluation board for STMicroelectronics ARM Cortex-M3 core-based
STM32L152VB microcontrollers. Read the STM32L152-EVAL evaluation board User Manual (UM1018),
for detailed information about the board.

Installing driver software

Before you connect J-Link or ST-LINK to the board or if you want to use the ST-LINK/V2 that is embedded
on the board, first make sure you have installed the latest driver software. You can download the latest
software for J-Link from www.segger.com/download_jlink.html. You can download the latest software for

ST-LINK and ST-LINK/V2 from
http:/Amww.st.com/internet/com/SOFTWARE_RESOURCES/SW_COMPONENT/SW_DRIVER/stlink_v2_ushdriver.zip.

Jumper settings

Set jumper JP12 to PSU for power through the 5V DC power jack.

Connecting the board

1. Connect any of the J-Link or ST-LINK debugger probes with the 20-pin JTAG/SWD cable to the
board. Alternatively, you can use the ST-LINK/V2 that is embedded on the board. In this case, connect
a USB cable from CN11 to a PC.

2. (Only if a debugger probe is connected) Connect J-Link or ST-LINK to a PC with a USB cable.

3. Power the board with the 5V DC power adapter connected to the power jack on the board (CN12).

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting
Target STMicroelectronics STM32L152-EVAL
Configuration Default
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Target board debug configuration |Setting

Connection J-Link over USB (JTAG or SWD) /
ST-LINK over USB (JTAG or SWD)

Flash settings: monitor file fstm32l1xx.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000

12.30. Using the STMicroelectronics STM32L152D-Eval Board

The STM32L152D-EVAL is an evaluation board for STMicroelectronics ARM Cortex-M3 core-based
STM32L152ZD microcontrollers. Read the STM32L152D-EVAL evaluation board User Manual, for detailed
information about the board.

Note that prototype versions of the STM32L152D-EVAL board have some limitations. STMicroelectronic
recommends to use SWD instead of JTAG to load and debug the code. For more details see section 1.1
Prototype limitations in the STM32L152D-EVAL evaluation board User Manual.

Installing driver software

Before you connect J-Link or ST-LINK to the board or if you want to use the ST-LINK/V2 that is embedded
on the board, first make sure you have installed the latest driver software. You can download the latest
software for J-Link from www.segger.com/download_jlink.html. You can download the latest software for
ST-LINK and ST-LINK/V2 from
http:/Amwwv.st.com/internet/com/SOFTWARE._RESOURCES/SW_COMPONENT/SW_DRIVER/stink_v2_ushdriver.zip.

Jumper settings

Set jumper JP1 to PSU for power through the 5V DC power jack (CN2), or set JP1 to STIk for power
supply from the ST-LINK/V2 USB connector (CN14).

Connecting the board

1. Connect any of the J-Link or ST-LINK debugger probes with the 20-pin JTAG/SWD cable to the
board. Alternatively, you can use the ST-LINK/V2 that is embedded on the board. In this case, connect
a USB cable from CN14 to a PC.

2. (Only if a debugger probe is connected) Connect J-Link or ST-LINK to a PC with a USB cable.
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3. Power the board with the 5V DC power adapter connected to the power jack on the board (CN2), or
with the 5V DC power with 500mA limitation from CN14, the ST-LINK/V2 USB type B connector.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target STMicroelectronics STM32L152D-EVAL

Configuration Default

Connection J-Link over USB (JTAG or SWD) /
ST-LINK over USB (JTAG or SWD)

Flash settings: monitor file fstm32l1xx.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000

12.31. Using the STMicroelectronics STM32L Discovery

The STM32L-DISCOVERY is an evaluation board for STMicroelectronics ARM Cortex-M3 core-based
STM32L152RB microcontrollers. Read the STM32L-DISCOVERY User Manual (UM1079), for detailed
information about the board.

Installing driver software
Before you use the ST-LINK/V2 that is embedded on the board, first make sure you have installed the

latest driver software. You can download the latest software for ST-LINK/V2 from
http:/Amww.st.com/internet/com/SOFTWARE._RESOURCES/SW_COMPONENT/SW_DRIVER/stlink_v2_ushdriver.zip.

Jumper settings

Set jumper JP1 to ON for Idd measurement. Set both CN3 jumpers to ON to enable ST-LINK/V2 functions
for on board programming.
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Connecting the board

¢ Connect the board to a PC with a USB cable.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target STMicroelectronics STM32L Discovery
Configuration Default

Connection Embedded ST-LINK over USB

Flash settings: monitor file fstm32l1xx.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000

12.32. Using the STMicroelectronics STM3220G-EVAL Board

The STM3220G-EVAL is an evaluation board for STMicroelectronics ARM Cortex-M3 core-based
STM32F2xxxx microcontrollers. Read the STM3220G-EVAL evaluation board User Manual (UM1057),
for detailed information about the board.

Installing driver software

Before you connect J-Link or ST-LINK to the board or if you want to use the ST-LINK/V2 that is embedded
on the board, first make sure you have installed the latest driver software. You can download the latest
software for J-Link from www.segger.com/download_jlink.html. You can download the latest software for
ST-LINK and ST-LINK/V2 from
http:/Amww.st.com/internet/com/SOFTWARE._RESOURCES/SW_COMPONENT/SW_DRIVER/stink_v2_ushdriver.zip.
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Jumper settings

Set jumper JP18 to PSU for power through the 5V DC power jack (CN18), or set JP18 to STlk for power
supply from the ST-LINK/V2 USB connector (CN21).

Connecting the board

1. Connect any of the J-Link or ST-LINK debugger probes with the 20-pin JTAG/SWD cable to the
board. Alternatively, you can use the ST-LINK/V2 that is embedded on the board. In this case, connect
a USB cable from CN21 to a PC.

2. (Only if a debugger probe is connected) Connect J-Link or ST-LINK to a PC with a USB cable.

3. Power the board with the 5V DC power adapter connected to the power jack on the board (CN18),
or with the 5V DC power with 500mA limitation from CN21, the ST-LINK/V2 USB connector.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target STMicroelectronics STM3220G-EVAL

Configuration Default

Connection J-Link over USB (JTAG or SWD) /
ST-LINK over USB (JTAG or SWD)

Flash settings: monitor file fstm32f2xxxx.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000

12.33. Using the STMicroelectronics STM3221G-EVAL Board

The STM3221G-EVAL is an evaluation board for STMicroelectronics ARM Cortex-M3 core-based
STM32F2xxxx microcontrollers. Read the STM3221G-EVAL evaluation board User Manual (UM1065),
for detailed information about the board.
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Installing driver software

Before you connect J-Link or ST-LINK to the board or if you want to use the ST-LINK/V2 that is embedded
on the board, first make sure you have installed the latest driver software. You can download the latest
software for J-Link from www.segger.com/download_jlink.html. You can download the latest software for
ST-LINK and ST-LINK/V2 from

http:/Amww.st.com/internet/com/SOFTWARE _RESOURCES/SW_COMPONENT/SW_DRIVER/st-ink_v2_ushbdriver.zip.

Jumper settings

Set jumper JP18 to PSU for power through the 5V DC power jack (CN18), or set JP18 to STlk for power
supply from the ST-LINK/V2 USB connector (CN21).

Connecting the board

1. Connect any of the J-Link or ST-LINK debugger probes with the 20-pin JTAG/SWD cable to the
board. Alternatively, you can use the ST-LINK/V2 that is embedded on the board. In this case, connect
a USB cable from CN21 to a PC.

2. (Only if a debugger probe is connected) Connect J-Link or ST-LINK to a PC with a USB cable.

3. Power the board with the 5V DC power adapter connected to the power jack on the board (CN18),
or with the 5V DC power with 500mA limitation from CN21, the ST-LINK/V2 USB connector.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target STMicroelectronics STM3221G-EVAL

Configuration Default

Connection J-Link over USB (JTAG or SWD) /
ST-LINK over USB (JTAG or SWD)

Flash settings: monitor file fstm32f2xxxx.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000
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12.34. Using the STMicroelectronics STM32303C-EVAL Board

The STM32303C-EVAL is an evaluation board for STMicroelectronics ARM Cortex-M4 core-based
STM32F303VC microcontrollers. Read the STM32303C-EVAL evaluation board User Manual, for detailed
information about the board.

Installing driver software

Before you connect J-Link or ST-LINK to the board or if you want to use the ST-LINK/V2 that is embedded
on the board, first make sure you have installed the latest driver software. You can download the latest
software for J-Link from www.segger.com/download_jlink.html. You can download the latest software for
ST-LINK and ST-LINK/V2 from
http:/Amww.st.com/internet/com/SOFTWARE_RESOURCES/SW_COMPONENT/SW_DRIVER/stlink_v2_ushdriver.zip.

Jumper settings

Set jumper JP14 to PSU for power through the 5V DC power jack (CN14), or set JP14 to STIk for power
supply from the ST-LINK/V2 USB connector (CN5).

Connecting the board

1. Connect any of the J-Link or ST-LINK debugger probes with the 20-pin JTAG/SWD cable to the
board. Alternatively, you can use the ST-LINK/V2 that is embedded on the board. In this case, connect
a USB cable from CN5 to a PC.

2. (Only if a debugger probe is connected) Connect J-Link or ST-LINK to a PC with a USB cable.

3. Power the board with the 5V DC power adapter connected to the power jack on the board (CN14),
or with the 5V DC power with 500mA limitation from CN5, the ST-LINK/V2 USB connector.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting
Target STMicroelectronics STM32303C-Eval board

324


http://www.segger.com/download_jlink.html
http://www.st.com/internet/com/SOFTWARE_RESOURCES/SW_COMPONENT/SW_DRIVER/st-link_v2_usbdriver.zip

Target Board Support

Target board debug configuration |Setting

Configuration Default

Connection J-Link over USB (JTAG or SWD) /
ST-LINK over USB (JTAG or SWD)

Flash settings: monitor file fstm32f10x.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000

12.35. Using the STMicroelectronics STM32373C-EVAL Board

The STM32373C-EVAL is an evaluation board for STMicroelectronics ARM Cortex-M4 core-based
STM32F373VC microcontrollers. Read the STM32373C-EVAL evaluation board User Manual, for detailed
information about the board.

Installing driver software

Before you connect J-Link or ST-LINK to the board or if you want to use the ST-LINK/V2 that is embedded
on the board, first make sure you have installed the latest driver software. You can download the latest
software for J-Link from www.segger.com/download_jlink.html. You can download the latest software for
ST-LINK and ST-LINK/V2 from

http:/Amww.st.com/internet/com/SOFTWARE _RESOURCES/SW_COMPONENT/SW_DRIVER/st-ink_v2_ushdriver.zip.

Jumper settings

Set jumper JP10 to PSU for power through the 5V DC power jack (CN18), or set JP10 to STlk for power
supply from the ST-LINK/V2 USB connector (CN22).

Connecting the board

1. Connect any of the J-Link or ST-LINK debugger probes with the 20-pin JTAG/SWD cable to the
board. Alternatively, you can use the ST-LINK/V2 that is embedded on the board. In this case, connect
a USB cable from CN22 to a PC.

2. (Only if a debugger probe is connected) Connect J-Link or ST-LINK to a PC with a USB cable.

3. Power the board with the 5V DC power adapter connected to the power jack on the board (CN18),
or with the 5V DC power with 500mA limitation from CN22, the ST-LINK/V2 USB connector.
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Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting
Target STMicroelectronics STM32373C-Eval board
Configuration Default
Connection J-Link over USB (JTAG or SWD) /
ST-LINK over USB (JTAG or SWD)
Flash settings: monitor file fstm32f10x.sre
Flash settings: sector buffer size 4096
Flash settings: workspace address |0x20000000

12.36. Using the STMicroelectronics STM3240G-EVAL Board

The STM3240G-EVAL is an evaluation board for STMicroelectronics ARM Cortex-M4 core-based
STM32F4071E, STM32F4071G, STM32F417IE or STM32F4171G microcontrollers. Read the
STM3240G-EVAL evaluation board User Manual (UM1461), for detailed information about the board.

Wit 2

Installing driver software

Before you connect J-Link or ST-LINK to the board or if you want to use the ST-LINK/V2 that is embedded
on the board, first make sure you have installed the latest driver software. You can download the latest
software for J-Link from www.segger.com/download_jlink.html. You can download the latest software for
ST-LINK and ST-LINK/V2 from
http:/Amww.st.com/internet/com/SOFTWARE._RESOURCES/SW_COMPONENT/SW_DRIVER/stlink_v2_ushdriver.zip.

Jumper settings

Set jumper JP18 to PSU for power through the 5V DC power jack (CN18), or set JP18 to STlk for power
supply from the ST-LINK/V2 USB connector (CN21).
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Connecting the board

1. Connect any of the J-Link or ST-LINK debugger probes with the 20-pin JTAG/SWD cable to the
board. Alternatively, you can use the ST-LINK/V2 that is embedded on the board. In this case, connect
a USB cable from CN21 to a PC.

2. (Only if a debugger probe is connected) Connect J-Link or ST-LINK to a PC with a USB cable.

3. Power the board with the 5V DC power adapter connected to the power jack on the board (CN18),
or with the 5V DC power with 500mA limitation from CN21, the ST-LINK/V2 USB connector.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target STMicroelectronics STM3240G-EVAL

Configuration Default

Connection J-Link over USB (JTAG or SWD) /
ST-LINK over USB (JTAG or SWD)

Flash settings: monitor file fstm32f2xxxx.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000

12.37. Using the STMicroelectronics STM324371-EVAL Board

The STM32437I-EVAL is an evaluation board for STMicroelectronics ARM Cortex-M4 core-based
STM32F437I11 microcontrollers. Read the STM324371-EVAL evaluation board User Manual (UM1592),
for detailed information about the board.

Installing driver software

Before you connect J-Link or ST-LINK to the board or if you want to use the ST-LINK/V2 that is embedded
on the board, first make sure you have installed the latest driver software. You can download the latest
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software for J-Link from www.segger.com/download_jlink.html. You can download the latest software for
ST-LINK and ST-LINK/V2 from

http:/Amww.st.com/internet/com/SOFTWARE._RESOURCES/SW_COMPONENT/SW_DRIVER/st-link_v2_ushdriver.zip.

Jumper settings

Set jumper JP18 to PSU for power through the 5V DC power jack (CN18), or set JP18 to STlk for power
supply from the ST-LINK/V2 USB connector (CN21).

Connecting the board

1. Connect any of the J-Link or ST-LINK debugger probes with the 20-pin JTAG/SWD cable to the
board. Alternatively, you can use the ST-LINK/V2 that is embedded on the board. In this case, connect
a USB cable from CN21 to a PC.

2. (Only if a debugger probe is connected) Connect J-Link or ST-LINK to a PC with a USB cable.

3. Power the board with the 5V DC power adapter connected to the power jack on the board (CN18),
or with a USB cable connected to the ST-LINK/V2 USB connector (CN21).

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target STMicroelectronics STM32437I1-EVAL

Configuration Default

Connection J-Link over USB (JTAG or SWD) /
ST-LINK over USB (JTAG or SWD)

Flash settings: monitor file fstm32f2xxxx_dual.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000
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12.38. Using the STMicroelectronics STM32F4 Discovery

The STM32F4DISCOVERY is an evaluation board for STMicroelectronics ARM Cortex-M4 core-based
STM32F407VG microcontrollers. Read the STM32F4DISCOVERY User Manual (UM1472), for detailed
information about the board.

Installing driver software

Before you use the ST-LINK/V2 that is embedded on the board, first make sure you have installed the
latest driver software. You can download the latest software for ST-LINK/V2 from
http:/Aww.st.com/internet/com/SOFTWARE_RESOURCES/SW_COMPONENT/SW_DRIVER/stlink_v2_ushdriver.zip.
Jumper settings

Set jumper JP1 to ON for Idd measurement. Set both CN3 jumpers to ON to enable ST-LINK/V2 functions
for on board programming.

Connecting the board

¢ Connect the board to a PC with a USB cable.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target STMicroelectronics STM32F4 Discovery Kit
Configuration Default

Connection Embedded ST-LINK over USB

Flash settings: monitor file fstm32f2xxxx.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000
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12.39. Using the STMicroelectronics STM32W108B-SK

The STM32W108B-SK is a starter kit for STMicroelectronics ARM Cortex-M3 core-based STM32FW108xx
microcontrollers. The starter kit comes with two STM32W108 application boards (MB851), one STM32W108
extension board (MB850), one STM32-Primer2 tool, one J-Link Lite and a mini USB cable. Read the
STM32W-SK and STM32W-EXT starter and extension kits for STM32W108xx microcontrollers User
Manual (UMO0894), for detailed information about the kit.

Installing driver software
Before you connect J-Link or ST-LINK to the board, first make sure you have installed the latest driver
software. You can download the latest software for J-Link from www.segger.com/download_jlink.html.

You can download the latest software for ST-LINK from
http:/Amww.st.com/internet/com/SOFTWARE_RESOURCES/SW_COMPONENT/SW_DRIVER/stlink_v2_ushdriver.zip.

Jumper settings

Set jumper P2 to USB JTAG for power through the USB or JTAG interface.

Connecting the board

1. Connect any of the J-Link or ST-LINK debugger probes with the 20-pin JTAG/SWD cable to the
board.

2. Connect J-Link or ST-LINK to a PC with a USB cable.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target STMicroelectronics STM32W108B-SK Starter Kit board MB851
Configuration Default
Connection J-Link over USB (JTAG or SWD) /

ST-LINK over USB (JTAG or SWD)
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Target board debug configuration |Setting
Flash settings: monitor file fstm32wxxx.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000

12.40. Using the STMicroelectronics STM32W108B-KEXT

The STM32W108B-KEXT is an extension kit for STMicroelectronics ARM Cortex-M3 core-based
STM32FW108xx microcontrollers. The extension kit comes with two STM32W108 application boards
(MB851) and two STM32W108 application boards with a power amplifier (MB954). Read the STM32W-SK
and STM32W-EXT starter and extension kits for STM32W108xx microcontrollers User Manual (UM0894),
for detailed information about the kit.
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Installing driver software

Before you connect J-Link or ST-LINK to the board, first make sure you have installed the latest driver
software. You can download the latest software for J-Link from www.segger.com/download_jlink.html.
You can download the latest software for ST-LINK from
http:/Awww.st.com/internet/com/SOFTWARE._RESOURCES/SW_COMPONENT/SW_DRIVER/stink_v2_ushdriver.zip.

Jumper settings

Set jumper P2 to USB JTAG for power through the USB or JTAG interface.

Connecting the board

1. Connect any of the J-Link or ST-LINK debugger probes with the 20-pin JTAG/SWD cable to the
board.

2. Connect J-Link or ST-LINK to a PC with a USB cable.
Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:
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Target board debug configuration |Setting

Target STMicroelectronics STM32W108B-KEXT Extension Kit board
MB954

Configuration Default

Connection J-Link over USB (JTAG or SWD) /
ST-LINK over USB (JTAG or SWD)

Flash settings: monitor file fstm32wxxx.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000

12.41. Using the STMicroelectronics STM32W RF Control Kit

The STM32W-RFCKIT is an RF control kit for STMicroelectronics ARM Cortex-M3 core-based
STM32FW108xx RF microcontrollers. The RF control kit contains an STM32W108xx remote application
board (MB950) that you can use for debugging if you solder JTAG/SWD pins on the board. Read the
STM32W-RFCKIT RF control kit for STM32W108xx microcontrollers User Manual (UM1050), for detailed
information about the kit.

Installing driver software
Before you connect J-Link or ST-LINK to the board, first make sure you have installed the latest driver
software. You can download the latest software for J-Link from www.segger.com/download_jlink.html.

You can download the latest software for ST-LINK from
http:/Amwwv.st.com/internet/com/SOFTWARE._RESOURCES/SW_COMPONENT/SW_DRIVER/stink_v2_ushdriver.zip.

JTAG/SWD connection

Note that you can only use the MB950 board for debugging if you solder JTAG/SWD pins on P1.

Connecting the board

1. Connect any of the J-Link or ST-LINK debugger probes with the 20-pin JTAG/SWD cable to the pins
on the board.

2. Connect J-Link or ST-LINK to a PC with a USB cable.
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Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting
Target STMicroelectronics STM32W RF Control Kit board
Configuration Default
Connection J-Link over USB (JTAG or SWD) /
ST-LINK over USB (JTAG or SWD)
Flash settings: monitor file fstm32wxxx.sre
Flash settings: sector buffer size 4096
Flash settings: workspace address |0x20000000

12.42. Using the Keil MCB1760 Evaluation Board

The Keil MCB1760 Evaluation Board is part of a kit that comes with a USB cable and a CD. Read the
MCB1700 Evaluation Board User’s Manual on the CD, for detailed information about the board.

Installing driver software

Before you connect J-Link to the board, first make sure you have installed the latest driver software. You
can download the latest software for J-Link from www.segger.com/download_jlink.html.

Jumper settings

Set the jumpers according to the following picture of the board:
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Connecting the board
1. Connect any of the J-Link debugger probes with a 20-pin JTAG cable to the board.
2. Connect J-Link to a PC with a USB cable.

3. Connect the board via the USB Device port to a PC with the USB cable for power supply. If Windows
asks to search for drivers, you can ignore this.

Eclipse target board debug configuration

In order to debug in the Eclipse environment, you have to create a debug launch configuration for your
hardware configuration. This is explained in Section 11.2, Creating a Customized Debug Configuration.

Use the following settings:

Target board debug configuration |Setting

Target Keil MCB1760 Evaluation Kit
Configuration Default

Connection J-Link over USB

Flash settings: monitor file flpclxxx.sre

Flash settings: sector buffer size 4096

Flash settings: workspace address |0x20000000

12.43.Trace Port Interface Unit Support

Many modern ARM-based processors have a Trace Port Interface Unit (TPIU), which provides a means
to communicate trace and other debug related information to a suitable debug probe, such as a SEGGER
J-Trace.

Currently, the TASKING debugger can process TPIU output only for STMicroelectronics STM32F
processors and only in conjunction with a SEGGER J-Trace probe. Note that not all evaluation boards
actually allow connecting a J-Trace.

You need to be aware of the following:

» The TPIU data is output via five pins named TRACECK and TRACEDO...3 or similar. Typically, these
pins are shared with other chip peripherals and hence you must take care not to use these pins for
other purposes while using TPIU-related debugger facilities.

» At the moment, the TPIU is used only for tracing purposes (see Section 11.4.12, Trace View). In this
case especially the amount of TPIU data is relatively large and therefore, it is important that the TPIU
output frequency is large enough relative to the core's, because otherwise overflow may occur. The
default settings are such that no overflow will occur, but if you increase the core clock frequency, it is
recommended that you increase the TPIU output frequency by the same factor.
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If overflow does occur, the debugger will try to detect and/or work around it, but this may not always
succeed. This may manifest itself as a trace which is inconsistent with actual program execution, for
example.
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Chapter 13. Tool Options

This chapter provides a detailed description of the options for the compiler, assembler, linker, control
program, make utility and the archiver.

Tool options in Eclipse (Menu entry)

For each tool option that you can set from within Eclipse, a Menu entry description is available. In Eclipse
you can customize the tools and tool options in the following dialog:

1. From the Project menu, select Properties for
The Properties dialog appears.

2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.

3. Open the Tool Settings tab.
You can set all tool options here.

Unless stated otherwise, all Menu entry descriptions expect that you have this Tool Settings tab
open.

The following tables give an overview of all tool options on the Tool Settings tab in Eclipse with hyperlinks
to the corresponding command line options (if available).

Global Options

Eclipse option Description or option

Use global 'product directory' preference Directory where the TASKING toolset is
installed

Treat warnings as errors Control program option --warnings-as-errors

Keep temporary files Control program option
--keep-temporary-files (-t)

Verbose mode of control program Control program option --verbose (-v)

Endianness Control program option --endianness

C/C++ Compiler

Eclipse option |Description or option
Preprocessing

Include CMSIS device register definition header file ‘C compiler option --include-file
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Eclipse option

Description or option

Store preprocessor output in <file>.pre

Control program option --preprocess (-E) /
--no-preprocessing-only

Keep comments in preprocessor output

Control program option
--preprocess=+comments

Keep #line info in preprocessor output

Control program option
--preprocess=-noline

Defined symbols

C compiler option --define

Pre-include files

C compiler option --include-file

Include Paths

Add CMSIS include paths

C compiler option --include-directory

Include paths

C compiler option --include-directory

Precompiled C++ Headers

Automatically use/create precompiled header file

C++ compiler option --pch

Create precompiled header file

C++ compiler option --create-pch

Use precompiled header file

C++ compiler option --use-pch

Precompiled header file directory

C++ compiler option --pch-dir

Language

Comply to C standard

C compiler option --iso

Allow GNU C extensions

C compiler option --language=+gcc

Allow // comments in ISO C90 mode

C compiler option --language=+comments

Check assignment of string literal to non-const string pointer

C compiler option --language=-strings

Treat “char” variables as unsigned

C compiler option --uchar

Treat double as float

C compiler option --no-double

Allow optimization across volatile access

C compiler option --language=-volatile

Comply to embedded C++ subset

C++ compiler option --embedded-c++

Support for C++ 1/O streams

C++ compiler option --io-streams

Support for C++ exception handling

C++ compiler option --exceptions

Support for C++ RTTI (run-time type information)

C++ compiler option --rtti

Allow the 'wchar_t' keyword (C++)

C++ compiler option --wchar_t-keyword

Allow non-ANSI/ISO C++ features

C++ compiler option --strict

C++ anachronisms

C++ compiler option --anachronisms

Allow GNU C++ extensions

C++ compiler option --g++

Code Generation

Use Thumb instruction set

C compiler option --thumb

Compile for ARM/Thumb interworking

C compiler option --interwork

Use FPU

C compiler option --fpu
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Eclipse option

Description or option

Alignment for composite types

C compiler option --align-composites

Select call mode

C compiler option --call

Optimization

Optimization level

C compiler option --optimize

Trade-off between speed and size

C compiler option --tradeoff

Maximum size for code compaction

C compiler option --compact-max-size

Maximum call depth for code compaction

C compiler option --max-call-depth

Always inline function calls

C compiler option --inline

Maximum size increment when inlining (in %)

C compiler option --inline-max-incr

Maximum size for functions to always inline

C compiler option --inline-max-size

Build for application wide optimizations (MIL linking)

Control program option --mil-link / --mil-split

Application wide optimization mode

Control program option --mil-link / --mil-split

Custom Optimization

C compiler option --optimize

Compilation Speed

C compiler option --cache

Debugging

Generate symbolic debug information

C compiler option --debug-info

Static profiling

C compiler option --profile=+static

Generate profiling information for block counters

C compiler option --profile=+block

Generate profiling information to build a call graph

C compiler option --profile=+callgraph

Generate profiling information for function counters

C compiler option --profile=+function

Generate profiling information for function timers

C compiler option --profile=+time

Exclude time spent in interrupt functions

C compiler option --profile=+time,+interrupt

Generate code for bounds checking

C compiler option --runtime=+bounds

Generate code to detect unhandled case in a switch

C compiler option --runtime=+case

Generate code for malloc consistency checks

C compiler option --runtime=+malloc

Generate code for stack overflow checks (allowed for USR
and SYS mode only)

C compiler option --runtime=+stack

Generate code for division by zero checks

C compiler option --runtime=+zero

MISRA-C

MISRA-C checking

C compiler option --misrac

MISRA-C version

C compiler option --misrac-version

Warnings instead of errors for required rules

C compiler option
--misrac-required-warnings

Warnings instead of errors for advisory rules

C compiler option
--misrac-advisory-warnings

Custom 1998 / Custom 2004

C compiler option --misrac
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Eclipse option

Description or option

CERT C Secure Coding

CERT C secure code checking

C compiler option --cert

Warnings instead of errors

C compiler option
--warnings-as-errors=700-715

Custom CERT C

C compiler option --cert

Diagnostics

Suppress C compiler warnings

C compiler option --no-warnings=num

Suppress all warnings

C compiler option --no-warnings

Suppress C++ compiler “used before set” warnings

C++ compiler option
--no-use-before-set-warnings

Issue remarks on C++ code

C++ compiler option --remarks

Perform global type checking on C code

C compiler option --global-type-checking

Miscellaneous

Merge C source code with generated assembly

C compiler option --source

Force definition of virtual function tables (C++)

C++ compiler option --force-vtbl

Suppress definition of virtual function tables (C++)

C++ compiler option --suppress-vtbl

Implicit inclusion of source files for finding templates

C++ compiler option --implicit-include

Minimal inlining of function calls (C++)

C++ compiler option --no-inlining

Instantiation mode of external template entities

C++ compiler option --instantiate

Additional options

C compiler options, C++ compiler options,
Control program options

Assembler

Eclipse option

Description or option

Preprocessing

Use TASKING preprocessor

Assembler option --preprocessor-type

Defined symbols

Assembler option --define

Pre-include files

Assembler option --include-file

Include Paths

Include paths

Assembler option --include-directory

Symbols

Generate symbolic debug

Assembler option --debug-info

Case insensitive identifiers

Assembler option --case-insensitive

Emit local EQU symbols

Assembler option --emit-locals=+equ

Emit mapping symbols ($a,$t,$d)

Assembler option --emit-locals=+mappings
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Eclipse option

Description or option

Emit local non-EQU symbols

Assembler option --emit-locals=+symbols

Set default symbol scope to global

Assembler option --symbol-scope

List File
Generate list file Control program option --list-files
List ... Assembler option --list-format

List section summary

Assembler option --section-info=+list

Diagnostics

Suppress warnings

Assembler option --no-warnings=num

Suppress all warnings

Assembler option --no-warnings

Display section summary

Assembler option --section-info=+console

Maximum number of emitted errors

Assembler option --error-limit

Miscellaneous

Use full assembler for mixed ARM and Thumb instructions

Control program option --mixed-arm-thumb

Assemble Thumb instructions by default

Control program option --thumb

Allow 2-operand form for 3-operand instructions

Assembler option --relaxed

UAL syntax mode

Assembler option --old-syntax

Allow instruction inversions

Assembler option --inversions

Additional options

Assembler options

Linker

Eclipse option

Description or option

Output Format

Generate Intel Hex format file

Linker option --output=file:IHEX

Generate S-records file

Linker option --output=file:SREC

Create file for each memory chip

Linker option --chip-output

Size of addresses (in bytes) for Intel Hex records

Linker option --output=file:IHEX:size

Size of addresses (in bytes) for Motorola S records

Linker option --output=file: SREC:size

Emit start address record

Linker option --hex-format=s

Libraries

Link default libraries

Control program option --no-default-libraries

Link CMSIS DSP library

Control program option --dsp-library

Rescan libraries to solve unresolved externals

Linker option --no-rescan

Libraries

The libraries are added as files on the
command line.

Library search path

Linker option --library-directory
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Eclipse option

|Description or option

Data Objects

Data objects

| Linker option --import-object

Script File

Defined symbols

Linker option --define

Linker script file (.Isl)

Linker option --Isl-file

Optimization

Delete unreferenced sections

Linker option --optimize=c

Use a 'first-fit decreasing' algorithm

Linker option --optimize=I

Compress copy table

Linker option --optimize=t

Delete duplicate code

Linker option --optimize=x

Delete duplicate data

Linker option --optimize=y

Compress ROM sections of copy table items

Linker option --optimize=z

Map File

Generate map file (.map)

Control program option --no-map-file

Generate XML map file format (.mapxml) for map file viewer

Linker option --map-file=file. mapxml: XML

Include ...

Linker option --map-file-format

Diagnostics

Suppress warnings

Linker option --no-warnings=num

Suppress all warnings

Linker option --no-warnings

Maximum number of emitted errors

Linker option --error-limit

Miscellaneous

Strip symbolic debug information

Linker option --strip-debug

Link case insensitive

Linker option --case-insensitive

Do not use standard copy table for initialization

Linker option
--user-provided-initialization-code

Show link phases during processing

Linker option --verbose

Generate long-branch veneers

Linker option --long-branch-veneers

Application is not romable

Linker option --non-romable

Additional options

Linker options
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13.1. Configuring the Command Line Environment

If you want to use the tools on the command line (using a Windows command prompt), you can set

environment variables.

You can set the following environment variables:

Environment Description

variable

ASARMINC With this variable you specify one or more additional directories in which the
assembler looks for include files. See Section 7.4, How the Assembler Searches
Include Files.

CARMINC With this variable you specify one or more additional directories in which the C
compiler looks for include files. See Section 4.3, How the Compiler Searches
Include Files.

CPARMINC With this variable you specify one or more additional directories in which the C++
compiler looks for include files. See Section 5.2, How the C++ Compiler Searches
Include Files.

CCARMBIN When this variable is set, the control program prepends the directory specified
by this variable to the names of the tools invoked.

LIBCARM With this variable you specify one or more additional directories in which the linker

looks for libraries. See Section 8.3.1, How the Linker Searches Libraries.

LM_LICENSE_FILE

With this variable you specify the location of the license data file. You only need
to specify this variable if the license file is not on its default location

(c:\flexI mIicense. dat for Windows,
/fusr/local/flexlmlicenses/license. dat for Solaris).

PATH

With this variable you specify the directory in which the executables reside. This
allows you to call the executables when you are not in the bi n directory. Usually
your system already uses the PATH variable for other purposes. To keep these
settings, you need to add (rather than replace) the path. Use a semicolon (;) to
separate path names.

TASKING_LIC_WAIT

If you set this variable, the tool will wait for a license to become available, if all
licenses are taken. If you have not set this variable, the tool aborts with an error
message. (Only useful with floating licenses)

TMPDIR

With this variable you specify the location where programs can create temporary
files. Usually your system already uses this variable. In this case you do not need
to change it.

See the documentation of your operating system on how to set environment variables.
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13.2. C Compiler Options

This section lists all C compiler options.

Options in Eclipse versus options on the command line

Most command line options have an equivalent option in Eclipse but some options are only available on
the command line. Eclipse invokes the compiler via the control program. Therefore, it uses the syntax of
the control program to pass options and files to the C compiler. If there is no equivalent option in Eclipse,
you can specify a command line option in Eclipse as follows:

1. From the Project menu, select Properties for
The Properties dialog appears.
2. Inthe left pane, expand C/C++ Build and select Settings.
In the right pane the Settings appear.
3. On the Tool Settings tab, select C/C++ Compiler » Miscellaneous.
4. Inthe Additional options field, enter one or more command line options.

Because Eclipse uses the control program, you have to precede the option with -Wc to pass the
option via the control program directly to the C compiler.

Be aware that some command line options are not useful in Eclipse or just do not have any effect. For
example, the option -n sends output to stdout instead of a file and has no effect in Eclipse.

Short and long option names

Options can have both short and long names. Short option names always begin with a single minus (-)
character, long option names always begin with two minus (--) characters. You can abbreviate long option
names as long as it forms a unique name. You can mix short and long option names on the command
line.

Options can have flags or suboptions. To switch a flag 'on’, use a lowercase letter or a +longflag. To
switch a flag off, use an uppercase letter or a -longflag. Separate longflags with commas. The following
two invocations are equivalent:

carm-Qac test.c
carm --optinm ze=+coal esce, +cse test.c

When you do not specify an option, a default value may become active.
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C compiler option: --align-composites

Menu entry

1. Select C/C++ Compiler » Code Generation.

2. Select the Alignment for composite types: Natural alignment or Optimal alignment.
Command line syntax

--align-conposites=alignnent

You can specify the following alignments:

n Natural alignment (default)
o] Optimal alignment
Description

With this option you can set the alignment for composite types (structs, unions and arrays).
Natural alignment (n) uses the natural alignment of the most-aligned member of the composite type.

Optimal alignment (0) sets the alignment to 8, 16, or 32 bits depending on the size of the composite type.

Example
Consider the following structure of three chars.

struct s

{
char a;
char b;
char c;

} s_var;

With natural alignment this results in a size of s_var of three bytes.

s_var .type object
.size s_var,3
.ds 3

With --align-composites=0, s_var is padded with one extra byte, so that the contents of the struct is
aligned at 4 bytes.

s_var .type object

.size s_var,4
. ds 4
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Related information
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C compiler option: --cache

Menu entry
1. Select C/C++ Compiler » Optimization » Compilation Speed.
2. Enable the option Cache generated code to improve the compilation speed.

3. Inthe Directory for cached files field, enter the name for the location of the cache.

Command line syntax
--cache[ =di rectory]
Default on command line: . (current directory)

Default in Eclipse: . cache directory under project directory

Description

This option enables a cache for output files in the specified directory. When the source code after
preprocessing and relevant compiler options and the compiler version are the same as in a previous
invocation, the previous result is copied to the output file. The cache only works when there is a single C
input file and a single output file (no --mil-split).

You can also enable the cache and specify the cache directory with the environment variable
CARMCACHE. This option takes precedence over the environment variable.

The cache directory may be shared, for instance by placing it on a network drive.

The compiler creates a directory car ncache in the directory specified with the option --cache or the
environment variable CARMCACHE. The directory is only created when it does not yet exist. The cache
files are stored in this directory.

Example

To improve the compilation speed and put cached files in directory . cache, enter:
carm --cache=. cache test.c

Related information

Section 4.6, Influencing the Build Time

Section 10.6, Expire Cache Utility
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C compiler option: --call (-m)
Menu entry

1. Select C/C++ Compiler » Code Generation.

2. Set the option Select call mode to Use PC-relative calls (default) or to Use 32-bit indirect calls.

Command line syntax

--call ={far]| near}

- f ] n}

Description

To address the memory of the ARM, you can use two different call modes:

far 32-bit indirect calls. Though you can address the full range of memory, the
address is first loaded into a register after which the call is executed.

near 26-bit PC-relative call. The PC-relative call is directly coded into the B instruction.
This way of calling results in higher execution speed. However, not the full range
of memory can be addressed with near calls.

If you compile your C source with near calls but the called address cannot be reached with a near
call, the linker will generate an error.

It is recommended to use the near addressing mode unless your application needs calls to addresses
that fall outside a 256 MB region.

Example
Consider the following function g which calls function p:

extern int p(int a, int b, int c, int d)

{
}

return at+b+c+d + a*b*c*d;
extern int iii;
voi d g(void)

iii=p(42,43, 44, 45);
}

With --call=near, this results into

q: .type func
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. L3:

str Ir,[sp, #4]!
nov r3, #45
nov r2, #44
nov ri, #43
nov ro, #42

bl p

| dr ri,.L3

str ro,[r1, #0]
| dr pc, [sp], #4
align 4

dw P

size q,%-¢q
calls 'q','p'
.calls '"p','",8
calls 'q,'',4
.extern iii

With --call=far, this results into

o

. L3:

.type func

stnfd sp!,{r4,Ir}

| dr r4,.L3
nmov r 3, #45
nmov r2, #44
nmov rl, #43
nmov ro, #42
nov Ir, pc

bx ra

| dr ri,.L3+4
str ro,[r1, #0]

| dnfd sp!,{r4, pc}
.align 4

. dw
. dw
. Size

=]

ii
,$-q

o -

.calls ' __INDIRECT_ '

.calls '¢
.calls '"p',"",8
.calls 'q',"'',8
.extern iii

.extern __ I NDI RECT__

PC-rel ative call

address | oaded in register

i ndirect call

,'p' ; indirect calls
," _INDIRECT__'

Tool Options

349



TASKING VX-toolset for ARM User Guide

Related information
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C compiler option: --cert

Menu entry
1. Select C/C++ Compiler » CERT C Secure Coding.
2. Make a selection from the CERT C secure code checking list.

3. If you selected Custom, expand the Custom CERT C entry and enable one or more individual
recommendations/rules.

Command line syntax
--cert={all | nane[-nane],...}
Default format: all

Description

With this option you can enable one or more checks for CERT C Secure Coding Standard
recommendations/rules. When you omit the argument, all checks are enabled. name is the name of a
CERT recommendation/rule, consisting of three letters and two digits. Specify only the three-letter
mnemonic to select a whole category. For the list of names you can use, see Chapter 20, CERT C Secure
Coding Standard.

On the command line you can use --diag=cert to see a list of the available checks, or you can use a

three-letter mnemonic to list only the checks in a particular category. For example, --diag=pre lists all
supported preprocessor checks.

Example

To enable the check for CERT rule STR30-C, enter:
carm--cert=str30 test.c

Related information

Chapter 20, CERT C Secure Coding Standard

C compiler option --diag (Explanation of diagnostic messages)
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C compiler option: --check

Menu entry

Command line syntax

--check

Description

With this option you can check the source code for syntax errors, without generating code. This saves
time in developing your application because the code will not actually be compiled.

The compiler reports any warnings and/or errors.
This option is available on the command line only.
Related information

Assembler option --check (Check syntax)
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C compiler option: --code-endianness

Menu entry

Command line syntax
- -code- endi anness=endi anness

You can specify the following endianness:

big b Big endian
little | Little endian (default)
Description

This option tells the compiler what code endianness you want, little-endian (least significant byte of a
word at lowest byte code address) or big-endian (most significant byte of a word at lowest byte code
address). The code endianness used must be a valid one for the architecture you are compiling for. This
option is only available for ARMV7R.

Related information

C compiler option --endianness (Data endianness)
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C compiler option: --compact-max-size

Menu entry
1. Select C/C++ Compiler » Optimization.

2. Inthe Maximum size for code compaction field, enter the maximum size of a match.

Command line syntax

- - conpact - max- si ze=val ue
Default: 200

Description

This option is related to the compiler optimization --optimize=+compact (Code compaction or reverse
inlining). Code compaction is the opposite of inlining functions: large sequences of code that occur more
than once, are transformed into a function. This reduces code size (possibly at the cost of execution
speed).

However, in the process of finding sequences of matching instructions, compile time and compiler memory
usage increase quadratically with the number of instructions considered for code compaction. With this
option you tell the compiler to limit the number of matching instructions it considers for code compaction.

Example

To limit the maximum number of instructions in functions that the compiler generates during code
compaction:

carm --optinm ze=+conpact --conpact-nmax-si ze=100 test.c
Related information
C compiler option --optimize=+compact (Optimization: code compaction)

C compiler option --max-call-depth (Maximum call depth for code compaction)
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C compiler option: --cpu (-C)
Menu entry

1. Expand C/C++ Build and select Processor.

2. From the Processor Selection list, make a selection by Architecture, Core or one of the
manufacturers.

Command line syntax
--cpu=architecture
-Carchitecture

You can specify the following architectures:

ARMv6M Compile for ARMv6-M architecture

ARMv7M Compile for ARMv7-M architecture

ARMV7EM Compile for ARMV7E-M architecture

ARMV7R Compile for ARMv7-R architecture
Description

With this option you specify the ARM architecture for which you create your application. The ARM target
supports more than one architecture and therefore you need to specify for which architecture the compiler
should compile. The architecture determines which instructions are valid and which are not.

You choose one of the following architectures: ARMv6-M, ARMv7-M, ARMvV7E-M or ARMvV7-R. The
compiler sets the Thumb instruction set implicitly (option --thumb).

The macro __CPU_ar ch__ is defined in the C source file. The arch is converted to uppercase.

When you call the compiler from the command line, make sure you specify the same core type to the
assembler to avoid conflicts!

Example

To compile the file t est . ¢ for the ARMV7E-M processor type, enter the following on the command line:
carm - - cpu=ARM/7EM t est . c

The compiler compiles for the chosen processor type.

Related information

Control program option --cpu (Select architecture)

Assembler option --cpu (Select architecture)
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C compiler option: --debug-info (-g)
Menu entry

1. Select C/C++ Compiler » Debugging.

2. Togenerate symbolic debug information, select Default, Small set or Full.
To disable the generation of debug information, select None.

Command line syntax
- -debug-i nf o[ =subopti on]
- g[ subopti on]

You can set the following suboptions:

small 1/c Emit small set of debug information.
default 2/d Emit default symbolic debug information.
all 3/a Emit full symbolic debug information.

Default: - - debug- i nf o (same as - - debug- i nf o=def aul t)

Description

With this option you tell the compiler to add directives to the output file for including symbolic information.
This facilitates high level debugging but increases the size of the resulting assembler file (and thus the
size of the object file). For the final application, compile your C files without debug information.

The DWARF debug format allows for a flexible approach as to how much symbolic information is included,
as long as the structure is valid. Adding all possible DWARF data for a program is not practical. The
amount of DWARF information per compilation unit can be huge. And for large projects, with many object
modules the link time can grow unacceptably long. That is why the compiler has several debug information
levels. In general terms one can say, the higher the level the more DWARF information is produced.

The DWARF data in an object module is not only used for debugging. The toolset can also do "type
checking" of the whole application. In that case the linker will use the DWARF information of all object
modules to determine if every use of a symbol is done with the same type. In other words, if the application
is built with type checking enabled then the compiler will add DWARF information too.

Small set of debug information

With this suboption only DWARF call frame information and type information are generated. This enables
you to inspect parameters of nested functions. The type information improves debugging. You can perform
a stack trace, but stepping is not possible because debug information on function bodies is not generated.
You can use this suboption, for example, to compact libraries.
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Default debug information

This provides all debug information you need to debug your application. It meets the debugging
requirements in most cases without resulting in oversized assembler/object files.

Full debug information

With this suboption extra debug information is generated about unused typedefs and DWARF "lookup
table sections". Under normal circumstances this extra debug information is not needed to debug the
program. Information about unused typedefs concerns all typedefs, even the ones that are not used for
any variable in the program. (Possibly, these unused typedefs are listed in the standard include files.)
With this suboption, the resulting assembler/object file will increase significantly.

In the following table you see in more detail what DWARF information is included for the debug option
levels.

Feature -g1 |[-g2 |-g3 |type check Remarks
basic info + + + + info such as symbol name and type
call frame + + + + this is information for a debugger to compute

a stack trace when a program has stopped
at a breakpoint

symbol lifetime + + this is information about where symbols live
(e.g. on stack at offset so and so, when the
program counter is in this range)

line number info + + + file name, line number, column number

"lookup tables" + DWARF sections ... this is an optimization
for the DWARF data, it is not essential

unused typedefs + in the C/C++ code of the program there can

be (many) typedefs that are not used for any
variable. Sometimes this can cause
enormous expansion of the DWARF data and
thus it is only included in -g3.

Related information
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C compiler option: --define (-D)

Menu entry
1. Select C/C++ Compiler » Preprocessing.
The Defined symbols box shows the symbols that are currently defined.
2. To define a new symbol, click on the Add button in the Defined symbols box.

3. Type the symbol definition (for example, denp=1)
Use the Edit and Delete button to change a macro definition or to remove a macro from the list.

Command line syntax

- -defi ne=macr o_nane[ =macr o_defi ni ti on]
- Dmacr o_name[ =nacr o_defini tion]
Description

With this option you can define a macro and specify it to the preprocessor. If you only specify a macro
name (no macro definition), the macro expands as '1".

You can specify as many macros as you like. Simply use the Add button to add new macro definitions.

On the command line, you can use the option --define (-D) multiple times. If the command line exceeds
the limit of the operating system, you can define the macros in an option file which you then must specify
to the compiler with the option --option-file (-f) file.

Defining macros with this option (instead of in the C source) is, for example, useful to compile conditional
C source as shown in the example below.

Example

Consider the following C program with conditional code to compile a demo program and a real program:

void main( void )

{
#i f DEMO

deno_func(); /* conpile for the deno program */
#el se

real _func(); /* conpile for the real program*/
#endi f
}

You can now use a macro definition to set the DEMO flag:
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carm --define=DEMO test.c
carm --defi ne=DEMO=1 test.c
Note that both invocations have the same effect.

The next example shows how to define a macro with arguments. Note that the macro name and definition
are placed between double quotes because otherwise the spaces would indicate a new option.

carm - -define="MAX(A B)=((A) > (B) ? (A : (B))" test.c
Related information
C compiler option --undefine (Remove preprocessor macro)

C compiler option --option-file (Specify an option file)
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C compiler option: --dep-file

Menu entry

Eclipse uses this option in the background to create a file with extension . d (one for every input file).

Command line syntax
--dep-file[=file]
Description

With this option you tell the compiler to generate dependency lines that can be used in a Makefile. In
contrast to the option --preprocess=+make, the dependency information will be generated in addition to
the normal output file.

By default, the information is written to a file with extension . d (one for every input file). When you specify
a filename, all dependencies will be combined in the specified file.

Example
carm--dep-file=test.dep test.c

The compiler compiles the file t est . ¢, which results in the output file t est . sr ¢, and generates
dependency lines in the file t est . dep. For example:

test.obj : test.c

test.c :

test.obj : <install-dir>/carnilinclude/stdio.h
<install-dir>/carnlinclude/stdio.h :

test.obj : <install-dir>/carnifinclude/stdarg.h

<install-dir>/carnlinclude/stdarg.h :

Related information

C compiler option --preprocess=+make (Generate dependencies for make)
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C compiler option: --diag

Menu entry

1. From the Window menu, select Show View » Other » TASKING » Problems.
The Problems view is added to the current perspective.

2. In the Problems view right-click on a message.
A popup menu appears.

3. Select Detailed Diagnostics Info.

A dialog box appears with additional information.
Command line syntax
--diag=[format:]{all | nsg[-nBQg],...}

You can set the following output formats:

html HTML output.
rtf Rich Text Format.
text ASCII text.

Default format: text

Description

With this option you can ask for an extended description of error messages in the format you choose.
The output is directed to stdout (normally your screen) and in the format you specify. The compiler does
not compile any files. You can specify the following formats: html, rtf or text (default). To create a file
with the descriptions, you must redirect the output.

With the suboption all, the descriptions of all error messages are given (except for the CERT checks). If
you want the description of one or more selected error messages, you can specify the error message
numbers, separated by commas, or you can specify a range.

With --diag=cert you can see a list of the available CERT checks, or you can use a three-letter mnemonic
to list only the checks in a particular category. For example, --diag=pre lists all supported preprocessor
checks.

Example
To display an explanation of message number 282, enter:
carm - - di ag=282

This results in the following message and explanation:
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E282: unterm nated conment

Make sure that every comment starting with /* has a matching */.
Nest ed coments are not possible.

To write an explanation of all errors and warnings in HTML format to file cer r or s. ht m , use redirection
and enter:

carm--diag=htm:all > cerrors.htn

Related information
Section 4.8, C Compiler Error Messages

C compiler option --cert (Enable individual CERT checks)
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C compiler option: --endianness

Menu entry

1. Select Global Options.

2. Specify the Endianness:Little-endian mode or Big-endian mode.

Command line syntax
- - endi anness=endi anness

-B
- - bi g-endi an

You can specify the following endianness:

big b Big endian
little | Little endian (default)
Description

Tool Options

By default, the compiler generates code for a little-endian target (least significant byte of a word at lowest
byte address). With --endianness=big the compiler generates code for a big-endian target (most significant

byte of a word at lowest byte address). -B is an alias for option --endianness=big.

Related information

C compiler option --code-endianness (Code endianness)
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C compiler option: --error-file

Menu entry
Command line syntax
--error-file[=file]
Description

With this option the compiler redirects error messages to a file. If you do not specify a filename, the error
file will be named after the input file with extension . err .

Example
To write errors to error s. err instead of st derr, enter:

carm--error-file=errors.err test.c

Related information
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C compiler option: --fpu

Menu entry

1. Select C/C++ Compiler » Code Generation.
2. Enable the option Use FPU.

Command line syntax

--fpu=fpu

You can specify the following arguments:

FPv4-sp alias for VFPv4-sp

VFPv2 alias for VFPv3

VFPv3 Compile for VFPv3 architecture

VFPv3-sp Compile for VFPv3-sp architecture

VFPv4-sp Compile for VFPv4-sp architecture

none Compile for software FPU library (default)
Description

With this option you define the kind of FPU support with which you create your application. The "sp" suffix
denotes single precision floating-point only.

The macro __FPU _f pu__ is defined in the C source file. The fpu is converted to uppercase and the
lowercase “v" and the "-' will be removed. Also when "none" is not used, the macro __FPU_VFP__is
defined in the C source file, otherwise the macro __FPU_NONE__ is defined.

Example
To compile the file t est . ¢ for the VFPv3-sp architecture, enter the following on the command line:
carm --fpu=VFPv3-sp test.c

This defines the symbols __FPU VFP__and __FPU_VFP3SP__.

Related information
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C compiler option: --global-type-checking
Menu entry

1. Select C/C++ Compiler » Diagnostics.

2. Enable the option Perform global type checking on C code.
Command line syntax

--gl obal -t ype-checki ng

Description

The C compiler already performs type checking within each module. Use this option when you want the
linker to perform type checking between modules.

Related information
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C compiler option: --help (-?)
Menu entry
Command line syntax

--help[=item

-2

You can specify the following arguments:

intrinsics i Show the list of intrinsic functions

options o] Show extended option descriptions

pragmas p Show the list of supported pragmas

typedefs t Show the list of predefined typedefs
Description

Displays an overview of all command line options. With an argument you can specify which extended
information is shown.

Example

The following invocations all display a list of the available command line options:
carm-?

carm--help

carm

The following invocation displays a list of the available pragmas:

carm - - hel p=pr agnmas

Related information
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C compiler option: --include-directory (-I)

Menu entry
1. Select C/C++ Compiler » Include Paths.

The Include paths box shows the directories that are added to the search path for include files.
2. To define a new directory for the search path, click on the Add button in the Include paths box.
3. Type or select a path.

4. Optionally enable the option Add CMSIS include paths.
Use the Edit and Delete button to change a path or to remove a path from the list.

Command line syntax
--include-directory=path, ...

-lpath, ...

Description

With this option you can specify the path where your include files are located. A relative path will be
relative to the current directory,

The order in which the compiler searches for include files is:

1. The pathname in the C source file and the directory of the C source (only for #include files that are
enclosed in ")

2. The path or paths that are specified with this option. Multiple paths/options are handled by the C
compiler from left to right. From Eclipse, the CMSIS include paths, if enabled, are the first option, so
they are searched first.

3. The path that is specified in the environment variable CARM NC when the product was installed.

4. The default directory $( PRODDI R) \ i ncl ude (unless you specified option --no-stdinc).

Example
Suppose that the C source file t est . ¢ contains the following lines:

#i ncl ude <stdio. h>
#i ncl ude "nyinc. h"

You can call the compiler as follows:

carm --incl ude-directory=nyinclude test.c
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First the compiler looks for the file st di 0. h in the directory nyi ncl ude relative to the current directory.
If it was not found, the compiler searches in the environment variable and then in the default include
directory.

The compiler now looks for the file nyi nc. h in the directory where t est . ¢ is located. If the file is not
there the compiler searches in the directory nyi ncl ude. If it was still not found, the compiler searches
in the environment variable and then in the default include directory.

Related information
C compiler option --include-file (Include file at the start of a compilation)

C compiler option --no-stdinc (Skip standard include files directory)
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C compiler option: --include-file (-H)
Menu entry
1. Select C/C++ Compiler » Preprocessing.
The Pre-include files box shows the files that are currently included before the compilation starts.
2. To define a new file, click on the Add button in the Pre-include files box.
3. Type the full path and file name or select a file.

4. (Optional) Enable the option Include CMSIS device register definition header file.

Use the Edit and Delete button to change a file name or to remove a file from the list.

Command line syntax
--include-file=file,...
-Hfile,...

Description

With this option you include one or more extra files at the beginning of each C source file, before other
includes. This is the same as specifying #i ncl ude "fil e" atthe beginning of each of your C sources.

Example

carm--include-file=stdio.h testl.c test2.c

The file st di 0. h is included at the beginning of botht est 1. c and t est 2. c.
Related information

C compiler option --include-directory (Add directory to include file search path)
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C compiler option: --inline
Menu entry

1. Select C/C++ Compiler » Optimization.

2. Enable the option Always inline function calls.
Command line syntax

--inline

Description

With this option you instruct the compiler to inline calls to functions without the __noi nl i ne function
qualifier whenever possible. This option has the same effect as a #pr agnma i nl i ne at the start of the
source file.

This option can be useful to increase the possibilities for code compaction (C compiler option
--optimize=+compact).

Example

To always inline function calls:

carm --optim ze=+conpact --inline test.c

Related information

C compiler option --optimize=+compact (Optimization: code compaction)

Section 1.10.2, Inlining Functions: inline
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C compiler option: --inline-max-incr / --inline-max-size
Menu entry

1. Select C/C++ Compiler » Optimization.

2. Inthe Maximum size increment when inlining field, enter a value (default -1).

3. Inthe Maximum size for functions to always inline field, enter a value (default -1).

Command line syntax

--inline-max-incr=percentage (default: -1)

--inline-max-size=threshol d (default: -1)

Description

With these options you can control the automatic function inlining optimization process of the compiler.

These options have only effect when you have enabled the inlining optimization (option --optimize=+inline
or Optimize most).

Regardless of the optimization process, the compiler always inlines all functions that have the
function qualifieri nl i ne.

With the option --inline-max-size you can specify the maximum size of functions that the compiler inlines
as part of the optimization process. The compiler always inlines all functions that are smaller than the
specified threshold. The threshold is measured in compiler internal units and the compiler uses this
measure to decide which functions are small enough to inline. The default threshold is -1, which means
that the threshold depends on the option --tradeoff.

After the compiler has inlined all functions that have the function qualifier i nl i ne and all functions that
are smaller than the specified threshold, the compiler looks whether it can inline more functions without
increasing the code size too much. With the option --inline-max-incr you can specify how much the code
size is allowed to increase. The default value is -1, which means that the value depends on the option
--tradeoff.

Example
carm --inline-max-incr=40 --inline-max-size=15 test.c
The compiler first inlines all functions with the function qualifier i nl i ne and all functions that are smaller

than the specified threshold of 15. If the code size has still not increased with 40%, the compiler decides
which other functions it can inline.

Related information
C compiler option --optimize=+inline (Optimization: automatic function inlining)

Section 1.10.2, Inlining Functions: inline
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Section 4.5.3, Optimize for Size or Speed
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C compiler option: --interwork

Menu entry
1. Select C/C++ Compiler » Code Generation.

2. Enable the option Compile for ARM/Thumb interworking.
Command line syntax
--interwork

Description

With this option the compiler generates code which supports calls between functions with the ARM and
Thumb instruction set.

Use this option if your program consists of both ARM and Thumb functions.
By default this option is disabled, since it produces slightly larger code.
Related information

C compiler option --thumb (Use Thumb instruction set)
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C compiler option: --iso (-c)

Menu entry

1. Select C/C++ Compiler » Language.

2. From the Comply to C standard list, select ISO C99 or ISO C90.
Command line syntax

--is0={90| 99}

-¢{90] 99}

Default: - - i s0=99

Description

With this option you select the ISO C standard. C90 is also referred to as the "ANSI C standard". C99
refers to the newer ISO/IEC 9899:1999 (E) standard. C99 is the default.

Example

To select the ISO C90 standard on the command line:
carm--iso=90 test.c

Related information

C compiler option --language (Language extensions)
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C compiler option: --keep-output-files (-k)

Menu entry

Eclipse always removes the . sr ¢ file when errors occur during compilation.

Command line syntax
--keep-output-files
-k

Description

If an error occurs during compilation, the resulting . sr ¢ file may be incomplete or incorrect. With this
option you keep the generated output file (. sr ¢) when an error occurs.

By default the compiler removes the generated output file (. sr ¢c) when an error occurs. This is useful
when you use the make utility. If the erroneous files are not removed, the make utility may process corrupt
files on a subsequent invocation.

Use this option when you still want to inspect the generated assembly source. Even if it is incomplete or
incorrect.

Example

carm --keep-output-files test.c

When an error occurs during compilation, the generated output file t est . sr ¢ will not be removed.
Related information

C compiler option --warnings-as-errors (Treat warnings as errors)
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C compiler option: --language (-A)
Menu entry
1. Select C/C++ Compiler » Language.
2. Enable or disable one or more of the following options:
» Allow GNU C extensions
* Allow // comments in ISO C90 mode
» Check assignment of string literal to non-const string pointer

* Allow optimization across volatile access

Command line syntax
- -l anguage=[f | ags]
- Al fl ags]

You can set the following flags:

+/-gcc g/G  enable a number of gcc extensions

+/-comments p/P /I comments in ISO C90 mode

+/-volatile viV don't optimize across volatile access

+/-strings x/X relaxed const check for string literals
Default: - AGoVx

Default (without flags): - AGPVX

Description

With this option you control the language extensions the compiler can accept. By default the ARM compiler
allows all language extensions, except for gcc extensions.

The option --language (-A) without flags disables all language extensions.

GNU C extensions

The --language=+gcc (-Ag) option enables the following gcc language extensions:
» The identifier __ FUNCTION__ expands to the current function name.

* Alternative syntax for variadic macros.

 Alternative syntax for designated initializers.
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 Allow zero sized arrays.

 Allow empty struct/union.

 Allow unnamed struct/union fields.

» Allow empty initializer list.

« Allow initialization of static objects by compound literals.

» The middle operand of a ? : operator may be omitted.

» Allow a compound statement inside braces as expression.

« Allow arithmetic on void pointers and function pointers.

» Allow a range of values after a single case label.

» Additional preprocessor directive #war ni ng.

» Allow comma operator, conditional operator and cast as Ivalue.
» Aninline function without "st at i c" or "ext er n" will be global.
* An"extern inline"function will not be compiled on its own.

 An__attribute__ directly following a struct/union definition relates to that tag instead of to the
objects in the declaration.

For a more complete description of these extensions, you can refer to the UNIX gcc info pages (info
gce).

Comments in ISO C90 mode

With --language=+comments (-Ap) you tell the compiler to allow C++ style comments (/) in ISO C90
mode (option --is0=90). In ISO C99 mode this style of comments is always accepted.

Check assignment of string literal to non-const string pointer

With --language=+strings (-Ax) you disable warnings about discarded const qualifiers when a string
literal is assigned to a non-const pointer.

char *p;
void main( void ) { p = "hello"; }

Optimization across volatile access

With the --language=+volatile (-Av) option, the compiler will block optimizations when reading or writing
a volatile object, by treating the access as a call to an unknown function. With this option you can prevent
for example that code below the volatile object is optimized away to somewhere above the volatile object.

Example:
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extern unsigned int variable;

extern volatile unsigned int access;

voi d Test Func( unsigned int flag )

{
access = 0
variable | = flag;
if( variable == 3)
{
variable = 0;
}
vari abl e | = 0x8000;
access = 1;
}
Result with --language=-volatile (default)
Test Func: .type func
str Ir,[sp, #4]!
| dr ri,.L3
| dr lr,.L3+4
| dr r2,[r1, #0]
nmov r3, #0
orr ro,r2,r0
cnp ro, #3
str r3,[1r, #0] ;
bne . L2
nmov ro,r3
.L2:
orr ro0,r0, #32768
nmov r2, #1
str r2,[1r, #0] ;
str ro,[r1, #0] ;
| dr pc, [sp], #4
.Si ze Test Func, $- Test Func
.align 4
. L3:
. dw vari abl e
. dw access

Result with --language=+volatile:

Test Func: .type func
str Ir,[sp, #-4]!
| dr r3,.L3
| dr r2,.L3+4
| dr Ir,[r3,#0]
nov ri, #0
orr ro,lr,ro0
cnp ro, #3
str ri,[r2, #0] ;

<== Moved across volatile access

<== Vol atil e access

<== Vol atil e access
<== Moved across volatile access

<== Vol atil e access

Tool Options
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str ro, [r3, #0]
bne . L2
str ri,[r3, #0]
.L2:
| dr ro, [r3, #0]
orr ro, r0, #32768
str ro, [r3, #0]
nov ro, #1
str ro,[r2, #0] ; <== Vol atile access
| dr pc, [sp], #4
. Si ze Test Func, $- Test Func
.align 4
. L3:
. dw vari abl e
. dw access

Note that the volatile behavior of the compiler with option --language=-volatile or --language=+volatile
is ISO C compliant in both cases.

Example

carm - -1 anguage=-coments, +strings --iso=90 test.c
carm-APx -c90 test.c

The compiler compiles in ISO C90 mode, accepts assignments of a constant string to a non-constant
string pointer and does not allow C++ style comments.

Related information

C compiler option --iso (ISO C standard)
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C compiler option: --make-target

Menu entry

Command line syntax

- -make-t ar get =nane

Description

With this option you can overrule the default target name in the make dependencies generated by the
options --preprocess=+make (-Em) and --dep-file. The default target name is the basename of the input
file, with extension . obj .

Example
carm - - preprocess=+make --make-target=nytarget.obj test.c

The compiler generates dependency lines with the default target name nyt ar get . obj instead of
test.obj.

nytarget.obj : test.c
test.c :

Related information
C compiler option --preprocess=+make (Generate dependencies for make)

C compiler option --dep-file (Generate dependencies in a file)
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C compiler option: --max-call-depth

Menu entry
1. Select C/C++ Compiler » Optimization.

2. Inthe Maximum call depth for code compaction field, enter a value.

Command line syntax
- - max- cal | - dept h=val ue

Default: -1

Description

This option is related to the compiler optimization --optimize=+compact (Code compaction or reverse
inlining). Code compaction is the opposite of inlining functions: large sequences of code that occur more
than once, are transformed into a function. This reduces code size (possibly at the cost of execution
speed).

During code compaction it is possible that the compiler generates nested calls. This may cause the
program to run out of its stack. To prevent stack overflow caused by too deeply nested function calls, you
can use this option to limit the call depth. This option can have the following values:

-1 Poses no limit to the call depth (default)

0 The compiler will not generate any function calls. (Effectively the same as if you turned of
code compaction with option --optimize=-compact)

>0 Code sequences are only reversed if this will not lead to code at a call depth larger than
specified with value. Function calls will be placed at a call depth no larger than value-1.
(Note that if you specified a value of 1, the option --optimize=+compact may remain
without effect when code sequences for reversing contain function calls.)

This option does not influence the call depth of user written functions.

If you use this option with various C modules, the call depth is valid for each individual module.
The call depth after linking may differ, depending on the nature of the modules.

Related information
C compiler option --optimize=+compact (Optimization: code compaction)

C compiler option --compact-max-size (Maximum size of a match for code compaction)
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C compiler option: --mil / --mil-split

Menu entry

1. Select C/C++ Compiler » Optimization.

2. Enable the option Build for application wide optimizations (MIL linking).

3. Select Optimize less/Build faster or Optimize more/Build slower.

Command line syntax

il
—-mil-split[=file,...]

Description

With option --mil the C compiler skips the code generator phase and writes the optimized intermediate
representation (MIL) to a file with the suffix . mi | . The C compiler accepts . nmi | files as input files on the
command line.

Option --mil-split does the same as option --mil, but in addition, the C compiler splits the MIL representation
and writes it to separate files with suffix . ms. One file is written for each input file or MIL library specified
on the command line. The . s files are only updated on a change. The C compiler accepts . ns files as
input files on the command line.

With option --mil-split you can perform application-wide optimizations during the frontend phase by
specifying all modules at once, and still invoke the backend phase one module at a time to reduce the
total compilation time. Application wide code compaction is not possible in this case.

Optionally, you can specify another filename for the . ns file the C compiler generates. Without an
argument, the basename of the C source file is used to create the . s filename. Note that if you specify
a filename, you have to specify one filename for every input file.

Build for application wide optimizations (MIL linking) and Optimize less/Build faster

This option is standard MIL linking and splitting. Note that you can control the optimizations to be performed
with the optimization settings.

Optimize more/Build slower

When you enable this option, the compiler's frontend does not split the MIL stream in separate modules,
but feeds it directly to the compiler's backend, allowing the code compaction to be performed application
wide.

Related information
Section 4.1, Compilation Process

Control program option --mil-link / --mil-split
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C compiler option: --misrac

Menu entry
1. Select C/C++ Compiler » MISRA-C.
2. Make a selection from the MISRA-C checking list.

3. If you selected Custom, expand the Custom 2004 or Custom 1998 entry and enable one or more
individual rules.

Command line syntax
--misrac={all | nr[-nr]},...
Description

With this option you specify to the compiler which MISRA-C rules must be checked. With the option
--misrac=all the compiler checks for all supported MISRA-C rules.

Example

carm--msrac=9-13 test.c

The compiler generates an error for each MISRA-C rule 9, 10, 11, 12 or 13 violation in file t est . c.
Related information

Section 4.7.2, C Code Checking: MISRA-C

C compiler option --misrac-advisory-warnings

C compiler option --misrac-required-warnings

Linker option --misrac-report
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C compiler option: --misrac-advisory-warnings / --misrac-required-warnings
Menu entry

1. Select C/C++ Compiler » MISRA-C.

2. Make a selection from the MISRA-C checking list.

3. Enable one or both options Warnings instead of errors for required rules and Warnings instead
of errors for advisory rules.

Command line syntax

--m srac-advi sory-war ni ngs
--m srac-required-warni ngs
Description

Normally, if an advisory rule or required rule is violated, the compiler generates an error. As a consequence,
no output file is generated. With this option, the compiler generates a warning instead of an error.

Related information
Section 4.7.2, C Code Checking: MISRA-C
C compiler option --misrac

Linker option --misrac-report
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C compiler option: --misrac-version

Menu entry
1. Select C/C++ Compiler » MISRA-C.

2. Select the MISRA-C version: 2004 or 1998.

Command line syntax
--m srac-versi on={1998| 2004}

Default: 2004
Description
MISRA-C rules exist in two versions: MISRA-C:1998 and MISRA-C:2004. By default, the C source is

checked against the MISRA-C:2004 rules. With this option you can specify to check against the
MISRA-C:1998 rules.

Related information
Section 4.7.2, C Code Checking: MISRA-C

C compiler option --misrac
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C compiler option: --no-double (-F)
Menu entry

1. Select C/C++ Compiler » Language.

2. Enable the option Treat double as float.
Command line syntax

--no-doubl e

-F

Description

With this option you tell the compiler to treat variables of the type doubl e as f | oat . Because the float
type takes less space, execution speed increases and code size decreases, both at the cost of less
precision.

Example
carm --no-double test.c

The file t est . ¢ is compiled where variables of the type double are treated as float.

Related information
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C compiler option: --no-stdinc

Menu entry

1. Select C/C++ Compiler » Miscellaneous.

2. Add the option --no-stdinc to the Additional options field.
Command line syntax

--no-stdinc

Description

With this option you tell the compiler not to look in the defaulti ncl ude directory relative to the installation
directory, when searching for include files. This way the compiler only searches in the include file search
paths you specified.

Related information
C compiler option --include-directory (Add directory to include file search path)

Section 4.3, How the Compiler Searches Include Files
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C compiler option: --no-warnings (-w)
Menu entry
1. Select C/C++ Compiler » Diagnostics.
The Suppress C compiler warnings box shows the warnings that are currently suppressed.
2. To suppress a warning, click on the Add button in the Suppress warnings box.

3. Enter the numbers, separated by commas or as a range, of the warnings you want to suppress (for
example 537, 538). Or you can use the Add button multiple times.

4. To suppress all warnings, enable the option Suppress all warnings.
Use the Edit and Delete button to change a warning number or to remove a number from the list.

Command line syntax

- - no-war ni ngs[ =nunber [ - nunber],...]

-w nunber [ - nunber], ...]

Description

With this option you can suppresses all warning messages or specific warning messages.
On the command line this option works as follows:

« If you do not specify this option, all warnings are reported.

« If you specify this option but without numbers, all warnings are suppressed.

* If you specify this option with a number or a range, only the specified warnings are suppressed. You
can specify the option --no-warnings=number multiple times.

Example

To suppress warnings 537 and 538, enter:

carmtest.c --no-warni ngs=537, 538

Related information

C compiler option --warnings-as-errors (Treat warnings as errors)

Pragma war ni ng
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C compiler option: --optimize (-O)
Menu entry

1. Select C/C++ Compiler » Optimization.

2. Select an optimization level in the Optimization level box.

Command line syntax
--optin ze[ =fl ags]
-Ofl ags

You can set the following flags:

+/-coalesce alA Coalescer: remove unnecessary moves
+/-ipro b/B Interprocedural register optimizations
+/-cse c/C Common subexpression elimination
+/-expression elE Expression simplification

+/-flow fIF Control flow simplification

+/-glo g/G Generic assembly code optimizations
+/-inline il Automatic function inlining

+/-sign i Sign extend elimination

+/-schedule k/IK Instruction scheduler

+/-loop I/L Loop transformations

+/-forward 0/O  Forward store

+/-propagate p/P Constant propagation

+/-compact r'R Code compaction (reverse inlining)
+/-subscript s/S Subscript strength reduction
+/-unroll u/U Unroll small loops

+/-peephole ylIY Peephole optimizations

+/-cluster Cluster global variables

Use the following options for predefined sets of flags:

--optimize=0 -O0  No optimization
Alias for -OaBCEFGIJKLOPRSUY,-cluster

No optimizations are performed except for the coalescer (to allow better debug information). The compiler
tries to achieve an optimal resemblance between source code and produced code. Expressions are
evaluated in the same order as written in the source code, associative and commutative properties are
not used.
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--optimize=1 -O1  Optimize
Alias for -OabcefglJKLOPRSUy,-cluster

Enables optimizations that do not affect the debug ability of the source code. Use this level when you
encounter problems during debugging your source code with optimization level 2.

--optimize=2 -02  Optimize more (default)
Alias for -OabcefglJkloprsUy,-cluster

Enables more optimizations to reduce code size and/or execution time. This is the default optimization
level.

--optimize=3 -O3  Optimize most
Alias for -OabcefgiJkloprsuy,+cluster

This is the highest optimization level. Use this level to decrease execution time to meet your real-time
requirements.

Default: - - opti mi ze=2
Description

With this option you can control the level of optimization. If you do not use this option, the default
optimization level is Optimize more (option --optimize=2 or --optimize).

When you use this option to specify a set of optimizations, you can overrule these settings in your C
source file with #pr agna optim ze fl ag/#pragma endoptim ze.

In addition to the option --optimize, you can specify the option --tradeoff (-t). With this option you specify
whether the used optimizations should optimize for more speed (regardless of code size) or for smaller
code size (regardless of speed).

Example
The following invocations are equivalent and result all in the default optimization set:

carmtest.c

carm--optimze=2 test.c
carm-Q2 test.c

carm--optimze test.c
carm-Otest.c

carm - Cabcef gl Jkl opsrUy test.c

carm --optim ze=+coal esce, +i pro, +cse, +expr essi on, +f | ow, +gl o,
-inline,-sign, +schedul e, +l oop, +f orwar d, +pr opagat e,
+conpact, +subscri pt, -unrol |, +peephol e, -cl uster test.c
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Related information
C compiler option --tradeoff (Trade off between speed and size)
Pragma opti m ze/ endopti m ze

Section 4.5, Compiler Optimizations
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C compiler option: --option-file (-f)

Menu entry
1. Select C/C++ Compiler » Miscellaneous.
2. Add the option --option-file to the Additional options field.

Be aware that the options in the option file are added to the C compiler options you have set in the
other pages. Only in extraordinary cases you may want to use them in combination.

Command line syntax
--option-file=file,...

-f file,...

Description

This option is primarily intended for command line use. Instead of typing all options on the command line,
you can create an option file which contains all options and flags you want to specify. With this option
you specify the option file to the compiler.

Use an option file when the command line would exceed the limits of the operating system, or just to store
options and save typing.

You can specify the option --option-file multiple times.

Format of an option file

* Multiple arguments on one line in the option file are allowed.

» To include whitespace in an argument, surround the argument with single or double quotes.

« If you want to use single quotes as part of the argument, surround the argument by double quotes and
vise versa:

"This has a single quote ' enbedded"
"This has a double quote " enbedded'
'"This has a double quote " and a single quote '"' enbedded"
» When a text line reaches its length limit, use a \ to continue the line. Whitespace between quotes is
preserved.

"This is a continuation \
li ne"

-> "This is a continuation |ine"
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* Itis possible to nest command line files up to 25 levels.

Example

Suppose the file myopt i ons contains the following lines:

--debug-info
- - def i ne=DEMO=1
test.c

Specify the option file to the compiler:
carm --option-fil e=myoptions
This is equivalent to the following command line:

carm --debug-info --defi ne=DEMO=1 test.c

Related information
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C compiler option: --output (-0)

Menu entry

Eclipse names the output file always after the C source file.
Command line syntax

--output=file

-o file

Description

With this option you can specify another filename for the output file of the compiler. Without this option
the basename of the C source file is used with extension . src.

Example
To create the file out put . src instead of t est . src, enter:

carm --out put =out put.src test.c

Related information
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C compiler option: --preprocess (-E)

Menu entry

1. Select C/C++ Compiler » Preprocessing.

2. Enable the option Store preprocessor output in <file>.pre.

3. (Optional) Enable the option Keep comments in preprocessor output.
4. (Optional) Enable the option Keep #line info in preprocessor output.
Command line syntax

- - preprocess[ =fl ags]

-E[ fl ags]

You can set the following flags:

+/-comments c/C keep comments

+/-includes i/l generate a list of included source files
+/-list I/L generate a list of macro definitions
+/-make m/M  generate dependencies for make
+/-noline p/P strip #line source position information

Default: - ECI LIMP

Description

With this option you tell the compiler to preprocess the C source. Under Eclipse the compiler sends the
preprocessed output to the file nane. pr e (where name is the name of the C source file to compile).
Eclipse also compiles the C source.

On the command line, the compiler sends the preprocessed file to stdout. To capture the information in
a file, specify an output file with the option --output.

With --preprocess=+comments you tell the preprocessor to keep the comments from the C source file
in the preprocessed output.

With --preprocess=+includes the compiler will generate a list of all included source files. The preprocessor
outpu